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Chapter 1 Introduction

1.1 Overview

This manual describes how to use the Renesas Flexible Software Package (FSP) for writing
applications for the RA microcontroller series.

1.2 Using this Manual

This manual provides a wide variety of information, so it can be helpful to know where to start. Here
is a short description of each main section and how they can be used.

Starting Development - Provides a step by step guide on how to use e2 studio and FSP to develop a
project for RA MCUs. This is a good place to start to get up to speed quickly and efficiently.

FSP Architecture - Provides useful background material on key FSP concepts such as Modules,
Stacks, and API standards. Reference this section to extend or refresh your knowledge of FSP
concepts.

API Reference

e Provides detailed information on each module and interface including features, API
functions, configuration settings, usage notes, function prototypes and code examples.
Board Support Package (BSP) related API functions are also included.

Note
Much of the information in the APl Reference section is available from within the e2 studio tool via the Devel oper
Assistance feature. The information here can be referenced for additional details on API features.

1.3 Documentation Standard

Each module user guide outlines the following:

e Features: A bullet list of high level features provided by the module.

e Configuration: A description of module specific configurations available in the RA
Configuration editor.

¢ Usage Notes: Module specific documentation and limitations.

e Examples: Example code provided to help the user get started.

e API Reference: Usage notes for each API in the module, including the function prototype and
hyperlinks to the interface documentation for parameter definitions.

Interface documentation includes typed enumerations and structures-including a structure of
function pointers that defines the API-that are shared by all modules that implement the interface.

1.4 Introduction to FSP

1.4.1 Purpose

R11UMO146EU0120 Revision 1.20 RENESANAS Page 7/ 1,560
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The Renesas Flexible Software Package (FSP) is an optimized software package designed to provide
easy to use, scalable, high quality software for embedded system design. The primary goal is to
provide lightweight, efficient drivers that meet common use cases in embedded systems.

1.4.2 Quality

FSP code quality is enforced by peer reviews, automated requirements-based testing, and
automated static analysis.

1.4.3 Ease of Use

FSP provides uniform and intuitive APIs that are well documented. Each module is supported with
detailed user documentation including example code.

1.4.4 Scalability

FSP modules can be used on any MCU in the RA family, provided the MCU has any peripherals
required by the module.

1.4.5 Build Time Configurations

FSP modules also have build time configurations that can be used to optimize the size of the module
for the feature set required by the application.

1.4.6 e2 studio IDE

FSP provides a host of efficiency enhancing tools for developing projects targeting the Renesas RA
series of MCU devices. The e2 studio IDE provides a familiar development cockpit from which the key
steps of project creation, module selection and configuration, code development, code generation,
and debugging are all managed.

R11UMO146EU0120 Revision 1.20 RENESANAS Page 8/ 1,560
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Chapter 2 Starting Development

2.1 Starting Development Introduction

The wealth of resources available to learn about and use e2 studio and FSP can be overwhelming on
first inspection, so this section provides a Starting Development Guide with a list of the most
important initial steps. Following these highly recommended first 11 steps will bring you up to speed
on the development environment in record time. Even experienced developers can benefit from the
use of this guide, to learn the terminology that might be unfamiliar or different from previous
environments.

1. Read the section What is e2 studio?, up to but not including e2 studio Prerequisites. This
will provide a description of the various windows and views to use e2 studio to create a
project, add modules and threads, configure module properties, add code, and debug a
project. It also describes how to use key coding 'accelerators' like Developer Assist (to drag
and drop parameter populated API function calls right into your code), a context aware
Autocomplete (to easily find and select from suggested enumerations, functions, types, and
many other coding elements), and many other similar productivity enhancers.

2. Read the FSP Architecture, FSP Modules and FSP Stacks sections. These provide the basic
background on how FSP modules and stacks are used to construct your application.
Understanding their definitions and the theory behind how they combine will make it easier
to develop with FSP.

3. Read a few Modules sections to see how to use API function calls, structures, enumerations,
types and callbacks. These module guides provide the information you will use to
implement your project code.

4. After you have a Kit and you have downloaded and installed e2 studio and FSP, you can
build and debug a simple project to test your installation, tool flow, and the kit. (If you do
not have a Kit or have not yet installed the development software, use the links included in
the e2 studio Prerequisites for more information.) The simple Tutorial: Your First RA MCU
Project - Blinky will Blink an LED on and off. Follow the instructions for importing and
running this project. It will use some of the key steps for managing projects within e2 studio
and is a good way to learn the basics.

5. Once you have successfully run Blinky you have a good starting point for using FSP for more
complex projects. The Using HAL Drivers Tutorial, available at Tutorial: Using HAL Drivers -
Programming the WDT, shows how to create a project from scratch, using FSP API functions.
Do this next.

6. Several Hands-on Quick FSP Labs are available that cover key development topics with
short 15-minute Do it Yourself (DiY) activities targeting the EK-RA6M3. Topics covered
include code development accelerators like Developer Assistance, Autocomplete, Edit
Hover, Help, Visual Expressions and using Example Projects. The complete list of available
Quick FSP Labs can be found here: https://en-
support.renesas.com/knowledgeBase/19308277. Doing a couple of these labs provides
further details and practice using FSP and is highly recommended.

7. The balance of the FSP Architecture sections (that is, those not called out in step 2 above)
contain additional reference material that may be helpful in the future. Scan them so you
know what they contain, in case you need them.

8. The balance of the e2 studio User Guide, starting with the What is a Project? section up to,
but not including, Writing the Application section, provides a detailed description of each of
the key steps, windows, and entries used to create, manage, configure, build and debug a

R11UMO146EU0120 Revision 1.20 RENESANAS Page 9/ 1,560
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10.

11.

project. Much of this may be familiar after running through the tutorials and Quick Labs.
However, it is important to have a good grasp of what each of the configuration tabs are
used for as that is where the bulk of the project preparation work takes place prior to

writing code. Skim over this section as it may help with any questions in the future.

. Read the Writing the Application section to get a short introduction to the steps used when

creating application code with FSP. It covers both RTOS-independent and RTOS-dependent
applications. It also includes a short description for several of the code accelerators you
should be familiar with by now. Using additional Quick FSP Labs is a good way to become
familiar with the application development process and links to them are included in the
appropriate places in this section. You can find the complete list of available Quick FSP Labs

here: https://en-support.renesas.com/knowledgeBase/19308277.

Scan the Debugging the Project section to see the steps required to download and start a

debug session.

Explore the additional material available on the following web pages and bookmark the

resources that look most valuable to you:

. RA Landing Page: https://www.renesas.com/ra

. FSP Landing Page: https://www.renesas.com/fsp

. Example Projects on GitHub: https://github.com/renesas/ra-fsp-examples

™ QN T QD

support.renesas.com/knowledgeBase/category/31087

. Quick FSP Labs Listing: https://en-support.renesas.com/knowledgeBase/19308277
. RA and FSP Knowledge Base (with articles of interest on RA and FSP): https://en-

f. RA and FSP Renesas Rulz site (Community posted and answered questions):

https://renesasrulz.com/ra/
g. FSP Releases: https://github.com/renesas/fsp/releases
h. FSP Documentation: https://renesas.github.io/fsp

i. Online Technical Support: https://www.renesas.com/us/en/support/contact.html

2.2 e2 studio User Guide

2.2.1 What is e2 studio?

Renesas e2 studio is a development tool encompassing code development, build, and debug. e2
studio is based on the open-source Eclipse IDE and the associated C/C++ Development Tooling

(CDT).

When developing for RA MCUs, e2 studio hosts the Renesas Flexible Software Package (FSP). FSP

provides a wide range of time saving tools to simplify the selection, configuration, and management
of modules and threads, to easily implement complex applications. The time saving tools available in
e2 studio and FSP include the following:

A Graphical User Interface (GUI) (see Adding Threads and Drivers) with numerous wizards

for configuring and auto-generating code

A context sensitive Autocomplete (see Tutorial: Using HAL Drivers - Programming the WDT)

feature that provides intelligent options for completing a programming element

A Developer Assistance tool for selection of and drag and drop placement of API functions

directly in application code
An Edit Hover feature to show detailed descriptions of code elements while editing

A Welcome Window with links to example projects, application notes and a variety of other

self-help support resources

An Information Icon from each module is provided in the graphic configuration viewer that
links to specific design resources, including code 'cheat sheets' that provide useful starting

points for common application implementations.
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RENESAS

e’ studio

(' BUILT ON

Figure 1: e2 studio Splash Screen

e2 studio organizes project work based on Perspectives, Views, Windows, Panes, and Pages
(sometimes called Tabs). A window is a section of the e2 studio GUI that presents information on a
key topic. Windows often use tabs to select sub-topics. For example, an editor window might have a
tab available for each open file, so it is easy to switch back and forth between them. A window Pane
is a section of a window. Within a window, multiple Panes can be opened and viewed simultaneously,
as opposed to a tabbed window, where only individual content is displayed. A memory-display
Window, for example, might have multiple Panes that allow the data to be displayed in different
formats, simultaneously. A Perspective is a collection of Views and Windows typical for a specific
stage of development. The default perspectives are a C/C++ Perspective, an FSP Configuration
Perspective and a Debug Perspective. These provide specific Views, Windows, Tabs, and Panes
tailored for the common tasks needed during the specific development stage.
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File Edit MNavigate Search Project RenesasVWiews Run Window Help

4 Detug

I Project Bxplorer 31 [ %‘ @
v T Blinky

[£7] Blinky Debug [

¥ = B {8 [Blinky] RA Configuration 2%

|[®-&-B FiH-Q-ic -

m}

& Package %

) B R R I

|| B C/Ce+ {5 RA Configuration
a&- @-B-- 0

Summar;
i Includes ¥ Generate Project Content PR AR B TRRE R I R L AR, TR
Era A [P1oe |[P300 | vss || wcc || pzoo || P20s | P20 |jwCcuspuseow| pao7 | A
(2 ra_gen Project Summary ; ~ =
B2 src RENESAS B P10 ||p302 [ P03 || P304 || P20t | 208 | P214 |jvsSSUSBUSECE|| pacs | B
& radg Board: Custom User Board (Any Devi [~
: y Device) - -
] Blinky Debug.launch Devica: A7FABMIADZCLY C [Pz |[p301 (P10 ([P30s (| P307 || P210 || P205 (| P207 || P413 || P41z | €
% configuration.xml -
i:R"FAgMTADZCLJ inch Toolchain: GCC ARM Embedded D | peos || P1a4 || P11t || P06 ||RES# || P211 | Pags || Peay || vss ((vec |D
= e Toolchain Version: 92120191025
(3) Developer Assistance
FSP Version: 110 E | vCC ([ Pe1d | PE0S (| PU15 (| P113 || P410 || P414 || P15 || P23 (| P212 | E
Selected software components F | vew || vss | peoz || peot (| peoo || Pao2 || pavs || P7o8 || xCIN (xooUT F
Custom Board Support Files vii0 G | p10s |[ P10s [ P107 || PS03 || PS04 (| Psoe | Poos (| Paos VBATT]vCLO | 6
Simple application that blinks an LED. No RTOS included. v1.1.0 avee
X H [p1o4 (P10t | P103 || P10O avsso || Poo7 ([ Poo3 || paos [ peo3 | H
Arm CMSIS Version 5 - Core (M) v5.6.0 o
Board support package for RFFABM1AD2CLJ v1.1.0 1 | p1oz || psot || vss || pots |jvrem| VK[;EF‘- pooe || poot || paot || paze |0
Board support package for RAGM1 v1.1.0
Board support package for RAGM1 - FSP Data v1.1.0 | psgo || psoz || vee || pons |rern|MREFH| poos || pooz || poot | poco | X
Board Support Package Common Files v1.1.0 v 1 2 ) 1 5 5 7 ] 3 10
110 Port v1.1.0
R7FAGM1AxxL]) - T00LGA (Top View)
Yol @ Connection status:
(i) e -
Support I:IOK
Summary | BSP | Clocks | Pins| Interrupts | Event Links | Stacks| Components
[ Properties 5 |[#] Problems @ Smart Browser £ ¥ = B [&PinConflicts 3 * T =A
S = = 0 it
configuration.xml - Blinky HEms
Description Module Pin Location Resource
Resource | Property Value
v Info
derived false
editable true
last medified May 25, 2020 at 6:48:18 PM
linked false
location Ci\Users\Austin Hansen'\e2_studichworkspace_demo'Blinky\conf
name configurationxml
path /Blinky/configurationxml
size 12,051 bytes
< > < >

Figure 2: Default Perspective

In addition to managing project development, selecting modules, configuring them and simplifying
code development, e2 studio also hosts the engine for automatically generating code based on
module selections and configurations. The engine continually checks for dependencies and
automatically adds any needed lower level modules to the module stack. It also identifies any lower
level modules that require configuration (for example, an interrupt that needs to have a priority
assigned). It also provides a guide for selecting between multiple choices or options to make it easy
to complete a fully functional module stack.

The Generate Project Content function takes the selected and configured modules and automatically
generates the complete and correct configuration code. The code is added to the folders visible in
the Project Explorer window in e2 studio. The configuration.xml file in the project folder holds all
the generated configuration settings. This file can be opened in the GUI-based RA Configuration
editor to make further edits and changes. Once a project has been generated, you can go back and
reconfigure any of the modules and settings if required using this editor.
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15 Project Explorer £3 ]
~ 1% MyProject [Debug]

3 Binaries

5l Includes

= ra

2 ra_gen

8 src

= Debug

= ra_cfg

= script
507 configuration.xml

=| MyProject Debug,jlink
= R7FAGM3AHICFC.pincfg
=/ ra_cfgixt

= RABM3-EK.pincfg

(7) Developer Assistance

Figure 3: Project Explorer Window showing generated folders and configuration.xml file

2.2.2 e2 studio Prerequisites

2.2.2.1 Obtaining an RA MCU Kit

To develop applications with FSP, start with one of the Renesas RA MCU Evaluation Kits. The Renesas
RA MCU Evaluation Kits are designed to seamlessly integrate with the e2 studio.

Ordering information, Quick Start Guides, User Manuals, and other related documents for all RA MCU
Evaluation Kits are available at https://www.renesas.com/ra.

2.2.2.2 PC Requirements
The following are the minimum PC requirements to use e2 studio:

e Windows 10 with Intel i5 or i7, or AMD A10-7850K or FX

e Memory: 8-GB DDR3 or DDR4 DRAM (16-GB DDR4/2400-MHz RAM is preferred)

e Minimum 250-GB hard disk
2.2.2.3 Installing e2 studio, platform installer and the FSP package
Detailed installation instructions for the e2 studio and the FSP are available on the Renesas website
https://www.renesas.com/fsp. Review the release notes for e2 studio to ensure that the e2 studio
version supports the selected FSP version. The starting version of the installer includes all features of
the RA MCUs.
2.2.2.4 Choosing a Toolchain
e2 studio can work with several toolchains and toolchain versions such as the GNU Arm compiler and
Arm AC6. A version of the GNU Arm compiler is included in the e2 studio installer and has been
verified to run with the FSP version.

2.2.2.5 Licensing

FSP licensing includes full source code, limited to Renesas hardware only.
2.2.3 What is a Project?

In e2 studio, all FSP applications are organized in RA MCU projects. Setting up an RA MCU project
involves:

1. Creating a Project
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2. Configuring a Project

These steps are described in detail in the next two sections. When you have existing projects
already, after you launch e2 studio and select a workspace, all projects previously saved in the
selected workspace are loaded and displayed in the Project Explorer window. Each project has an
associated configuration file named configuration.xml, which is located in the project's root directory.

i Project Explorer £3

~ 1% MyProject [Debug]

X}k Binaries

o Includes

Bra

[ ra_gen

3 src

= Debug

= ra_cfg

= script

=| MyProject Debug,jlink
= RTFAEM3AHICFC.pincfg
= ra_cfgixt

= RAEM3-EK pincfg

(7) Developer Assistance

Figure 4: e2 studio Project Configuration file

Double-click on the configuration.xml file to open the RA MCU Project Editor. To edit the project
configuration, make sure that the RA Configuration perspective is selected in the upper right hand
corner of the e2 studio window. Once selected, you can use the editor to view or modify the
configuration settings associated with this project.

[ | BEC/C++ {5} RA Configuration

Figure 5: e2 studio RA Configuration Perspective

Note

Whenever the RA project configuration (that is, the configuration.xml file) is saved, a verbose RA Project Report
file (ra_cfg.txt) with all the project settings is generated. The format allows differences to be easily viewed using a
text comparison tool. The generated file islocated in the project root directory.

[ Project Explorer 32 = (a5

=Rl

w =5 MyProject [Debug]

g;b Binaries

[ Includes

B ra

(2 ra_gen

(# src

(= Debug

(= ra_cfg

= script

& configurationxml

|=l MyProject Debug.jlink

|=| RTFAEM3IAHICFC.pincfg

==

|=| RAGM3-EK.pincfg

(?) Developer Assistance

=| ra_cfg.txt B2

i § RA Configuration
2 Board "EK-RAGM3™
3 R7FABM3AH3CFC
part_number: R7FAGM3AH3CFC
5 rom_size bytes: 2897152
6 ram_size bytes: 65536@
7 data_flash_size_bytes: 65536
g package_style: LQFP
package_pins: 176

RAGM3

12 series: g

14 RAGM3 Family

OFS@ register settings: Independent WDT: Start Mod
OFS@ register settings: Independent WDT: Timeout P

1 OF5@ register settings: Independent WDT: Dedicated

OFS@ register settings: Independent WDT: Window En
OFS@ register settings: Independent WDT: Window St
OF5@ register settings: Independent WDT: Reset Int
OF5@ register settings: Independent WDT: Stop Cont
OFS@ register settings: WDT: Start Mode Select: 5t

22

23 OFS@ register settings: WDT: Timeout Period: 16384

24 OFS@ register settings: WDT: Clock Frequency Divis

25 OFS@ register settings: WDT: Window End Position:
<

Figure 6: RA Project Report
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The RA Project Editor has a number of tabs. The configuration steps and options for individual tabs
are discussed in the following sections.

Note
The tabs available in the RA Project Editor depend on the €2 studio version.

£ *[MyProject] RA Configuration 52 - a

Summar’
¥ Generate Project Content

Project Summary

RENESAS
Board: EK-RAGM3
Device: R7FABM3AH3CFC
Toolchain: GCC ARM Embedded
Toolchain Version: 9.2.1.20191025
FSP Version: 110

Selected software components

RABM3-EK Board Support Files v11.0
Board support package for RTFAGM3AH3CFC v1.1.0
Board support package for RABM3 v1.1.0
Board support package for RABM3 - FSP Data v1.1.0
Arm CMSIS Version 5 - Cora (M) v5.6.0
Board Support Package Commeon Files v11.0
1iQ Port v1.1.0

=H0

I Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks Componantsl

Figure 7: RA Project Editor tabs

e Click on the YouTube icon to visit the Renesas FSP playlist on YouTube
e Click on the Support icon to visit RA support pages at Renesas.com
e Click on the user manual (owl) icon to open the RA software package User's Manual

2.2.4 Creating a Project

During project creation, you specify the type of project, give it a project name and location, and
configure the project settings for version, target board, whether an RTOS is included, the toolchain
version, and the beginning template. This section includes easy-to-follow step-by-step instructions
for all of the project creation tasks. Once you have created the project, you can move to configuring
the project hardware (clocks, pins, interrupts) and the parameters of all the modules that are part of
your application.

2.2.4.1 Creating a New Project
For RA MCU applications, generate a new project using the following steps:

1. Click on File > New > RA C/C++ Project.

B Workspace - ¢ studio
File Edit MNavigate Search Project RenesasViews Run Window Help

New Alt+Shift+N » = RA C/C++ Project
Open File... ™ Project...
() Open Projects from File System... % Eample..
Ele=s GtW |2 Other. Ctrl+N

Figure 8: New RA MCU Project

R11UMO146EU0120 Revision 1.20 RENESANS Page 15 /1,560
Jun.26.20



Flexible Software Package User’s Manual

Starting Development > e2 studio User Guide > Creating a Project > Creating a New Project

Then click on the type of template for the type of project you are creating.

Mew RA C/C++ Project ul X

Templates for New RA C/C++ Project

Renesas RA C Executable Project
C/C++ == A C Brecutable Project for Renesas RA.

Renesas RA C Library Project
=== A C Library Project for Renesas RA.

Renesas RA C Project Using RA Librar
) 9 ¥
F== Creates o C application project which uses an existing RA library project

Renesas RA C++ Executable Project
FE A C++ Executable Project for Renesas RA.

enesas ++ LiDrar roj
R RA C++ Library Project
== A C++ Library Project for Renesas RA.

Renesas RA C++ Project Using RA Librar
] 9 Y
FSZ Creates o C++ applicatior. project which uses an existing RA library project

@ <Back | Nets Finish Cancel

Figure 9: New Project Templates

2. Select a project name and location.

e stucio - Project Configuratior (RA C Executable Project) [u] X
e2 studio - Project Configuration (RA C Executable Project) —

Specify the new project details,

Project Toolchains

Project name | MyProject GCC ARM Embedded

Use default lacation
D:\FSPAFSP_Workspace\MyProject Browse...

default

('_7) = Back Next > Finish Cancel

Figure 10: RA MCU Project Generator (Screen 1)

3. Click Next.
2.2.4.2 Selecting a Board and Toolchain
In the Project Configuration window select the hardware and software environment:

1. Select the FSP version.

2. Select the Board for your application. You can select an existing RA MCU Evaluation Kit or
select Custom User Board for any of the RA MCU devices with your own BSP definition.

3. Select the Device. The Device is automatically populated based on the Board selection.
Only change the Device when using the Custom User Board (Any Device) board
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selection.
. To add threads, select RTOS, or No RTOS if an RTOS is not being used.
. The Toolchain selection defaults to GCC Arm Embedded.
. Select the Toolchain version. This should default to the installed toolchain version.
. Select the Debugger. The J-Link Arm Debugger is preselected.

~N o U b~

8. Click Next.
e studio - Project Configuration (RA C Executable Project) O X
e2 studio - Project Configuration (RA C Executable Project) —_—
Select the board support that you require.
Device Selection
FSP version: |1.1.0 Board Details
Device: R7FABM3IAHICFC
RTOS: No RTOS ~
Select Tools Available Tools
Toolchain: GMU ARM Embedded ~ GNU ARM Embedded
Toolchain version: |9.2.1.20191025 ~ 8:21.20191025
8.3.1.20190703
Debugger: J-Link ARM ~ 7.2.1.20170904
4.9.3.20150529
w Debuggers
E2 (ARM)
E2 Lite (ARM)
J-Link ARM
~ Smart Manual
10 Registers Supported
Software Manual Supported
@ Hel e
b elp < Back Nest > Einish Cancel
Figure 11: RA MCU Project Generator (Screen 2)
Note

Click onthe Help icon (?) for user guides, RA contents, and other documents.

2.2.4.3 Selecting a Project Template

In the next window, select a project template from the list of available templates. By default, this
screen shows the templates that are included in your current RA MCU pack. Once you have selected
the appropriate template, click Finish.

Note
If you want to devel op your own application, select the basic template for your board, Bare Metal - Minimal.
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e studio - Project Configuration (RA C Executable Project) m] X

e2 studio - Project Configuration (RA C Executable Project)
Select the type of project you wish to create.

Project Template Selection

o '| Bare Metal - Blinky
o]

- Bare metal FSP project that includes BSP and will blink LEDs if available, This project will initialize
clocks, pins, stacks, and the C runtime envirenment.

[Renesas.RA.1.1.0.pack]

® d Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C
runtime environment.

[Renesas.RA.1.1.0.pack]

Code Generation Settings
Use Renesas Code Formatter

@ Next > Einish Cancel
Figure 12: RA MCU Project Generator (Screen 3)

When the project is created, e2 studio displays a summary of the current project configuration in the
RA MCU Project Editor.

48k *[MyProject] RA Configuration 53 = g

Summar
y Generate Project Content

Project Summary

RENESAS
Board: EK-RABM3
Device: R7FAEM3AH3ICFC
Toolchain: GCC ARM Embedded
Toolchain Version: 9.2.1.20191025
FSP Version: 1.1.0

Selected software components

RAEM3-EK Board Support Files vi1.0
Board support package for RTFAGM3AH3CFC v1.1.0
Board support package for RABM3 v11.0
Board support package for RABM3 - FSP Data v1.1.0
Arm CMSIS Version 5 - Core (M) v5 6.0
Board Support Package Common Files vi1.0
110 Port v11.0

=B0

I Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks Cumpunentsl

Figure 13: RA MCU Project Editor and available editor tabs

On the bottom of the RA MCU Project Editor view, you can find the tabs for configuring multiple
aspects of your project:

e With the Summary tab, you can see all they key characteristics of the project: board,
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device, toolchain, and more.

e With the BSP tab, you can change board specific parameters from the initial project
selection.

e With the Clocks tab, you can configure the MCU clock settings for your project.

e With the Pins tab, you can configure the electrical characteristics and functions of each
port pin.

e With the Interrupts tab, you can add new user events/interrupts.

e With the Event Links tab, you can configure events used by the Event Link Controller.

e With the Stacks tab, you can add and configure FSP modules. For each module selected in
this tab, the Properties window provides access to the configuration parameters, interrupt
priorities, and pin selections.

e The Components tab provides an overview of the selected modules. Although you can also
add drivers for specific FSP releases and application sample code here, this tab is normally
only used for reference.

The functions and use of each of these tabs is explained in detail in the next section.
2.2.5 Configuring a Project

Each of the configurable elements in an FSP project can be edited using the appropriate tab in the
RA Configuration editor window. Importantly, the initial configuration of the MCU after reset and
before any user code is executed is set by the configuration settings in the BSP, Clocks and Pins
tabs. When you select a project template during project creation, e2 studio configures default values
that are appropriate for the associated board. You can change those default values as needed. The
following sections detail the process of configuring each of the project elements for each of the
associated tabs.

Summary Tab

8% *[MyProject] RA Configuration 53 = 8

Summar’
¥ Generate Project Content

Project Summary

RENESAS
Board: EK-RAGM3
Device: R7FABM3AH3CFC
Toolchain: GCC ARM Embedded
Toolchain Version: 9.2.1.20191025
FSP Version: 110

Selected software components

Arm CMSIS Version 5 - Core (M) v5 6.0
RAEM3-EK Board Support Files vi1.0
Board support package for RTFAGM3AH3CFC v1.1.0
Board support package for RABM3 vi1.0
Board support package for RABM3 - FSP Data v1.1.0
Board Support Package Commeon Files v11.0
1iQ Port v1.1.0

You[TD @

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Compenents

Figure 14: Configuration Summary tab

The Summary tab, seen in the above figure, identifies all the key elements and components of a
project. It shows the target board, the device, toolchain and FSP version. Additionally, it provides a
list of all the selected software components and modules used by the project. This is a more
convenient summary view when compared to the Components tab.
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The summary tab also includes handy icons with links to the Renesas YouTube channel, the Renesas
support page and to the RA FSP User Manual that was downloaded during the installation process.

2.2.5.1 Configuring the BSP

The BSP tab shows the currently selected board (if any) and device. The Properties view is located in
the lower left of the Project Configurations view as shown below.

Note

If the Properties view is not visible, click Window > Show View > Properties in the top menu bar.

Summa locks | Pins | Interrupts | Event Links | Stacks Components

[E Properties 52

EK-RABM3

Settings Property

~ R7FABM3AH3ICFC
part_number
rom_size_bytes
ram_size_bytes
data_flash_size_bytes
package_style
package_pins

~ RABM3
series

v =g

Value

R7FABM3AH3CFC
2097152

653360

63336

LQFP

176

6

~ RABM3 Family
OFS0 register settings
OF51 register settings
MPU

~ RA Common
Main stack size (bytes) Oacd D0
Heap size (bytes) 0
MCU Ve (mV) 3300

Darameter charkinm Nicshlad

Figure 15: Configuration BSP tab

The Properties view shows the configurable options available for the BSP. These can be changed
as required. The BSP is the FSP layer above the MCU hardware. e2 studio checks the entry fields to
flag invalid entries. For example, only valid numeric values can be entered for the stack size.

When you click the Generate Project Content button, the BSP configuration contents are written
to ra_cfg/fsp_cfg/bsp/bsp_cfg.h

This file is created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

2.2.5.2 Configuring Clocks

The Clocks tab presents a graphical view of the MCU's clock tree, allowing the various clock dividers
and sources to be modified. If a clock setting is invalid, the offending clock value is highlighted in
red. It is still possible to generate code with this setting, but correct operation cannot be guaranteed.
In the figure below, the USB clock UCLK has been changed so the resulting clock frequency is 60 MHz
instead of the required 48 MHz. This parameter is colored red.
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5 *[MyProject] RA Configuration 53

Clocks Configuration

PLL Sre: XTAL v > pCLKA Div /2 < —{ pcLia 120mH:z

PLL Div /2 t - > PCLKE Div /4 w —{pcLi somtz

PLL Mul xZOi v > pCLIC Div /4 N
[ USBMCLK 24MHz | | [P 240MH;L ! Clock Sre: PLL « <= PCLKD Div /2 v—s{pakp oM
HOCO 20MHz v SDCLKout On —{ spcLkout 120MHz

"= FCLK Div /4 ~ —)| FCLK 60MHz

CLKOUT Disabled ~ —= CLKOUT Div /1 v —>| CLKOUT 0Hz
Summary | BSP Pins | Interrupts | Event Links Stacks  Components

Figure 16: Configuration Clocks tab

When you click the Generate Project Content button, the clock configuration contents are written
to: ra_gen/bsp_clock_cfg.h

This file will be created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

2.2.5.3 Configuring Pins

The Pins tab provides flexible configuration of the MCU's pins. As many pins are able to provide
multiple functions, they can be configured on a peripheral basis. For example, selecting a serial
channel via the SCI peripheral offers multiple options for the location of the receive and transmit pins
for that module and channel. Once a pin is configured, it is shown as green in the Package view.

Note
If the Package view window is not open in e2 studio, select Window > Show View > Pin Configurator > Package
from the top menu bar to open it.

The Pins tab simplifies the configuration of large packages with highly multiplexed pins by
highlighting errors and presenting the options for each pin or for each peripheral. If you selected a
project template for a specific board such as the EK-RA6M3, some peripherals connected on the
board are preselected.
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455 *[MyProject] RA Configuration 33 = &  pPackage 31 2 @

Pins Configuration ML o 1000000000

Select pin configuration

RAGM3-EK.pincfg v Generate data: | g_bsp_pin_cfg

Pin Selection Pin Configuration
typefiltertent | o7 | @ =
v v Connectivity:5C1 & Module name: scI7 N
sCio RIFABM3A00FC
Usage: When using Simple 12C mode, ensure port ¢ 17ELOFR
s open drain, [Top View!
sCi2 When switching between 12C and other moi
v SCI3
el Pin Group Selection: _Conly ~
sh Operation Mode: Asynchronous UART ~
sCle
v SCI7 Input/Qutput
S8 | B613
sCig
i Coidecsnin s Y 0RO v [PA14
< > <

Summary |BSP | & Clocks Interrupts | Event Links | Stacks | Components
< >

ckage |[ig Pin Conflicts 57

Figure 17: Pins Configuration

The pin configurator includes a built-in conflict checker, so if the same pin is allocated to another
peripheral or I/O function the pin will be shown as red in the package view and also with white cross
in a red square in the Pin Selection pane and Pin Configuration pane in the main Pins tab. The
Pin Conflicts view provides a list of conflicts, so conflicts can be quickly identified and fixed.

In the example shown below, port P611 is already used by the CAC, and the attempt to connect this
port to the Serial Communications Interface (SCI) results in a dangling connection error. To fix this

error, select another port from the pin drop-down list or disable the CAC in the Pin Selection pane
on the left side of the tab.

8% *[MyProject] RA Configuration 3 o e

Pins Configuration
g9 Generate Project Content

Select pin configuration Pins Tutorial /;3 2 ﬁJ,

RAEM3-EK, pincfg ~ Generate data: | g_bsp_pin_cfg
Pin Selection Pin Configuration
type filter text £| @ E
v B Connectivity:5C! " Operstion Mode: Simple SPI v &
sCI0
sCn Input/Qutput
5CI2
s TXD_MOSE: v |PB13 > =
SCI4 RXD_MISO: ¥ | P614 i =}
SCI5 1
sCi6 SCK: v |P612 v =
e R i ’PEH = Ey
5CI8 ]
scio ) None
v Connectivity:SPI None 2
Connectivity:55] 3 &

oo _enrc 2

Summary.BSP % Clocks | @ Pms.lnterrupts Event Links | Stacks Compunents.

Figure 18: e2 studio Pin configurator

The pin configurator also shows a package view and the selected electrical or functional
characteristics of each pin.
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& Package 3% ;}{vlg‘vv'ﬂg

Connection Status
Drive Capacity
~ Mode

Qutput Type
Pull Up

RTFABM3AxaFC
176LOFP

(Top View)

Figure 19: e2 studio Pin configurator package view

When you click the Generate Project Content button, the pin configuration contents are written
to: ra_gen\bsp_pin_cfg.h

This file will be created if it does not already exist.

Warning

Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

To make it easy to share pinning information for your project, e2 studio exports your pin
configuration settings to a csv format and copies the csv file to ra_gen/<MCU package>.csv.

2.2.5.4 Configuring Interrupts from the Stacks Tab

You can use the Properties view in the Stacks tab to enable interrupts by setting the interrupt
priority. Select the driver in the Stacks pane to view and edit its properties.
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ﬁ} *[MyProject] RA Configuration &3

Stacks Configuration

Threads B HAL/Common Stacks

4| New Stack »

Generate Project Content

=& Extend Stack > 5] Remove

v %% HAL/Common
7 g_ioport 170 Port Driver on r_iopert
& g_elc ELC Driver on r_elc
& g_uart0 UART Driver on r_sci_uart @

42 g_iopert |70 Port
Driver on r_icport

4 g_elc ELC Driver on
r_elc

®

+ g_uartd UART Driver on r_sci_uart

®

Objects

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components
[ Properties 22 |#] Problems & Smart Browser
g_uart0 UART Driver on r_sci_uart

Settings Property Value
APl Info Common
w Module g_uartd UART Driver on r_sci_uart
General
Baud
Flow Control
Extra
w Interrupts
Callhack user uart callback
Receive Interrupt Priority Priority 12
Transmit Data Empty Interrupt Priority  Priority 12
Transmit End Interrupt Priority Priority 12

Error Interrupt Priority Priority 12

Pins

Figure 20: Configuring Interrupts in the Stacks tab

Creating Interrupts from the Interrupts Tab

4 g_transferd Transfer
Driver on r_dtec SCID
TXI (Transmit data

(@ empty)

4 g_transfer! Transfer
Driver on r_dtec SCID
RXI (Receive data full)

On the Interrupts tab, the user can bypass a peripheral interrupt set by FSP by configuring a user-
defined ISR. This can be done by adding a new event via the New User Event button.

s:ﬂ"rj»' *[MyProject] RA Configuration &3

Interrupts Configuration

= 0

Generate Project Content

User Events | 47| New User Event » |
Event ISR
Allocations
Interrupt Event ISR
0 SCI0 RXI (Receive data full) sci_uart_rxi_isr
SCI0 TXI (Transmit data empty) sci_uart_txi_isr
2 SCI0 TEl (Transmit end) sci_uart_tei_isr
3 SCI0 ERI (Receive error) sci_uart_eri_isr

Summary | BSP | Clocks PinEvant Links | Stacks Components
Figure 21: Configuring interrupt in Interrupt Tab
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& *[MyProject] RA Configuration 33 brc > |Package 33
. . EDMAC >
Interrupts Configuration Genel Iore g
EPTPC >
User Events 1.| 4] New User Eve | Fcu »
Event ISR CLEDE ?
GPT >
Icu >
l[e >
IOPORT >
IWDT >
Allocations JPEG >
Interrupt Boert N SCI0 RX| (Receive data full) || EEE
0 SCI0 X (Receive data full) SCID TXI (Transmit data empty) sci
1 SCID TXI (Transmit data empty) SCI0 TEI (Transmit end) SCI2
2 SCIO TEI (Transmit end) SCID ERI (Receive error) sCI3
3 SCID ERI (Receive error) SCI0 AM (Address match event) sCl4
SCI0 RX| OR ERI (Receive data full/Receive) SCI5
Sﬁmmary ES‘P C“Io(‘k;‘f‘liins'Intarrupts.Staéks.;“Componentif. ) QsPI > sCle
) RTC > scr
i SCE > sci8
2. 5Cl By sCig
SDHIMMC > {
<ol ol
Figure 22: Adding user-defined event
Enter the name of ISR for the new user event.
B New User Event x ‘
Enter the name of the ISR for the new user event:
| user_dE‘ﬁned_sm_uart_rxl_\srl ‘
Figure 23: User-defined event ISR
48k *[MyProject] RA Configuration 53 = O

Interrupts Configuration
P g Generate Project Content

User Events 4] New User Event »

Event ISR

SCI0 RXI (Receive data full) user_defined_sci_uart_rxi_isr
Allocations

Interrupt Event ISR

D SCID RXl (Receive data full) user_defined_sci_uart_nxi_isr I

1 SCI0 TXI (Transmit data empty) sci_uart_txi_isr

2 SCID TEI (Transmit end) sci_uart_tei_isr

3 SCID ERI (Receive error) sci_uart_eri_isr

:‘:ummary;éS’P ;C\oéls jli\ns Interrupts | Stacks| tbmponer;ts'

Figure 24: Using a user-defined event

2.2.5.5 Viewing Event Links

The Event Links tab can be used to view the Event Link Controller events. The events are sorted by

peripheral to make it easy to find and verify them.
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{8} *[MyProject] RA Configuration 53 = b

Event Links Configuration "
Generate Project Content

User Events Produced &) New User Event > User Events Consumed 4] New User Event

Event Peripheral Function Event
GPTO CAPTURE COMPARE A (Compare match A) I == | PORT 1 GPTO CAPTURE COMPARE A (Compare match A) I

Allocations /

Peripheral Function Event &
ADC12B1 Mo allocation

DAC12 Channel O Mo allacation

DACI2 Channel 1

Mo allocation
PORT 1 GPTO CAPTURE COMPARE A (Compare match A]I
PORT 2 No allacation
PORT 3 Mo allocation
PORT 4 Mo allocation v

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 25: Viewing Event Links

Like the Interrupts tab, user-defined event sources and destinations (producers and consumers) can
be defined by clicking the relevant New User Event button. Once a consumer is linked to a
producer the link will appear in the Allocations section at the bottom.

Note
When selecting an ELC event to receive for a module (or when manually defining an event link), only the events
that are made available by the modules configured in the project will be shown.

2.2.6 Adding Threads and Drivers

Every FreeRTOS-based RA Project includes at least one RTOS Thread and a stack of FSP modules
running in that thread. The Stacks tab is a graphical user interface which helps you to add the right
modules to a thread and configure the properties of both the threads and the modules associated
with each thread. Once you have configured the thread, e2 studio automatically generates the code
reflecting your configuration choices.

For any driver, or, more generally, any module that you add to a thread, e2 studio automatically
resolves all dependencies with other modules and creates the appropriate stack. This stack is
displayed in the Stacks pane, which e2 studio populates with the selected modules and module
options for the selected thread.

The default view of the Stacks tab includes a Common Thread called HAL/Common. This thread
includes the driver for I/O control (IOPORT). The default stack is shown in the HAL/Common Stacks
pane. The default modules added to the HAL/Common driver are special in that the FSP only requires
a single instance of each, which e2 studio then includes in every user-defined thread by default.

In applications that do not use an RTOS or run outside of the RTOS, the HAL/Common thread
becomes the default location where you can add additional drivers to your application.

For a detailed description on how to add and configure modules and stacks, see the following
sections:

e Adding and Configuring HAL Drivers
e Adding Drivers to a Thread and Configuring the Drivers
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Once you have added a module either to HAL/Common or to a new thread, you can access the
driver's configuration options in the Properties view. If you added thread objects, you can access
the objects configuration options in the Properties view in the same way.

You can find details about how to configure threads here: Configuring Threads

Note
Driver and module selections and configuration options are defined in the FSP pack and can therefore change
when the FSP version changes.

2.2.6.1 Adding and Configuring HAL Drivers

For applications that run outside or without the RTOS, you can add additional HAL drivers to your
application using the HAL/Common thread. To add drivers, follow these steps:

1. Click on the HAL/Common icon in the Stacks pane. The Modules pane changes to
HAL/Common Stacks.

{8 *[MyProject] RA Configuration 53 = |
Click here to add )
Stacks Configuration
g new module Generate Project Content
Threads I 5 o =] HAL/Common Stacks 4] New Stack > Extenis ) Remove

~ g HAL/Common
42 g_ioport |/0 Port Driver on r_ioport
4 g_wetD Watchdog Driver on r_widt
4% g_cgcd CGC Driver on r_cge

42 g_ioport /0 Port 4 g_wdtD Watchdog 42 g_cgcl CGC Driver on
Driver on r_ioport Driver on r_wdt r_cge

Objects

Summary |BSP | Clocks | Pins | Interrupts EventLinkanmpﬂnents

Figure 26: e2 studio Project configurator - Adding drivers

2. Click New Stack to see a drop-down list of HAL level drivers available in the FSP.

3. Select a driver from the menu New Stack > Driver.
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45 “[MyProject] RA Configuration 53 = B | gPackage X

Stacks Configuration
9 Generate Project Content

Threads = HAL/Commoen Stacks 4] New Stack >
v & HAL/Common - - Amazon FreeRTOS >
47 g_ioport /0 Port Driver on r_ioport & [gl_rlssrﬂ:nhr?nzﬂnr:t Arm > HEJ
Driver > Analog >
Middleware > CapTouch >
SEGGER > Connectivity iy
& Search.. Graphics »
Input >
Monitoring »
Network »
Power ?
Storage »
Objects System >
RTC Driver on r_rtc Timers >
»

Timer Driver on r_agt Transfer

(¢ @ ¢

Timer Driver on r_gpt

Summary |BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 27: Select a driver
4. Select the driver module in the HAL/Common Modules pane and configure the driver
properties in the Properties view.
e2 studio adds the following files when you click the Generate Project Content button:
e The selected driver module and its files to the ra/fsp directory

e The main() function and configuration structures and header files for your application as
shown in the table below.

File Contents Overwritten by Generate
Project Content?

ra_gen/main.c Contains main() calling Yes
generated and user code. When
called, the BSP already has
Initialized the MCU.

ra_gen/hal_data.c Configuration structures for HAL | Yes
Driver only modules.

ra_gen/hal_data.h Header file for HAL driver only | Yes
modules.

src/hal_entry.c User entry point for HAL Driver | No

only code. Add your code here.

The configuration header files for all included modules are created or overwritten in this folder:
ra_cfg/fsp_cfg

2.2.6.2 Adding Drivers to a Thread and Configuring the Drivers
For an application that uses the RTOS, you can add one or more threads, and for each thread at least
one module that runs in the thread. You can select modules from the Driver dropdown menu. To add

modules to a thread, follow these steps:

1. In the Threads pane, click New Thread to add a Thread.
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48 *[Blinky] RA Configuration £3 al e -0

Stacks Configuration

Threads | & Mew Thread | 3] Remove [=]  Mew Thread Stacks 4] New Stack> =

v g‘si‘ HAL/Common 4 1 Add RA stacks to the selected thread by using the 'Mew Stack > toolbar button (above), or

47 g ioport I/0 Port Driver on r_ioport I\ L by pasting here from the clipboard.
2 Mew Thread

Generate Project Content

Objects 4| New Object >

Summary | BSP | Clocks | Pins | Interrupts | Stacks| Components

I#] Problems =) Tasks [E) Console | [T Properties 2% |3 Call Hierarchy @ Smart Browser Memory Usage

New Thread
- Property Value
Scting: » Common
w Thread

Symbol new threadd Enter the name of your thread
MName [New Thread | here example: My Thread
Stack size (bytes) 1024
Priority 1

<

Figure 28: Adding a new RTOS Thread on the Stacks tab

2. In the Properties view, click on the Name and Symbol entries and enter a distinctive
name and symbol for the new thread.

Note
e2 studio updates the name of the thread stacks pane to My Thread Stacks.

3. In the My Thread Stacks pane, click on New Stack to see a list of modules and drivers.
HAL-level drivers can be added here.

48 *[MyProject] RA Configuration 2 = O  §&lPackage 2

Stacks Configuration
g Generate Project Content

Threads 42 New Thread 5| Remove []  Mew Thread Stacks 4] New Stack
Amazon FreeRTOS >
v & H;'\L*’Cummon b Add RA stacks to the selected thread by using the T Arm > ) —
- '::Ej?r\;f:a:h(] Port Driver on r_ioport ¥ or by pasting here from the clipboard. A 5 i :
Wl CapTouch »
& 12C Master Driver on r_iic_master Connectivity »
@ 12C Slave Driver on r_iic_slave Graphics ¥
& 125 Driver on r_ssi Input 3
“  SP| Driver on r_spi Monitoring »
Objects ‘a Mew Object » @ UART Driver on r_sci_uart Power »
Storage >
System ?
Timers »
Transfer >

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Compeonents

Figure 29: Adding Modules and Drivers to a thread

4. Select a module or driver from the list.

5. Click on the added driver and configure the driver as required by the application by
updating the configuration parameters in the Properties view. To see the selected module
or driver and be able to edit its properties, make sure the Thread containing the driver is
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highlighted in the Threads pane.

48 [MyProject] RA Configuration I3

Stacks Configuration

Threads 4] Mew Thread %] Remove |5 g_wdt( Watchdog Driver on r_wdt Stacks &) Mew Stack >

v & HAL/Common

4% g_ioport /O Port Driver on r_ioport
~ i@ New Thread

4 g_wdt) Watchdog Driver on r_wdt @

4 g wdtD Watchdog
Driver on r_wdt

Objects
I

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

4] New Object >

[}3 Pin Conflicts & Console | [T Properties 3

g_wdt0 Watchdog Driver on r_wdt

Settings Property Value
Common
v Module g_wdt) Watchdog Driv
MName g_wdtl
Timeout 16,384 Cycles
Clock Division Ratio PCLK/8192

Window Start Position
Window End Position
Reset Control Reset Qutput

Stop Control WDT Count Disabled in Low Power Mode
MMI Callhack NI

100% (Window Position Not Specified)
0% (Window Position Not Specified)

=]

Generate Project Content

i Remove

Figure 30: Configuring Module or Driver properties

6. If needed, add another thread by clicking New Thread in the Threads pane.

When you press the Generate Project Content button for the example above, e2 studio creates

the files as shown in the following table:

File Contents

Overwritten by Generate

Project Content?

ra_gen/main.c Contains main() calling Yes
generated and user code. When
called the BSP will have

initialized the MCU.

ra_gen/my_thread.c Generated thread "my_thread" |Yes
and configuration structures for

modules added to this thread.

Header file for thread Yes

"my_thread"

ra_gen/my_thread.h

ra_gen/hal _data.c Configuration structures for HAL | Yes

Driver only modules.

ra_gen/hal_data.h Header file for HAL Driver only |Yes

modules.

src/hal_entry.c User entry point for HAL Driver | No

only code. Add your code here.

src/my_thread_entry.c User entry point for thread No
"my_thread". Add your code

here.
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The configuration header files for all included modules and drivers are created or overwritten in the
following folders: ra_cfg/fsp_cfg/<header files>

2.2.6.3 Configuring Threads

If the application uses the FreeRTOS, the Stacks tab can be used to simplify the creation of
FreeRTOS threads, semaphores, mutexes, and event flags.

The components of each thread can be configured from the Properties view as shown below.

New Thread

Settings Property Value
v Common
General
Hooks
Stats
Memory Allocation
Co-routines
Timers
Optienal Functions

v Thread
Symbol new_thread
Mame Mew Thread
Stack size (bytes) 1024
Priority L

Figure 31: New Thread Properties

The Properties view contains settings common for all Threads (Common) and settings for this
particular thread (Thread).

For this thread instance, the thread's name and properties (such as priority level or stack size) can
be easily configured. e2 studio checks that the entries in the property field are valid. For example, it
will verify that the field Priority, which requires an integer value, only contains numeric values
between 0 and 9.

To add FreeRTOS resources to a Thread, select a thread and click on New Object in the Thread
Objects pane. The pane takes on the name of the selected thread, in this case My Thread Objects.

§:> “[MyProject] RA Configuration 2 = (=

Stacks Configuration
9 Generate Project Content

Threads &% New Thread 3| Remove [T]  MewThread Stacks &) NewStack> =% Extend Stack> | Remove

4 g‘;:‘l HAL/Commen

E g_ioport I/0 Port Driver on r_iopert
v &3 Mew Thread

) g_timer0 Timer Driver on r_gpt @

4 g_timer0 Timer Driver
onr_gpt

Objects | 4| New Object > | A B
Binary Semaphore

L
© g new event groupD Event Gr g Counting Semaphore
LY 0
ig_new_gueuel Queue: O BabEes
@ Message Buffer
Summary BSP | Clocks |Pins |Intern v nts
® Queue
# T =
[ Properties 2 @  Stream Buffer L =
g_new_queuel Queue @ Timer
Settings Property Value
Symbol g_new_gueuel I
Item Size (Bytes) 4
Queue Length (ltems) 20
Memory Allocation Static

Figure 32: Configuring Thread Object Properties
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Make sure to give each thread object a unique name and symbol by updating the Name and
Symbol entries in the Properties view.

2.2.7 Reviewing and Adding Components

The Components tab enables the individual modules required by the application to be included or
excluded. Modules common to all RA MCU projects are preselected (for example: BSP > BSP >
Board-specific BSP and HAL Drivers > all > r_cgc). All modules that are necessary for the
modules selected in the Stacks tab are included automatically. You can include or exclude
additional modules by ticking the box next to the required component.

8% *[MyProject] RA Configuration 2 - o

Components Configuration
P 9 Generate Project Content

Component Version Description Variant 2
v radwl
¢ rabml
¢ rabm2
w @ rabm3
V] device 1.1.0 Board support package for R7TFABM3AH3CFC R7FABM3AH3CFC
V| device 1.1.0 Board support package for RAGM3
device 1.1.0 Board support package for RFTFAGM3AF2CEG R7FABM3AF2CBG
device 1.1.0 Board support package for RFTFABM3AF2CLK R7FABM3AF2CLK
device 1.1.0 Board support package for R7TFAGM3AF3CFE R7FABM3AF3CFB
device 1.1.0 Board support package for R7TFAGM3AF3CFC R7FABM3AF3CFC
device 1.1.0 Board support package for R7TFAGM3AF3CFP R7FABM3AF3CFP
device 1.1.0 Board support package for RFTFAGM3AHZCEG R7FABM3AHZCBG
device 1.1.0 Board support package for RFTFABM3AHZCLK R7FABM3AHZCLK
device 1.1.0 Board support package for R7TFAGM3AH3ICFE R7FABM3AHICFB
device 1.1.0 Board support package for R7TFAGM3AH3ICFP R7FABM3AHICFP
V] fsp 1.1.0 Board support package for RAGM3 - FSP Data
oy c_sdk
w ¢y CMSIS
w @ CMSISS
W] CoreM 5.6.0 Arm CMBSIS Version 5 - Core (M)
DSP 5.6.0 Arm DSP Library Source
NN 5.6.0 Arm NN Library Source
w @y Common
v ol
V| fsp_common 1.1.0 Board Support Package Commeon Files
+#y FreeRTOS
+f FreeRTOS Plus
# GUI

Figure 33: Components Tab

Clicking the Generate Project Content button copies the .c and .h files for each selected
component into the following folders:

e ra/fsp/inc/api

e ra/fsp/inc/instances
 ra/fsp/src/bsp

e ra/fsp/src/<Driver_Name>

e2 studio also creates configuration files in the ra_cfg/fsp_cfg folder with configuration options set in
the Stacks tab.

2.2.8 Writing the Application

Once you have added Modules and drivers and set their configuration parameters in the Stacks tab,
you can add the application code that calls the Modules and drivers.
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Note
To check your configuration, build the project once without errors before adding any of your own application code.

2.2.8.1 Coding Features

e2 studio provides several efficiency improving features that help write code. Review these features
prior to digging into the code development step-by-step sections that follow.

Autocomplete

Autocomplete is a context aware coding accelerator that suggests possible completions for partially
typed-in code elements. If you can 'guess' the first part of a macro, for example, the Autocomplete
function can suggest options for completing the rest of the macro.

In the following example, a macro related to a BSP_lO setting needs to be found. After typing
BSP_I0_in a source code file, pressing Ctrl + Space opens the Autocomplete list. This list shows a
selection of context aware options for completing the macro. Scroll through the window to find the
desired macro (in this case BSP_IO_LEVEL_HIGH) and click on it to add it to your code.

Protect PES regicters

R_BSP_PinAccessDisable();

Toggle level for next rite */

if (BSP_IO LEVEL_LOW == pin_level

{
pin_level = BSP_IO_
ilse o BSP_IO_DIRECTION_INPUT A
{ o BSP_IO_DIRECTION_QUTPUT
pin_level = BSP_IO L o BSP | o
} o BSP_IO_LEVEL_LOW

vTaskDelay(configTICK_RA ° BSP_IO_PORT_00
} o BSP_IO_PORT_00_PIN_00

} o BSP_IO_PORT_00_PIN_01
o BSP_IO_PORT_00_PIN_02

o BSP_IO_PORT_00_PIN_03

B H 4 o BSP_IO_PORT_00_PIN_04

o BSP_IO_PORT_00_PIN_05

o BSP 10 PORT 00 PIN 06 vi Moc
Press "Ctrl=Space’ to show Template Proposals

Figure 34: Autocomplete example

Other code elements can use autocomplete too. Some of the more common uses for Autocomplete
include Enumerations, Types, and API functions - but try it in any situation you think the tool may
have enough context to determine what you might be looking for.

For a hands-on experience using Autocomplete use the Quick FSP Labs for Creating Blinky from
Scratch and Creating an RTC Blinky from Scratch. These 15-minute Do it Yourself labs take you
through the step-by-step process of using Autocomplete, Developer Assistance, Edit hover, and the
Help system.

Edit Hover
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e2 studio supports hovers in the textual editor. This function can be enabled or disabled via Window
> Preferences > C/C++ > Editor > Hovers.

B Preferences O X
type filter text Hovers T i
Code Style

Expand vertical ruler icons upon hovering (does not affect open editors)
Core Build Toolchains o
Text Hover key modifier preferences:

Debug
v Editor Text Hover Name Pressed Key Modifier While Hoverin.
Content Assist Combined Hover
Encrypted Files J Debugger
Folding :l Renesas |0 Register Help
Hovers :l RenesasCDocHover
Mark Occurrences _] Problem Description
Save Actions _I Documentation
Scalability _] Macro Expansion
Syntax Coloring 7] Source Shift
Templates || Annotation Description
Typing
File Types ;
Indexer Pressed key modifier while hovering:\
Language Mappings Description:
New C/C++ Project ‘Wrzard Tries the hovers in the sequence listed below and uses the one which fits best
Property Pages Settings for the selected element and the current context.
Renesas
Task Tags
Resti Default: A
Template Default Values e hicbid i Apply

@® Apply and Close Cancel

Figure 35: Hover preference

To enable hover, check Combined Hover box. To disable it, uncheck this box. By default, it is
enabled. The Hover function allows a user to view detailed information about any identifiers in the
source code by hovering the mouse over an identifier and checking the pop-up.

| 24 bsp_leds_t leds; A =B Rl T
B43 /* LED state variable */ u hal_datah
| EE3 ioport_level_t level = IOPORT_LEVEL_HIGH; e hal_entry(void)
Has T
| i [* Get LED information for this board */
R47 R _BSP LedsGet(&leds):
#48
| & Name: R_BSP_LedsGet
fse Prototype: ssp_err_t R_BSP_LedsGet (bsp_leds_t *p_leds)

. Description:
B52

53 5 :
| Return information about the LEDs on the current board.
fiss : 3 oo
| 55 Structure with LED information. p_leds Pointer to structure where LED info is stored.
| e
f53
fs9
|
Bs1 >
| Gl {

64 level = IOPORT_LEVEL_LOW;
| ¥
L 513 b

< >

Figure 36: Hover Example

For a hands-on experience using Edit Hover use the Quick FSP Labs for Creating Blinky from Scratch
and Creating an RTC Blinky from Scratch. These 15-minute Do it Yourself labs take you through the
step-by-step process of using Autocomplete, Developer Assistance, Edit hover, and the Help system.

Welcome Window
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The e2 studio Welcome window displays useful information and common links to assist in
development. Check out these resources to see what is available. They are updated with each
release, so check back to see what has been added after a new release.

RA_Workspace - Blinky/src/hal_entry.c - € studio - O X
File Edit Source Refactor MNavigate Search Project RenesasViews Run  Window Help
5' .;',?,. Welcome 51 ] P o R
s
il RENESAS Welcome to e2 studio >
Workbench
Create a new e2 studio C/C++ project Get an overview of the features
Import existing e studio projects from the Go through tutorials

filesystem or archive

Try out the samples
Review the IDE's most fiercely contested . B

preferences

Find out what is new
Open a file from the filesystem

M1 aiways show Welcome at start up

Figure 37: Welcome window

Cheat Sheets

Cheat sheets are macro driven illustrations of some common tasks. They show, step-by-step, what
commands and menus are used. These will be populated with more examples on each release.
Cheat Sheets are available from the Help menu.
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RA_Workspace - Blinky/src/hal_entry.c - € studio - m} X
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
] || %] #5 Debug v || 9 Blinky Debug v o @9 Welcome
% M DS B A - Q™S &~ 4G Gl () Help Contents
%’ Search
= Show Contextual Help
[ Project Explorer 53 = G| & Y = B {8 [Blinky] RA Configuration
e o . . ] Show Active Keybindings... Ctrl+Shift
v [ Blinky [Debug] A 1 #include ) )
w1l Includes [ 2 #include ' Tips and Tricks...
@ ra #include ' & Report Bug or Ephgncement...
(2 ra_gen 5 void R_BSI Cheat Sheets...
v G src 5
| hal_entry.c @ * The RA RA Helpdesk
(= ra_cfg void _hﬂ_‘ & RenesasRulz Community Forum
L? sc.ript mewew /7 Add Renesas Toolchains
o Bllnk_y Deb_ug.launch "f;; Perform Setup Tasks...
20¢ configurationxml }
- RTFABM3AH3CFC.pincfg % Check for Updates
5| ra_cfg.ba vil - = _T,h'_l,swf: (@ Install New Software...
< > < Renesas e2 studio feedback
[T] Properties 52 = B8 [:Q Pin Conflic' §& |AR Embedded Workbench plugin manager...
L HE M~ |Qikems B About e studio
Property Value Description o L L}

Developer Assistance

Figure 38: Cheat Sheets

FSP Developer Assistance provides developers with module and Application Programming Interface
(API) reference documentation in e2 studio. After configuring the threads and software stacks for an
FSP project with the RA Configuration editor, Developer Assistance quickly helps you get started
writing C/C++ application code for the project using the configured stack modules.

1. Expand the project explorer to view Developer Assistance
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JL
d
q
0
(I

iy Project Explorer &3 B <
v 15 Blinky
m) Includes
2 ra
(2 ra_gen
(2 src
= ra_cfg
(= script
2| Blinky Debug.launch
&% configuration.xml
=] R7TFABM3AH3CFC.pincfg
= ra_cfg.bd
) RASM3-EK pincig

v (2) Developer Assistance
v % HAL/Common
& g_ioport /O Port Driver on r_ioport
47 g_elc ELC Driver onr_elc
4 g_adc0 ADC Driver on r_adc

Figure 39: Developer Assistance

2. Expand a stack module to show its APIs

v (@ DevelnparAssist;nce
v gt HAL/Common

42 g_joport |70 Port Driver on r_ioport
47 g_elc ELC Driver on r_elc
w & g_adch ADC Driver on r_adc

~ @ fsp_err t R_ADC_Open(adc_ctrl_t *p_ctrl, ade_cfg_t const *const p_cfg)
| Call R_ADC_Open()

v @ fsp_err t R_ADC ScanCfg(ade_ctrl_t *p_ctrl, adc_channel_cfg_t const *const p_channel_cfg)
|2 Call R_ADC ScanCfg()

v @ fsp_err t R_ADC InfoGet(adc_ctrl_t *p_ctrl, adc_info_t *p_adc_info)
[t Call R_ADC InfoGet()

v @ fsp_err_t R_ADC ScanStart(adc_ctrl_t *p_ctrl)
|23 Call R_ADC ScanStart()

v @ fsp_err_t R_ADC_ScanStop(adc_ctrl_t *p_ctrl}
|23 Call R_ADC_ScanStop()

v @ fsp_err t R_ADC StatusGet{adc_ctrl_t *p_ctrl, ade_status_t *p_status)
|24 Call R_ADC_StatusGet()

~ @ fsp_err t R_ADC_Read(adc_ctrl_t *p_ctrl, adc_channel_t const reg_id, uint16_t *const p_data)
[t3 Call R_ADC_Read()

~ @ fon errtR ADNC Read32(ade ctrl t *n ctrl ade channel t const ren id uint3? + *const 0 datal

Figure 40: Developer Assistance APIs

]

3. Dragging and dropping an API from Develop Assistance to a source file helps to write source

code quickly.
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5 Project Explorer 31 B %| & ¥ = B {8 MyProject RA Configuration [€] *hal_entry.c 51 = 8
= script - 1 #include "hal_data.h"
8k configuration.xml
= MyProject Debug.launch

TFABM3AH3CFC.pincfg

_cfg.ot Drag and drop

=| RABM3I-EK, fi . .
= pines directly into code

w (7) Developer Assistance
v g HAL/Common
) g_ioport [/0 Port Driver on r_ioport
~ @ g_adc0 ADC Driver on r_adc
@ fep e tR_ANC Openiade ctrl_f
=tepEm TR oA STamC Y (ade_ctrl_t *p_ctrl, void const *¢
b= Call R_ADC ScanCfg()
v @ fsp_err_t R_ADC InfoGet{adc_ctrl_t *p_ctrl, adc_info_t *p,
= Call R_ADC InfoGet()
v @ fsp_err t R_ADC ScanStart{adc_ctrl_t *p_ctrl)
=1 Call R_ADC ScanStart()
v @ fsp_err_t R_ADC ScanStopiadc_ctrl_t "p_ctrl)
b= Call R_ADC_ScanStop()
v @ fsp_err_t R_ADC StatusGet(adc_ctrl_t *p_ctrl, adc_status_
2 Call R_ADC_StatusGet()

FSP_CPP_HEADER
void R_BSP_WarmStart(bsp_warm_start_event_t event);
FSP_CPP_FOOTER

2
3
5
6

@® * main() is generated by the RA Configuration editor and is used to generate threads if an RTOS
=~ void hal_entry(void) {

7 —mreityoT

= R_ADC_Open(&g adcé_ctrl, &g adcod_cfg); =

}

@ * This function is called at wvarious points during the startup process. This implementation use
=~ void R_BSP_WarmStart(bsp_warm_start_event_t event) {

= if (BSP_WARM START_RESET == event) {

= #if BSP_FEATURE_FLASH_LP_VERSION != 8

i)

/* Enable reading from data flash. */
R_FACI_LP->DFLCTL = 1U;

@ B o~ oW

= /* Would normally have to wait tDSTOP(6us) for data flash recovery. Placing the enable he
* C runtime initialization, should negate the need for a delay since the initialization
#endif
¥

R

Wbl WL L L W R RS R RS RS RS R
t S = E 4

v @ fsp_em_t RADC_Read(adc_ctrl t *p._ctr, adc_channel_t c : = If (BSP_WARM START_POST_C == event) { . i
&, Csll RADC_Read() i C runtime environment and system clocks are setup.
v @ fsp_erm t R_ADC Read32(adc_ctrl t *p_ctrl, adc_channel - 3 /* Configure pins. */
= Call R_ADC Read32() 9 R_TOPORT Open{&g ioport_ctrl, &g bsp pin_cfg);
v @ fsp_erm t R_ADC SampleStateCountSet(adc_ctrl t *p_ctr, fs }
= Call R_ADC_SampleStateCountSet() = ¥
v @ fsp_err_t R_ADC_Close(adc_ctrl_t *p_ctrl) ™
= Call R_ADC Close() < >

Figure 41: Dragging and Dropping an API in Developer Assistance

For a hands-on experience using Developer Assistance use the Quick FSP Labs for An Introduction to
Developer Assistance, Creating Blinky from Scratch and Creating an RTC Blinky from Scratch. These
15-minute Do it Yourself labs take you through the step-by-step process of using Autocomplete,
Developer Assistance, Edit hover, and the Help system.

Information Icon
Information icons are available on each module in the thread stack. Clicking on these icons opens a

module folder on GitHub that contains additional information on the module. An example information
Icon is shown below:

4 g_ioport 1/0 Port

\ Driver on r_ioport
D

Figure 42: Information icon

IDE Help

A good source of additional information for many FSP topics is the Help system. To get to the Help
system, click on Help and then select Help Contents as seen below.

R11UMO146EU0120 Revision 1.20 RENESANS Page 38/ 1,560
Jun.26.20


https://en-support.renesas.com/knowledgeBase/19110786
https://en-support.renesas.com/knowledgeBase/19110786
https://en-support.renesas.com/knowledgeBase/19110690
https://en-support.renesas.com/knowledgeBase/19110690

Flexible Software Package

User’s Manual

Starting Development > e2 studio User Guide > Writing the Application > Coding Features

Window | Help
v 1 lge) Welcome
(7) Help Contents
% Search
Show Contextual Help
Show Active Keybindings... Ctrl+Shift+L
) Tips and Tricks...
g t
4t Report Bug or Enhancement...
Cheat Sheets...
RA Helpdesk
RenesasRulz Community Forum
47 Add Renesas Toolchains
L &t %, Perform Setup Tasks...
“ Check for Updates
L Low; 4k Install New Software...
Renesas e2 studio feedback
e delay 2
ELAY UNT & AR Embedded Workbench plugin manager...
X E About € studio
units

Figure 43: Opening the Help System

Once the Help system is open, select the RA Contents entry in the left side Guide-bar. Expand it to
see the main RA Topics.

B8 Help - € studio

O X

Search: G Scope; All topics

Contents B ¥ B g

¥ € Workbench User Guide
€ C/C++ Development User Guide
€ 2 studio User Guide
Eclipse Remote Developer’s Guide
12> Linker Script and Linker Script Editor
@ Domph P2 Management Documentation
@ Domph Setup Documentation
@ RA Contents

1 RA configuration editor

I RA user pack creator

=Rz

=

=

Bl RA Developer Assistance
I How to create and use a RA static library
B RAFAQ

5 € Scripting User Guide

o edlaen

RA Contents >
onten -~

Creating a RA project

A new Renesas RA project is created using one of the RA C or C++ project wizards. The wizard
selection page can be opened in one of the following ways

+ The €2 studio [File->New->RA C/C++ Project] main menu

+ The Project Explorer view [New-=RA C/C++ Project] context menu
» The €2 studio [New->RA C/C++ Project] toolbar drop-down

‘Wizard selection page

The wizard selection page allows you to choose the type of RA wizard to open. Wizards are available
for either C or C++ and for a RA Executable or Static Library project.

Figure 44: RA Content Help

You can also search for help topics by using the Search bar. Below is an example searching for
Visual Expressions, a helpful feature in the e2 studio debugger.
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B Help - € studio — O X
Search: |Visual Expressions Scope: All topics

Search Results BB o fwedlan
6 matches In All topics: Chanae scop. e2 studio User Guide > Debugging Projects > Views '~

e2 studio Visual Expressions View

e2 studic Visual Expressions View Overview The
Wisual Expressions view can show a visual

representation of expressions that are present in s} Visual Expression 27 mHEarn
the user’s code, It is similar to... T T A 414
-

B e2 studio Plug-in list Gauges and melers =
e2 studic Plug-ins The table lists some of the e ierteiey
plug-ins available in e2 studio, The table alsa
lists who were the most recent developers of the 6 GAUGE
view or plugin: Plug-in Name...

B Tuning Error Parsers b
Controllers

¥k |

Error Parsers scan build output line by line

laoking for errors and warnings (also for certain

informational messages). They generate Problem :
) Markers which visually indicat.. ‘ - ) DIAL
|21 Error Parser Preferences -

S

Use the Error Parsers Tab on Build preference
panel to define global error parsing options,
Error Parsers scan build output looking for
potential error or warning messages....

B Edit Menu actions
MName Function Keyboard Shortcut Undo Reverts
the last change made in the editor Ctrl+Z Redo
Re-applies a change previously reverted with
Undo Ctrl+Y Cut Copies the currentl...

Bl Compare/Patch

| pusHBUTTON ||

Overview
The Visual Expressions view can show a visual representation of expressions that are present in the user’s code.

It is similar to the Expressions view but with graphical representations. Each graphically represented expression

4 in the Visual Expressions view is referred to as a ‘visual element’.
The following preferences can be changed on

Figure 45: e2 studio Help from the Search Bar

For a hands-on experience using the Help system use the Quick FSP Labs for An Introduction to
Developer Assistance, Creating Blinky from Scratch and Creating an RTC Blinky from Scratch. These
15-minute Do it Yourself labs take you through the step-by-step process of using Autocomplete,
Developer Assistance, Edit hover, and the Help system.

2.2.8.2 HAL Modules in FSP: A Practical Description

The FSP Architecture section describes FSP stacks, modules and interfaces in significant detail,
providing an understanding of the theory behind them. The following sections provides a quick and
practical introduction on how to use API functions when writing code and where in the API reference
sections you can find useful API related information.

Introduction to HAL Modules

In FSP, HAL module drivers provide convenient API functions that access RA processor peripheral
features. Module properties are defined in the RA GUI configurator, eliminating the tedious and error
prone process of setting peripheral control registers. When configuration is complete, the generator
automatically creates the code needed to implement the associated API functions. API functions are
the main way a developer interacts with the target processor and peripherals.

HAL Driver API Function Call Formats

HAL driver API functions all have a similar format. They all start with "R_" to indicate they are HAL

related functions. Next comes the module name followed by the function and any parameters. This
format is illustrated below:

R <nodul e>_<functi on>(<par anet er s>) ;

Here are some examples:
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status = R GPT_Qpen(&g tinmer0 _ctrl, &g timer0_cfq);
status = R GPT_Start (& tinmer0_ctrl);

status = R GPT_PeriodSet (&g tinmer0O_ctrl, period);
status = R ADC Open(&g_adcO_ctrl, &g adcO _cfg);
status = R ADC | nfoGet (&g adcO _ctrl, &adc_info);

HAL Driver API Call Reference Information

Each HAL module has a useful API Reference section that includes key details on each function. The
function prototype is presented first, showing the return type (usually fsp_status_t for HAL functions)
and the function parameters. A short description and any warnings or notes follow the function
definition. In some cases, a code snippet is included to illustrate use of the function. Finally, all
possible return values are provided to assist in debugging and error management.

& R_GPT PeriodSet()

t R_GPT_PeriodSet [ tim t *const p_ctrl,
uint32_t const period_counts

Sets period value provided. If the timer is running, the period will be updated after the next counter overflow. If
the timer is stopped, this function resets the counter and updates the period. Implements

Warning
If periodic output is used, the duty cycle buffer registers are updated after the period buffer register. If
this function is called while the timer is running and a GPT overflow occurs during processing, the duty

cycle will not be the desired 50% duty cycle until the counter overflow after processing completes.

Example:

* @Get the source clock frequency (in Hz). There are 3 ways to do this in FSP:
=

- If the PCLKD frequency has not changed since reset, the source clock
frequency is

x BSP_STARTUP_PCLKD_HZ >> timer_cfg_t::source_div

- Use the R_GPT_InfoGet function (it accounts for the divider).

* - Calculate the current PCLKD frequency using R_FSP_SystemClockHzGet
(FSP_PRIV_CLOCK_PCLKD) and right shift

>, by timer_cfg t::source_div.

~

#

* This example uses the 3rd option (R_FSP_SystemClockHzGet).
x4

uint32_t pclkd_freq_hz = R_FSP_SystemClockHzGet(FSP_PRIV_CLOCK_PCLKD) >>
g_timer® _cfg.source_div;

/* Calculate the desired period based on the current clock. Note that this
calculation could overflow if the

* desired period is larger than UINT32 _MAX / pclkd freq_hz. A cast to uinté4 t is
used to prevent this. */

uint32_t period_counts =
(uInt32 t) (((uint64_t) pclkd freq hz * GPT_EXAMPLE_DESTIRED PERTOD_MSEC) /
GPT_EXAMPLE_MSEC_PER_SEC);

/* Set the calculated period. */

err = R_GPT_PeriodSet(&g_timere_ctrl, period counts);

handle_error{err);

Return values
FSP_SUCCESS Period value written successfully.
FSP_ERR_ASSERTION p_ctrl was NULL.
FSP_ERR_NOT_OPEN The instance is not opened.

Figure 46: Module Api Reference Section Example

2.2.8.3 RTOS-Independent Applications

To write application code:
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1. Add all drivers and modules in the Stacks tab and resolve all dependencies flagged by e2
studio such as missing interrupts or drivers.

. Configure the drivers in the Properties view.
3. In the Project Configuration view, click the Generate Project Content button.

N

4. In the Project Explorer view, double-click on the src/hal_entry.c file to edit the source file.

|
o

i Project Explorer 332 = =
-
IS

125 Blinky
T FSP_project

v 15 MyProject [Debug]

#;;b Binaries

[ Includes
Era
(2 ra_gen
v @ src
l€| hal_entry.c
(= Debug
(= ra_cfg
= script
=| A2A1-TBB.pincfg

Note

All configuration structures necessary for the driver to be called in the application are initialized in
ra_gen/hal_data.c.
Warning

Do not modify the files in the directory ra_gen. These files are overwritten every
time you push the Generate Project Content button.

5. Add your application code here:

[€ hal_entry.c 52 | {55 [MyProject] RA Configuration
B 1 #include "hal Hata.h”
2 #include "bsp_pin_cfg.h"
#include "r_ioport.h”
void R_BSP_WarmStart(bsp_warm_start_ever

@ * The RA Configuration tool generates n

11 void hal_entry(void)
12 {

=13 £¥ : add your own code here */
14 17 \

Add your own code here

Figure 47: Adding user code to hal_entry.c

6. Build the project without errors by clicking on Project > Build Project.

The following tutorial shows how execute the steps above and add application code: Tutorial: Using
HAL Drivers - Programming the WDT.

The WDT example is a HAL level application which does not use an RTOS. The user guides for each
module also include basic application code that you can add to hal_entry.c.

2.2.8.4 RTOS Applications
To write RTOS-aware application code using FreeRTOS, follow these steps:

1. Add a thread using the Stacks tab.
2. Provide a uniqgue name for the thread in the Properties view for this thread.
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3. Configure all drivers and resources for this thread and resolve all dependencies flagged by

e2 studio such as missing interrupts or drivers.
. Configure the thread objects.

~N o U b~

. Provide unique names for each thread object in the Properties view for each object.
. Add more threads if needed and repeat steps 1 to 5.
. In the RA Project Editor, click the Generate Project Content button.

8. In the Project Explorer view, double-click on the src/my_thread 1 _entry.c file to edit the

source file.

[y Project Explorer 3 = 8

E S ¥

&

« 15 RA_RTOS_Application [Debug] A
[ Includes
= ra
v 5 ra_gen

[.g] blinky_thread.c
blinky_thread.h
bsp_clock_cfg.h
bsp_pin_cfg.h
[€] common_data.c
comrmon_data.h

lg] hal_data.c
hal_data.h

€] main.c

4g] my_thread_1.c
rmy_thread_1.h
€] pin_data.c

|.g] vector_data.c
vector_data.h
2] ABM3-PK.csv

v B src

lg] blinky_thread_entry.c

lg] hal_entry.c

l.g] my_thread_1_entry.c

(= ra_cfg
(= script
= ABM3-PK.pincfg

4 configuration.xml

<

=| RTFABM3AH3CFC.pincfg

>

Figure 48: Generated files for an RTOS application

Note

All configuration structures necessary for the driver to be called in the application are initialized in

ra_gen/my_thread 1.cand my thread 2.c
Warning

Do not modify the files in the directory ra_gen. These files are overwritten every
time you push the Generate Project Content button.

9. Add your application code here:

<_"—:_> [RA_RTOS_Application] RA Configuration S(s’l \€] my_thread_1_entry.c 3% |

#include "my th|
@ /* My Thread ent

[ RA_RTOS_Application/configuration.xml |
T

o

void my_thread_1_entry{void *pvParameters)

s);

: add your own code here */

while (1)
{
1a wTaskDelay (1);

Figure 49: Adding user code to my_thread_1.entry

10. Repeat steps 1 to 9 for the next thread.
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11. Build your project without errors by clicking on Project > Build Project.

Additional Resources for Application Development

Example Projects

A wide variety of Example Projects for FSP and RA MCUs is available on the GitHub site here:
https://github.com/renesas/ra-fsp-examples. Example projects are organized by target kit so it is
easy to find all the examples for your kit of choice.

g =k_raZal
Bl ek_radm1
Bl ek_rabm1

J ek_rabm2
Il ek rabm3

Il ek_rabm3g

Figure 50: FSP Example Projects Organized by Kit

Projects are available as both downloadable zip files and as project source files. Typically, there is a
project for each module. New example projects are being added periodically, so check back if a
particular module isn't yet available.

il acmphs/acmphs_ek_rabm3_ep
adc/adc_ek_rabm3_ep

B agt/agt_ek_rabm3_ep

M cac/cac_ek_rabm3_ep

Bl crc/crc_ek_rabm3_ep

B dmac/dmac_sk_rabm3_ep

j freertos/freertos_ek_rabm3_ep
gpt/gpt_ek_rabm3_ep
Bl icu/icu_ek_rabm3_ep
M iic_master/iic_master_ek_rabm3_ep
§ iic_slave/iic_slave_ek_rabm3_ep
Bl kint/kint_ek_rabm3_ep
Ivd/lvd_ek_rabm3_ep
quickstart/quickstart_ek_rabm3

rte/rtc_ek_rabm3_ep

Figure 51: A Selection of Example Projects Available on GitHub

Quick Labs

A variety of Hands-on Do It Yourself labs are available on the Renesas RA and FSP Knowledge Base.
Quick FSP Labs target the EK-RA6M3 kit and typically require only 15 minutes to complete. Each lab
covers a couple related development tools and techniques like Edit Hover, Autocomplete, Developer
Assistance, console I/O over RTT, and Visual Expressions, that can speed up the development
process. A list of all available Quick Labs can be found here: https://en-
support.renesas.com/knowledgeBase/19108110
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2.2.9 Debugging the Project

Once your project builds without errors, you can use the Debugger to download your application to
the board and execute it.

To debug an application follow these steps:

1. On the drop-down list next to the debug icon, select Debug Configurations.

B~ Qu-is 4~

7] 1 FSP_project Debug
Debug As >
Debug Configurations...

Organize Favorites..,

2. In the Debug Configurations view, click on your project listed as MyProject Debug.

Debug Configurations X

Create, manage, and run configurations

= X | sf i Name: | MyPraoject Debug |

type filter text [£] Main . %5 Debugger| B» Startup| (] Common 1/ Source

[] C/C++ Application

[] C/C++ Remote Applicatic
EASE Script | MyProject Browse...

[] GDB Hardware Debuggin: || ¢/C++ Application:

[ ] GDB OpenOCD Debuggin

[c*] GDEB Simulator Debuggin:
Java Applet Variables... Search Project... Browse...
Java Application

R Launch Group

= Launch Group (Deprecate Build Configuration: | Use Active A

Remote Java Application
v [7] Renesas GDB Hardware D (O Enable aute build () Disable aute build

[£¥] MyProject Debug (®) Use workspace settings Configure Workspace Settings...

Project:

[ Debug/MyProject.clf

Build (if required) before launching

[£] Renesas Simulator Debug

< >

. . Revert Appl,
Filter matched 14 of 16 items -
@

3. Connect the board to your PC via either the on-board Segger J-Link debugger (available on
all RA EKs), a standalone Segger J-Link debugger, or an E2 or E2 Lite and click Debug.

Note
For details on using J-Link and connecting the board to the PC, see the Quick Start Guide included in the RA MCU
Kit.

2.2.10 Modifying Toolchain Settings

There are instances where it may be necessary to make changes to the toolchain being used (for
example, to change optimization level of the compiler or add a library to the linker). Such
modifications can be made from within e2 studio through the menu Project > Properties >
Settings when the project is selected. The following screenshot shows the settings dialog for the
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GNU Arm toolchain. This dialog will look slightly different depending upon the toolchain being used.

Properties for Blinky m] X
| Settings R =
Resource
A
Builders
~ C/C++ Build Configuration: | Debug [ Active ] ~ | | Manage Configurations...

Build Variables
Environment

Logging i Tool Settings &3 Toolchain “ Build Steps Build Artifact M} Binary Parsers @3 Error Parsers
Settings
Tool Chain Editor (22 Target Processor ARM family cortex-md =
C/C++ General (2 Optimization .
Mcu (B Warmings Architecture Toolchain default &
Project References @ Debugging Instruction set Thumb (-mthumb) ~
i85 GNU ARM Cross A bl
Renesas QF v ® = ross Assembler [ Thumb interwork (-mthumb-interwork)
Run/Debug Settings (% Preprocessor
Task Repository (22 Includes Endianness Toolchain default .
=
Task Tags (£ Warnings Flost ABI FP instructions (hard) v
Validation (£ Miscellaneous
~ 83 GNUARM Cross C Compiler FPU Type fpvd-sp-d16 2
(£2 Preprocessor
= Unaligned access | Toolchain default ~
( Includes
(2 Optimization Generic (-mcpu=generic)

(2 Warnings
(£ Miscellaneous
~ 5 GNU ARM Cross C Linker
(2 General
(£ Libraries
(£ Miscellaneous
~ 5 GNU ARM Cross Create Flash Image

Toolchain default
Toolchain default
Toolchain default

Enabled (+simd)

@ General Small (-mcmedel=small)
.. KT\ CAILADRA e Nuis Cinn . A
< >
P
‘.2,' Apply and Close Cancel

Figure 52: e2 studio Project toolchain settings

The scope for the settings is project scope which means that the settings are valid only for the
project being modified.

The settings for the linker which control the location of the various memory sections are contained in
a script file specific for the device being used. This script file is included in the project when it is
created and is found in the script folder (for example, /script/aém3.Id).

2.2.11 Creating RA project with ARM Compiler 6 in e2 studio

e2 studio does not include the ARM Compiler 6 (AC6) toolchain by default. Follow the steps below to
integrate AC6 into e2 studio and create an AC6 RA project.

Note
It isassumed that the user is already familiar with RA project creation in €2 studio.

Steps 1 through 8 describe the process for integrating ARM Compiler 6 into e2 studio.

1. Download, install, and configure license for the AC6 toolchain
(https://developer.arm.com/tools-and-software/embedded/arm-
compiler/downloads/version-6).

. Launch e2 studio.

3. Go to Window > Preferences > Toolchains.

N

4. Click Add.
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E Preferences

type filter text Toolchains

Library Howver ~

Add/Remove toolchains

LinkerScript
MCU
Mylyn

Add...

Remove
Oomph

Remote Development
Renesas QF
Run/Debug

Scripting

Team

Terminal

Toolchains MName: Mo Toolchain Selected

Tracing Path:

Validation
XML Apply

Cancel

Apply and Close

Figure 53: Add Toolchain

@@®

5. Browse to the path where AC6 toolchain is installed and select the \bin folder. Click Next.

O X

E Add a new Toolchain

Select Toolchain Path

Please enter the path to the toolchain's binaries directory.

| IBrowse...I

Download toolchains from ds.arm.com

Path to toolchain binaries: | C:\Program Files\ARMCompiler6.14\bin

@ < Back Finish Cancel

Figure 54: Browse to AC6 Compiler

6. Toolchain information in displayed. Click Finish.
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E Add a new Toolchain

Discovered Toolchain Information

Toolchain ARM Compiler 6.14 was discovered from C:\Program Files\ARMCompiler6.14\bin

Compiler: armclang.exe
Assembler: armasm.exe
Linker: armlink.exe
Archiver: armar.exe

Image Converter: fromelf.exe

If this information is correct, click Finish to add the toolchain, otherwise click Next to edit/correct

this information.

Next >

Figure 55: Toolchain Information

7. Click Apply and Close.

8. Click Restart Eclipse when prompted.

E Preferences

type filter text

Library Hover
LinkerScript
MCU

Mylyn
Oomph
Remote Development
Renesas QF
Run/Debug
Scripting
Team
Terminal
Toolchains
Tracing
Validation
XML

@®

~

X
Toolchains =i
Add/Remove toolchains
Name Add...
Remove

Name: ARM Compiler 6.14

Path:

C\Program Files\ARMCompiler6.14\bin

Apply

Apply and Close Cancel

Figure 56: Apply and Close
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E Confirm Restart Eclipse

I-e'-‘ Eclipse must be restarted in order for the changes to be visible.

Figure 57: Restart Eclipse

9. When creating a new RA C/C++ project, select ARM Compiler 6 included in the Toolchains
section.

E e2 studio - Project Configuration (RA C Executable Project)

e2 studio - Project Configuration (RA C Executable Project)
Specify the new project details.

Project Toolchains
Project name | ARM_Compiler_Test ‘ GNU ARM Embedded
Use default location

|ARM Compiler 6.14 |

Figure 58: Select Arm Compiler

2.2.12 Importing an Existing Project into e2 studio
1. Start by opening e2 studio.

2. Open an existing Workspace to import the project and skip to step d. If the workspace
doesn't exist, proceed with the following steps:

a. At the end of e2 studio startup, you will see the Workspace Launcher Dialog box as
shown in the following figure.

B8 Eclipse Launcher *
Select a directory as workspace

& studio uses the workspace directory to store its preferences and development artifacts.

RIS ETEWEC \Users\\ < user_namele2studio\workspace]

Browse...

[] Use this as the default and do not ask again
» Recent Workspaces

Cancel
Figure 59: Workspace Launcher dialog

R11UMO0146EU0120 Revision 1.20
Jun.26.20

RLENESAS Page 49 / 1,560



Flexible Software Package

User’s Manual
Starting Development > e2 studio User Guide > Importing an Existing Project into e2 studio

b. Enter a new workspace name in the Workspace Launcher Dialog as shown in the
following figure. e2 studio creates a new workspace with this name.

E Eclipse Launcher

*
Select a directory as workspace

& studio uses the workspace directory to store its preferences and development artifacts,

IR ET N Users\ <username > \e2studiol\new workspace] Browse...

[] Use this as the default and de not ask again

b Recent Workspaces

Cancel
Figure 60: Workspace Launcher dialog - Select Workspace

c. Click Launch.

d. When the workspace is opened, you may see the Welcome Window. Click on the

Workbench arrow button to proceed past the Welcome Screen as seen in the
following figure.

RENESAS Welcome to e2 studio (=)

Workbench

Figure 61: Workbench arrow button

3. You are now in the workspace that you want to import the project into. Click the File menu
in the menu bar, as shown in the following figure.

File Edit Source Refactdr Mavigate ° e Menu Bar
@J @ .,E. e Tool Bar

G- @@ it G

Figure 62: Menu and tool bar

4. Click Import on the File menu or in the menu bar, as shown in the following figure.
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i

File Edit Source Refactor Navigate

New

Open File...

4 Open Projects from File System...

Close
Close All

Save
Save As...
Save All
Revert
Move...
Rename...
Refresh

Convert Line Delimiters To

Print...

7 Import.

Export...

Properties

Search Project Renesa

Alt+Shift+N »

Ctrl-W
Ctrl+ Shift+ W

Ctrl+5

Ctrl+Shift+5

Ctrl+P

Alt+Enter

1 Web Browser [tool-support.renesas.c...]

Switch Workspace
Restart
Exit

Figure 63: File drop-down menu

5. In the Import dialog box, as shown in the following figure, choose the General option, then
Existing Projects into Workspace, to import the project into the current workspace.

Create new projects from an archive file or directory.

Select an import wizard:

v = General
I Archive File
&) CMSIS Pack
&) CMSIS Pack
- Existing Projects into Workspace
(= File System
[T Preferences
() Projects from Folder or Archive
=% Rename & Import Existing C/C++ Project into Workspace

< Back Next >

E

Einish Cancel

Figure 64: Project Import dialog with "Existing Projects into Workspace" option selected

6. Click Next.

7. To import the project, use either Select archive file or Select root directory.

a. Click Select archive file as shown in the following figure.
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B import O x
Import Projects o
Select a directory to search for existing Eclipse projects, / A,'
(0 Select root directo ny Browse..
I@ Select archive file: I | | ~ |I Browse... I
Projects:
Select All
Deselect All
Refresh
Options

Search for nested projects
Copy projects into workspace

[[] Hide projects that already exist in the workspace

Working sets

[JAdd project to working sets Mew...
Sele

=

@ < Back et Finish Cance)

Figure 65: Import Existing Project dialog 1 - Select archive file

b. Click Select root directory as shown in the following figure.

B8 import m] X
Import Projects ¥ *\
Select a directory to search for existing Eclipse projects. / ‘
I@ Select root directory: I‘ ‘ ~ |I Browse... |
() Select archive file: Browse...
Projects:
Select All
Deselect All
Refresh
Options

[[15earch for nested projects
Copy projects into workspace
[[IHide projects that already exist in the workspace

Working sets

[[] Add project to working sets New...
Selec

@ < Back Mo > e T

Figure 66: Import Existing Project dialog 1 - Select root directory

. Click Browse.

. For Select archive file, browse to the folder where the zip file for the project you want to
import is located. For Select root directory, browse to the project folder that you want to
import.

10. Select the file for import. In our example, it is CAN_HAL MG_AP.zip or CAN_HAL MG _AP.

O 00
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11. Click Open.

12. Select the project to import from the list of Projects, as shown in the following figure.

Projects:

CAN_HAL_MG_AP (CAN_HAL_MG_AP/)
Figure 67: Import Existing Project dialog 2

13. Click Finish to import the project.

2.3 Tutorial: Your First RA MCU Project - Blinky

2.3.1 Tutorial Blinky

The goal of this tutorial is to quickly get acquainted with the Flexible Platform by moving through the
steps of creating a simple application using e2 studio and running that application on an RA MCU
board.

2.3.2 What Does Blinky Do?

The application used in this tutorial is Blinky, traditionally the first program run in a new embedded
development environment.

Blinky is the "Hello World" of microcontrollers. If the LED blinks you know that:

e The toolchain is setup correctly and builds a working executable image for your chip.

e The debugger has installed with working drivers and is properly connected to the board.
e The board is powered up and its jumper and switch settings are probably correct.

e The microcontroller is alive, the clocks are running, and the memory is initialized.

The Blinky example application used in this tutorial is designed to run the same way on all boards
offered by Renesas that hold the RA microcontroller. The code in Blinky is completely board
independent. It does the work by calling into the BSP (board support package) for the particular
board it is running on. This works because:

e Every board has at least one LED connected to a GPIO pin.

e That one LED is always labelled LED1 on the silk screen.

e Every BSP supports an API that returns a list of LEDs on a board, and their port and pin
assignments.

2.3.3 Prerequisites

To follow this tutorial, you need:
e Windows based PC
e e2 studio

e Flexible Software Package
e An RA MCU board kit

2.3.4 Create a New Project for Blinky
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The creation and configuration of an RA MCU project is the first step in the creation of an application.
The base RA MCU pack includes a pre-written Blinky example application that is simple and works on
all Renesas RA MCU boards.

Follow these steps to create an RA MCU project:
1. In e2 studio, click File > New > RA Project and select Renesas RA C Executable

Project.
2. Assign a name to this new project. Blinky is a good name to use for this tutorial.

3. Click Next. The Project Configuration window shows your selection.

e studio - Project Configuration (RA C Executable Project) O X

e2 studio - Project Configuration (RA C Executable Project)
Specify the new project details.

Project Toolchains

Project name | Blinky| GNU ARM Embedded

Use default location

C\Users\Austin.Hansen\e2_studio\workspace_deme| | Browse...

default

(':7) < Back Next > Finish Cancel

Figure 68: e2 studio Project Configuration window (part 1)

4. Select the board support package by selecting the name of your board from the Device
Selection drop-down list and click Next.
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e studio - Project Configuration (RA C Executable Project) O x

e2 studio - Project Configuration (RA C Executable Project)
Select the board suppert that you require.

Device Selection

FSP version: |1.1.0 EcelDetk

Board: EK-RAGM3 ~

Device: RYFAEM3IAHICFC

RTOS: No RTOS ~
Select Tools Available Tools
Toolchain: GMU ARM Embedded ~ GNU ARM Embedded
Toolchain version: |9.2.1.20191025 ~ 9.2.1.20191025

8.3.1.20190703

Debugger: J-Link ARM ~ 7.2.1.20170904
4.9.3.20150529

w Debuggers
E2 (ARM])
E2 Lite (ARM)
J-Link ARM

w Smart Manual
10 Registers Supported
Software Manual Supported

@ < Back Next > Einish Cancel

Figure 69: e2 studio Project Configuration window (part 2)

5. Select the Blinky template for your board and click Finish.

e studio - Project Configuration (RA C Executable Project) O x

e2 studio - Project Configuration (RA C Executable Project)
Select the type of project you wish to create,

Project Template Selection

® ' Bare Metal - Blinky
o,

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize
clocks, pins, stacks, and the C runtime envirenment,

[Renesas.RA.1.1.0.pack]

o d Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C
runtime environment,

[Renesas.RA.1.1.0.pack]

Code Generation Settings
Use Renesas Code Formatter

@ Next > Einish Cancel

Figure 70: e2 studio Project Configuration window (part 3)
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Once the project has been created, the name of the project will show up in the Project
Explorer window of e2 studio. Now click the Generate Project Content button in the top
right corner of the Project Configuration window to generate your board specific files.

5% [Blinky] RA Configuration 13 Ll
Summary Generate Project Content

Project Summary A

RENESAS

Board: EK-RABM3

Device: R7FABM3AH3CFC

Toolchain: GCC ARM Embedded

Toolchain Version: 8.3.1.20190703

FSP Version: 0.8.0-rc.0

Selected software components v

Figure 71: e2 studio Project Configuration tab

Your new project is now created, configured, and ready to build.

2.3.4.1 Details about the Blinky Configuration
The Generate Project Content button creates configuration header files, copies source files from

templates, and generally configures the project based on the state of the Project Configuration
screen.

For example, if you check a box next to a module in the Components tab and click the Generate
Project Content button, all the files necessary for the inclusion of that module into the project will
be copied or created. If that same check box is then unchecked those files will be deleted.

2.3.4.2 Configuring the Blinky Clocks

By selecting the Blinky template, the clocks are configured by e2 studio for the Blinky application.
The clock configuration tab (see Configuring Clocks) shows the Blinky clock configuration. The Blinky
clock configuration is stored in the BSP clock configuration file (see BSP Clock Configuration).
2.3.4.3 Configuring the Blinky Pins

By selecting the Blinky template, the GPIO pins used to toggle the LED1 are configured by e2 studio
for the Blinky application. The pin configuration tab shows the pin configuration for the Blinky
application (see Configuring Pins). The Blinky pin configuration is stored in the BSP configuration file
(see BSP Pin Configuration).

2.3.4.4 Configuring the Parameters for Blinky Components

The Blinky project automatically selects the following HAL components in the Components tab:

e r_ioport

To see the configuration parameters for any of the components, check the Properties tab in the
HAL window for the respective driver (see Adding and Configuring HAL Drivers).

2.3.4.5 Where is main()?

The main function is located in < project >/ra_gen/main.c. It is one of the files that are generated
during the project creation stage and only contains a call to hal_entry(). For more information on

R11UMO146EU0120 Revision 1.20 RENESANAS Page 56 / 1,560
Jun.26.20



Flexible Software Package User’s Manual

Starting Development > Tutorial: Your First RA MCU Project - Blinky > Create a New Project for Blinky > Where is main()?

generated files, see Adding and Configuring HAL Drivers.
2.3.4.6 Blinky Example Code

The blinky application is stored in the hal_entry.c file. This file is generated by e2 studio when you
select the Blinky Project template and is located in the project's src/ folder.

The application performs the following steps:

1. Get the LED information for the selected board by bsp_leds_t structure.
2. Define the output level HIGH for the GPIO pins controlling the LEDs for the selected board.

3. Get the selected system clock speed and scale down the clock, so the LED toggling can be
observed.

4. Toggle the LED by writing to the GPIO pin with R_BSP_PinWrite((bsp_io_port_pin_t) pin,
pin_level);
2.3.5 Build the Blinky Project

Highlight the new project in the Project Explorer window by clicking on it and build it.
There are three ways to build a project:
1. Click on Project in the menu bar and select Build Project.

2. Click on the hammer icon.
3. Right-click on the project and select Build Project.

R s Views Run Window

B workspace - & studio

File Edit Navigate Searc

a. Project->Build Project

&
=] sl b. Click hammer icon
,: ¢. Right click->Build Project
i Pro
&
4 Boa

Figure 72: e2 studio Project Explorer window

Once the build is complete a message is displayed in the build Console window that displays the
final image file name and section sizes in that image.

2 = [ Console &2

COT Build Console [Blinky]

"Finished building: ../ra/board/raém3_ek/board_leds.c’
"Finished building: ../ra/board/raém3_ek/board_init.c’

*Finished building: ../ra/board/raém3_ek/board_gspi.c’

'Building target: Blinky.elf'
"Invoking: GNU ARM Cross C Linker'
arm-none-eabi-gcc @"Blinky.elf.in"
"Finished building target: Blinky.elf'

"Invoking: GNU ARM Cross Create Flash Image'
arm-none-eabi-objcopy -0 srec "Blinky.elf™ "Blinky.srec™
"Invoking: GNU ARM Cross Print Size'
arm-none-eabi-size --format=berkeley "Blinky.elf"

text data bss dec hex filename

4248 8 1152 5488 1518 Blinky.elf
"Finished building: Blinky.srec'
"Finished building: Blinky.siz'

11:5@:45 Build Finished. @ errors, @ warnings. (took 19s.268ms)

Figure 73: e2 studio Project Build console
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2.3.6 Debug the Blinky Project

2.3.6.1 Debug prerequisites
To debug the project on a board, you need
* The board to be connected to e2 studio
* The debugger to be configured to talk to the board

e The application to be programmed to the microcontroller

Applications run from the internal flash of your microcontroller. To run or debug the application, the
application must first be programmed to the microcontroller's flash. There are two ways to do this:

e JTAG debugger
¢ Built-in boot-loader via UART or USB

Some boards have an on-board JTAG debugger and others require an external JTAG debugger
connected to a header on the board.

Refer to your board's user manual to learn how to connect the JTAG debugger to e2 studio.
2.3.6.2 Debug steps
To debug the Blinky application, follow these steps:

1. Configure the debugger for your project by clicking Run > Debugger Configurations ...

Run | Window Help

[ Tracex >
Eh  Tracealyzer >
@, Run Ctrl+F11
4, Debug F11
Run History >
Run As >
Run Configurations...
Debug History >
Debug As >
Debug Configurations... I
@ Bdemal Tools >

Figure 74: e2 studio Debug icon

or by selecting the drop-down menu next to the bug icon and selecting Debugger
Configurations ...

v e Q- o~

Debug As >
Debug Configurations...

Organize Favorites...

Figure 75: e2 studio Debugger Configurations selection option
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2. Select your debugger configuration in the window. If it is not visible then it must be created
by clicking the New icon in the top left corner of the window. Once selected, the Debug
Configuration window displays the Debug configuration for your Blinky project.

B Debug Configurations X
Create, manage, and run configurations = ”"P
- = i [ -
CExX| B3 || Name: [ Blinky Debug |
type filter text B Main ﬁ&-Dahuggel\' f Startup | & Source| [F] Common

[E] C/C++ Application
[E] €/C++ Remote Applic
= EASE Script [ Brinky Browse...
[€] GDB Hardware Debugg
[€] GDB OpenOCD Debuge
[t GDB Simulator Debugg
Java Applet Variables... Search Project... Browse...
lava Application
i Launch Group

Project:

C/C++ Application:
[ Debug/Blinky.if

Build (if required) before launching

& Launch Group (Deprec: Build Configuration: | Use Active ~
Remote Java Applicatio : : .
« [ Renesas GDE Hardware () Enable auto build () Disable auto build
[£7] Blinky Debug (® Use workspace settings Configure Workspace Settings...

[E7 Renesas Simulator Debt

< >
Revert Apph
Filter matched 14 of 16 items —

Figure 76: e2 studio Debugger Configurations window with Blinky project

3. Click Debug to begin debugging the application.

4., Extracting RA Debug.

Progress Information m] X

Extracting RA Debug

Configuring GDB

2.3.6.3 Details about the Debug Process
In debug mode, e2 studio executes the following tasks:

1. Downloading the application image to the microcontroller and programming the image to
the internal flash memory.

. Setting a breakpoint at main().

. Setting the stack pointer register to the stack.

. Loading the program counter register with the address of the reset vector.

. Displaying the startup code where the program counter points to.

b wWwN
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Program Counter

{8% [Blinky] RA Configgfation L€l hal_entry.c Lg startup.c 2

@ * MCU starts executing here out of re

void Reset Handler (void)

L
/* Initialize system using BSP. */
SystemInit();

/* Call user application. */
main();

while (1)
1

Figure 77: e2 studio Debugger memory window

2.3.7 Run the Blinky Project

While in Debug mode, click Run > Resume or click on the Play icon twice.

L U

Figure 78: e2 studio Debugger Play icon

The LEDs on the board marked LED1, LED2, and LED3 should now be blinking.

2.4 Tutorial: Using HAL Drivers - Programming the WDT

2.4.1 Application WDT

This tutorial illustrates the creation of a simple application that uses the Watchdog Timer module to
monitor program operation. The tutorial shows each step in the development process and in
particular identifies the auto-generated files and project structure created when using FSP and its
GUI based configurator. The level of detail provided here is more than is normally needed during
development but can be helpful in explaining how FSP works behind the scenes to simplify your
work.

This application makes use of the following FSP modules:

e MCU Board Support Package
e Watchdog Timer (r_wdt)
e |/O Ports (r_ioport)

2.4.2 Creating a WDT Application Using the RA MCU FSP and e2 studio

2.4.2.1 Using the FSP and e2 studio

The Flexible Software Package (FSP) from Renesas provides a complete driver library for developing
RA MCU applications. The FSP provides Hardware Abstraction Layer (HAL) drivers, Board Support
Package (BSP) drivers for the developer to use to create applications. The FSP is integrated into
Renesas e2 studio based on eclipse providing build (editor, compiler and linker) and debug phases
with an extended GNU Debug (GDB) interface.

2.4.2.2 The WDT Application
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The flowchart for the WDT application is shown below.

Program start

BSP initializes
clocks, pins etc

Tum on red
LED for 125 ms
Feed WDT

Tum off red
LED for 125 ms

Feed WDT

==307
Yes

Tum on green
LED for 250 ms
‘WDT counts
without refresh
Tum off green
LED for 250 ms
Underflow

( WOT resets MCU )
Figure 79: WDT Application flow diagram

Initialize and
start WDT

2.4.2.3 WDT Application flow
The main sections of the WDT application are:

1. The BSP initializes the clocks, pins and other elements of the MCU readying the application
to run.

2. main() calls hal_entry(). The function hal_entry() is created by the FSP with a placeholder for
user code. The code for the WDT is added to this function.

3. Initialize the WDT, but do not start it.

4. Start the WDT by refreshing it.

5. In the first loop the red LED flashes 30 times and refreshes the watchdog each time the LED
state is changed.

6. In the second loop, the green LED flashes, but the program DOES NOT refresh the
watchdog. After the watchdog timeout period the device will reset which can be observed
by the red LED flashing again as the sequence repeats.

2.4.3 Creating the Project with e2 studio

Start e2 studio and choose a workspace folder in the Workspace Launcher. Configure a new RA MCU
project as follows.

1. Select File > New > RA C/C++ Project. Then select the template for the project.

File Edit MNavigate Search Project RenesasViews Run  Window Help

N st >
Open File... ™ Project...
() Open Projects from File System... % Eample.
Hn C=W = Other... CtrieN
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Mew RA C/C++ Project O X

Templates for New RA C/C++ Project

fan ] Renesas RA C Executable Project ~

C/C++ FE= A C Executable Project for Renesas RA.

Renesas RA C Library Project
¥ Froj
FEEZmN A C Library Project for Renesas RA.

Renesas RA C Project Using RA Library
FE==N Creates a C application project which uses an
existing RA library project

Renesas RA C++ Executable Project
FE= A C++ Executable Project for Renesas RA.

Renesas RA C-+-+ Library Project
FEZN A C++ Library Project for Renesas RA. .

< >

5
@ < Back Next > Finish Cancel

Figure 80: Creating a new project

2. In the e2 studio Project Configuration (RA Project) window enter a project name, for
example, WDT_Application. In addition, select the toolchain. If you want to choose new
locations for the project unselect Use default location. Click Next.

e studio - Project Configuration (RA C Executable Project) O x
e2 studio - Project Configuration (RA C Executable Project) —
Specify the new project details,
Project Toolchains
Project name | WDT_Application GNU ARM Embedded
Use default location
C\Users\Austin.Hansen\e2_studio\workspace deme| | Browse...
default
@ < Back Next > Finish Cancel

Figure 81: Project configuration (part 1)

3. This application runs on the EK-RA6M3 board. So, for the Board select EK-RA6M3.
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This will automatically populate the Device drop-down with the correct device used on this
board. Select the Toolchain version. Select J-Link ARM as the Debugger. Click Next to
configure the project.

e studic - Project Configuration (RA C Executable Project) O
e2 studio - Project Configuration (RA C Executable Project) —

Select the board support that you require.

Device Selection

FSP version: |1.1.0 Board Detsils

Board:

Device: R7FABM3AHICFC

RTOS: No RTOS ~
Select Tools Available Tools
Toolchain: GMU ARM Embedded ~ GNU ARM Embedded
Toslchain version: |9.2.1.20121025 v 8.21.20181023

8.3.1.20190703

Debugger: J-Link ARM ~ 7.2,1.20170904
4.9.3.20150529

w Debuggers
E2 (ARM)
E2 Lite (ARM)
J-Link ARM

v Smart Manual
10 Registers Supported
Software Manual Supported

':?) < Back Mext > Finish Cancel

Figure 82: Project configuration (part 2)

The project template is now selected. As no RTOS is required select Bare Metal - Blinky.

e studic - Project Configuration (RA C Executable Project) O
e2 studio - Project Configuration (RA C Executable Project) —

Select the type of project you wish to create.

Project Template Selection

® (;} Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize
clocks, pins, stacks, and the C runtime environment.

[Renesas.RA.1.1.0.pack]

O (;} Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C
runtime environment,

[Renesas.RA1.1.0.pack]

Code Generation Settings
Use Renesas Code Formatter

Finish Cancel

Figure 83: Project configuration (part 3)
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4. Click Finish.

e2 studio creates the project and opens the Project Explorer and Project Configuration
Settings views with the Summary page showing a summary of the project configuration.

2.4.4 Configuring the Project with e2 studio

e2 studio simplifies and accelerates the project configuration process by providing a GUI interface for
selecting the options to configure the project.

e2 studio offers a selection of perspectives presenting different windows to the user depending on
the operation in progress. The default perspectives are C/C++, RA Configuration and Debug. The
perspective can be changed by selecting a new one from the buttons at the top right.

[ C/C++ {5 RA Configuration #5 Debug

Figure 84: Selecting a perspective

The C/C++ perspective provides a layout selected for code editing. The RA Configuration
perspective provides elements for configuring a RA MCU project, and the Debug perspective
provides a view suited for debugging.

1. In order to configure the project settings ensure the RA Configuration perspective is
selected.

2. Ensure the Project Configuration [WDT Application] is open. It is already open if the
Summary information is visible. To open the Project Configuration now or at any time make
sure the RA Configuration perspective is selected and double-click on the
configuration.xml file in the Project Explorer pane on the right side of e2 studio.

| - =7

£

If5 Project Explorer 52 =
LI Blinky
w 15 WDT _Application [Debug]
[ Includes
v [Era
= arm
(&= board
= fsp
2 ra_gen
v [ src
\g| hal_entry.c
= ra_cfg
45 configurationml
=| RTFAEM3AHICFC pincfg
=| RABM3-EK.pincfg
=| WDT_Application Debug.launch
(7) Developer Assistance

Figure 85: RA MCU Project Configuration Settings

At the base of the Project Configuration view there are several tabs for configuring the project. A
project may require changes to some or all of these tabs. The tabs are shown below.
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{5 [WDT_Application] RA Configuration 5% =8

Summar
y Generate Project Content

Project Summary

RENESAS
Board: EK-RABGM3
Device: R7FAGM3AH3ICFC
Toolchain: GCC ARM Embedded
Toolchain Version: 9.2.1.20191025
FSP Version: 110

Selected software components

RABM3-EK Board Support Files v1.1.0
Simple application that blinks an LED. No RTOS included. v1.1.0
Board support package for RTFAGM3AH3CFC vi1.0
Board support package for RABM3 v1.1.0
Board support package for RAG6M3 - FSP Data vi1.0
Arm CMSIS Version 5 - Cora (M) v5.6.0
Board Support Package Common Files vi1.0
1iQ Port vi1.0

=H0

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Compeonents

Figure 86: Project Configuration Tabs

2.4.4.1 BSP Tab

The BSP tab allows the Board Support Package (BSP) options to be modified from their defaults. For
this particular WDT project no changes are required. However, if you want to use the WDT in auto-
start mode, you can configure the settings of the OFS0 (Option Function Select Register 0) register in
the BSP tab. See the RA Hardware User's Manual for details on the WDT autostart mode.

2.4.4.2 Clocks Tab

The Clocks tab presents a graphical view of the clock tree of the device. The drop-down boxes in the
GUI enables configuration of the various clocks. The WDT uses PCLCKB. The default output frequency
for this clock is 60 MHz. Ensure this clock is outputting this value.

48k [WDT_Application] RA Configuration 2

0
]

Clocks Configuration

@L ~lick i 2 o —sf1cc1200mmz

PLL Sre: XTAL v L=/ pcika biv 2 « sl peika 120mHz
PLL Div /2 k v | PCLKB Div /4 « =/ PCLKE 0MHz |
PLL Mul xzo.{f: v L=/ pcLic Div /4 s/ PCLKC B0MHz

[ USBMCL 2401z | | [PLL240MH [/ clockesrc: PLL v —¢! PCLKD Div /2 « s/ pcLkD 120MH2

HOCO 20MHz v SDCLKout On « =/ SDCLKout 120MHz

b/ BCLK Div /2T o —s[BCIK 120MHz

MOCO 8MHz BCLK/2 ~ BCLKout 60MHz

SUBCLK 32768Hz [ UCLK Div /3 ~ UCLK 48MHz

“= FCLK Div /4 ~ FCLK 60MHz

CLKOUT Disabled w —= CLKOUT Div /1 ~ CLKOUT 0Hz

[n]
o
5
o
B
o
i
o
= ¥
fio
g e
-
"ToA
2 g
5 2
e 5
F oA

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 87: Clock configuration
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2.4.4.3 Interrupts Tab

The Interrupts tab is used to add new user events or interrupts. No new interrupts or events are
needed by the application, so no edits in this tab are required.

2.4.4.4 Event Links Tab

The Event Links tab is used to configure events used by the Event Link Controller (ELC). This
project doesn't use the ELC, so no edits in this tab are required.

2.4.4.5 Pins Tab

The Pins tab provides a graphical tool for configuring the functionality of the pins of the device. For
the WDT project no pin configuration is required. Although the project uses two LEDs connected to
pins on the device, these pins are pre-configured as output GPIO pins by the BSP.

2.4.4.6 Stacks Tab

You can add any driver to the project using the Stacks tab. The HAL driver 10 port pins are added
automatically by e2 studio when the project is configured. The WDT application uses no RTOS
Resources, so you only need to add the HAL WDT driver.

197 [WDT_Application] RA Configuration 3 = |m

o

Stacks Configuration -
Generate Project Content

Threads ] : : o HAL/Common Stacks & ] New Stack >

I v g HAL/Common I
@ g_ioport [/Q Port Driver on r_ioport

42 g_ioport I/0 Port
Driver on r_ioport

®

Objects

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 88: Stacks tab

1. Click on the HAL/Common Panel in the Threads Window as indicated in the figure above.

The Stacks Panel becomes a HAL/Common Stacks panel and is populated with the
modules preselected by e2 studio.

2. Click on New Stack to find a pop-up window with the available HAL level drivers.
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3. Select WATCHDOG Driver on r_wdt.

{5} [WOT_Application] RA Configuration 53

Stacks Configuration

Threads HAL/Common Stacks

v a¢ HAL/Common
= & g_ioport1/O Port

¥ it /0 Port Dy ioport
% g_ioport |/O Port Driver on r_iopo! Driver on r_ioport

®

Objects

Summary | BSP | Clocks | Pins | Interrupts Event Links | Stacks | Components

Figure 89:

= 0

Generate Project Content

%] New Stark >

Arm > |
Driver >
FreeRTOS >
FreeRTOS+ >
Middleware >
SEGGER >

4 Search...

Module Selection

Analog
CapTouch
Connectivity
Graphics
Input
Menitoring
Network
Power
Storage
System
Timers

Transfer

& Package 3

CRC Driver on r_crc
Clock Accuracy Circuit Driver on r_cac
Data Operation Circuit Driver on r_doc

Watchdog Driver on r_iwdt

Watchdog Driver on r_wdt I

= 0
R R

The selected HAL WDT driver is added to the HAL/Common Stacks Panel and the Property
Window shows all configuration options for the selected module. The Property tab for the WDT
should be visible at the bottom left of the screen. If it is not visible, check that the RA

Configuration perspective is selected.

485 [WDT_Application] RA Configuration 3

Stacks Configuration

Threads B

HAL/Common Stacks

4] New Stack >

= 8

Generate Project Content

~ & HAL/Common
42 g_ieport 170 Port Driver on r_ioport
4 g_wdtd Watchdog Driver on r_wdt

42 g_ioport 1/0 Port

@

Driver on r_ioport

@

& g_wdtD Watchdog
Driver on r_wdt

Objects

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Compenents

[ Properties 5% |2 Problems & Smart Browser

g wdt0 Watchdog Driver on r wdt

Property
w Commaon

Settings
APl Info

Parameter Checking

Register Start NMI Support

v Module g_wdtD Watchdog Driver on r_wdt

Name

Timeout

Clock Division Ratio

Window Start Position

Window End Position

Reset Control

Stop Control

NMI Callback

Figure 90:

Value

Default (BSP)
Disabled

g_wdtd

16,384 Cycles

PCLK 8192

100% (Window Pasition Mot Specified)
0% (Window Position Not Specified)
Reset Qutput

'WOT Count Disabled in Low Power Made
NULL

Module Properties

All parameters can be left with their default values.

s Remove

o7CA

v
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[34 Pin Conflicts =# MCU Package [Z) Console | [T Properties 7 | 4% Debug

g wdt0 Watchdog Driver on r wdt

Settings Property Value

w Common
Parameter Checking Default (BSP)
Register Start NM| Support Disabled

v Module g_wdtd Watchdog Driver on r_wdt
Mame g_wdth
Timeout 16,384 Cycles
Clock Division Ratio PCLK/81532
Window Start Position 100% (Window Position Mot Specified)
Window End Position 0% [(Window Position Not Specified)
Reset Control Reset Qutput
Stop Control 'WOT Count Disabled in Low Power Mode
NMI Callback NULL

Figure 91: g wdt WATCHDOG Driver on WDT properties

With PCLKB running at 60 MHz the WDT will reset the device 2.23 seconds after the last refresh.

WDT clock = 60 MHz / 8192 = 7.32 kHz

Cycle time

1/7.324 kHz = 136.53 us
Timeout = 136.53 us x 16384 = 2.23 seconds

Save the Project Configuration file and click the Generate Project Content button in the top
right corner of the Project Configuration pane.

8% [WDT_Application] RA Configuration 5% ==

Stacks Configuration
g Generate Project Content

Threads = HAL/Common Stacks | New Stack > &) Remove
v & HAL/Commen . -
42 g_ioport 170 Port Driver on r_ioport 4 g_ioport 1/0 Port 4 g wdt0 Watchdog
) - Driver on r_ioport Driver on r_wdt

& g_wdtl Watchdeg Driver on r_wdt

® ®

Objects

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Compenents

Figure 92: Generate Project Content button

e2 studio generates the project files.
2.4.4.7 Components Tab

The components tab is included for reference to see which modules are included in the project.
Modules are selected automatically in the Components view after they are added in the Stacks Tab.

For the WDT project ensure that the following modules are selected:

1. HAL_Drivers -> r_ioport
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Note

2. HAL_Drivers -> r_wdt

48 [WDT_Application] RA Configuration &3

Components Configuration

Compenent
[ ricu
[C] riic_master
] riic_slave
r_ioport
[ r_iwdt
[C] ripeg
] r_kint
[ rlpm
] r_hvd
[C] r_opamp
[C] r_poeg
1 r_gspi
[ rrte
[[] rscera2
[[] rscerad
[[] r_sceraé
[[] rsciiize
[C] r_sci_spi
[C] r_scivart
[[] r_sdade
[ r_sdhi
7] rslede
] rspi
] rssi
[C] r_usb_basic
[[] r_usb_hede
[C] r_usb_hhid
[C] r_usb_hmsc
[C] r_usb_pede
[[] r_usb_phid
[[] r_usb_pmsc
r_wdt
[C] rm_psa_crypto

Version
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0
1.1.0

= 0

Generate Project Content

Description Variant @

External Interrupt

12C Master Interface

12C Slave Interface

170 Port

Independent Watchdeg Timer

JPEG Codec

Key Input

Low Power Modes

Low Voltage Detection

Operational Amplifier

Port Qutput Enable for GPT

Cuad Serial Peripheral Interface Flash

Real Time Clock

Secure Cryptography Engine on RAZ

Secure Cryptography Engine on RA4

Secure Cryptography Engine on RAG

SCI12C Master Interface

Serial Peripheral Interface on Serial Communicati...
SCIUART

Sigma Delta A/D Converter

SD/MMC Host Interface

Segment LCD Controller/Driver

Serial Peripheral Interface

Serial Sound Interface

Universal Serial Bus Basic

Universal Serial Bus Host Communication Device...
Universal Serial Bus Basic Host Human Interface ...
Universal Serial Bus Basic Host Mass Storage Class
Universal Serial Bus Peripheral Communication ...
Universal Serial Bus Peripheral Human Interface ...
Universal Serial Bus Peripheral Mass Storage Class
Watchdog Timer

MbedCrypto H/W Acceleration v

Summary | BSP Clocks | Pins In‘t‘:errupts Event Links | Stacks | Components

The list of modules displayed in the Components tab depends on the installed FSP version.

2.4.5 WDT Generated Project Files

Figure 93: Component Selection

Clicking the Generate Project Content button performs the following tasks.

e r_wdt folder and WDT driver contents created at:

ra/fsp/src

e r_wdt_api.h created in:
ra/fsp/inc/api

e r_wdt.h created in:

ra/fsp/inc/instances

The above files are the standard files for the WDT HAL module. They contain no specific project
contents. They are the driver files for the WDT. Further information on the contents of these files can
be found in the documentation for the WDT HAL module.
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Configuration information for the WDT HAL module in the WDT project is found in:

ra_cfg/fsp_cfg/r_wdt_cfg.h

The above file's contents are based upon the Common settings in the g_wdt WATCHDOG Driver

on WDT Properties pane.

[ Properties 52 [2] Problems @ Smart Browser

g wdt0 Watchdog Driver on r_wdt

Settings  Property Value %5 [WDT_pplication] R& Configuration

APlinfo | V¥ Common

Parameter Checking Default (BSP) 2
Register Start NMI Support Disabled )
~ Moedule g_wdtd Watchdog Driver on r_wdt 4

Name g wdt0

Timeout 16,384 Cycles =
Clock Division Ratio PCLK/8192

Window Start Position 100% (Window Position Mot Specified)

Window End Position 0% (Window Position Not Specified)

Reset Control Reset Output

Stop Control 'WDT Count Disabled in Low Power Mode

MMI Callback MULL

Figure 94: r_wdt_cfg.h contents

Warning

[+ generated configuration header file -
#ifndef R_WDT_CFG_H_
s#idefine R_WDT_CFG_H_
#define WDT_CFG_PARAM_CHECKING ENABLE (BSP_CFG_PARAM CHECKING_ENABLE)
GISTER_START_NMI_SUPPORTED ((8))

do not edit */

Do not edit any of these files as they are recreated every time the Generate Project Content

button is clicked and so any changes will be overwritten.

The r_ioport folder is not created at ra/fsp/src as this module is required by the BSP and so already

exists. It is included in the WDT project in order to include the correct header file in

ra_gen/hal_data.c-see later in this document for further details. For the same reason the other
IOPORT header files- ra/fsp/inc/api/r_ioport_api.handra/fsp/inc/instances/r_ioport.h-are not created as

they already exist.

In addition to generating the HAL driver files for the WDT and IOPORT files e2 studio also generates
files containing configuration data for the WDT and a file where user code can safely be added.

These files are shown below.

- =

I{5 Project Explorer 22 Ef=S ‘
~ =% WDT_Application [Debug]
[ Includes
v [Era
(= arm
(= board
= fsp
2 ra_gen
v [ src
\.g| hal_entry.c
(= Debug
v [= ra_cfg
v (= fsp_cfg
[= bsp
lg| r_ioport_cfg.h
lgl r_wdt_cfg.h
(= script
45k configurationml
=| RTFABM3AHICFC pincfg
=| ra_cfg.bt
=| RAEM3-EK.pincfg
=| WDT_Application Debug.launch
(7) Developer Assistance

Figure 95: WDT project files

2.4.5.1 WDT hal_data.h
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The contents of hal_data.h are shown below.

hal_data.h contains the header files required by the generated project. In addition this file includes
external references to the g_wdtO0 instance structure which contains pointers to the configuration,
control, api structures used for WDT HAL driver.

Warning
This file is regenerated each time Generate Project Content is clicked and must not be
edited.

2.4.5.2 WDT hal_data.c

The contents of hal_data.c are shown below.
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/* generated HAL source file - do not edit */
#i ncl ude "hal data.h"
wdt _instance_ctrl _t g wdtO ctrl;

const wdt_cfg_t g wdtO_cfg =

{
.ti nmeout = WDT_TI MEOUT 16384,
.clock division = WDT_CLOCK DI VI SI ON 8192,
. Wi ndow st art = WDT_W NDOW START 100,
. Wi ndow_end = WDT_W NDOW END_0O,
.reset_control = WDT_RESET CONTROL_RESET,
.stop_control = WDT_STOP_CONTROL_ENABLE,
. p_cal | back = NULL,

}i

[* Instance structure to use this nodule. */

const wdt _instance t g wdtO =

{.p_ctrl = & wdtO ctrl, .p_cfg = & wdtO cfg, .p_api = &_wdt_on_wdt};
void g _hal _init (void)

{

g_conmon_init();

hal_data.c contains g_wdtO_ctrl which is the control structure for this instance of the WDT HAL
driver. This structure should not be initialized as this is done by the driver when it is opened.

The contents of g wdt0_cfg are populated in this file using the Watchdog Driver on g wdt0 pane
in the Project Configuration Stacks tab. If the contents of this structure do not reflect the settings
made in the IDE, ensure the Project Configuration settings are saved before clicking the
Generate Project Content button.

Warning
This file is regenerated each time Generate Project Content is clicked and so should not be
edited.

2.4.5.3 WDT main.c

Contains main() called by the BSP start-up code. main() calls hal_entry() which contains user
developed code (see next file). Here are the contents of main.c.

/* generated nmain source file - do not edit*/

#i ncl ude "hal _data. h"
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Warning
This file is regenerated each time Generate Project Content is clicked and so should not be
edited.

2.4.5.4 WDT hal_entry.c

This file contains the function hal_entry() called from main(). User developed code should be placed
in this file and function.

For the WDT project edit the contents of this file to contain the code below. This code implements
the flowchart in overview section of this document.
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i f (BSP_WARM START_RESET == event)
{
#i f BSP_FEATURE FLASH LP_VERSION != 0
/* Enable reading fromdata flash. */
R FACI LP->DFLCTL = 1U;
/* Would normally have to wait for tDSTOP(6us) for data flash recovery. Placing the
enabl e here, before clock and
* Cruntinme initialization, should negate the need for a delay since the
initialization will typically take nore than 6us. */
#endi f
}
i f (BSP_WARM START_POST_C == event)
{
/* C runtine environment and system cl ocks are setup. */
/* Configure pins. */
R | OPORT_Open(&g_ioport_ctrl, &y bsp pin_cfg);
}

The WDT HAL driver API functions are defined in r_wdt.h. The WDT HAL driver is opened through the
open API call using the instance structure defined in r_wdt_api.h:

/* Open the WDT */
R WDOT_Open(&g_wdtO_ctrl, & wdtO _cfg);

The first passed parameter is the pointer to the control structure g wdt0_ctrl instantiated in
hal_data.c. The second parameter is the pointer to the configuration data g_wdto_cfg instantiated in
the same hal_data.c file.

The WDT is started and refreshed through the API call:

[* Start the WDT by refreshing it */
R WDOT Refresh(&g wdtO _ctrl);

Again the first (and only in this case) parameter passed to this API is the pointer to the control
structure of this instance of the driver.
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2.4.6 Building and Testing the Project

Build the project in e2 studio by clicking Build > Build Project or by clicking the build icon. The
project should build without errors.

To debug the project

1. Connect the USB cable between the target board debug port and host PC.

2. In the Project Explorer pane on the left side of e2 studio, right-click on the WDT project
WDT _Application and select Debug As > Debug Configurations.

3. Under Renesas GDB Hardware Debugging select WDT_Application Debug as shown
below.

Debug Configurations

x
Create, manage, and run configurations :
= X ‘ = 25 MName: |WDT7Apphcation Debug ‘
type filter text [El Main’ %5. Debugger | = Startup | [] Common| & Source
[£] C/C++ Application e
[E] C/C++ Remote Application M=
=/ EASE Script ‘ WOT_Application Browse...
[©] GDB Hardware Debugging C/C++ Application:
[©] GDB OpenOCD Debuggin =
[ GDB Si:mamr Dahuggggingg(RHSSD) [ Debug/WDT_Appiicstion e
Java Applet Variables... Search Project... Browse...
& E\fnfszl::::n Build {if required) before launching
= Launch Group (Deprecated) Build Configuration: |Use Active B
Remote Java Application
« [E7 Renesas GDB Hardware Debugging (O Enable auto build () Disable aute build
[£7] WDT_Application Debug (®) Use workspace settings Configure Workspace Settings...
[£7 Renesas Simulator Debugging (RX, RL7S)
2 > e
Filter matched 14 of 16 items il i
Figure 96: Debug configuration
4, Click the Debug button. Click Yes to the debug perspective if asked.
Progress Information m] X
@k Extracting RA Debug
I
Configuring GDB
Details > =
5. The code should run the Reset_Handler() function.
6. Resume execution via Run > Resume. Execution will stop in main() at the call to
hal_entry().
7. Resume execution again.
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The red LED should start flashing. After 30 flashes the green LED will start flashing and the red LED
will stop flashing.

While the green LED is flashing the WDT will underflow and reset the device resulting in the red LED
to flash again as the sequence repeats.

1. Stop the debugger in e2 studio via Run > Terminate.
2. Click the reset button on the target board. The LEDs begin flashing.

2.5 RA SC User Guide for MDK and IAR

2.5.1 What is RA SC?

The Renesas RA Smart Configurator (RA SC) is a desktop application designed to configure device
hardware such as clock set up and pin assignment as well as initialization of FSP software
components for a Renesas RA microcontroller project when using a 3rd-party IDE and toolchain.

The RA Smart Configurator can currently be used with

1. Keil MDK and the Arm compiler toolchain.
2. IAR EWARM with IAR toolchain for Arm

Projects can be configured and the project content generated in the same way as in e2 studio.
Please refer to Configuring a Project section for more details.

2.5.2 Using RA Smart Configurator with Keil MDK

2.5.2.1 Prerequisites

e Keil MDK and Arm compiler are installed and licensed. Please refer to the Release notes for
the version to be installed.

* Import the RA device pack. Download the RA device pack archive file (ex:

MDK Device Packs x.x.x.zip) from the FSP GitHub release page. Extract the archive file to
locate the RA device pack. To import the RA device pack, launch the Packinstaller.exe from
<keil_mdk_install_dir>\UV4. Select the menu item File > Import... and browse to the
extracted .pack file.

e Verify that the latest updates for RA devices are included in Keil MDK. To verify, select the
menu "Packs" in Pack Installer and verify that the menu item Check for Updates on
Launch is selected. If not, select Check for Updates on Launch and relaunch Pack
Installer.

e For flashing and debugging, the latest Segger J-Link DLL is installed into Keil MDK.

e Install RA SC and FSP using the Platform Installer from the GitHub release page.

2.5.2.2 Create new RA project
The following steps are required to create an RA project using Keil MDK, RA SC and FSP:
1. To create an RA project in Keil MDK, an example template needs to be copied from the Pack

Installer. The Pack Installer can be launched by running Packinstaller.exe from
<keil_mdk_install_dir>\UV4.

2. Select the device family or a device in the left pane of pack installer to filter the example
templates in Examples tab in the right pane. The search bar in left pane helps to easily find
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a device. It is important to select the correct device and package type as this will be used
by RA SC to configure pins.

{8 Pack Installer - C:\Users\{ ) i_pmmsmun e s [\Arm\Packs - O x

File Packs Window Help
.:-:’ Device: Renesas - RAGBM3 Series

ﬂ Devices Eoards ﬂ ﬂ Pa:ksl Examples ﬂ

ISEarch: ABM3 i X [ Show ex lled Packs only
Device /| Summary Example Action Description
=7 All Devices 10 Devices R7FABM3AF2CBG project template (R7TFABM3AF2CEG custom) i Copy R7FABM3AF2CEG project template
=~ ¥ Renesas 10 Devices RTFABM3AFZCLE project template (RTFAGM3AFZCLK custom) ! Copy R7FAEM3IAF2CLK project template
Rl RAGMS3 Series 10 Devices R7FABM3AF3CFB project template (RTFABM3AF3CFE custom) i Copy R7FABM3AF3CFB project template
R7FABM3AF3CFC project template (R7TFABM3AF3CFC custom) i Copy R7FABM3AF3CFC project template
RTFAGM3AFICFP project template (RTFAGM3AF3CFP custom) 4 Copy R7FAEM3AF3CFP project template

4 Copy R7FABM3AH2CEG project template
4 Copy R7FAGBM3AHZCLK project template
! Copy R7FABM3AH3CFB project template
R7FABM3AH3CFC project template (R7TFABM3AHICFC EK-RABM3) i Copy R7FABM3AH3CFC project template
R7FABM3AH3CFC project template (R7TFABM3AHICFC EK-RABM3G) i Copy R7FABM3AH3CFC project template
R7FABM3AH3CFP project template (RTFAGM3AHICFP custom) ! Copy R7FABM3AH3CFP project template
1 3
Output . x
Refresh Pack descriptions
(Check for updates
Update available for ARM::CMSIS-Driver (installed: 2.4.1, available: 2.5.0)
(Check for updates
Update available for ARM::CMSIS-Driver (installed: 2.4.1, available: 2.5.0]
OMLINE

Ready

Figure 97: Packinstaller device example template

3. Click the Copy button for the example template to launch a dialog box and select where to
copy the example project. The default project name will be the target device name.

Copy Example X

Destination Folder

IC!V! | peeme w mpe g L‘ Browse...

[~ Use Pack Folder Structure V¥ Launch pVision

OK | Cancel l

Figure 98: Copy Example dialog

Click OK to launch Keil uVision with the new project.
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V] Vo e )

File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help

(I NEHd ] % B[P RBRESERD Ja®|a-lec s @8- A
& E 2 B 5 e R AR Y@
. Project a B3
2 % Project: RTFAGM3AH2CBG
O 4T Target1

[ Source Group 1

4 Flex Software

MDK: Selected Software Component Requires Code Generation by ‘Renesas RA Smart Configur.. X

Component:
Renesas::Flex Software:RA Configuration

Generator Program:
Renesas RA Smart Configurator

Generates:
buildinfo. gpdsc

Cancel

Tﬂijett@E:'

Build Output =8

CAP/ NUM SCRL OVR R/W ;|

Figure 99: uVision

If the project name needs to be changed then deselect Launch uVision_ in the Copy
Example dialog and click __OK. Follow project rename instructions here:
http://www.keil.com/support/docs/3579.htm Once renamed, open the project using menu
item Project > Open Project... in uVision and continue with steps in Modify existing RA
project.

4. uVision offers to start the RA Smart Configurator (RA SC). Click Start Renesas RA Smart
Configurator to launch it.

MDK: Selected Software Component Requires Code Generation by ‘Renesas RA Smart Configur... X

Component:
Renesas::Flex Software:RA Configuration

Generator Program:
Renesas RA Smart Configurator

Generates:
Nbuildinfo. gpdsc

| Start Renesas RA Smart Configurator | Cancel
Figure 100: Launch RA SC confirmation dialog

5. If multiple versions of RA SC are installed, select the appropriate version of RA SC to run.

= CAWINDOWS\system32\cmd.exe - O X

Multiple RA Smart
e: Version .8

Figure 101: RA SC version selection
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6. RA SC will be launched with project generator wizard.
7. The configuration window opens once the project wizard is closed. Refer to Configuring a
Project for more details on how to configure the project.

8. After clicking Generate Project Content in the RA Smart Configurator, return to uVision.
uVision offers a dialog to import the changes and updates to the project made in RA SC.
Select Yes to import the updated project and the project is ready to build.

WVision

4@-% Forthe current project new generated code is available for
| import.

Project:
C:\Dev_work\Keil_projects\lab_project\R7TFA6M3AH3CFC\RTFAG
M3AH3ICFC.uvprojx

Generated:
C\Dev_work\Keil_projects\lab_project\R7TFA6M3AH3CFC\buildi
nfo.gpdsc

Import Changes?

Figure 102: Import project data

RA SC will place the necessary FSP source code and header files into the project
workspace. The folder structure is defined as below.

e Source Group 1 User source code should be added to the project in this folder
e Renesas RA Smart Configurator: Common Sources These source files are generated by RA
Smart Configurator and can be edited as necessary

¢ Flex Software These are the source files from FSP and can be modified if needed. However,
it is recommended NOT to edit these files as this may impact dependencies or functionality.

Project L x |
= 1% Project: RTFAEM3AH3CFC =
-4 Target1
td Source Group 1
-l-i. Renesas RA Smart Configurator:Common Sources
&-_] blinky_thread_entry.c
[+ _1 hal_entry.c
= ‘@ Flex Software

[+ event_groups.c (Components:ra)

&2 list.c (Components:ra)
[+ queue.c (Components:ra)

stream_buffer.c (Components:ra)

tasks.c (Components:ra)

timers.c (Components:ra)

-5

)
TEEEEEEE

board_init.c (Components:ra)

rm

Figure 103: uVision project workspace with imported project data
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2.5.2.3 Modify existing RA project

Once an initial project has been generated and configured, it is also possible to make changes using
RA SC as follows:

1. If the desired project is not already open in uVision, the project can be opened using menu
item Project > Open project... or selecting from the list of previous projects.

2. Select menu item Project > Manage > Run-time Environment... or tool bar button
Manage Run-Time Environment.

3. Expand the Flex Software tree item in the dialog shown and click the green run button
next to RA Configuration. This launches RA SC and the FSP project configuration can be
modified and updated.

K4 Manage Run-Time Environment X

Software Component Sel. Variant Version Description
@ € CMSIS Cortex Microcontroller Software Interface Components 1=
& @ CMSIS Driver Unified Device Drivers compliant to CMSIS-Driver Specifications
=R 3 Compiler ARM Compiler 160 Compiler Extensions for ARM Compiler 5 and ARM Compiler 6
+ € Device Startup, System Setup
w4 File System MDK-Plus ~ | 6.13.0 File Access on various sterage devices
= 4 Flex Software Renesas Flex Software

@ Build Configuration [V |»

@ Generated Data [v [m

@ linker Scopt [

@ RA Configuration v (> 1.00 Renesas RA Configuration

bgromprmem
5 Graphics MDK-Plus ~ | 5.50.0 User Interface on graphical LCD displays —
& 49 Network MDK-Plus ~ | 7120 1Pv4 Networking using Ethernet or Serial protocols
& ‘@f UsB MDK-Plus ~ |6.13.7 USBE Communication with various device classes ﬂ
« { ol
Validation Output Description
Resolve | |SelectPacks| | Detais Cancel Help

Figure 104: Manage run-time environment

2.5.2.4 Build and Debug RA project

The project can be built by selecting the menu item Project > Build Target or tool bar item
Rebuild or the keyboard shortcut F7.

Assembler, Compiler, Linker and Debugger settings can be changed in Options for Target dialog,
which can be launched using the menu item Project > Options for Target, the tool bar item
Options for Target or the keyboard shortcut Alt+F7.
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kA Options for Target 'Target 1' pd

Device | Target | Output | Listing | User | C/C++ (ACB) | Asm | Linker Debug ILlliI'rtiesl

" Use Simulator  with restrictions Settings + Use: |J-LINK / J-TRACE Cortex Ll Settings
[~ Limit Speed to Real-Time
¥ Load Application at Startup [¥ Run to main() ¥ Load Application at Startup ™ Run to main()
Initialization File: Initialization File:
Restore Debug Session Settings Restore Debug Session Settings

[v Breakpoints ¥ Toolbox [v Breakpoints v Toolbox

[v Watch Windows & Performance Analyzer [V Watch Windows

¥ Memory Display ¥ System Viewer ¥ Memory Display [V System Viewer
CPU DLL: Parameter: Driver DLL: Parameter:
|SAF~!MCM3.DLL \ |5ARMCM3.DLL |
Dialog DLL: Parameter; Dialog DLL: Parameter:
|DCM DLL ‘-pCM-i |TCM,DLL |~;.CM4
[~ Wam if outdated Executable is loaded [T Wam if outdated Executable is loaded

Manage Component Viewer Description Files ... |

[ ok || cace || Defauts |

Figure 105: Options for Target

RA SC will set up the uVision project to debug the selected device using J-Link or J-Link OB debugger
by default.

A Debug session can be started or stopped by selecting the menu item Debug > Start/Stop Debug
Session or keyboard shortcut CTRL+F5. When debugging for the first time, J-Link firmware update
may be needed if requested by the tool.

Refer to the documentation from Keil to get more information on the debug features in uVision. Note
that not all features supported by uVision debugger are implemented in the J-Link interface. Consult
SEGGER J-Link documentation for more information.

2.5.2.5 Notes and Restrictions

1. When creating a new RA project, do not create a new project directly inside uVision. Follow
the steps as mentioned in Create new RA project

2. RA FSP contains a full set of drivers and middleware and may not be compatible with other
CMSIS packs from Keil, Arm or third parties.

3. Flash programming is currently only supported through the debugger connection.

2.5.3 Using RA Smart Configurator with IAR EWARM

IAR Systems Embedded Workbench for Arm (EWARM) includes support for Renesas RA devices.
These can be set up as bare metal designs within EWARM. However, most RA developers will want to
integrate RA FSP drivers and middleware into their designs. RA SC will facilitate this.

RA SC generates a "Project Connection" file that can be loaded directly into EWARM to update
project files.

2.5.3.1 Prerequisites
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¢ |AR EWARM installed and licensed. Pleae refer to the Release notes for the version to be
installed.
e RA SC and FSP Installed

2.5.3.2 Create new RA project
The following steps are required to create an RA project using IAR EWARM, RA SC and FSP:

1. To Use RA SC with EWARM, RA SC needs to configured as a tool in EWARM by selecting the
menu item Tools > Configure Tools.... Select New to create a new tool in the dialog
shown and add the following information:

o Menu Text: RA Smart Configurator

Command: Select Browse... and navigate to rasc.exe in the installed RA SC
o Argument: -compiler IAR configuration.xml

Initial Directory: $PROJ_DIR$

Tool Available: Always

o

o

o

Configure Tools

Menu Content:

Cancel

Hew

Delete

Menu Text:

|F!A Smart Configuratar |

Command:

[ i | | Erowisa

Argument;

|--cumpllsr 18R configuration. sml |

Initial Directary:
[sPRO._DIRS |

I Redirect to Output /indow
] Prompt for Command Line

Tool Ayvailable:

Always ~

Figure 106: Tool setup

2. A new EWARM project can be created using the menu item Project > Create New
Project... and selecting the Empty Project and toolchain as Arm. Save the project to an
empty folder.

3. RA SC can now be launched from EWARM using the menu item Tools > RA Smart
Configurator.
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User’s Manual

Tools I Window Help

o

Options...

Filename Extensions...

Configure Viewers...

Configure Custom Argument Variables...

Configure Tools...

IAR Project Converter

RA Smart Configurator

Figure 107: RA SC Menu Item

RA SC will be launched with project generator wizard. The configuration window opens
once the project wizard is closed. Refer to Configuring a Project for more details on how to
configure the project. After configuring the project, click Generate Project Content.

Changes to the RA configuration will be reflected in the EWARM project.

4. A Project connection needs to be set up in EWARM to build the project. Select Project >
Add Project Connection in EWARM and select IAR Project Connection. Navigate to the
project folder and select buildinfo.ipcf and click open. The project can now build in EWARM.
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Chapter 3 FSP Architecture

3.1 FSP Architecture Overview

This guide describes the Renesas Flexible Software Package (FSP) architecture and how to use the
FSP Application Programming Interface (API).

3.1.1 C99 Use

The FSP uses the ISO/IEC 9899:1999 (C99) C programming language standard. Specific features
introduced in C99 that are used include standard integer types (stdint.h), booleans (stdbool.h),
designated initializers, and the ability to intermingle declarations and code.

3.1.2 Doxygen

Doxygen is the default documentation tool used by FSP. You can find Doxygen comments throughout

the FSP source.

3.1.3 Weak Symbols

Weak symbols are used occasionally in the FSP. They are used to ensure that a project builds even
when the user has not defined an optional function.

3.1.4 Memory Allocation

Dynamic memory allocation through use of the malloc() and free() functions are not used in FSP
modules; all memory required by FSP modules is allocated in the application and passed to the
module in a pointer. Exceptions are considered only for ports of 3rd party code that require dynamic

memory.

3.1.5 FSP Terms

Term

Description

Reference

BSP

Short for Board Support
Package. In the FSP the BSP
provides just enough
foundation to allow other FSP
modules to work together
without issue.

MCU Board Support Package

R11UMO0146EU0120 Revision 1.20
Jun.26.20

RLENESAS

Page 85/ 1,560



Flexible Software Package

FSP Architecture > FSP Architecture Overview > FSP Terms

User’s Manual

Module

Modules can be peripheral
drivers, purely software, or
anything in between. Each
module consists of a folder with
source code, documentation,
and anything else that the
customer needs to use the code
effectively. Modules are
independent units, but they
may depend on other modules.
Applications can be built by
combining multiple modules to
provide the user with the
features they need.

FSP Modules

Driver

A driver is a specific kind of
module that directly modifies
registers on the MCU.

Interface

An interface contains API
definitions that can be shared
by modules with similar
features. Interfaces are
definitions only and do not add
to code size.

FSP Interfaces

Stacks

The FSP architecture is
designed such that modules
work together to form a stack.
A stack consists of a top level
module and all its
dependencies.

FSP Stacks

Module Instance

Single and independent
instantiation of a module. An
application may require two
GPT timers. Each of these
timers is a module instance of
the r_gpt module.

Application

Code that is owned and
maintained by the user.
Application code may be based
on sample application code
provided by Renesas, but it is
the responsibility of the user to
maintain as necessary.
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Callback Function

This term refers to a function
that is called when an event
occurs. As an example, suppose
the user would like to be
notified every second based on
the RTC. As part of the RTC
configuration, a callback
function can be supplied that
will be jumped to during each
RTC interrupt. When a single
callback services multiple
events, the arguments contain
the triggering event. Callback
functions for interrupts should
be kept short and handled
carefully because when they
are called the MCU is still inside
of an interrupt, delaying any
pending interrupts.

3.2 FSP Modules

Modules are the core building block of FSP. Modules can do many different things, but all modules
share the basic concept of providing functionality upwards and requiring functionality from below.

Provides

Requires

Figure 108: Modules

The amount of functionality provided by a module is determined based on functional use cases.
Common functionality required by multiple modules is often placed into a self-contained submodule
so it can be reused. Code size, speed and complexity are also considered when defining a module.

The simplest FSP application consists of one module with the Board Support Package (BSP) and the

user application on top.
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Application

FSP Module

Figure 109: Module with application

The Board Support Package (BSP) is the foundation for FSP modules, providing functionality to
determine the MCU used as well as configuring clocks, interrupts and pins. For the sake of clarity,
the BSP will be omitted from further diagrams.

3.3 FSP Stacks

When modules are layered atop one another, an FSP stack is formed. The stacking process is
performed by matching what one module provides with what another module requires. For example,
the SPI module (Serial Peripheral Interface (r_spi)) requires a module that provides the transfer
interface (Transfer Interface) to send or receive data without a CPU interrupt. The transfer interface
requirement can be fulfilled by the DTC driver module (Data Transfer Controller (r_dtc)).

Through this methodology the same code can be shared by several modules simultaneously. The
example below illustrates how the same DTC module can be used with SPI (Serial Peripheral
Interface (r_spi)), UART (Serial Communications Interface (SCI) UART (r_sci_uart)) and SDHI (SD/MMC
Host Interface (r_sdhi)).

Application

Provides: SPI Provides: UART Provides: SD/MMC

UART Driver SD Card Driver

Requires: Transfer Requires: Transfer

Requires: Transfer
J

Provides:|Transfer

Figure 110: Stacks -- Shared DTC Module

The ability to stack modules ensures the flexibility of the architecture as a whole. If multiple
modules include the same functionality issues arise when application features must work across
different user designs. To ensure that modules are reusable, any dependent modules must be
capable of being swapped out for other modules that provide the same features. The FSP
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architecture provides this flexibility to swap modules in and out through the use of FSP interfaces.

3.4 FSP Interfaces

At the architecture level, interfaces are the way that modules provide common features. This
commonality allows modules that adhere to the same interface to be used interchangeably.
Interfaces can be thought of as a contract between two modules - the modules agree to work
together using the information that was established in the contract.

On RA hardware there is occasionally an overlap of features between different peripherals. For
example, 12C communications can be achieved through use of the IIC peripheral or the SCI
peripheral. However, there is a difference in the level of features provided by both peripherals; in 12C
mode the SCI peripheral will only support a subset of the capabilities of the fully-featured IIC.

Interfaces aim to provide support for the common features that most users would expect. This
means that some of the advanced features of a peripheral (such as 1IC) might not be available in the
interface. In most cases these features are still available through interface extensions.

In FSP design, interfaces are defined in header files. All interface header files are located in the folder
ra/fsp/inc/api and end with *_api.h. Interface extensions are defined in header files in the folder
ra/fsp/inc/instances. The following sections detail what makes up an interface.

3.4.1 FSP Interface Enumerations

Whenever possible, interfaces use typed enumerations for function parameters and structure
members.

typedef enum e_i 2c_nmst er _addr _node

{
| 2C_ MASTER ADDR MODE 7BIT = 1, /1/< Use 7-bit addressing node

| 2C_MASTER ADDR MODE 10BI T = 2, /1/< Use 10-bit addressi ng node

} i2c_naster_addr_node t;

Enumerations remove uncertainty when deciding what values are available for a parameter. FSP
enumeration options follow a strict naming convention where the name of the type is prefixed on the
available options. Combining the naming convention with the autocomplete feature available in e2
studio (Ctrl + Space) provides the benefits of rapid coding while maintaining high readability.

3.4.2 FSP Interface Callback Functions

Callback functions allow modules to asynchronously alert the user application when an event has
occurred, such as when a byte has been received over a UART channel or an IRQ pin is toggled. FSP
driver modules define and handle the interrupt service routines for RA MCU peripherals to ensure
any required hardware procedures are implemented. The interrupt service routines in FSP modules
then call the user-defined callbacks to allow the application to respond.

Callback functions must be defined in the user application. They always return void and take a
structure for their one parameter. The structure is defined in the interface for the module and is
named <interface>_callback_args_t. The contents of the structure may vary depending on the
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interface, but two members are common: event and p_context.

The event member is an enumeration defined in the interface used by the application to determine
why the callback was called. Using the UART example, the callback could be triggered for many
different reasons, including when a byte is received, all bytes have been transmitted, or a framing
error has occurred. The event member allows the application to determine which of these three
events has occurred and handle it appropriately.

The p_context member is used for providing user-specified data to the callback function. In many
cases a callback function is shared between multiple channels or module instances; when the
callback occurs, the code handling the callback needs context information so that it can determine
which module instance the callback is for. For example, if the callback wanted to make an FSP API
call in the callback, then at a minimum the callback will need a reference to the relevant control
structure. To make this easy, the user can provide a pointer to the control structure as the
p_context. When the callback occurs, the control structure is passed in the p_context element of the
callback structure.

Callback functions are called from within an interrupt service routine. For this reason callback
functions should be kept as short as possible so they do not affect the real time performance of the
user's system. An example skeleton function for the flash interface callback is shown below.

void flash _cal |l back (flash _callback _args_t * p_args)

{

/* See what event caused this call back. */

switch (p_args->event)

{
case FLASH EVENT ERASE COVPLETE:
{
/* Handl e event. */
br eak;
}
case FLASH EVENT WRI TE COVPLETE:
{
/* Handl e event. */
br eak;
}
case FLASH EVENT BLANK:
{
/* Handl e event. */
br eak;
}

case FLASH EVENT_NOT_BLANK:
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When a module is not directly used in the user application (that is, it is not the top layer of the
stack), its callback function will be handled by the module above. For example, if a module requires
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a UART interface module the upper layer module will control and use the UART's callback function. In
this case the user would not need to create a callback function for the UART module in their
application code.

3.4.3 FSP Interface Data Structures

At a minimum, all FSP interfaces include three data structures: a configuration structure, an API
structure, and an instance structure.

3.4.3.1 FSP Interface Configuration Structure

The configuration structure is used for the initial configuration of a module during the
<MODULE>_Open() call. The structure consists of members such as channel number, bitrate, and
operating mode.

The configuration structure is used purely as an input into the module. It may be stored and
referenced by the module, so the configuration structure and anything it references must persist as
long as the module is open.

The configuration structure is allocated for each module instance in files generated by the RA
Configuration editor.

When FSP stacks are used, it is also important to understand that configuration structures only have
members that apply to the current interface. If multiple layers in the same stack define the same
configuration parameters then it becomes difficult to know where to modify the option. For example,
the baud rate for a UART is only defined in the UART module instance. Any modules that use the
UART interface rely on the baud rate being provided in the UART module instance and do not offer it
in their own configuration structures.

3.4.3.2 FSP Interface API Structure

All interfaces include an API structure which contains function pointers for all the supported interface
functions. An example structure for the Digital to Analog Converter (r_dac) is shown below.
typedef struct st _dac_api
{

/[** Initial configuration.

* @ar |nplenmented as

* - @ef R DAC Open()

* - @ef R_DACB_Open()

.

* @aranfin] p_ctrl Pointer to control block. Mist be declared by user. Elenents
set here.

* @araniin] p_cfg Pointer to configuration structure. Al elenents of this
structure nust be set by user.

*/

fsp err t (* open)(dac _ctrl _t * const p ctrl, dac _cfg t const * const p_cfqQ);
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tinmer.
*/
fsp_err_t (* stop)(dac_ctrl _t * const p_ctrl);
[** Cet version and store it in provided pointer p_version.
* @ar |nplenented as
* - @ef R _DAC VersionGet()
* - @ef R DACB VersionCet()
B
* @aranfout] p_version Code and APl version used.
*/
fsp err_t (* versionGet)(fsp version_t * p _version);

} dac_api _t;

The API structure is what allows for modules to easily be swapped in and out for other modules that
are instances of the same interface. Let's look at an example application using the DAC interface
above.

RA MCUs have an internal DAC peripheral. If the DAC API structure in the DAC interface is not used

the application can make calls directly into the module. In the example below the application is
making calls to the R_DAC_Write() function which is provided in the r_dac module.

Application

r_dac
R_DAC_Write()

Figure 111: DAC Write example

Now let's assume that the user needs more DAC channels than are available on the MCU and
decides to add an external DAC module named dac_external using I12C for communications. The
application must now distinguish between the two modules, adding complexity and further
dependencies to the application.
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Application

Is External?

r_dac
R_DAC_Write()

dac_external

DAC_EXTERNAL Write()

Figure 112: DAC Write with two write modules

The use of interfaces and the API structure allows for the use of an abstracted DAC. This means that
no extra logic is needed if the user's dac_external module implements the FSP DAC interface, so the
application no longer depends upon hard-coded module function names. Instead the application now
depends on the DAC interface APl which can be implemented by any number of modules.

Application

DAC Interface

'
................. T —
"

Internal DAC External DAC 1

External DAC 2

Figure 113: DAC Interface

3.4.3.3 FSP Interface Instance Structure

Every FSP interface also has an instance structure. The instance structure encapsulates everything
required to use the module:

e A pointer to the instance API structure (FSP Instance API)
¢ A pointer to the configuration structure
¢ A pointer to the control structure

The instance structure is not required at the application layer. It is used to connect modules to their
dependencies (other than the BSP).

Instance structures have a standardized name of <interface>_instance_t. An example from the
Transfer Interface is shown below.
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typedef struct st _transfer_instance

{
transfer _ctrl t * p_ctrl; ///< Pointer to the control structure for this
i nstance
transfer _cfg t const * p _cfg; /1/< Pointer to the configuration structure
for this instance
transfer_api _t const * p_api; /1/< Pointer to the APl structure for this
i nstance

} transfer_instance_ t;

Note that when an instance structure variable is declared, the API is the only thing that is instance
specific, not module instance specific. This is because all module instances of the same module
share the same underlying module source code. If SPI is being used on SCI channels 0 and 2 then
both module instances use the same API while the configuration and control structures are typically
different.

3.5 FSP Instances

While interfaces dictate the features that are provided, instances actually implement those features.
Each instance is tied to a specific interface. Instances use the enumerations, data structures, and API
prototypes from the interface. This allows an application that uses an interface to swap out the
instance when needed.

On RA MCUs some peripherals are used to implement multiple interfaces. In the example below the
IIC and SPI peripherals map to only one interface each while the SCI peripheral implements three
interfaces.

Interface: 12C Interface: UART Interface: SPI
r_i2c_api.h r_uart_api.h r_spi_api.h

Peripheral: lIC Peripheral: SCI Peripheral: 5CI Peripheral: 5CI Peripheral: SPI
Module: r_riic Module: r_sci_i2c Module: r_sci_uart Module: r_sci_spi Module: r_rspi

Figure 114: Instances

In FSP design, instances consist of the interface extension and API defined in the instance header
file located in the folder ra/fsp/inc/instances and the module source ra/fsp/src/<module>.

3.5.1 FSP Instance Control Structure

The control structure is used as a unique identifier for the module instance and contains memory
required by the module. Elements in the control structure are owned by the module and must not be
modified by the application. The user allocates storage for a control structure, often as a global
variable, then sends a pointer to it into the <MODULE>_Open() call for a module. At this point, the
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module initializes the structure as needed. The user must then send in a pointer to the control
structure for all subsequent module calls.

3.5.2 FSP Interface Extensions

In some cases, instances require more information than is provided in the interface. This situation
can occur in the following cases:

* An instance offers extra features that are not common to most instances of the interface.
An example of this is the start source selection of the GPT (General PWM Timer (r_gpt)). The
GPT can be configured to start based on hardware events such as a falling edge on a trigger
pin. This feature is not common to all timers, so it is included in the GPT instance.

e An interface must be very generic out of necessity. As an interface becomes more generic,
the number of possible instances increases. An example of an interface that must be
generic is a block media interface that abstracts functions required by a file system.
Possible instances include SD card, SPI Flash, SDRAM, USB, and many more.

The p_extend member provides this extension function.

Use of interface extensions is not always necessary. Some instances do not offer an extension since
all functionality is provided in the interface. In these cases the p_extend member can be set to NULL.
The documentation for each instance indicates whether an interface extension is available and
whether it is mandatory or optional.

3.5.2.1 FSP Extended Configuration Structure

When extended configuration is required it can be supplied through the p_extend parameter of the
interface configuration structure.

The extended configuration structure is part of the instance, but it is also still considered to be part
of the configuration structure. All usage notes about the configuration structure described in FSP
Interface Configuration Structure apply to the extended configuration structure as well.

The extended configuration structure and all typed structures and enumerations required to define it
make up the interface extension.

3.5.3 FSP Instance API

Each instance includes a constant global variable tying the interface API functions to the functions
provided by the module. The name of this structure is standardized as
g_<interface>_on_<instance>. Examples include g_spi_on_spi, g_transfer _on_dtc, and
g_adc_on_adc. This structure is available to be used through an extern in the instance header file
(r_spi.h, r_dtc.h, and r_adc.h respectively).

3.6 FSP API Standards

3.6.1 FSP Function Names

FSP functions start with the uppercase module name (<MODULE>). All modules have
<MODULE>_Open() and <MODULE>_Close() functions. The <MODULE>_Open() function must be
called before any of the other functions. The only exception is the <MODULE>_VersionGet() function
which is not dependent upon any user provided information.

Other functions that will commonly be found are <MODULE>_Read(), <MODULE>_Write(),
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<MODULE>_InfoGet(), and <MODULE>_StatusGet(). The <MODULE>_StatusGet() function provides
a status that could change asynchronously, while <MODULE>_InfoGet() provides information that
cannot change after open or can only be updated by API calls. Example function names include:

R_SPI_Read(), R_SPI_Write(), R_SPI_WriteRead()

e R _SDHI_StatusGet()

R_RTC_CalendarAlarmSet(), R_RTC_CalendarAlarmGet()

R_FLASH HP_AccessWindowSet(), R_FLASH HP_AccessWindowClear()

3.6.2 Use of const in APl parameters

The const qualifier is used with APl parameters whenever possible. An example case is shown below.

fsp err t R FLASH HP Open(flash ctrl _t * const p_api_ctrl, flash cfg t const * const

p_cfg);

In this example, flash_cfg_t is a structure of configuration parameters for the r_flash_hp module. The
parameter p_cfg is a pointer to this structure. The first const qualifier on p_cfg ensures the
flash_cfg_t structure cannot be modified by R_FLASH_HP_Open(). This allows the structure to be
allocated as a const variable and stored in ROM instead of RAM.

The const qualifier after the pointer star for both p_ctrl and p_cfg ensures the FSP function does not
modify the input pointer addresses. While not fool-proof by any means this does provide some extra
checking inside the FSP code to ensure that arguments that should not be altered are treated as
such.

3.6.3 FSP Version Information
All instances supply a <MODULE>_VersionGet() function which fills in a structure of type

fsp_version_t. This structure is made up of two version numbers: one for the interface (the API) and
one for the underlying instance that is currently being used.

typedef union st_fsp_version

{

/** Version id */

uint32 t version_id;

/** Code version paraneters */

struct

{
uint8 t code_version_mn nor; /1/< Code m nor version
uint8 t code_version_mgjor; /1l < Code maj or version
uint8 t api_version_m nor; /1/< APl m nor version
uint8 t api_version_ngjor; /1/< APl major version

[
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} fsp_version_t;

The API version ideally never changes, and only rarely if it does. A change to the APl may require
users to go back and modify their code. The code version (the version of the current instance) may
be updated more frequently due to bug fixes, enhancements, and additional features. Changes to
the code version typically do not require changes to user code.

3.7 FSP Build Time Configurations

All modules have a build-time configuration header file. Most configuration options are supplied at
run time, though options that are rarely used or apply to all instances of a module may be moved to
build time. The advantage of using a build-time configuration option is to potentially reduce code
size reduction by removing an unused feature.

All modules have a build time option to enable or disable parameter checking for the module. FSP
modules check function arguments for validity when possible, though this feature is disabled by
default to reduce code size. Enabling it can help catch parameter errors during development and
debugging. By default, each module's parameter checking configuration inherits the BSP parameter
checking setting (set on the BSP tab of the RA Configuration editor). Leaving each module's
parameter checking configuration set to Default (BSP) allows parameter checking to be enabled or
disabled globally in all FSP code through the parameter checking setting on the BSP tab.

If an error condition can reasonably be avoided it is only checked in a section of code that can be
disabled by disabling parameter checking. Most FSP APIs can only return FSP_SUCCESS if parameter
checking is disabled. An example of an error that cannot be reasonably avoided is the "bus busy"
error that occurs when another master is using an 12C bus. This type of error can be returned even if
parameter checking is disabled.

3.8 FSP File Structure

The high-level file structure of an FSP project is shown below.

ra_gen
ra
+--fsp
+---inc
| +- - -api
| \---instances
\---src
+---bsp
\---r_nodul e
ra_cfg
+---fsp_cfg
+---bsp
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+---driver

Directly underneath the base ra folder the folders are split into the source and include folders.
Include folders are kept separate from the source for easy browsing and easy setup of include paths.

The ra_gen folder contains code generated by the RA Configuration editor. This includes global
variables for the control structure and configuration structure for each module.

The ra_cfg folder is where configuration header files are stored for each module. See FSP Build Time
Configurations for information on what is provided in these header files.

3.9 FSP Architecture in Practice

3.9.1 FSP Connecting Layers

FSP modules are meant to be both reusable and stackable. It is important to remember that modules
are not dependent upon other modules, but upon other interfaces. The user is then free to fulfill the
interface using the instance that best fits their needs.

Interface: X
FSP Module 1
Dependency: /

Interface:
FSP Module 2

Dependency:

Interface: /
FSP Module 3
Dependency: None

Figure 115: Connecting layers

In the image above interface Y is a dependency of interface X and has its own dependency on
interface Z. Interface X only has a dependency on interface Y. Interface X has no knowledge of
interface Z. This is a requirement for ensuring that layers can easily be swapped out.

3.9.2 Using FSP Modules in an Application

The typical use of an FSP module involves generating required module data then using the APl in the
application.

3.9.2.1 Create a Module Instance in the RA Configuration Editor

The RA Configuration editor (available both in the Renesas e2 studio IDE as well as through the
standalone RA Smart Configurator) provides a graphical user interface for setting the parameters of
the interface and instance configuration structures. It also automatically includes those structures
(once they are configured in the GUI) in application-specific header files that can be included in
application code.
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The RA Configuration editor allocates storage for the control structures, all required configuration
structures, and the instance structure in generated files in the ra_gen folder. Use the Properties
window to set the values for the members of the configuration structures as needed. Refer to the
Configuration section of the module usage notes for documentation about the configuration options.

If the interface has a callback function option then the application must declare and define the
function. The return value is always of type void and the parameter to the function is a typed
structure of name <interface>_callback_args_t. Once the function has been defined, assign its name
to the p_callback member of the configuration structure. Callback function names can be assigned
through the Properties window for the selected module.

3.9.2.2 Use the Instance API in the Application

Call the module's <MODULE>_Open() function. Pass pointers to the generated control structure and
configuration structure. The names of these structures are based on the 'Name' field provided in the
configuration editor. The control structure is <Name>_ctrl and the configuration structure is
<Name>_cfg. An example <MODULE>_Open() call for an r_rtc module instance named g_clock is:

R RTC Open(&g_clock ctrl, &g clock cfq);

Note
Each layer in the FSP Sack isresponsible for calling the API functions of its dependencies. This means that users
areonly responsible for calling the API functions at the layer at which they are interfacing. Using the example
above of a SPI module with a DTC dependency, the application uses only SPI APIs. The application starts by
calling R_SPI_Open(). Internally, the SPI module opensthe DTC. It locates R_DTC_Open() by accessing the
dependent transfer interface function pointers from the pointers DTC instances (spi_cfg_t::p_transfer_tx and
spi_cfg t::p_transfer_rx) to open the DTC.

Refer to the module usage notes for example code to help get started with any particular module.
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Chapter 4 APl Reference

This section includes the FSP APl Reference for the Module and Interface level functions.

»BSP Common code shared by FSP drivers

»Modules Modules are the smallest unit of software
available in the FSP. Each module implements
one interface

»Interfaces The FSP interfaces provide APIs for common
functionality. They can be implemented by one
or more modules. Modules can use other
modules as dependencies using this interface
layer

4.1 BSP

Detailed Description
Common code shared by FSP drivers.

Modules

Common Error Codes

MCU Board Support Package

The BSP is responsible for getting the MCU from reset to the user's
application. Before reaching the user's application, the BSP sets up
the stacks, heap, clocks, interrupts, C runtime environment, and
stack monitor.

BSP 1/O access

This module provides basic read/write access to port pins.

Data Structures

union fsp_pack_version_t
struct fsp_pack version_t. _unnamed__

Macros
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#define FSP_VERSION_MAJOR
#define FSP_VERSION_MINOR
#define FSP_VERSION_PATCH
#define  FSP_VERSION_BUILD
#define FSP_VERSION_STRING

#define FSP_VERSION_BUILD_STRING

Data Structure Documentation

¢ fsp_pack_version_t

union fsp_pack_version_t

FSP Pack version structure

Data Fields
uint32 t version_id Version id
struct fsp_pack_version_t __unnamed__ Code version parameters, little
endian order.

¢ fsp_pack_version_t. _unnamed__

struct fsp_pack version_t. _unnamed__

Code version parameters, little endian order.

Data Fields
uint8_t build Build version of FSP Pack.
uint8 t patch Patch version of FSP Pack.
uint8 t minor Minor version of FSP Pack.
uint8 t major Major version of FSP Pack.
Macro Definition Documentation
¢ FSP_VERSION_MAJOR
#define FSP_VERSION_MAJOR
FSP pack major version.
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¢ FSP_VERSION_MINOR
#define FSP_VERSION_MINOR

FSP pack minor version.

¢ FSP_VERSION_PATCH
#define FSP_VERSION_PATCH

FSP pack patch version.

¢ FSP_VERSION_BUILD
#define FSP_VERSION_ BUILD

FSP pack version build number (currently unused).

¢ FSP_VERSION_STRING
#define FSP_VERSION_STRING

Public FSP version name.

¢ FSP_VERSION_BUILD STRING
#define FSP_VERSION_BUILD_STRING

Unique FSP version ID.

4.1.1 Common Error Codes
BSP

Detailed Description

All FSP modules share these common error codes.

Data Structures

union fsp_ version t

struct fsp version t. unnamed
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Macros

#define FSP_PARAMETER_NOT_USED(p)

#define FSP_CPP_HEADER
#define FSP_HEADER

Enumerations

enum fsp_err_t

Data Structure Documentation

¢ fsp_version_t

union fsp_version_t
Common version structure

Data Fields
uint32_t version_id Version id
struct fsp_version_t __unnamed__ Code version parameters
¢ fsp_version_t. _unnamed__
struct fsp_version_t. _unnamed__
Code version parameters

Data Fields
uint8 t code_version_minor Code minor version.
uint8_t code_version_major Code major version.
uint8_t api_version_minor APl minor version.
uint8 t api_version_major APl major version.

Macro Definition Documentation

& FSP_PARAMETER_NOT_USED

#define FSP_PARAMETER_NOT _USED ( p)

This macro is used to suppress compiler messages about a parameter not being used in a function.
The nice thing about using this implementation is that it does not take any extra RAM or ROM.
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¢ FSP_CPP_HEADER

#define FSP_CPP_HEADER

Determine if a C++ compiler is being used. If so, ensure that standard C is used to process the API

information.

¢ FSP_HEADER

#define FSP_HEADER

FSP Header and Footer definitions

Enumeration Type Documentation

¢ fsp_err_t

enum fsp_err_t

Common error codes

Enumerator

FSP_ERR_ASSERTION

A critical assertion has failed.

FSP_ERR_INVALID_POINTER

Pointer points to invalid memory location.

FSP_ERR_INVALID_ARGUMENT

Invalid input parameter.

FSP_ERR_INVALID_CHANNEL

Selected channel does not exist.

FSP_ERR_INVALID_MODE

Unsupported or incorrect mode.

FSP_ERR_UNSUPPORTED

Selected mode not supported by this API.

FSP_ERR_NOT OPEN

Requested channel is not configured or API not
open.

FSP_ERR_IN_USE

Channel/peripheral is running/busy.

FSP_ERR_OUT_OF_MEMORY

Allocate more memory in the driver's cfg.h.

FSP_ERR_HW_LOCKED

Hardware is locked.

FSP_ERR_IRQ_BSP_DISABLED

IRQ not enabled in BSP.

FSP_ERR_OVERFLOW

Hardware overflow.

FSP_ERR_UNDERFLOW
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Hardware underflow.

FSP_ERR_ALREADY OPEN

Requested channel is already open in a
different configuration.

FSP_ERR_APPROXIMATION

Could not set value to exact result.

FSP_ERR_CLAMPED

Value had to be limited for some reason.

FSP_ERR_INVALID_RATE

Selected rate could not be met.

FSP_ERR_ABORTED An operation was aborted.

FSP_ERR_NOT_ENABLED Requested operation is not enabled.

FSP_ERR_TIMEOUT Timeout error.

FSP_ERR_INVALID_BLOCKS Invalid number of blocks supplied.

FSP_ERR_INVALID_ADDRESS Invalid address supplied.

FSP_ERR_INVALID_SIZE Invalid size/length supplied for operation.

FSP_ERR_WRITE_FAILED Write operation failed.

FSP_ERR_ERASE_FAILED Erase operation failed.

FSP_ERR_INVALID_CALL Invalid function call is made.

FSP_ERR_INVALID_HW_CONDITION Detected hardware is in invalid condition.

FSP_ERR_INVALID_FACTORY_FLASH Factory flash is not available on this MCU.

FSP_ERR_INVALID_STATE API or command not valid in the current state.

FSP_ERR_NOT_ERASED Erase verification failed.

FSP_ERR_SECTOR_RELEASE_FAILED Sector release failed.

FSP_ERR_NOT_INITIALIZED Required initialization not complete.

FSP_ERR_INTERNAL Internal error.

FSP_ERR_WAIT_ABORTED Wait aborted.

FSP_ERR_FRAMING Framing error occurs.

FSP_ERR_BREAK_DETECT Break signal detects.
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FSP_ERR_PARITY

Parity error occurs.

FSP_ERR_RXBUF_OVERFLOW

Receive queue overflow.

FSP_ERR_QUEUE_UNAVAILABLE

Can't open s/w queue.

FSP_ERR_INSUFFICIENT_SPACE

Not enough space in transmission circular
buffer.

FSP_ERR_INSUFFICIENT_DATA

Not enough data in receive circular buffer.

FSP_ERR_TRANSFER_ABORTED

The data transfer was aborted.

FSP_ERR_MODE_FAULT

Mode fault error.

FSP_ERR_READ OVERFLOW

Read overflow.

FSP_ERR_SPI_PARITY

Parity error.

FSP_ERR_OVERRUN

Overrun error.

FSP_ERR_CLOCK_INACTIVE

Inactive clock specified as system clock.

FSP_ERR_CLOCK_ACTIVE

Active clock source cannot be modified without
stopping first.

FSP_ERR_NOT _STABILIZED

Clock has not stabilized after its been turned
on/off.

FSP_ERR_PLL_SRC_INACTIVE

PLL initialization attempted when PLL source is
turned off.

FSP_ERR_OSC_STOP_DET_ENABLED

lllegal attempt to stop LOCO when Oscillation
stop is enabled.

FSP_ERR_OSC_STOP_DETECTED

The Oscillation stop detection status flag is
set.

FSP_ERR_OSC_STOP_CLOCK_ACTIVE

Attempt to clear Oscillation Stop Detect Status
with PLL/MAIN_OSC active.

FSP_ERR_CLKOUT_EXCEEDED

Output on target output clock pin exceeds
maximum supported limit.

FSP_ERR_USB_MODULE_ENABLED

USB clock configure request with USB Module
enabled.

FSP_ERR_HARDWARE_TIMEOUT

A register read or write timed out.
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FSP_ERR_LOW_VOLTAGE_MODE

Invalid clock setting attempted in low voltage
mode.

FSP_ERR_PE_FAILURE

Unable to enter Programming mode.

FSP_ERR_CMD_LOCKED

Peripheral in command locked state.

FSP_ERR_FCLK

FCLK must be >= 4 MHz.

FSP_ERR_INVALID_LINKED_ADDRESS

Function or data are linked at an invalid region
of memory.

FSP_ERR_BLANK_CHECK_FAILED

Blank check operation failed.

FSP_ERR_INVALID_CAC_REF_CLOCK

Measured clock rate < reference clock rate.

FSP_ERR_CLOCK_GENERATION

Clock cannot be specified as system clock.

FSP_ERR_INVALID_TIMING_SETTING

Invalid timing parameter.

FSP_ERR_INVALID_LAYER SETTING

Invalid layer parameter.

FSP_ERR_INVALID_ALIGNMENT

Invalid memory alignment found.

FSP_ERR_INVALID_GAMMA_SETTING

Invalid gamma correction parameter.

FSP_ERR_INVALID_LAYER_FORMAT

Invalid color format in layer.

FSP_ERR_INVALID_UPDATE_TIMING

Invalid timing for register update.

FSP_ERR_INVALID_CLUT ACCESS

Invalid access to CLUT entry.

FSP_ERR_INVALID_FADE_SETTING

Invalid fade-in/fade-out setting.

FSP_ERR_INVALID_BRIGHTNESS_SETTING

Invalid gamma correction parameter.

FSP_ERR JPEG_ERR

JPEG error.

FSP_ERR JPEG_SOI_NOT_DETECTED

SOl not detected until EOI detected.

FSP_ERR_JPEG_SOF1_TO SOFF_DETECTED

SOF1 to SOFF detected.

FSP_ERR_JPEG_UNSUPPORTED_PIXEL_FORMAT

Unprovided pixel format detected.

FSP_ERR_JPEG_SOF _ACCURACY_ERROR

SOF accuracy error: other than 8 detected.

FSP_ERR JPEG_DQT_ACCURACY_ERROR

DQT accuracy error: other than 0 detected.
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FSP_ERR_JPEG_COMPONENT_ERROR1

Component error 1: the number of SOFO0
header components detected is other than 1,
3, or4.

FSP_ERR_JPEG_COMPONENT_ERROR2

Component error 2: the number of components
differs between SOF0 header and SOS.

FSP_ERR JPEG_SOF0_DQT_DHT NOT DETECTED

SOFO0, DQT, and DHT not detected when SOS
detected.

FSP_ERR_JPEG_SOS NOT DETECTED

SOS not detected: SOS not detected until EOI
detected.

FSP_ERR JPEG_EOI_NOT DETECTED

EOI not detected (default)

FSP_ERR_JPEG_RESTART INTERVAL DATA_NUMB
ER_ERROR

Restart interval data number error detected.

FSP_ERR JPEG_IMAGE_SIZE_ERROR

Image size error detected.

FSP_ERR JPEG_LAST MCU_DATA NUMBER_ERRO
R

Last MCU data number error detected.

FSP_ERR _JPEG_BLOCK_DATA_NUMBER_ERROR

Block data number error detected.

FSP_ERR JPEG_BUFFERSIZE_NOT_ENOUGH

User provided buffer size not enough.

FSP_ERR JPEG_UNSUPPORTED_IMAGE_SIZE

JPEG Image size is not aligned with MCU.

FSP_ERR_CALIBRATE_FAILED

Calibration failed.

FSP_ERR_IP_HARDWARE_NOT PRESENT

Requested IP does not exist on this device.

FSP_ERR_IP_UNIT_NOT_PRESENT

Requested unit does not exist on this device.

FSP_ERR_IP_CHANNEL_NOT PRESENT

Requested channel does not exist on this
device.

FSP_ERR_NO_MORE_BUFFER

No more buffer found in the memory block
pool.

FSP_ERR_ILLEGAL_BUFFER_ADDRESS

Buffer address is out of block memory pool.

FSP_ERR_INVALID_WORKBUFFER_SIZE

Work buffer size is invalid.

FSP_ERR_INVALID_MSG_BUFFER_SIZE

Message buffer size is invalid.

FSP_ERR_TOO_MANY_BUFFERS

Number of buffer is too many.

FSP_ERR_NO_SUBSCRIBER_FOUND

No message subscriber found.
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FSP_ERR_MESSAGE_QUEUE_EMPTY No message found in the message queue.

FSP_ERR_MESSAGE_QUEUE_FULL No room for new message in the message
gueue.

FSP_ERR_ILLEGAL_SUBSCRIBER_LISTS Message subscriber lists is illegal.

FSP_ERR_BUFFER_RELEASED Buffer has been released.

FSP_ERR_D2D_ERROR_INIT D/AVE 2D has an error in the initialization.
FSP_ERR_D2D_ERROR_DEINIT D/AVE 2D has an error in the initialization.
FSP_ERR_D2D_ERROR_RENDERING D/AVE 2D has an error in the rendering.

FSP_ERR_D2D_ERROR_SIZE D/AVE 2D has an error in the rendering.

FSP_ERR_ETHER _ERROR_NO DATA No Data in Receive buffer.
FSP_ERR_ETHER_ERROR_LINK ETHERC/EDMAC has an error in the Auto-
negotiation.

FSP_ERR_ETHER_ERROR_MAGIC_PACKET_MODE As a Magic Packet is being detected, and

transmission/reception is not enabled.

FSP_ERR_ETHER ERROR_TRANSMIT BUFFER FUL

L Transmit buffer is not empty.

FSP_ERR_ETHER_ERROR_FILTERING Detect multicast frame when multicast frame
filtering enable.

FSP_ERR_ETHER_ERROR_PHY_COMMUNICATION ETHERC/EDMAC has an error in the phy
communication.

FSP_ERR_ETHER_PHY_ERROR_LINK PHY is not link up.
FSP_ERR_ETHER_PHY_NOT_READY PHY has an error in the Auto-negotiation.
FSP_ERR_QUEUE_FULL Queue is full, cannot queue another data.
FSP_ERR_QUEUE_EMPTY Queue is empty, no data to dequeue.
FSP_ERR_CTSU_SCANNING Scanning.
FSP_ERR_CTSU_NOT_GET_DATA Not processed previous scan data.
FSP_ERR_CTSU_INCOMPLETE_TUNING Incomplete initial offset tuning.
FSP_ERR_CARD_INIT_FAILED SD card or eMMC device failed to initialize.
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FSP_ERR_CARD_NOT_INSERTED

SD card not installed.

FSP_ERR_DEVICE_BUSY

Device is holding DATO low or another
operation is ongoing.

FSP_ERR_CARD_NOT _INITIALIZED

SD card was removed.

FSP_ERR_CARD_WRITE_PROTECTED

Media is write protected.

FSP_ERR_TRANSFER_BUSY

Transfer in progress.

FSP_ERR_RESPONSE

Card did not respond or responded with an
error.

FSP_ERR_MEDIA_FORMAT FAILED

Media format failed.

FSP_ERR_MEDIA_OPEN_FAILED

Media open failed.

FSP_ERR_CAN_DATA_UNAVAILABLE

No data available.

FSP_ERR_CAN_MODE_SWITCH_FAILED

Switching operation modes failed.

FSP_ERR_CAN_INIT_FAILED

Hardware initialization failed.

FSP_ERR_CAN_TRANSMIT_NOT_READY

Transmit in progress.

FSP_ERR_CAN_RECEIVE_MAILBOX

Mailbox is setup as a receive mailbox.

FSP_ERR_CAN_TRANSMIT_MAILBOX

Mailbox is setup as a transmit mailbox.

FSP_ERR_CAN_MESSAGE_LOST

Receive message has been overwritten or
overrun.

FSP_ERR_WIFI_CONFIG_FAILED

WiFi module Configuration failed.

FSP_ERR_WIFI_INIT_FAILED

WiFi module initialization failed.

FSP_ERR_WIFI_TRANSMIT_FAILED

Transmission failed.

FSP_ERR_WIFI_INVALID_MODE

API called when provisioned in client mode.

FSP_ERR_WIFI_FAILED

WiFi Failed.

FSP_ERR_CELLULAR_CONFIG_FAILED

Cellular module Configuration failed.

FSP_ERR_CELLULAR_INIT_FAILED

Cellular module initialization failed.

FSP_ERR_CELLULAR_TRANSMIT_FAILED

Transmission failed.
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FSP_ERR_CELLULAR_FW_UPTODATE

Firmware is uptodate.

FSP_ERR_CELLULAR_FW_UPGRADE_FAILED

Firmware upgrade failed.

FSP_ERR_CELLULAR_FAILED

Cellular Failed.

FSP_ERR_CELLULAR_INVALID_STATE

API Called in invalid state.

FSP_ERR_CELLULAR_REGISTRATION_FAILED

Cellular Network registration failed.

FSP_ERR BLE_FAILED

BLE operation failed.

FSP_ERR_BLE_INIT FAILED

BLE device initialization failed.

FSP_ERR_BLE_CONFIG_FAILED

BLE device configuration failed.

FSP_ERR_BLE_PRF_ALREADY_ENABLED

BLE device Profile already enabled.

FSP_ERR_BLE_PRF_NOT_ENABLED

BLE device not enabled.

FSP_ERR_BLE_ABS_INVALID_OPERATION

Invalid operation is executed.

FSP_ERR_BLE_ABS_NOT_FOUND

Valid data or free space is not found.

FSP_ERR_CRYPTO_CONTINUE

Continue executing function.

FSP_ERR_CRYPTO_SCE_RESOURCE_CONFLICT

Hardware resource busy.

FSP_ERR_CRYPTO_SCE_FAIL

Internal 1/O buffer is not empty.

FSP_ERR_CRYPTO_SCE_HRK_INVALID_INDEX

Invalid index.

FSP_ERR_CRYPTO_SCE_RETRY

Retry.

FSP_ERR_CRYPTO_SCE_VERIFY_FAIL

Verify is failed.

FSP_ERR_CRYPTO_SCE_ALREADY_ OPEN

HW SCE module is already opened.

FSP_ERR_CRYPTO_NOT_OPEN

Hardware module is not initialized.

FSP_ERR_CRYPTO_UNKNOWN

Some unknown error occurred.

FSP_ERR_CRYPTO_NULL_POINTER

Null pointer input as a parameter.

FSP_ERR_CRYPTO_NOT_IMPLEMENTED

Algorithm/size not implemented.

FSP_ERR_CRYPTO_RNG_INVALID_PARAM

An invalid parameter is specified.
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FSP_ERR_CRYPTO_RNG_FATAL_ERROR A fatal error occurred.

FSP_ERR_CRYPTO_INVALID_SIZE Size specified is invalid.

FSP_ERR_CRYPTO_INVALID_STATE Function used in an valid state.

FSP_ERR_CRYPTO_ALREADY_OPEN control block is already opened

FSP_ERR_CRYPTO_INSTALL_KEY_FAILED Specified input key is invalid.

FSP_ERR_CRYPTO_AUTHENTICATION_FAILED Authentication failed.

FSP_ERR_CRYPTO_COMMON_NOT_OPENED Crypto Framework Common is not opened.

FSP_ERR_CRYPTO_HAL_ERROR Cryoto HAL module returned an error.

FSP_ERR_CRYPTO_KEY_BUF_NOT_ENOUGH Key buffer size is not enough to generate a

key.

FSP_ERR_CRYPTO_BUF_OVERFLOW Attempt to write data larger than what the

buffer can hold.

FSP_ERR_CRYPTO_INVALID_OPERATION_MODE

Invalid operation mode.

FSP_ERR_MESSAGE_TOO_LONG

Message for RSA encryption is too long.

FSP_ERR_RSA DECRYPTION_ERROR

RSA Decryption error.

4.1.2 MCU Board Support Package
BSP

Functions

fsp_err t R_FSP VersionGet (fsp_pack version_t *const p_version)

void Reset Handler (void)

void Default Handler (void)

void Systemlnit (void)

void R BSP WarmStart (bsp_warm_start event t event)

fsp_err t R _BSP_VersionGet (fsp_version_t *p_version)
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void R _BSP SoftwareDelay (uint32_t delay, bsp_delay_units_t units)

fsp_err t R_BSP_GrouplrqWrite (bsp_grp_irq_tirq,
void(*p_callback)(bsp_grp_irq_t irq))

void NMI_Handler (void)
void R _BSP_RegisterProtectEnable (bsp_reg_protect t regs to_protect)

void R _BSP_RegisterProtectDisable (bsp reg protect t regs to unprotect)

Detailed Description

The BSP is responsible for getting the MCU from reset to the user's application. Before reaching the
user's application, the BSP sets up the stacks, heap, clocks, interrupts, C runtime environment, and
stack monitor.

BSP Features

BSP Clock Configuration
System Interrupts
Group Interrupts
External and Peripheral Interrupts
Error Logging

BSP Weak Symbols
Warm Start Callbacks
Register Protection

ID Codes

e Software Delay

e Board Specific Features
e Configuration

Overview

BSP Features
BSP Clock Configuration

All system clocks are set up during BSP initialization based on the settings in bsp_clock cfg.h. These
settings are derived from clock configuration information provided from the RA Configuration editor
Clocks tab.

» Clock configuration is performed prior to initializing the C runtime environment to speed up
the startup process, as it is possible to start up on a relatively slow (that is, 32 kHz) clock.

e The BSP implements the required delays to allow the selected clock to stabilize.

e The BSP will configure the CMSIS SystemCoreClock variable after clock initialization with the
current system clock frequency.

System Interrupts

As RA MCUs are based on the Cortex-M ARM architecture, the NVIC Nested Vectored Interrupt
Controller (NVIC) handles exceptions and interrupt configuration, prioritization and interrupt
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masking. In the ARM architecture, the NVIC handles exceptions. Some exceptions are known as
System Exceptions. System exceptions are statically located at the "top" of the vector table and
occupy vector numbers 1 to 15. Vector zero is reserved for the MSP Main Stack Pointer (MSP). The
remaining 15 system exceptions are shown below:

e Reset

e NMI

Cortex-M4 Hard Fault Handler
Cortex-M4 MPU Fault Handler
Cortex-M4 Bus Fault Handler
Cortex-M4 Usage Fault Handler
Reserved

Reserved

Reserved

Reserved

Cortex-M4 SVCall Handler
Cortex-M4 Debug Monitor Handler
Reserved

Cortex-M4 PendSV Handler
Cortex-M4 SysTick Handler

NMI and Hard Fault exceptions are enabled out of reset and have fixed priorities. Other exceptions
have configurable priorities and some can be disabled.

Group Interrupts

Group interrupt is the term used to describe the 12 sources that can trigger the Non-Maskable
Interrupt (NMI). When an NMI occurs the NMI Handler examines the NMISR (status register) to
determine the source of the interrupt. NMI interrupts take precedence over all interrupts, are usable
only as CPU interrupts, and cannot activate the RA peripherals Data Transfer Controller (DTC) or
Direct Memory Access Controller (DMAC).

Possible group interrupt sources include:

IWDT Underflow/Refresh Error
WDT Underflow/Refresh Error
Voltage-Monitoring 1 Interrupt
Voltage-Monitoring 2 Interrupt
VBATT monitor Interrupt
Oscillation Stop is detected
NMI pin

RAM Parity Error

RAM ECC Error

e MPU Bus Slave Error

e MPU Bus Master Error

e MPU Stack Error

A user may enable notification for one or more group interrupts by registering a callback using the
BSP API function R_BSP_GrouplrgWrite(). When an NMI interrupt occurs, the NMI handler checks to
see if there is a callback registered for the cause of the interrupt and if so calls the registered
callback function.

External and Peripheral Interrupts

User configurable interrupts begin with slot 16. These may be external, or peripheral generated
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interrupts.

Although the number of available slots for the NVIC interrupt vector table may seem small, the BSP
defines up to 512 events that are capable of generating an interrupt. By using Event Mapping, the
BSP maps user-enabled events to NVIC interrupts. For an RA6M3 MCU, only 96 of these events may
be active at any one time, but the user has flexibility by choosing which events generate the active
event.

By allowing the user to select only the events they are interested in as interrupt sources, we are able
to provide an interrupt service routine that is fast and event specific.

For example, on other microcontrollers a standard NVIC interrupt vector table might contain a single
vector entry for the SCIO (Serial Communications Interface) peripheral. The interrupt service routine
for this would have to check a status register for the 'real' source of the interrupt. In the RA
implementation there is a vector entry for each of the SCI0O events that we are interested in.

BSP Weak Symbols

You might wonder how the BSP is able to place ISR addresses in the NVIC table without the user
having explicitly defined one. All that is required by the BSP is that the interrupt event be given a
priority.

This is accomplished through the use of the 'weak' attribute. The weak attribute causes the
declaration to be emitted as a weak symbol rather than a global. A weak symbol is one that can be
overridden by an accompanying strong reference with the same name. When the BSP declares a
function as weak, user code can define the same function and it will be used in place of the BSP
function. By defining all possible interrupt sources as weak, the vector table can be built at compile
time and any user declarations (strong references) will be used at runtime.

Weak symbols are supported for ELF targets and also for a.out targets when using the GNU
assembler and linker.

Note that in CMSIS system.c, there is also a weak definition (and a function body) for the Warm Start
callback function R_BSP_WarmStart(). Because this function is defined in the same file as the weak
declaration, it will be called as the 'default' implementation. The function may be overridden by the
user by copying the body into their user application and modifying it as necessary. The linker
identifies this as the 'strong' reference and uses it.

Warm Start Callbacks

As the BSP is in the process of bringing up the board out of reset, there are three points where the
user can request a callback. These are defined as the 'Pre Clock Init', 'Post Clock Init' and 'Post C'
warm start callbacks.

As described above, this function is already weakly defined as R_BSP_WarmStart(), so it is a simple
matter of redefining the function or copying the existing body from CMSIS system.c into the
application code to get a callback. R_BSP_WarmStart() takes an event parameter of type
bsp_warm_start_event_t which describes the type of warm start callback being made.

This function is not enabled/disabled and is always called for both events as part of the BSP startup.
Therefore it needs a function body, which will not be called if the user is overriding it. The function
body is located in system.c. To use this function just copy this function into your own code and
modify it to meet your needs.

Heap Allocation

R11UMO146EU0120 Revision 1.20 RENESANAS Page 117 /1,560
Jun.26.20



Flexible Software Package User’s Manual

API| Reference > BSP > MCU Board Support Package

The relatively low amount of on-chip SRAM available and lack of memory protection in an MCU
means that heap use must be very carefully controlled to avoid memory leaks, overruns and
attempted overallocation. Further, many RTOSes provide their own dynamic memory allocation
system. For these reasons the default heap size is set at 0 bytes, effectively disabling dynamic
memory. If it is required for an application setting a positive value to the "Heap size (bytes)" option
in the RA Common configurations on the BSP tab will allocate a heap.

Note
When using printf/sprintf (and other variants) to output floating point numbers a heap is required. A minimum size
of 0x1000 (4096) bytes is recommended when starting development in this case.

Error Logging

When error logging is enabled, the error logging function can be redefined on the command line by
defining FSP_ERROR_LOG(err) to the desired function call. The default function implementation is
FSP_ERROR_LOG(err)=fsp_error_log(err, FILE, LINE). This implementation uses the predefined
macros FILE and LINE to help identify the location where the error occurred. Removing the line from
the function call can reduce code size when error logging is enabled. Some compilers may support
other predefined macros like FUNCTION, which could be helpful for customizing the error logger.

Register Protection

The BSP register protection functions utilize reference counters to ensure that an application which
has specified a certain register and subsequently calls another function doesn't have its register
protection settings inadvertently modified.

Each time R_BSP_RegisterProtectDisable() is called, the respective reference counter is incremented.

Each time R_BSP_RegisterProtectEnable() is called, the respective reference counter is decremented.

Both functions will only modify the protection state if their reference counter is zero.

/* Enable witing to protected CGC registers */

R BSP_Regi st er Pr ot ect Di sabl e( BSP_REG PROTECT CCC) ;
/* Insert code to nodify protected CGC registers. */
/* Disable witing to protected CCGC regi sters */

R BSP_Regi st er Pr ot ect Enabl e( BSP_REG PROTECT CCC) ;

ID Codes

The ID code is a 16-byte value that can be used to protect the MCU from being connected to a
debugger or from connecting in Serial Boot Mode. There are different settings that can be set for the
ID code; please refer to the hardware manual for your device for available options.

Software Delay

Implements a blocking software delay. A delay can be specified in microseconds, milliseconds or
seconds. The delay is implemented based on the system clock rate.

R11UMO146EU0120 Revision 1.20 RENESANAS Page 118 /1,560
Jun.26.20



Flexible Software Package User’s Manual

API| Reference > BSP > MCU Board Support Package

/* Delay at |least 1 second. Depending on the nunber of wait states required for the
regi on of nenory

* that the software_delay | oop has been linked in this could take | onger. The
default is 4 cycles per |oop.

* This can be nodified by redefining DELAY LOOP_CYCLES. BSP_DELAY UN TS SECONDS,
BSP_DELAY_UNI TS M LLI SECONDS,

* and BSP_DELAY UNI TS M CROSECONDS can all be used with R BSP_Sof t wareDel ay. */

R BSP_Sof t war eDel ay(1, BSP_DELAY UNI TS SECONDS) ;

Critical Section Macors

Implements a critical section. Some MCUs (MCUs with the BASEPRI register) support allowing high
priority interrupts to execute during critical sections. On these MCUs, interrupts with priority less
than or equal to BSP_CFG_IRQ_MASK LEVEL FOR_CRITICAL_SECTION are not serviced in critical
sections. Interrupts with higher priority than BSP_CFG_IRQ_MASK LEVEL_FOR_CRITICAL_SECTION still
execute in critical sections.
FSP_CRI Tl CAL_SECTI ON_DEFI NE;

/* Store the current interrupt posture. */

FSP_CRI TI CAL_SECTI ON_ENTER;

/* Interrupts cannot run in this section unless their priority is less than
BSP_CFG | RQ MASK LEVEL_FOR CRI TI CAL_SECTI ON. */

/* Restore saved interrupt posture. */

FSP_CRI TI CAL_SECTI ON_EXI T;

Board Specific Features

The BSP will call the board's initialization function (bsp_init) which can initialize board specific
features. Possible board features are listed below.

Board Feature Description
SDRAM Support The BSP will initialize SDRAM if the board
supports it
QSPI Support The BSP will initialize QSPI if the board supports

it and put it into ROM mode. Use the R_QSPI
module to write and erase the QSPI chip.

Configuration
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The BSP is heavily data driven with most features and functionality being configured based on the
content from configuration files. Configuration files represent the settings specified by the user and
are generated when the project is built and/or when the Generate Project Content button is clicked in
the RA Configuration editor.

Build Time Configurations for fsp_common

The following build time configurations are defined in fsp_cfg/bsp/bsp_cfg.h:

Configuration

Options

Default

Description

Main stack size (bytes)

Heap size (bytes)

MCU Vcc (mV)

Parameter checking

Value must be an
integer multiple of 8
and between 8 and
OXFFFFFFFF

Value must be 0 or an
integer multiple of 8
between 8 and
OxFFFFFFFF.

Value must between 0
and 5500 (5.5V)

e Enabled
e Disabled

0x400

3300

Disabled

Set the size of the main
program stack.

NOTE: This entry is for
the main stack. When
using an RTOS, thread
stacks can be
configured in the
properties for each
thread.

The main heap is
disabled by default. Set
the heap size to a
positive integer
divisible by 8 to enable
it.

A minimum of 4K
(0x1000) is
recommended if
standard library
functions are to be
used.

Some peripherals
require different
settings based on the
supplied voltage.
Entering Vcc here (in
mV) allows the relevant
driver modules to
configure the
associated peripherals
accordingly.

When enabled,
parameter checking for
the BSP is turned on. In
addition, any modules
whose parameter
checking configuration
is set to 'Default (BSP)'
will perform parameter
checking as well.
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Assert Failures

Error Log

ID Code Mode

ID Code (32 Hex
Characters)

Soft Reset

Main Oscillator
Populated

PFS Protect

Value must be a 32
character long hex

string

Return FSP_ERR Return
_ASSERTION FSP_ERR_ASSERTION
Call

fsp_error_log

then Return FSP
_ERR_ASSERTIO

N

Use assert() to

Halt Execution

Disable checks

that would

return FSP_ERR
_ASSERTION

No Error Log
Errors Logged
via
fsp_error_log

No Error Log

Unlocked
(Ignore ID)
Locked with All
Erase support
Locked

Unlocked (Ignore ID)

FFFFFFFFFFFFFFFFFFFF
FFFFFFFFFFFF

Disabled
Enabled

Disabled

Populated
Not Populated

Populated

Disabled
Enabled

Enabled

Define the behavior of
the FSP_ASSERTY()
macro.

Specify error logging
behavior.

When set to 'Locked
with All Erase support',
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.

Support for soft reset.
If disabled, registers
are assumed to be set
to their default value
during startup.

Select whether or not
there is a main
oscillator (XTAL) on the
board. This setting can
be overridden in

board _cfg.h.

Keep the PFS registers
locked when they are
not being modified. If
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Main Oscillator Wait
Time

Main Oscillator Clock
Source

Subclock Populated

Subclock Drive

Subclock Stabilization

Time (ms)

Modules

0.25 us 32768 us
128 us

256 us

512 us

1024 us

2048 us

4096 us

8192 us

16384 us

32768 us

External

Oscillator
e Crystal or
Resonator

Crystal or Resonator

e Populated
¢ Not Populated

Populated

e Low Standard
e Standard

Value must between 0 1000
and 10000

RA2A1

RA4AM1

RA4W1

RA6M1

disabled they will be
unlocked during
startup.

Number of cycles to
wait for the main
oscillator clock to
stabilize. This setting
can be overridden in
board_cfg.h

Select the main
oscillator clock source.
This setting can be
overridden in

board _cfg.h

Select whether or not
there is a subclock
crystal on the board.
This setting can be
overridden in
board_cfg.h.

Select the subclock
oscillator drive
capacitance. This
setting can be
overridden in
board _cfg.h

Select the subclock
oscillator stabilization
time. This is only used
in the startup code if
the subclock is
selected as the system
clock on the Clocks tab.
This setting can be
overridden in
board_cfg.h
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Macros

#define

#define

#define

#define

#define

#define

#define

#define

#define

#define

#define

Enumerations

enum

enum

enum

enum

enum

enum

Variables

uint32 t

const fsp_version_t

RA6M2

RA6M3

BSP_IRQ_DISABLED
FSP_RETURN(err)
FSP_ERROR_LOG(err)
FSP_ASSERT(a)
FSP_ERROR_RETURN(a, err)
FSP_CRITICAL SECTION_ENTER
FSP_CRITICAL_SECTION_EXIT
FSP_INVALID_VECTOR
BSP_STACK_ALIGNMENT

R _BSP_MODULE_START(ip, channel)

R_BSP_MODULE_STOP(ip, channel)

fsp_ip_t

fsp_signal t
bsp_warm_start_event_t
bsp_delay units_t
bsp_grp_irqg_t

bsp reg protect t

SystemCoreClock

g_bsp_version

Default initialization function. More...
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¢ BSP_IRQ_DISABLED

#define BSP_IRQ_DISABLED

Used to signify that an ELC event is not able to be used as an interrupt.

¢ FSP_RETURN

#define FSP_RETURN ( err)

Macro to log and return error without an assertion.

o FSP_ERROR_LOG

#define FSP_ERROR_LOG ( err)

This function is called before returning an error code. To stop on a runtime error, define
fsp_error_log in user code and do required debugging (breakpoints, stack dump, etc) in this
function.

o FSP_ASSERT

#define FSP_ASSERT ( a)

Default assertion calls FSP_ERROR_RETURN if condition "a" is false. Used to identify incorrect use of
API's in FSP functions.

¢ FSP_ERROR_RETURN

#define FSP_ERROR_RETURN ( a, err )

All FSP error codes are returned using this macro. Calls FSP_ERROR_LOG function if condition "a" is
false. Used to identify runtime errors in FSP functions.

¢ FSP_CRITICAL_SECTION_ENTER

#define FSP_CRITICAL_SECTION_ENTER

This macro temporarily saves the current interrupt state and disables interrupts.

& FSP_CRITICAL_SECTION_EXIT

#define FSP_CRITICAL_SECTION_EXIT

This macro restores the previously saved interrupt state, reenabling interrupts.
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& FSP_INVALID_VECTOR

#define FSP_INVALID_VECTOR

Used to signify that the requested IRQ vector is not defined in this system.

¢ BSP_STACK_ALIGNMENT

#define BSP_STACK_ALIGNMENT

Stacks (and heap) must be sized and aligned to an integer multiple of this number.

¢ R_BSP_MODULE_START

#define R_BSP_MODULE_START ( ip, channel )

Cancels the module stop state.

Parameters
ip fsp_ip_t enum value for the module to be
stopped
channel The channel. Use channel 0 for modules
without channels.

¢ R_BSP_MODULE_STOP

#define R_BSP_MODULE_STOP ( ip, channel )

Enables the module stop state.

Parameters
ip fsp_ip_t enum value for the module to be
stopped
channel The channel. Use channel 0 for modules
without channels.

Enumeration Type Documentation
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¢ fsp_ip_t

enum fsp_ip t

Available modules.

Enumerator

FSP_IP_CFLASH Code Flash.

FSP_IP_DFLASH Data Flash.

FSP_IP_RAM RAM.

FSP_IP_LVD Low Voltage Detection.

FSP_IP_CGC Clock Generation Circuit.

FSP_IP_LPM Low Power Modes.

FSP_IP_FCU Flash Control Unit.

FSP_IP_ICU Interrupt Control Unit.

FSP_IP_DMAC DMA Controller.

FSP_IP_DTC Data Transfer Controller.
FSP_IP_IOPORT I/O Ports.

FSP_IP_PFS Pin Function Select.

FSP_IP_ELC Event Link Controller.

FSP_IP_MPU Memory Protection Unit.
FSP_IP_MSTP Module Stop.

FSP_IP_MMF Memory Mirror Function.

FSP_IP_KEY Key Interrupt Function.

FSP_IP_CAC Clock Frequency Accuracy Measurement

Circuit.

FSP_IP_DOC Data Operation Circuit.

FSP_IP_CRC Cyclic Redundancy Check Calculator.
FSP_IP_SCI Serial Communications Interface.
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FSP_IP_IIC I2C Bus Interface.

FSP_IP_SPI Serial Peripheral Interface.
FSP_IP_CTSU Capacitive Touch Sensing Unit.
FSP_IP_SCE Secure Cryptographic Engine.
FSP_IP_SLCDC Segment LCD Controller.
FSP_IP_AES Advanced Encryption Standard.
FSP_IP_TRNG True Random Number Generator.
FSP_IP_FCACHE Flash Cache.

FSP_IP_SRAM SRAM.

FSP_IP_ADC A/D Converter.

FSP_IP_DAC 12-Bit D/A Converter
FSP_IP_TSN Temperature Sensor.
FSP_IP_DAAD

D/A A/D Synchronous Unit.

FSP_IP_ACMPHS

High Speed Analog Comparator.

FSP_IP_ACMPLP

Low Power Analog Comparator.

FSP_IP_OPAMP Operational Amplifier.

FSP_IP_SDADC Sigma Delta A/D Converter.

FSP_IP_RTC Real Time Clock.

FSP_IP_WDT Watch Dog Timer.

FSP_IP_IWDT Independent Watch Dog Timer.

FSP_IP_GPT General PWM Timer.

FSP_IP_POEG Port Output Enable for GPT.

FSP_IP_OPS Output Phase Switch.

FSP_IP_AGT Asynchronous General-Purpose Timer.
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FSP_IP_CAN Controller Area Network.
FSP_IP_IRDA Infrared Data Association.
FSP_IP_QSPI Quad Serial Peripheral Interface.
FSP_IP_USBFS USB Full Speed.

FSP_IP_SDHI SD/MMC Host Interface.
FSP_IP_SRC Sampling Rate Converter.
FSP_IP_SSI Serial Sound Interface.
FSP_IP_DALI Digital Addressable Lighting Interface.
FSP_IP_ETHER Ethernet MAC Controller.
FSP_IP_EDMAC Ethernet DMA Controller.
FSP_IP_EPTPC Ethernet PTP Controller.
FSP_IP_PDC Parallel Data Capture Unit.
FSP_IP_GLCDC Graphics LCD Controller.
FSP_IP_DRW 2D Drawing Engine

FSP_IP_JPEG JPEG.

FSP_IP_DACS8 8-Bit D/A Converter
FSP_IP_USBHS

USB High Speed.
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¢ fsp_signal_t

enum fsp_signal_t

Signals that can be mapped to an interrupt.

Enumerator

FSP_SIGNAL_ADC_COMPARE_MATCH

ADC COMPARE MATCH.

FSP_SIGNAL_ADC_COMPARE_MISMATCH

ADC COMPARE MISMATCH.

FSP_SIGNAL_ADC_SCAN_END

ADC SCAN END.

FSP_SIGNAL_ADC_SCAN_END B

ADC SCAN END B.

FSP_SIGNAL_ADC_WINDOW A

ADC WINDOW A.

FSP_SIGNAL_ADC_WINDOW B

ADC WINDOW B.

FSP_SIGNAL_AES_RDREQ

AES RDREQ.

FSP_SIGNAL_AES_WRREQ

AES WRREQ.

FSP_SIGNAL_AGT_COMPARE_A

AGT COMPARE A.

FSP_SIGNAL_AGT_COMPARE_B

AGT COMPARE B.

FSP_SIGNAL_AGT_INT

AGT INT.

FSP_SIGNAL_CAC_FREQUENCY_ERROR

CAC FREQUENCY ERROR.

FSP_SIGNAL_CAC_MEASUREMENT _END

CAC MEASUREMENT END.

FSP_SIGNAL_CAC_OVERFLOW

CAC OVERFLOW.

FSP_SIGNAL_CAN_ERROR

CAN ERROR,
FSP_SIGNAL_CAN_FIFO_RX CAN FIFO RX.
FSP_SIGNAL_CAN_FIFO_TX CAN FIFO TX.

FSP_SIGNAL_CAN_MAILBOX_RX

CAN MAILBOX RX.

FSP_SIGNAL_CAN_MAILBOX_TX

CAN MAILBOX TX.

FSP_SIGNAL_CGC_MOSC_STOP

CGC MOSC STOP.

FSP_SIGNAL_LPM_SNOOZE_REQUEST

LPM SNOOZE REQUEST.
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FSP_SIGNAL_LVD LVD1

LVD LVD1.
FSP_SIGNAL_LVD_LVD2 LVD LVD2.
FSP_SIGNAL_VBATT_LVD VBATT LVD.
FSP_SIGNAL_LVD_VBATT LVD VBATT.
FSP_SIGNAL_ACMPHS_INT ACMPHS INT.
FSP_SIGNAL_ACMPLP_INT ACMPLP INT.
FSP_SIGNAL_CTSU_END CTSU END.
FSP_SIGNAL_CTSU_READ CTSU READ.
FSP_SIGNAL_CTSU_WRITE CTSU WRITE.
FSP_SIGNAL_DALI_DEI DALI DEI.
FSP_SIGNAL_DALI_CLI DALI CLI.
FSP_SIGNAL_DALI_SDI DALI SDI.
FSP_SIGNAL_DALI_BPI DALI BPI.
FSP_SIGNAL_DALI_FEI DALI FEI.

FSP_SIGNAL_DALI_SDI_OR_BPI

DALI SDI OR BPI.

FSP_SIGNAL_DMAC_INT

DMAC INT.
FSP_SIGNAL_DOC_INT DOC INT.
FSP_SIGNAL_DRW_INT DRW INT.

FSP_SIGNAL_DTC_COMPLETE

DTC COMPLETE.

FSP_SIGNAL_DTC_END

DTC END.

FSP_SIGNAL_EDMAC_EINT

EDMAC EINT.

FSP_SIGNAL_ELC_SOFTWARE_EVENT 0

ELC SOFTWARE EVENT 0.

FSP_SIGNAL_ELC_SOFTWARE_EVENT 1

ELC SOFTWARE EVENT 1.

FSP_SIGNAL_EPTPC_IPLS

EPTPC IPLS.
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FSP_SIGNAL_EPTPC_MINT

EPTPC MINT.

FSP_SIGNAL_EPTPC_PINT

EPTPC PINT.

FSP_SIGNAL_EPTPC_TIMERO_FALL

EPTPC TIMERO FALL.

FSP_SIGNAL_EPTPC_TIMERO_RISE

EPTPC TIMERO RISE.

FSP_SIGNAL_EPTPC_TIMER1_FALL

EPTPC TIMER1 FALL.

FSP_SIGNAL_EPTPC_TIMER1_RISE

EPTPC TIMERL1 RISE.

FSP_SIGNAL_EPTPC_TIMER2_FALL

EPTPC TIMER2 FALL.

FSP_SIGNAL_EPTPC_TIMER2_RISE

EPTPC TIMER2 RISE.

FSP_SIGNAL_EPTPC_TIMER3_FALL

EPTPC TIMER3 FALL.

FSP_SIGNAL_EPTPC_TIMER3_RISE

EPTPC TIMER3 RISE.

FSP_SIGNAL_EPTPC_TIMER4 FALL

EPTPC TIMER4 FALL.

FSP_SIGNAL_EPTPC_TIMER4_RISE

EPTPC TIMER4 RISE.

FSP_SIGNAL_EPTPC_TIMER5_FALL

EPTPC TIMERS5 FALL.

FSP_SIGNAL_EPTPC_TIMER5_RISE

EPTPC TIMERS5 RISE.

FSP_SIGNAL_FCU_FIFERR

FCU FIFERR.

FSP_SIGNAL_FCU_FRDYI

FCU FRDYI.

FSP_SIGNAL_GLCDC_LINE_DETECT

GLCDC LINE DETECT.

FSP_SIGNAL_GLCDC_UNDERFLOW 1

GLCDC UNDERFLOW 1.

FSP_SIGNAL_GLCDC_UNDERFLOW 2

GLCDC UNDERFLOW 2.

FSP_SIGNAL_GPT_CAPTURE_COMPARE_A

GPT CAPTURE COMPARE A.

FSP_SIGNAL_GPT_CAPTURE_COMPARE_B

GPT CAPTURE COMPARE B.

FSP_SIGNAL_GPT_COMPARE_C

GPT COMPARE C.

FSP_SIGNAL_GPT_COMPARE_D

GPT COMPARE D.

FSP_SIGNAL_GPT_COMPARE_E

GPT COMPARE E.
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FSP_SIGNAL_GPT_COMPARE_F GPT COMPARE F.
FSP_SIGNAL_GPT_COUNTER_OVERFLOW GPT COUNTER OVERFLOW.
FSP_SIGNAL_GPT_COUNTER_UNDERFLOW GPT COUNTER UNDERFLOW.
FSP_SIGNAL GPT _AD TRIG_A GPT AD TRIG A.
FSP_SIGNAL GPT _AD TRIG B GPT AD TRIG B.
FSP_SIGNAL_OPS_UVW_EDGE OPS UVW EDGE.
FSP_SIGNAL ICU_IRQO ICU IRQO.
FSP_SIGNAL ICU_IRQ1 ICU IRQ1.
FSP_SIGNAL_ICU_IRQ2 ICU IRQ2.
FSP_SIGNAL_ICU_IRQ3 ICU IRQ3.
FSP_SIGNAL ICU_IRQ4 ICU IRQA4.
FSP_SIGNAL_ICU_IRQ5 ICU IRQ5.
FSP_SIGNAL ICU IRQ6 ICU IRQS6.
FSP_SIGNAL_ICU_IRQ7 ICU IRQ7.
FSP_SIGNAL ICU_IRQ8 ICU IRQS.
FSP_SIGNAL _ICU_IRQ9 ICU IRQO9.
FSP_SIGNAL ICU _IRQ10 ICU IRQ10.
FSP_SIGNAL_ICU_IRQ11 ICU IRQ11.
FSP_SIGNAL ICU IRQ12 ICU IRQ12.
FSP_SIGNAL ICU_IRQ13 ICU IRQ13.
FSP_SIGNAL ICU IRQ14 ICU IRQ14.
FSP_SIGNAL_ICU_IRQ15 ICU IRQ15.
FSP_SIGNAL ICU SNOOZE_CANCEL ICU SNOOZE CANCEL.
FSP_SIGNAL IIC_ERI [IC ERI.
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FSP_SIGNAL_IIC_RXI

[IC RXI.
FSP_SIGNAL_IIC_TEI [IC TEI.
FSP_SIGNAL_IIC_TXI [IC TXI.
FSP_SIGNAL_IIC_WUI [IC WUI.

FSP_SIGNAL_IOPORT EVENT_1

IOPORT EVENT 1.

FSP_SIGNAL_IOPORT_EVENT 2

IOPORT EVENT 2.

FSP_SIGNAL_IOPORT _EVENT 3

IOPORT EVENT 3.

FSP_SIGNAL_IOPORT_EVENT 4

IOPORT EVENT 4.

FSP_SIGNAL_IWDT_UNDERFLOW

IWDT UNDERFLOW.

FSP_SIGNAL_JPEG_JDTI JPEG JDTI.
FSP_SIGNAL_JPEG_JEDI JPEG JEDI.
FSP_SIGNAL_KEY_INT KEY INT.

FSP_SIGNAL_PDC_FRAME_END

PDC FRAME END.

FSP_SIGNAL_PDC_INT

PDC INT.

FSP_SIGNAL_PDC_RECEIVE_DATA READY

PDC RECEIVE DATA READY.

FSP_SIGNAL_POEG_EVENT

POEG EVENT.
FSP_SIGNAL_QSPIL_INT QSPI INT.
FSP_SIGNAL_RTC_ALARM RTC ALARM.
FSP_SIGNAL_RTC_PERIOD RTC PERIOD.
FSP_SIGNAL_RTC_CARRY RTC CARRY.

FSP_SIGNAL_SCE_INTEGRATE_RDRDY

SCE INTEGRATE RDRDY.

FSP_SIGNAL_SCE_INTEGRATE_WRRDY

SCE INTEGRATE WRRDY.

FSP_SIGNAL_SCE_LONG_PLG

SCE LONG PLG.

FSP_SIGNAL_SCE_PROC_BUSY

SCE PROC BUSY.
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FSP_SIGNAL_SCE_RDRDY_0

SCE RDRDY 0.
FSP_SIGNAL_SCE_RDRDY_1 SCE RDRDY 1.
FSP_SIGNAL_SCE_ROMOK SCE ROMOK.

FSP_SIGNAL_SCE_TEST_BUSY

SCE TEST BUSY.

FSP_SIGNAL_SCE_WRRDY_0

SCE WRRDY 0.
FSP_SIGNAL_SCE_WRRDY_1 SCE WRRDY 1.
FSP_SIGNAL_SCE_WRRDY_4 SCE WRRDY 4.
FSP_SIGNAL_SCI_AM SCI AM.
FSP_SIGNAL_SCI_ERI SCI ERI.
FSP_SIGNAL_SCI_RXI SCI RXI.
FSP_SIGNAL_SCI_RXI_OR_ERI SCI RXI OR ERI.
FSP_SIGNAL_SCI_TEI SCI TEI.
FSP_SIGNAL_SCI_TXI SCI TXI.
FSP_SIGNAL_SDADC_ADI SDADC ADI.

FSP_SIGNAL_SDADC_SCANEND

SDADC SCANEND.

FSP_SIGNAL_SDADC_CALIEND

SDADC CALIEND.

FSP_SIGNAL_SDHIMMC_ACCS

SDHIMMC ACCS.

FSP_SIGNAL_SDHIMMC_CARD

SDHIMMC CARD.

FSP_SIGNAL_SDHIMMC_DMA_REQ

SDHIMMC DMA REQ.

FSP_SIGNAL_SDHIMMC_SDIO

SDHIMMC SDIO.

FSP_SIGNAL_SPI_ERI

SPI ERI.
FSP_SIGNAL SPI_IDLE SPI IDLE.
FSP_SIGNAL_SPI_RXI SPI RXI.
FSP_SIGNAL _SPI TEI SPI TEI.
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FSP_SIGNAL_SPI_TXI

SPI TXI.

FSP_SIGNAL_SRC_CONVERSION_END

SRC CONVERSION END.

FSP_SIGNAL_SRC_INPUT FIFO_EMPTY

SRC INPUT FIFO EMPTY.

FSP_SIGNAL_SRC_OUTPUT_FIFO_FULL

SRC OUTPUT FIFO FULL.

FSP_SIGNAL_SRC_OUTPUT_FIFO_OVERFLOW

SRC OUTPUT FIFO OVERFLOW.

FSP_SIGNAL_SRC_OUTPUT_FIFO_UNDERFLOW

SRC OUTPUT FIFO UNDERFLOW.

FSP_SIGNAL_SSI_INT

SSIINT.
FSP_SIGNAL_SSI_RXI SSI RXI.
FSP_SIGNAL_SSI_TXI SSI TXI.
FSP_SIGNAL_SSI_TXI_RXI SSI TXI RXI.
FSP_SIGNAL_TRNG_RDREQ TRNG RDREQ.
FSP_SIGNAL_USB_FIFO_O USB FIFO 0.
FSP_SIGNAL_USB_FIFO_1 USB FIFO 1.
FSP_SIGNAL_USB_INT USB INT.
FSP_SIGNAL_USB_RESUME USB RESUME.

FSP_SIGNAL_USB_USB_INT RESUME

USB USB INT RESUME.

FSP_SIGNAL_WDT_UNDERFLOW

WDT UNDERFLOW.
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¢ bsp_warm_start_event_t

enum bsp_warm_start_event _t

Different warm start entry locations in the BSP.

Enumerator

BSP_WARM_START RESET

Called almost immediately after reset. No C
runtime environment, clocks, or IRQs.

BSP_WARM_START_POST CLOCK

Called after clock initialization. No C runtime
environment or IRQs.

BSP_WARM_START _POST C

Called after clocks and C runtime environment
have been set up.

¢ bsp_delay_units_t

enum bsp_delay_units_t

microseconds

Available delay units for R_ BSP_SoftwareDelay(). These are ultimately used to calculate a total # of

Enumerator

BSP_DELAY_UNITS_SECONDS

Requested delay amount is in seconds.

BSP_DELAY_UNITS_MILLISECONDS

Requested delay amount is in milliseconds.

BSP_DELAY_UNITS_MICROSECONDS

Requested delay amount is in microseconds.
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¢ bsp _grp_irq_t

enum bsp_grp_irg_t

Which interrupts can have callbacks registered.

Enumerator

BSP_GRP_IRQ_IWDT_ERROR IWDT underflow/refresh error has occurred.

BSP_GRP_IRQ_WDT_ERROR WDT underflow/refresh error has occurred.

BSP_GRP_IRQ_LVD1 Voltage monitoring 1 interrupt.

BSP_GRP_IRQ_LVD2 Voltage monitoring 2 interrupt.

BSP_GRP_IRQ_VBATT VBATT monitor interrupt.

BSP_GRP_IRQ_OSC_STOP_DETECT Oscillation stop is detected.

BSP_GRP_IRQ_NMI_PIN NMI Pin interrupt.

BSP_GRP_IRQ_RAM_PARITY RAM Parity Error.
BSP_GRP_IRQ RAM_ECC RAM ECC Error.
BSP_GRP_IRQ_MPU_BUS_SLAVE MPU Bus Slave Error.
BSP_GRP_IRQ_MPU_BUS_MASTER MPU Bus Master Error.
BSP_GRP_IRQ_MPU_STACK MPU Stack Error.
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¢ bsp_reg_protect_t

enum bsp_reg_protect t

The different types of registers that can be protected.

Enumerator

BSP_REG_PROTECT CGC

Enables writing to the registers related to the
clock generation circuit.

BSP_REG_PROTECT OM_LPC_BATT

Enables writing to the registers related to
operating modes, low power consumption, and
battery backup function.

BSP_REG_PROTECT _LVD

Enables writing to the registers related to the
LVD: LVCMPCR, LVDLVLR, LVD1CRO, LVD1CR1,
LVD1SR, LVD2CRO, LVD2CR1, LVD2SR.

Function Documentation

4 R_FSP_VersionGet()

fsp_err t R_FSP_VersionGet ( fsp_pack version_t *const p version)

Parameters

Get the FSP version based on compile time macros.

[out]

p_version

Memory address to return
version information to.

Return values

FSP_SUCCESS

Version information stored.

FSP_ERR_ASSERTION

The parameter p_version is NULL.

¢ Reset_Handler()

void Reset Handler ( void )

MCU starts executing here out of reset. Main stack pointer is set up already.

¢ Default_Handler()

void Default Handler ( void )

Default exception handler.
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¢ Systeminit()

void Systemlnit ( void )

Initialize the MCU and the runtime environment.

4 R_BSP_WarmsStart()

void R_BSP_WarmStart ( bsp_warm_start_event t event)

This function is called at various points during the startup process. This function is declared as a
weak symbol higher up in this file because it is meant to be overridden by a user implemented
version. One of the main uses for this function is to call functional safety code during the startup

process. To use this function just copy this function into your own code and modify it to meet your
needs.

Parameters

[in] event Where the code currently is
in the start up process

4 R_BSP _VersionGet()

fsp_err_ t R_BSP_VersionGet ( fsp_version_t * p version)

Get the BSP version based on compile time macros.

Parameters

[out] p_version Memory address to return
version information to.

Return values

FSP_SUCCESS Version information stored.
FSP_ERR_ASSERTION The parameter p_version is NULL.
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¢ R_BSP_SoftwareDelay()

void R_BSP_SoftwareDelay ( uint32_t delay, bsp_delay_units _t units )

Delay for at least the specified duration in units and return.

Parameters
[in] delay The number of 'units' to
delay.
[in] units The 'base’

(bsp_delay_units_t) for the
units specified. Valid values
are:

BSP_DELAY _UNITS_SECONDS
, BSP_DELAY_UNITS_MILLISE
CONDS, BSP_DELAY_UNITS _
MICROSECONDS.

For example:

At 1 MHz one cycle takes 1
microsecond (.000001
seconds).

At 12 MHz one cycle takes
1/12 microsecond or 83
nanoseconds.

Therefore one run through b
sp_prv_software_delay_loop(
) takes: ~ (83 *

BSP_DELAY LOOP_CYCLES)
or 332 ns. A delay of 2 us
therefore requires
2000ns/332ns or 6 loops.

The 'theoretical' maximum delay that may be obtained is determined by a full 32 bit loop count
and the system clock rate. @120MHz: ((OxFFFFFFFF loops * 4 cycles /loop) / 120000000) = 143
seconds. @32MHz: ((OxFFFFFFFF loops * 4 cycles /loop) / 32000000) = 536 seconds

Note that requests for very large delays will be affected by rounding in the calculations and the
actual delay achieved may be slightly longer. @32 MHz, for example, a request for 532 seconds will
be closer to 536 seconds.

Note also that if the calculations result in a loop_cnt of zero, the bsp_prv_software_delay _loop()
function is not called at all. In this case the requested delay is too small (nanoseconds) to be
carried out by the loop itself, and the overhead associated with executing the code to just get to
this point has certainly satisfied the requested delay.

Note
Thisfunction callsbsp_cpu_clock get() which ultimately callsR_ CGC_SystemClockFreqGet() and therefore
requires that the BSP has already initialized the CGC (which it does as part of the Sysinit). Care should be taken to
ensure this remains the case if in the future this function were to be called as part of the BSP initialization.
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4 R_BSP_GrouplrqWrite()

fsp_err_t R_BSP_GrouplrgWrite ( bsp _grp_irg_t irq, void(*)(bsp_grp_irq_t irq) p_callback )

Register a callback function for supported interrupts. If NULL is passed for the callback argument
then any previously registered callbacks are unregistered.

Parameters
[in] irq Interrupt for which to
register a callback.
[in] p_callback Pointer to function to call
when interrupt occurs.

Return values
FSP_SUCCESS Callback registered

FSP_ERR_ASSERTION Callback pointer is NULL

¢ NMI_Handler()

void NMI_Handler ( void )

Non-maskable interrupt handler. This exception is defined by the BSP, unlike other system
exceptions, because there are many sources that map to the NMI exception.

¢ R_BSP_RegisterProtectEnable()

void R_BSP_RegisterProtectEnable ( bsp reg protect t regs to protect)

Enable register protection. Registers that are protected cannot be written to. Register protection is
enabled by using the Protect Register (PRCR) and the MPC's Write-Protect Register (PWPR).

Parameters
[in] regs_to_protect Registers which have write
protection enabled.
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4 R_BSP_RegisterProtectDisable()

void R_BSP_RegisterProtectDisable ( bsp_reg protect t regs to unprotect)

Disable register protection. Registers that are protected cannot be written to. Register protection is
disabled by using the Protect Register (PRCR) and the MPC's Write-Protect Register (PWPR).

Parameters

[in] regs_to_unprotect Registers which have write
protection disabled.

Variable Documentation

¢ SystemCoreClock

uint32_t SystemCoreClock

System Clock Frequency (Core Clock)

¢ g_bsp_version

const fsp_version_t g bsp version

Default initialization function.

Version data structure used by error logger macro.

4.1.2.1 RA2A1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra2al fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO0 register settings e I[WDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e I[WDT is

automatically
activated after
a reset
(Autostart
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mode)

OFSO0 register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles

e 2048 cycles
OFSO register settings o1 128
> Independent WDT > e 16
Dedicated Clock e 32
Frequency Divisor e 64

e 128

e 256
OFSO register settings e 75% 0% (no window end
> Independent WDT > * 50% position)
Window End Position * 25%

* 0% (no window

end position)

OFSO0 register settings e 25% 100% (no window start
> Independent WDT > e 50% position)
Window Start Position e 75%
e 100% (no
window start
position)

OFSO0 register settings

NMI request or

Reset is enabled

> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled
e Resetis
enabled
OFSO register settings ¢ Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or

Stop Control

OFSO register settings
> WDT > Start Mode
Select

Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

Software Standby

Stop WDT after a reset
(register-start mode)

OFSO register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO0 register settings o 4 128
> WDT > Clock * 64
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Frequency Division e 128
Ratio e 512

e 2048

e 8192
OFSO0 register settings e 75% 0% (no window end
> WDT > Window End e 50% position)
Position e 25%

¢ 0% (no window

end position)

OFSO register settings e 25% 100% (no window start

> WDT > Window Start 50% position)
Position e 75%
e 100% (no
window start

position)
OFSO register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO register settings e Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings e Voltage monitor Voltage monitor O reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after
reset
* Voltage monitor
O reset is
disabled after
reset
OFS1 register settings e 3.84V 1.90V
> Voltage Detection 0 e 282V
Level e 251V
e 190V
e 1.70V
OFS1 register settings  HOCO oscillation is HOCO oscillation is HOCO must be enabled
> HOCO Oscillation enabled after reset enabled after reset out of reset because
Enable the MCU starts up in
low voltage mode and
the HOCO must be
operating in low
voltage mode.
MPU > Enable or e Enabled Disabled
disable PC Region 0 ¢ Disabled
MPU > PCO Start Value must be an Ox000FFFFC

integer between 0 and
Ox000FFFFC (ROM) or
between 0x1FF00000
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and 0x200FFFFC (RAM)

Jun.26.20

MPU > PCO End Value must be an OxOOOFFFFF
integer between
0x00000003 and
Ox000FFFFF (ROM) or
between 0x1FFO0003
and Ox200FFFFF (RAM)
MPU > Enable or e Enabled Disabled
disable PC Region 1 ¢ Disabled
MPU > PC1 Start Value must be an 0x000FFFFC
integer between 0 and
OxO00O0FFFFC (ROM) or
between Ox1FFO0000
and 0x200FFFFC (RAM)
MPU > PC1 End Value must be an OxOO0OFFFFF
integer between
0x00000003 and
Ox000FFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
0
MPU > Memory Region Value must be an Ox000FFFFC
0 Start integer between 0 and
O0x000FFFFC
MPU > Memory Region Value must be an OxO00FFFFF
0 End integer between
0x00000003 and
Ox000FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
1
MPU > Memory Region Value must be an 0x200FFFFC
1 Start integer between
0x1FF00000 and
0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between
0x1FF00003 and
0x200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
2
MPU > Memory Region Value must be an 0x407FFFFC
2 Start integer between
0x400C0000 and
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0x400DFFFC or
between 0x40100000
and 0x407FFFFC

MPU > Memory Region Value must be an Ox407FFFFF
2 End integer between

0x400C0003 and

0Ox400DFFFF or

between 0x40100003

and 0x407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
3
MPU > Memory Region Value must be an O0x400DFFFC
3 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and 0x407FFFFC
MPU > Memory Region Value must be an 0x400DFFFF
3 End integer between

0x400C0003 and

O0x400DFFFF or

between 0x40100003

and Ox407FFFFF
Use Low Voltage Mode e Enable Disable Use the low voltage

e Disable mode. This limits the

Enumerations

enum elc_event t

Enumeration Type Documentation

¢ elc_event_t

ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least 4
when oscillation stop
detection is used.

enum elc_event t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist may change based on based on the device.
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4.1.2.2 RAAM1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for radm1l_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO0 register settings e [WDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e [WDT is

automatically
activated after

a reset
(Autostart
mode)
OFSO register settings e 128 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO register settings o1
> Independent WDT > * 16
Dedicated Clock e 32
Frequency Divisor * 64
e 128
e 256
OFSO register settings e 75%
> Independent WDT > e 50%
Window End Position e 25%
e 0% (no window

end position)

OFSO register settings e 25%
> Independent WDT > e 50%
Window Start Position e 75%

e 100% (no
window start
position)

OFSO0 register settings ¢ NMI request or
> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled

e Resetis

enabled
OFSO register settings ¢ Counting
> Independent WDT > continues
Stop Control ¢ Stop counting

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby
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when in Sleep,
Snooze mode,
or Software

Standby
OFSO register settings e Automatically Stop WDT after a reset
> WDT > Start Mode activate WDT (register-start mode)
Select after a reset

(auto-start

mode)

e Stop WDT after
a reset (register-
start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings o 4 128
> WDT > Clock e 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End * 50% position)
Position e 25%
¢ 0% (no window

end position)

OFSO register settings e 25% 100% (no window start
> WDT > Window Start * 50% position)
Position e 75%
* 100% (no

window start

position)
OFSO0 register settings e NMI Reset
> WDT > Reset ¢ Reset
Interrupt Request
OFSO register settings ¢ Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering
Sleep mode

OFS1 register settings ¢ Voltage monitor Voltage monitor O reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after

reset

¢ Voltage monitor

0 reset is

disabled after

reset
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OFS1 register settings
> Voltage Detection 0
Level

OFS1 register settings
> HOCO Oscillation
Enable

3.84V
2.82V
251V
190V
1.70Vv

HOCO oscillation is
enabled after reset

190V

HOCO oscillation is
enabled after reset

HOCO must be enabled
out of reset because
the MCU starts up in
low voltage mode and
the HOCO must be
operating in low
voltage mode.

Jun.26.20

MPU > Enable or e Enabled Disabled
disable PC Region 0 e Disabled
MPU > PCO Start Value must be an OxO0FFFFFC
integer between 0 and
Ox00FFFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)
MPU > PCO End Value must be an OXOOFFFFFF
integer between
0x00000003 and
OxOO0FFFFFF (ROM) or
between 0x1FF00003
and 0x200FFFFF (RAM)
MPU > Enable or e Enabled Disabled
disable PC Region 1 e Disabled
MPU > PC1 Start Value must be an OxO0FFFFFC
integer between 0 and
OxO00FFFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)
MPU > PC1 End Value must be an OXxOOFFFFFF
integer between
0x00000003 and
OxOO0FFFFFF (ROM) or
between 0x1FF00003
and 0x200FFFFF (RAM)
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
0
MPU > Memory Region Value must be an OxO00FFFFFC
0 Start integer between 0 and
OXOO0FFFFFC
MPU > Memory Region Value must be an OXxOOFFFFFF
0 End integer between
0x00000003 and
OxOOFFFFFF
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MPU > Enable or ¢ Enabled Disabled
disable Memory Region ¢ Disabled
1
MPU > Memory Region Value must be an 0x200FFFFC
1 Start integer between
Ox1FF00000 and
0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between
0x1FF00003 and
0x200FFFFF
MPU > Enable or ¢ Enabled Disabled
disable Memory Region * Disabled
2
MPU > Memory Region Value must be an Ox407FFFFC
2 Start integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC
MPU > Memory Region Value must be an Ox407FFFFF
2 End integer between
0x400C0003 and
0Ox400DFFFF or
between 0x40100003
and 0x407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
3
MPU > Memory Region Value must be an 0x400DFFFC
3 Start integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and Ox407FFFFC
MPU > Memory Region Value must be an 0x400DFFFF
3 End integer between
0x400C0003 and
Ox400DFFFF or
between 0x40100003
and 0x407FFFFF
Use Low Voltage Mode e Enable Disable Use the low voltage
¢ Disable mode. This limits the
ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least
4.
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Enumerations

enum elc_event t

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Note

Thislist may change based on based on the device.

Sources of event signals to be linked to other peripherals or the CPU

4.1.2.3 RA4AW1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for radwl_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO0 register settings e I[WDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e I[WDT is

automatically
activated after

a reset
(Autostart
mode)
OFSO0 register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO register settings o1 128
> Independent WDT > e 16
Dedicated Clock e 32
Frequency Divisor e 64
e 128
e 256
OFSO register settings e 75% 0% (no window end
> Independent WDT > * 50% position)
Window End Position e 25%
* 0% (no window
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end position)

OFSO register settings e 25% 100% (no window start
> Independent WDT > e 50% position)
Window Start Position e 75%
e 100% (no
window start
position)

OFSO register settings

NMI request or

Reset is enabled

> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled
e Resetis
enabled
OFSO register settings ¢ Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or

Stop Control

OFSO register settings
> WDT > Start Mode
Select

Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

Software Standby

Stop WDT after a reset
(register-start mode)

OFSO register settings e 1024 cycles 16384 cycles
> WDT > Timeout * 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO0 register settings e 4 128
> WDT > Clock * 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End e 50% position)
Position e 25%
¢ 0% (no window

end position)

OFSO register settings e 25% 100% (no window start
> WDT > Window Start e 50% position)
Position e 75%
e 100% (no
window start
position)
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OFSO register settings e NMI Reset

> WDT > Reset e Reset

Interrupt Request

OFSO register settings e Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering
Sleep mode

OFS1 register settings ¢ Voltage monitor Voltage monitor O reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after

reset

e Voltage monitor

0 reset is

disabled after

reset

3.84V 190V
2.82V
251V
190V
1.70V

OFS1 register settings
> Voltage Detection 0
Level

OFS1 register settings e HOCO HOCO oscillation is
> HOCO Oscillation oscillation is disabled after reset
Enable enabled after

reset

e HOCO

oscillation is

disabled after

reset

MPU > Enable or e Enabled Disabled
disable PC Region 0 ¢ Disabled

MPU > PCO Start Value must be an OXxOOFFFFFC
integer between 0 and
OxOOFFFFFC (ROM) or
between 0x1FFO0000
and 0x200FFFFC (RAM)

MPU > PCO End Value must be an OxOOFFFFFF
integer between
0x00000003 and
OxOOFFFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

MPU > Enable or e Enabled Disabled
disable PC Region 1 ¢ Disabled

MPU > PC1 Start Value must be an OXO0FFFFFC
integer between 0 and
Ox00FFFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)
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MPU > PC1 End Value must be an OXOOFFFFFF

integer between

0x00000003 and

OxOOFFFFFF (ROM) or

between 0x1FF00003

and 0x200FFFFF (RAM)
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
0
MPU > Memory Region Value must be an OxO0FFFFFC
0 Start integer between 0 and

OxXO00FFFFFC
MPU > Memory Region Value must be an OXxOOFFFFFF
0 End integer between

0x00000003 and

OxOOFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
1
MPU > Memory Region Value must be an Ox200FFFFC
1 Start integer between

0x1FFO0000 and

0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between

0x1FF00003 and

0x200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
2
MPU > Memory Region Value must be an Ox407FFFFC
2 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and Ox407FFFFC
MPU > Memory Region Value must be an Ox407FFFFF
2 End integer between

0x400C0003 and

0x400DFFFF or

between 0x40100003

and 0x407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region * Disabled
3
MPU > Memory Region Value must be an 0x400DFFFC
3 Start integer between

0x400C0000 and
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0x400DFFFC or
between 0x40100000
and 0x407FFFFC

MPU > Memory Region Value must be an 0x400DFFFF
3 End integer between

0x400C0003 and

0Ox400DFFFF or

between 0x40100003

and 0x407FFFFF

Use Low Voltage Mode e Enable Disable Use the low voltage
¢ Disable mode. This limits the
ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least
4.

Enumerations

enum elc_event t

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Sources of event signals to be linked to other peripherals or the CPU1

Note

Thislist may change based on device. Thislist isfor RAAWL.

4.1.2.4 RA6M1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra6m1l_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family cfg.h:

Configuration Options Default Description
OFSO register settings e IWDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e I[WDT is

automatically
activated after
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OFSO0 register settings
> Independent WDT >
Timeout Period

OFSO register settings
> Independent WDT >
Dedicated Clock
Frequency Divisor

OFSO register settings
> Independent WDT >
Window End Position

OFSO0 register settings
> Independent WDT >
Window Start Position

OFSO0 register settings
> Independent WDT >
Reset Interrupt
Request Select

OFSO0 register settings
> Independent WDT >
Stop Control

OFSO register settings
> WDT > Start Mode
Select

a reset
(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
(register-start mode)

e Stop WDT after
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a reset (register-
start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings o 4 128
> WDT > Clock * 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End * 50% position)
Position * 25%
* 0% (no window

end position)

OFSO0 register settings e 25% 100% (no window start
> WDT > Window Start * 50% position)
Position e 75%
¢ 100% (no

window start

position)
OFSO0 register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO register settings ¢ Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings e Voltage monitor Voltage monitor 0 reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after
reset
¢ Voltage monitor
0 reset is
disabled after
reset
OFS1 register settings e 294V 2.80V
> Voltage Detection O e 287V
Level e 280V
OFS1 register settings e HOCO HOCO oscillation is
> HOCO Oscillation oscillation is disabled after reset
Enable enabled after
reset
e HOCO

oscillation is
disabled after
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reset
MPU > Enable or e Enabled Disabled
disable PC Region 0 e Disabled
MPU > PCO Start Value must be an OXFFFFFFFC
integer between 0 and
OXFFFFFFFC
MPU > PCO End Value must be an OXFFFFFFFF
integer between
0x00000003 and
OxXFFFFFFFF
MPU > Enable or e Enabled Disabled
disable PC Region 1 ¢ Disabled
MPU > PC1 Start Value must be an OXFFFFFFFC
integer between 0 and
OXFFFFFFFC
MPU > PC1 End Value must be an OXFFFFFFFF
integer between
0x00000003 and
OxXFFFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region * Disabled
0
MPU > Memory Region Value must be an OxOO0FFFFFC
0 Start integer between 0 and
OxO00FFFFFC
MPU > Memory Region Value must be an OXOOFFFFFF
0 End integer between
0x00000003 and
OxOO0FFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
1
MPU > Memory Region Value must be an Ox200FFFFC
1 Start integer between
0x1FF00000 and
0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between
0x1FF00003 and
0x200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
2
MPU > Memory Region Value must be an Ox407FFFFC
2 Start integer between
0x400C0000 and
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0x400DFFFC or
between 0x40100000
and 0x407FFFFC

MPU > Memory Region Value must be an 0x407FFFFF
2 End integer between

0x400C0003 and

0Ox400DFFFF or

between 0x40100003

and 0x407FFFFF

MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled

3

MPU > Memory Region Value must be an O0x400DFFFC
3 Start integer between

0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

MPU > Memory Region Value must be an 0x400DFFFF
3 End integer between

0x400C0003 and

O0x400DFFFF or

between 0x40100003

and Ox407FFFFF

Enumerations

enum elc_event t

Enumeration Type Documentation

¢ elc_event_t

enum elc_event t

Sources of event signals to be linked to other peripherals or the CPU

Note
Thislist may change based on based on the device.

4.1.2.5 RA6M2
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for rabm2_fsp
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The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family cfg.h:

Configuration Options Default Description
OFSO register settings e IWDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e [WDT is

automatically
activated after
a reset

(Autostart
mode)
OFSO register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO register settings o1 128
> Independent WDT > e 16
Dedicated Clock e 32
Frequency Divisor e 64
e 128
e 256
OFSO0 register settings e 75% 0% (no window end
> Independent WDT > e 50% position)
Window End Position e 25%
¢ 0% (no window

end position)

OFSO register settings * 25% 100% (no window start
> Independent WDT > e 50% position)
Window Start Position e 75%
e 100% (no
window start
position)
OFSO register settings e NMI request or Reset is enabled
> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled
e Resetis
enabled
OFSO register settings ¢ Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or

Stop Control

(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,

Software Standby
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Snooze mode,
or Software

Standby
OFSO register settings e Automatically Stop WDT after a reset
> WDT > Start Mode activate WDT (register-start mode)
Select after a reset

(auto-start

mode)

e Stop WDT after
a reset (register-
start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings o 4 128
> WDT > Clock e 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO0 register settings e 75% 0% (no window end
> WDT > Window End * 50% position)
Position * 25%
* 0% (no window

end position)

OFSO0 register settings e 25% 100% (no window start
> WDT > Window Start * 50% position)
Position e 75%
* 100% (no

window start

position)
OFSO0 register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO register settings ¢ Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings e Voltage monitor Voltage monitor 0 reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after

reset

¢ Voltage monitor

0 reset is

disabled after

reset
OFS1 register settings e 294V 2.80V
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> Voltage Detection 0
Level

OFS1 register settings
> HOCO Oscillation
Enable

287V
2.80V

¢ HOCO
oscillation is
enabled after
reset

e HOCO
oscillation is
disabled after

HOCO oscillation is

disabled after reset

Jun.26.20

reset
MPU > Enable or e Enabled Disabled
disable PC Region 0 e Disabled
MPU > PCO Start Value must be an OXFFFFFFFC
integer between 0 and
OxXFFFFFFFC
MPU > PCO End Value must be an OXFFFFFFFF
integer between
0x00000003 and
OxXFFFFFFFF
MPU > Enable or e Enabled Disabled
disable PC Region 1 ¢ Disabled
MPU > PC1 Start Value must be an OXFFFFFFFC
integer between 0 and
OxXFFFFFFFC
MPU > PC1 End Value must be an OxXFFFFFFFF
integer between
0x00000003 and
OxXFFFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
0
MPU > Memory Region Value must be an OxO00OFFFFFC
0 Start integer between 0 and
OxO00FFFFFC
MPU > Memory Region Value must be an OxOOFFFFFF
0 End integer between
0x00000003 and
OxOO0FFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
1
MPU > Memory Region Value must be an Ox200FFFFC
1 Start integer between
0x1FF00000 and
0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between
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MPU > Enable or

disable Memory Region

2

0x1FFO0003 and
O0x200FFFFF

e Enabled
e Disabled

MPU > Memory Region Value must be an

2 Start

integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

MPU > Memory Region Value must be an

2 End

MPU > Enable or

disable Memory Region

3

integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and Ox407FFFFF

e Enabled
¢ Disabled

MPU > Memory Region Value must be an

3 Start

integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

MPU > Memory Region Value must be an

3 End

Enumerations

integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and 0x407FFFFF

enum elc_event_t

Enumeration Type Documentation

¢ elc_event_t

Disabled

0x407FFFFC

0x407FFFFF

Disabled

0x400DFFFC

0x400DFFFF

enum elc_event t

Note

Thislist may change based on based on the device.

Sources of event signals to be linked to other peripherals or the CPU
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4.1.2.6 RA6M3
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra6m3_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO0 register settings e |[WDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e I[WDT is

automatically
activated after

a reset
(Autostart
mode)
OFSO0 register settings e 128 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO register settings o1
> Independent WDT > e 16
Dedicated Clock e 32
Frequency Divisor * 64
e 128
e 256
OFSO register settings e 75%
> Independent WDT > * 50%
Window End Position * 25%
* 0% (no window

end position)

OFSO register settings e 25%
> Independent WDT > e 50%
Window Start Position e 75%

* 100% (no
window start
position)

OFSO register settings e NMI request or
> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled

e Resetis
enabled

OFSO register settings ¢ Counting
> Independent WDT > continues

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
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Stop Control

OFSO register settings
> WDT > Start Mode
Select

OFSO register settings
> WDT > Timeout
Period

OFSO register settings
> WDT > Clock
Frequency Division
Ratio

OFSO register settings
> WDT > Window End
Position

OFSO0 register settings
> WDT > Window Start
Position

OFSO0 register settings
> WDT > Reset
Interrupt Request

OFSO register settings
> WDT > Stop Control

(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Software Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after
a reset (register-
start mode)

Stop WDT after a reset
(register-start mode)

1024 cycles
4096 cycles
8192 cycles
16384 cycles

4 128
64

128

512

2048

8192

16384 cycles

75% 0% (no window end
50% position)

25%

0% (no window

end position)

25% 100% (no window start
50% position)

75%

100% (no

window start

position)

NMI Reset
Reset

Counting
continues
Stop counting
when entering
Sleep mode

Stop counting when
entering Sleep mode
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OFS1 register settings e Voltage monitor Voltage monitor 0 reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after
reset
¢ Voltage monitor
0 reset is
disabled after
reset
OFS1 register settings e 294V 2.80V
> Voltage Detection 0 e 287V
Level e 280V
OFS1 register settings e HOCO HOCO oscillation is
> HOCO Oscillation oscillation is disabled after reset
Enable enabled after
reset
e HOCO

oscillation is
disabled after

reset
MPU > Enable or e Enabled Disabled
disable PC Region 0 e Disabled
MPU > PCO Start Value must be an OXFFFFFFFC
integer between 0 and
OXFFFFFFFC
MPU > PCO End Value must be an OxFFFFFFFF

integer between
0x00000003 and

OxFFFFFFFF
MPU > Enable or e Enabled Disabled
disable PC Region 1 e Disabled
MPU > PC1 Start Value must be an OxXFFFFFFFC
integer between 0 and
OXFFFFFFFC
MPU > PC1 End Value must be an OxFFFFFFFF

integer between
0x00000003 and

OXFFFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
0
MPU > Memory Region Value must be an OxO00FFFFFC
0 Start integer between 0 and
OXOO0FFFFFC
MPU > Memory Region Value must be an OxOOFFFFFF
0 End integer between
0x00000003 and
OxOO0FFFFFF
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MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
1
MPU > Memory Region Value must be an 0x200FFFFC
1 Start integer between

0x1FF00000 and

0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between

0x1FF00003 and

0x200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region * Disabled
2
MPU > Memory Region Value must be an Ox407FFFFC
2 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and Ox407FFFFC
MPU > Memory Region Value must be an Ox407FFFFF
2 End integer between

0x400C0003 and

0Ox400DFFFF or

between 0x40100003

and Ox407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
3
MPU > Memory Region Value must be an 0x400DFFFC
3 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and Ox407FFFFC
MPU > Memory Region Value must be an 0x400DFFFF
3 End integer between

0x400C0003 and

Ox400DFFFF or

between 0x40100003

and Ox407FFFFF
Enumerations

enum elc_event t
Enumeration Type Documentation
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¢ elc_event_t

enum elc_event_t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist may change based on based on the device.

4.1.3 BSP I/O access
BSP

Functions

__STATIC_INLINE uint32_t R _BSP PinRead (bsp_io_port pin_t pin)
__STATIC_INLINE void R _BSP_PinWrite (bsp_io_port_pin_t pin, bsp_io_level t level)
__STATIC_INLINE void R_BSP_PinAccessEnable (void)

__STATIC_INLINE void R_BSP_PinAccessDisable (void)

Detailed Description

This module provides basic read/write access to port pins.

Enumerations

enum bsp_io_level t
enum bsp_io_direction_t
enum bsp_io_port_t
enum bsp_io_port pin_t

Enumeration Type Documentation
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¢ bsp_io _level t

enum bsp_io_level t

Levels that can be set and read for individual pins

Enumerator
BSP_I0_LEVEL LOW Low.
BSP_I0_LEVEL HIGH High.
¢ bsp_io_direction_t
enum bsp_io_direction_t
Direction of individual pins
Enumerator
BSP_1I0_DIRECTION_INPUT Input.
BSP_I0_DIRECTION_OUTPUT Output.
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¢ bsp_io_port_t

enum bsp_io_port t

Superset list of all possible 10 ports.

Jun.26.20

Enumerator
BSP_I0_PORT_00 10 port 0.
BSP_10_PORT 01 10 port 1.
BSP_IO_PORT 02 10 port 2.
BSP_|O_PORT_03 10 port 3.
BSP_IO_PORT_04 10 port 4.
BSP_IO_PORT_05 10 port 5.
BSP_10_PORT_06 IO port 6.
BSP_I0_PORT_07 10 port 7.
BSP_I0_PORT_08 10 port 8.
BSP_10_PORT_09 IO port 9.
BSP_IO_PORT 10 10 port 10.
BSP_|0_PORT_11 10 port 11.
¢ bsp_io_port_pin_t
enum bsp_io_port _pin_t
Superset list of all possible 10 port pins.
Enumerator
BSP_I0_PORT_00_PIN_00 10 port 0 pin 0.
BSP_|O_PORT_00_PIN_01 |0 port 0 pin 1.
BSP_I0_PORT_00 PIN 02 10 port 0 pin 2.
BSP_I0_PORT 00 PIN_03 10 port 0 pin 3.
BSP_I0_PORT _00 PIN_04 10 port 0 pin 4.
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BSP_IO_PORT 00 _PIN_05

IO port 0 pin 5.
BSP_IO_PORT_00 _PIN_06 |0 port 0 pin 6.
BSP_IO_PORT_00_PIN_07 IO port 0 pin 7.
BSP_I0_PORT 00 PIN_08 10 port 0 pin 8.
BSP_I0_PORT 00 PIN_09 10 port 0 pin 9.

BSP_IO_PORT 00 _PIN_10

IO port 0 pin 10.

BSP_10_PORT 00 PIN_11

IO port 0 pin 11.

BSP_IO_PORT_00 PIN_12

IO port 0 pin 12.

BSP_|O_PORT 00 PIN 13

IO port 0 pin 13.

BSP_IO_PORT 00 PIN_14

IO port O pin 14.

BSP_I0_PORT 00 PIN_15

IO port 0 pin 15.

BSP_IO_PORT 01 _PIN_00

10 port 1 pin 0.
BSP_I0_PORT 01 PIN 01 10 port 1 pin 1.
BSP_IO_PORT_01_PIN_02 10 port 1 pin 2.
BSP_IO_PORT_01_PIN_03 10 port 1 pin 3.
BSP_I0_PORT 01 PIN_04 10 port 1 pin 4.
BSP_I0_PORT 01 PIN_05 10 port 1 pin 5.
BSP_IO_PORT_01_PIN_06 |0 port 1 pin 6.
BSP_IO_PORT_01_PIN_07 10 port 1 pin 7.
BSP_I0_PORT 01 PIN_08 10 port 1 pin 8.
BSP_10_PORT 01 PIN_09 10 port 1 pin 9.

BSP_IO_PORT 01 _PIN_10

IO port 1 pin 10.

BSP_10_PORT 01 PIN_11

IO port 1 pin 11.

BSP_IO_PORT_01_PIN_12

IO port 1 pin 12.
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BSP_IO_PORT 01 PIN 13

IO port 1 pin 13.

BSP_|O_PORT 01 PIN_14

IO port 1 pin 14.

BSP_I0_PORT 01 PIN_15

IO port 1 pin 15.

BSP_IO_PORT_02_PIN_00

10 port 2 pin 0.
BSP_I0_PORT 02 PIN 01 10 port 2 pin 1.
BSP_IO_PORT_02_PIN_02 |0 port 2 pin 2.
BSP_IO_PORT_02_PIN_03 |0 port 2 pin 3.
BSP_I0_PORT 02 PIN_04 10 port 2 pin 4.
BSP_I0_PORT 02 _PIN_05 10 port 2 pin 5.
BSP_IO_PORT_02_PIN_06 |0 port 2 pin 6.
BSP_IO_PORT_02_PIN_07 1O port 2 pin 7.
BSP_10_PORT 02 PIN_08 10 port 2 pin 8.
BSP_10_PORT 02 _PIN_09 10 port 2 pin 9.

BSP_IO_PORT 02_PIN_10

IO port 2 pin 10.

BSP_10_PORT 02 PIN_11

IO port 2 pin 11.

BSP_IO_PORT_02_PIN_12

IO port 2 pin 12.

BSP_IO_PORT_02_PIN 13

IO port 2 pin 13.

BSP_IO_PORT 02_PIN_14

IO port 2 pin 14.

BSP_I0_PORT 02_PIN_15

IO port 2 pin 15.

BSP_IO_PORT _03_PIN_00

IO port 3 pin 0.
BSP_I0_PORT 03 PIN 01 10 port 3 pin 1.
BSP_IO_PORT_03_PIN_02 10 port 3 pin 2.
BSP_IO_PORT_03_PIN_03 |0 port 3 pin 3.
BSP_I0_PORT 03 PIN_04 10 port 3 pin 4.
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BSP_IO_PORT 03_PIN_05

IO port 3 pin 5.
BSP_IO_PORT_03_PIN_06 |0 port 3 pin 6.
BSP_IO_PORT_03_PIN_07 IO port 3 pin 7.
BSP_I0_PORT_03_PIN_08 10 port 3 pin 8.
BSP_10_PORT_03_PIN_09 10 port 3 pin 9.

BSP_IO_PORT 03_PIN_10

IO port 3 pin 10.

BSP_10_PORT 03_PIN_11

IO port 3 pin 11.

BSP_IO_PORT_03_PIN_12

IO port 3 pin 12.

BSP_|O_PORT 03 _PIN 13

IO port 3 pin 13.

BSP_IO_PORT 03_PIN_14

IO port 3 pin 14.

BSP_I0_PORT 03_PIN_15

IO port 3 pin 15.

BSP_IO_PORT 04 _PIN_00

10 port 4 pin 0.
BSP_I0_PORT 04 PIN 01 10 port 4 pin 1.
BSP_IO_PORT_04_PIN_02 |0 port 4 pin 2.
BSP_IO_PORT_04_PIN_03 |0 port 4 pin 3.
BSP_I0_PORT 04 PIN_04 10 port 4 pin 4.
BSP_I0_PORT 04 PIN_05 10 port 4 pin 5.
BSP_IO_PORT_04_PIN_06 |0 port 4 pin 6.
BSP_IO_PORT_04_PIN_07 1O port 4 pin 7.
BSP_I0_PORT 04 PIN_08 10 port 4 pin 8.
BSP_10_PORT 04 PIN_09 10 port 4 pin 9.

BSP_IO_PORT 04 _PIN_10

IO port 4 pin 10.

BSP_10_PORT 04 PIN_11

IO port 4 pin 11.

BSP_IO_PORT_04 PIN_12

IO port 4 pin 12.

R11UMO0146EU0120 Revision 1.20
Jun.26.20

RLENESAS

Page 173 /1,560



Flexible Software Package

API Reference > BSP > BSP I/O access

User’s Manual

BSP_|O_PORT 04 PIN 13

IO port 4 pin 13.

BSP_IO_PORT 04 PIN_14

IO port 4 pin 14.

BSP_I0_PORT 04 PIN_15

IO port 4 pin 15.

BSP_IO_PORT_05_PIN_00

IO port 5 pin 0.
BSP_I0_PORT 05 PIN 01 10 port 5 pin 1.
BSP_IO_PORT_05_PIN_02 10 port 5 pin 2.
BSP_IO_PORT_05_PIN_03 |0 port 5 pin 3.
BSP_I0_PORT 05 PIN_04 10 port 5 pin 4.
BSP_IO_PORT_05_PIN_05 10 port 5 pin 5.
BSP_IO_PORT_05_PIN_06 |0 port 5 pin 6.
BSP_IO_PORT_05_PIN_07 10 port 5 pin 7.
BSP_IO_PORT_05_PIN_08 |0 port 5 pin 8.
BSP_IO_PORT_05_PIN_09 10 port 5 pin 9.

BSP_IO_PORT 05 _PIN_10

IO port 5 pin 10.

BSP_10_PORT 05 PIN_11

IO port 5 pin 11.

BSP_IO_PORT_05 PIN_12

IO port 5 pin 12.

BSP_|O_PORT 05 PIN 13

IO port 5 pin 13.

BSP_IO_PORT 05 PIN_14

IO port 5 pin 14.

BSP_I0_PORT 05 PIN_15

IO port 5 pin 15.

BSP_IO_PORT_06_PIN_00

IO port 6 pin 0.
BSP_ 10 _PORT 06 PIN 01 10 port 6 pin 1.
BSP_IO_PORT_06_PIN_02 |0 port 6 pin 2.
BSP_IO_PORT_06_PIN_03 1O port 6 pin 3.
BSP_I0_PORT 06 _PIN_04 IO port 6 pin 4.
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BSP_IO_PORT _06_PIN_05

IO port 6 pin 5.
BSP_|O_PORT_06_PIN_06 |0 port 6 pin 6.
BSP_IO_PORT_06_PIN_07 IO port 6 pin 7.
BSP_I0_PORT 06 _PIN_08 10 port 6 pin 8.
BSP_10_PORT 06 _PIN_09 10 port 6 pin 9.

BSP_IO_PORT 06_PIN_10

IO port 6 pin 10.

BSP_10_PORT 06 PIN_11

IO port 6 pin 11.

BSP_IO_PORT_06_PIN_12

IO port 6 pin 12.

BSP_|O_PORT 06 PIN 13

IO port 6 pin 13.

BSP_IO_PORT 06_PIN_14

IO port 6 pin 14.

BSP_I0_PORT 06 _PIN_15

IO port 6 pin 15.

BSP_IO_PORT_07_PIN_00

10 port 7 pin 0.
BSP_I0_PORT 07 _PIN 01 10 port 7 pin 1.
BSP_IO_PORT_07_PIN_02 |0 port 7 pin 2.
BSP_IO_PORT_07_PIN_03 |0 port 7 pin 3.
BSP_I0_PORT 07 _PIN_04 10 port 7 pin 4.
BSP_10_PORT 07 _PIN_05 10 port 7 pin 5.
BSP_IO_PORT_07_PIN_06 |0 port 7 pin 6.
BSP_IO_PORT_07_PIN_07 10 port 7 pin 7.
BSP_I0_PORT 07 _PIN_08 10 port 7 pin 8.
BSP_10_PORT_07_PIN_09 10 port 7 pin 9.

BSP_IO_PORT 07_PIN_10

IO port 7 pin 10.

BSP_10_PORT 07 PIN_11

IO port 7 pin 11.

BSP_IO_PORT_07_PIN_12

IO port 7 pin 12.
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BSP_IO_PORT_07_PIN_13

IO port 7 pin 13.

BSP_IO_PORT 07_PIN_14

IO port 7 pin 14.

BSP_I0_PORT 07 _PIN_15

IO port 7 pin 15.

BSP_IO_PORT_08_PIN_00

IO port 8 pin 0.
BSP_I0_PORT 08 PIN 01 10 port 8 pin 1.
BSP_IO_PORT_08 PIN_02 |0 port 8 pin 2.
BSP_IO_PORT_08 PIN_03 |0 port 8 pin 3.
BSP_I0_PORT 08 PIN_04 10 port 8 pin 4.
BSP_IO_PORT_08_PIN_05 |0 port 8 pin 5.
BSP_IO_PORT_08 _PIN_06 |0 port 8 pin 6.
BSP_IO_PORT_08 PIN_07 |0 port 8 pin 7.
BSP_IO_PORT_08_PIN_08 |0 port 8 pin 8.
BSP_IO_PORT_08_PIN_09 10 port 8 pin 9.

BSP_IO_PORT 08_PIN_10

IO port 8 pin 10.

BSP_10_PORT 08_PIN_11

IO port 8 pin 11.

BSP_IO_PORT_08_PIN_12

IO port 8 pin 12.

BSP_|O_PORT 08 _PIN 13

IO port 8 pin 13.

BSP_IO_PORT 08_PIN_14

IO port 8 pin 14.

BSP_I0_PORT 08 _PIN_15

IO port 8 pin 15.

BSP_IO_PORT_09_PIN_00

IO port 9 pin 0.
BSP_10_PORT 09 PIN 01 10 port 9 pin 1.
BSP_IO_PORT_09 PIN_02 10 port 9 pin 2.
BSP_IO_PORT_09 PIN_03 1O port 9 pin 3.
BSP_I0_PORT _09 PIN 04 IO port 9 pin 4.
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BSP_IO_PORT 09 PIN_05

IO port 9 pin 5.
BSP_IO_PORT_09 PIN_06 |0 port 9 pin 6.
BSP_IO_PORT_09 _PIN_07 IO port 9 pin 7.
BSP_I0_PORT 09 PIN_08 10 port 9 pin 8.
BSP_10_PORT_09 PIN_09 10 port 9 pin 9.

BSP_IO_PORT 09 PIN_10

IO port 9 pin 10.

BSP_10_PORT 09 PIN_11

IO port 9 pin 11.

BSP_IO_PORT_09 PIN_12

IO port 9 pin 12.

BSP_|O_PORT 09 PIN 13

IO port 9 pin 13.

BSP_IO_PORT 09 PIN_14

IO port 9 pin 14.

BSP_I0_PORT 09 PIN_15

IO port 9 pin 15.

BSP_IO_PORT_10_PIN_00

IO port 10 pin 0.

BSP_IO_PORT_10_PIN_01

IO port 10 pin 1.

BSP_|O_PORT _10_PIN_02

IO port 10 pin 2.

BSP_10_PORT 10 PIN_03

0 port 10 pin 3.

BSP_IO_PORT 10 _PIN_04

IO port 10 pin 4.

BSP_|O_PORT_10 PIN 05

IO port 10 pin 5.

BSP_IO_PORT_10_PIN_06

IO port 10 pin 6.

BSP_10_PORT 10 PIN_07

IO port 10 pin 7.

BSP_IO_PORT 10 PIN 08

IO port 10 pin 8.

BSP_|O_PORT_10 PIN_09

IO port 10 pin 9.

BSP_IO_PORT 10 _PIN_10

IO port 10 pin 10.

BSP_10_PORT 10 PIN_11

|0 port 10 pin 11.

BSP_IO_PORT_10 PIN_12

|0 port 10 pin 12.
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BSP_IO_PORT_10_PIN 13

IO port 10 pin 13.

BSP_|O_PORT 10 _PIN_14

IO port 10 pin 14.

BSP_10_PORT 10 PIN_15

|0 port 10 pin 15.

BSP_IO_PORT_11_PIN_00

IO port 11 pin O.

BSP_IO_PORT_11_PIN_01

IO port 11 pin 1.

BSP_|O_PORT 11_PIN_02

IO port 11 pin 2.

BSP_10_PORT 11 PIN_03

0 port 11 pin 3.

BSP_IO_PORT_11_PIN_04

0 port 11 pin 4.

BSP_IO_PORT_11_PIN_05

IO port 11 pin 5.

BSP_|O_PORT 11 _PIN_06

IO port 11 pin 6.

BSP_10_PORT 11 PIN_07

0 port 11 pin 7.

BSP_IO_PORT_11_PIN_08

IO port 11 pin 8.

BSP_IO_PORT_11_PIN_09

IO port 11 pin 9.

BSP_IO_PORT 11 PIN_10

IO port 11 pin 10.

BSP_10_PORT 11 PIN_11

0 port 11 pin 11.

BSP_IO_PORT_11_PIN_12

10 port 11 pin 12.

BSP_IO_PORT 11 PIN 13

IO port 11 pin 13.

BSP_|O_PORT 11 PIN_14

IO port 11 pin 14.

BSP_10_PORT 11 PIN_15

0 port 11 pin 15.

Function Documentation
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¢ R_BSP_PinRead()

__STATIC_INLINE uint32_t R_BSP_PinRead ( bsp_io_port_pin_t pin)

Read the current input level of the pin.

Parameters

[in] pin The pin

Return values

Current input level

4 R_BSP_PinWrite()

__STATIC_INLINE void R_BSP_PinWrite ( bsp_io_port pin_t pin, bsp_io_level t level )

Set a pin to output and set the output level to the level provided

Parameters
[in] pin The pin
[in] level The level

& R_BSP_PinAccessEnable()

__STATIC_INLINE void R_BSP_PinAccessEnable ( void )

Enable access to the PFS registers. Uses a reference counter to protect against interrupts that
could occur via multiple threads or an ISR re-entering this code.

4 R_BSP_PinAccessDisable()

__STATIC_INLINE void R_BSP_PinAccessDisable ( void )

Disable access to the PFS registers. Uses a reference counter to protect against interrupts that
could occur via multiple threads or an ISR re-entering this code.

4.2 Modules

Detailed Description

Modules are the smallest unit of software available in the FSP. Each module implements one
interface.
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For more information on FSP Modules and Interfaces review FSP Modules, FSP Stacks and FSP
Interfaces in the FSP Architecutre section of this manual.

Organization of Module Sections

Each module within FSP has a detailed Users' Guide listed below. Each guide typically includes the
following content:

Functions: A list of all the API functions associated with the module

Detailed Description: A short description of the module and the peripherals used

Overview: An operational summary and a list of high level features provided by the module

Configuration: A description of module specific settings available in the configuration tool

including clock and pin configurations

e Usage Notes: Module specific documentation and limitations

e Examples: lllustrative code snippets that help the user better understand API use and
operation

e Data Structure and Enumeration: Definitions for data structures, enumerations and similar
elements used by the module API

e Function Documentation: Details on each API function, including the function prototype, a

function summary, a simple use example, list of return values and links to documentation

for any needed parameter definitions

Modules
High-Speed Analog Comparator (r_acmphs)

Driver for the ACMPHS peripheral on RA MCUs. This module
implements the Comparator Interface.

Low-Power Analog Comparator (r_acmplp)

Driver for the ACMPLP peripheral on RA MCUs. This module
implements the Comparator Interface.

Analog to Digital Converter (r_adc)

Driver for the ADC12, ADC14, and ADC16 peripherals on RA MCUs.
This module implements the ADC Interface.

Asynchronous General Purpose Timer (r_agt)

Driver for the AGT peripheral on RA MCUs. This module implements
the Timer Interface.

Bluetooth Low Energy Library (r_ble)

Driver for the Radio peripheral on RA MCUs. This module implements
the BLE Interface.

Clock Frequency Accuracy Measurement Circuit (r_cac)
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Driver for the CAC peripheral on RA MCUs. This module implements
the CAC Interface.

Controller Area Network (r_can)

Driver for the CAN peripheral on RA MCUs. This module implements
the CAN Interface.

Clock Generation Circuit (r_cgc)

Driver for the CGC peripheral on RA MCUs. This module implements
the CGC Interface.

Cyclic Redundancy Check (CRC) Calculator (r_crc)

Driver for the CRC peripheral on RA MCUs. This module implements
the CRC Interface.

Capacitive Touch Sensing Unit (r_ctsu)

This HAL driver supports the Capacitive Touch Sensing Unit (CTSU). It
implements the CTSU Interface.

Digital to Analog Converter (r_dac)

Driver for the DAC12 peripheral on RA MCUs. This module
implements the DAC Interface.

Digital to Analog Converter (r_dac8)

Driver for the DACS8 peripheral on RA MCUs. This module implements
the DAC Interface.

Direct Memory Access Controller (r_dmac)

Driver for the DMAC peripheral on RA MCUs. This module implements
the Transfer Interface.

Data Operation Circuit (r_doc)

Driver for the DOC peripheral on RA MCUs. This module implements
the DOC Interface.

D/AVE 2D Port Interface (r_drw)

Driver for the DRW peripheral on RA MCUs. This module is a port of
D/AVE 2D.
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Data Transfer Controller (r_dtc)

Driver for the DTC peripheral on RA MCUs. This module implements
the Transfer Interface.

Event Link Controller (r_elc)

Driver for the ELC peripheral on RA MCUs. This module implements
the ELC Interface.

Ethernet (r_ether)

Driver for the Ethernet peripheral on RA MCUs. This module
implements the Ethernet Interface.

Ethernet PHY (r_ether_phy)

The Ethernet PHY module (r_ether_phy) provides an API for standard
Ethernet PHY communications applications that use the ETHERC
peripheral. It implements the Ethernet PHY Interface.

High-Performance Flash Driver (r_flash_hp)

Driver for the flash memory on RA high-performance MCUs. This
module implements the Flash Interface.

Low-Power Flash Driver (r_flash_Ip)

Driver for the flash memory on RA low-power MCUs. This module
implements the Flash Interface.

Graphics LCD Controller (r_glcdc)

Driver for the GLCDC peripheral on RA MCUs. This module
implements the Display Interface.

General PWM Timer (r_gpt)

Driver for the GPT32 and GPT16 peripherals on RA MCUs. This
module implements the Timer Interface.

General PWM Timer Three-Phase Motor Control Driver
(r_gpt_three_phase)

Driver for 3-phase motor control using the GPT peripheral on RA
MCUs. This module implements the Three-Phase Interface.
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Interrupt Controller Unit (r_icu)

Driver for the ICU peripheral on RA MCUs. This module implements
the External IRQ Interface.

I2C Master on IIC (r_iic_master)

Driver for the IIC peripheral on RA MCUs. This module implements
the 12C Master Interface.

I2C Slave on IIC (r_iic_slave)

Driver for the IIC peripheral on RA MCUs. This module implements
the 12C Slave Interface.

I/0 Ports (r_ioport)

Driver for the I/O Ports peripheral on RA MCUs. This module
implements the I/O Port Interface.

Independent Watchdog Timer (r_iwdt)

Driver for the IWDT peripheral on RA MCUs. This module implements
the WDT Interface.

JPEG Codec (r_jpeg)

Driver for the JPEG peripheral on RA MCUs. This module implements
the JPEG Codec Interface.

Key Interrupt (r_kint)

Driver for the KINT peripheral on RA MCUs. This module implements
the Key Matrix Interface.

Low Power Modes (r_Ipm)

Driver for the LPM peripheral on RA MCUs. This module implements
the Low Power Modes Interface.

Low Voltage Detection (r_Ivd)

Driver for the LVD peripheral on RA MCUs. This module implements
the Low Voltage Detection Interface.

Operational Amplifier (r_opamp)
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Driver for the OPAMP peripheral on RA MCUs. This module
implements the OPAMP Interface.

Parallel Data Capture (r_pdc)

Driver for the PDC peripheral on RA MCUs. This module implements
the PDC Interface.

Port Output Enable for GPT (r_poeg)

Driver for the POEG peripheral on RA MCUs. This module implements
the POEG Interface.

Quad Serial Peripheral Interface Flash (r_qgspi)

Driver for the QSPI peripheral on RA MCUs. This module implements
the SPI Flash Interface.

Realtime Clock (r_rtc)

Driver for the RTC peripheral on RA MCUs. This module implements
the RTC Interface.

Serial Communications Interface (SCI) 12C (r_sci_i2c)

Driver for the SCI peripheral on RA MCUs. This module implements
the 12C Master Interface.

Serial Communications Interface (SCI) SPI (r_sci_spi)

Driver for the SCI peripheral on RA MCUs. This module implements
the SPI Interface.

Serial Communications Interface (SCI) UART (r_sci_uart)

Driver for the SCI peripheral on RA MCUs. This module implements
the UART Interface.

Sigma Delta Analog to Digital Converter (r_sdadc)

Driver for the SDADC24 peripheral on RA MCUs. This module
implements the ADC Interface.

SD/MMC Host Interface (r_sdhi)
Driver for the SD/MMC Host Interface (SDHI) peripheral on RA MCUs.
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This module implements the SD/MMC Interface.

Segment LCD Controller (r_slcdc)

Driver for the SLCDC peripheral on RA MCUs. This module
implements the SLCDC Interface.

Serial Peripheral Interface (r_spi)

Driver for the SPI peripheral on RA MCUs. This module implements
the SPI Interface.

Serial Sound Interface (r_ssi)

Driver for the SSIE peripheral on RA MCUs. This module implements
the 12S Interface.

USB (r_usb_basic)

Driver for the USB peripheral on RA MCUs. This module implements
the USB Interface.

USB Host Communications Device Class Driver (r_usb_hcdc)

This module provides a USB Host Communications Device Class
(HCDC) driver. It implements the USB HCDC Interface.

USB Host Human Interface Device Class Driver (r_usb_hhid)

This module provides a USB Host Human Interface Device Class
Driver (HHID). It implements the USB HHID Interface.

USB Host Mass Storage Class Driver (r_usb_hmsc)

This module provides a USB Host Mass Storage Class (HMSC) driver.
It implements the USB HMSC Interface.

USB Peripheral Communications Device Class (r_usb_pcdc)

This module provides a USB Peripheral Communications Device Class
Driver (PCDC). It implements the USB PCDC Interface.

USB Peripheral Human Interface Device Class (r_usb_phid)

This module is USB Peripheral Human Interface Device Class Driver
(PHID). It implements the USB PHID Interface.
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USB Peripheral Mass Storage Class (r_usb_pmsc)

This module provides a USB Peripheral Mass Storage Class (PMSC)
driver. It implements the USB PMSC Interface.

Watchdog Timer (r_wdt)

Driver for the WDT peripheral on RA MCUs. This module implements
the WDT Interface.

AWS PKCS11 PAL (rm_aws_pkcsll _pal)
PKCS#11 PAL layer implementation for use by FreeRTOS TLS.

AWS PKCS11 PAL LITTLEFS (rm_aws_pkcsll pal_littlefs)

PKCS#11 PAL LittleFS layer implementation for use by FreeRTOS
TLS.

Bluetooth Low Energy Abstraction (rm_ble_abs)

Middleware for the Bluetooth peripheral on RA MCUs. This module
implements the BLE ABS Interface.

SD/MMC Block Media Implementation (rm_block_media_sdmmc)

Middleware to implement the block media interface on SD cards.
This module implements the Block Media Interface.

USB HMSC Block Media Implementation (rm_block_media_usb)

Middleware to implement the block media interface on USB mass
storage devices. This module implements the Block Media Interface.

SEGGER emWin Port (rm_emwin_port)
SEGGER emWin port for RA MCUs.

FreeRTOS+FAT Port (rm_freertos_plus_fat)
Middleware for the FAT File System control on RA MCUs.

FreeRTOS Plus TCP (rm_freertos_plus_tcp)
Middleware for using TCP on RA MCUs.
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FreeRTOS Port (rm_freertos_port)
FreeRTOS port for RA MCUs.

LittleFS Flash Port (rm_littlefs flash)
Middleware for the LittleFS File System control on RA MCUs.

Crypto Middleware (rm_psa_crypto)

Hardware acceleration for the mbedCrypto implementation of the
ARM PSA Crypto API.

Capacitive Touch Middleware (rm_touch)

This module supports the Capacitive Touch Sensing Unit (CTSU). It
implements the Touch Middleware Interface.

AWS Device Provisioning

AWS Device Provisioning example software.

AWS MQTT
This module provides the AWS MQTT integration documentation.

Wifi Middleware (rm_wifi_onchip_silex)

Wifi and Socket implementation using the Silex SX-ULPGN WiFi
module on RA MCUs.

AWS Secure Sockets

This module provides the AWS Secure Sockets implementation.

4.2.1 High-Speed Analog Comparator (r_acmphs)

Modules
Functions
fsp_err t R_ACMPHS Open (comparator_ctrl _t *p_ctrl, comparator_cfg t const
*const p_cfg)
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fsp_err t R_ACMPHS OutputEnable (comparator ctrl _t *const p_ctrl)

fsp_err t R_ACMPHS InfoGet (comparator _ctrl_t *const p_ctrl,
comparator_info_t *const p_info)

fsp_err t R_ACMPHS_StatusGet (comparator_ctrl_t *const p_ctrl,
comparator_status_t *const p_status)

fsp_err t R_ACMPHS Close (comparator_ctrl_t *const p_ctrl)

fsp_err t R_ACMPHS VersionGet (fsp_version_t *const p_version)

Detailed Description

Driver for the ACMPHS peripheral on RA MCUs. This module implements the Comparator Interface.

Overview

Features
The ACMPHS HAL module supports the following features:

Callback on rising edge, falling edge or both
Configurable debounce filter

Option for comparator output on VCOUT pin
ELC event output

Configuration

Build Time Configurations for r_acmphs

The following build time configurations are defined in fsp_cfg/r_ acmphs_cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
e Enabled parameter checking is
e Disabled included in the build.

Configurations for Driver > Analog > Comparator Driver on r_acmphs

This module can be added to the Stacks tab via New Stack > Driver > Analog > Comparator Driver
on r_acmphs:

Configuration Options Default Description
Name Name must be a valid g _comparatorQ Module name.
C symbol
Channel Value must be a non- 0 Select the hardware
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negative integer channel.
Trigger Edge Selector ¢ Rising Both Edge The trigger specifies
¢ Falling when a comparator
e Both Edge callback event should

occur. Unused if the
interrupt priority is
disabled or the callback
is NULL.

No Filter No Filter Select the PCLK divisor
8 for the hardware digital
16 debounce filter. Larger
e 32 divisors provide a
longer debounce and
take longer for the
output to update.

Noise Filter

Maximum status retries Must be a valid non- 1024 Maximum number of
(CMPMON) negative integer status retries.
between 2 and 32-bit
maximum value

Output Polarity * Not Inverted Not Inverted When enabled
¢ Inverted comparator output is
inverted. This affects
the output read from
R_ACMPHS StatusGet()
, the pin output level,
and the edge trigger.

Pin Output(VCOUT) e Disabled Disabled Turn this on to include
¢ Enabled the output from this

comparator on VCOUT.
The comparator output
on VCOUT is OR'd with
output from all other
ACMPHS and ACMPLP
comparators.

Callback Name must be a valid  NULL Define this function in
C symbol the application. It is
called when the Trigger
event occurs.

Comparator Interrupt MCU Specific Options Select the interrupt
Priority priority for the
comparator interrupt.

Analog Input Voltage MCU Specific Options Select the Analog input

Source (IVCMP) voltage source.
Channel mentioned in
the options represents
channel in ACMPHS

Reference Voltage MCU Specific Options Select the Analog
Input Source (IVREF) reference voltage
source. Channel
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mentioned in the
options represents
channel in ACMPHS

Clock Configuration

The ACMPHS peripheral is clocked from PCLKB. You can set the PCLKB frequency using the Clocks
tab of the RA Configuration editor or by using the CGC Interface at run-time.

Pin Configuration

Comparator output can be enabled or disabled on each channel individually. The VCOUT pin is a
logical OR of all comparator outputs.

The IVCMPn pins are used as comparator inputs. The IVREFn pins are used as comparator reference
values.

Usage Notes

Noise Filter

When the noise filter is enabled, the ACMPHPO/ACMPHP1 signal is sampled three times based on the
sampling clock selected. The filter clock frequency is determined by PCLKB and the
comparator_filter_t setting.

Output Polarity

If output polarity is configured as "Inverted" then the VCOUT signal will be inverted and the
R_ACMPHS StatusGet() will return an inverted status.

Limitations

e Once the analog comparator is configured, the program must wait for the stabilization time
to elapse before using the comparator.

¢ When the noise filter is not enabled the hardware requires software debouncing of the
output (two consecutive equal values). This is automatically managed in
R_ACMPHS_StatusGet but may result in delay or an API error in rare edge cases.

e Constraints apply on the simultaneous use of ACMPHS analog input and ADC analog input.
Refer to the "Usage Notes" section in your MCU's User's Manual for the ADC unit(s) for more
details.

e To allow ACMPHSO to cancel Software Standby mode or enter Snooze, set the CSTEN bit to
1 and the CDFS bits to 00 in the CMPCTLO register.

Examples

Basic Example

The following is a basic example of minimal use of the ACMPHS. The comparator is configured to
trigger a callback when the input rises above the internal reference voltage (VREF). A GPIO output
acts as the comparator input and is externally connected to the IVCMP input of the ACMPHS.

/* Connect this control pin to the VCW input of the conparator. This can be any GPIO

pin
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* that is not input only. */

#def i ne ACMPHS_EXAMPLE_CONTROL_PI N (BSP_I O PORT_05_PI N_03)

#def i ne ADC_PGA BYPASS_VALUE (0x9999)

volatile uint32_t g conparator_events = 0U

/* This callback is called when a conparator event occurs. */

voi d acnphs_exanpl e_cal | back (conparator_cal | back_args_t * p_args)

{

FSP_PARAMVETER_NOT

USED(p_ar gs) ;

g_conpar at or _event s++;

}

voi d acnphs_exanpl e ()

{

fsp_err_t err = FSP_SUCCESS;

/* Disable pin register wite protection, if enabled */

R BSP_Pi nAccessEnabl e() ;

/* Start with the VCVMP pin | ow This exanple assunes the conparat or

trigger

* when VCMP ri ses above VREF. */

(void) R BSP_PinWite( ACMPHS EXAMPLE CONTROL_PIN, BSP_| O LEVEL_LOW);

/* Initialize the ACMPHS nodul e */

err = R_ACMPHS

Open(&g_conparator_ctrl, &g_conparator_cfqg);

/* Handl e any errors. This function should be defined by the user

handl e _error(err);

/* Bypass PGA on ADC unit O.

* (See Table 50.2 "Input source configuration of the ACVPHS"

Manual ( RO1UHO886EJ0100)) */

R_BSP_MODULE_START(FSP_I P_ADC, 0);

R ADCO- >ADPGACR = ADC_PGA BYPASS VALUE;

R_ADCD- >ADPGADCRO = O0;

/* Wait for the mininmumstabilization wait tinme before enabling output.

conparator _info_t

i nfo;

R _ACMPHS | nf oGet (&g conparator_ctrl, & nfo);

R BSP_Sof t war eDel ay(i nfo. m n_stabilization_wait_us

/* Enabl e the conparator output */

is configured to

*/

*/

in the RAGMB User's

BSP_DELAY_UNI TS_M CROSECONDS) ;
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(voi d) R _ACMPHS Qut put Enabl e( &g_conparator _ctrl);
/* Set the VCWP pin high. */
(void) R BSP_Pi nWite(ACVMPHS EXAMPLE CONTROL_PIN, BSP_I O LEVEL H GH);

while (0 == g_conparator_events)
{

/* Wait for interrupt. */
}

conparator_status_t status;
/* Check status of conparator, Status wll be COVPARATOR STATE OQUTPUT_HI GH */
(void) R ACMPHS St atusCet (&g_conparator_ctrl, &status);

Function Documentation

¢ R_ACMPHS _Open()

fsp_err t R_ACMPHS Open ( comparator_ctrl_t *const p_ctrl, comparator_cfg_t const *const p cfg

)

Configures the comparator and starts operation. Callbacks and pin output are not active until
outputEnable() is called. comparator_api_t::outputEnable() should be called after the output has
stabilized. Implements comparator_api_t::open().

Comparator inputs must be configured in the application code prior to calling this function.

Return values

FSP_SUCCESS Open successful.
FSP_ERR_ASSERTION An input pointer is NULL
FSP_ERR_INVALID ARGUMENT An argument is invalid. Window mode

(COMPARATOR_MODE_WINDOW) and filter
of 1 (COMPARATOR FILTER 1) are not
supported in this implementation.

FSP_ERR_ALREADY_OPEN The control block is already open or the
hardware lock is taken.
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¢ R_ACMPHS_OutputEnable()

fsp_err_ t R_ ACMPHS OutputEnable ( comparator_ctrl_t *const p_ctr/)

Enables the comparator output, which can be polled using comparator_api_t::statusGet(). Also
enables pin output and interrupts as configured during comparator_api_t::open(). Implements
comparator_api_t::outputEnable().

Return values

FSP_SUCCESS Comparator output is enabled.
FSP_ERR_ASSERTION An input pointer was NULL.
FSP_ERR_NOT_OPEN Instance control block is not open.

¢ R_ACMPHS _InfoGet()

fsp_err_t R_ACMPHS _InfoGet ( comparator_ctrl_t *const p_ctrl, comparator_info_t *const p_info )

Provides the minimum stabilization wait time in microseconds. Implements
comparator_api_t::infoGet().

Return values

FSP_SUCCESS Information stored in p_info.
FSP_ERR_ASSERTION An input pointer was NULL.
FSP_ERR_NOT_OPEN Instance control block is not open.

¢ R_ACMPHS_StatusGet()

fsp_err t R_ ACMPHS StatusGet ( comparator_ctrl_t *const p_ctrl, comparator_status_t *const
p_status )

Provides the operating status of the comparator. Implements comparator_api_t::statusGet().

Return values

FSP_SUCCESS Operating status of the comparator is
provided in p_status.

FSP_ERR_ASSERTION An input pointer was NULL.

FSP_ERR_NOT _OPEN Instance control block is not open.

FSP_ERR_TIMEOUT The debounce filter is off and 2 consecutive
matching values were not read within 1024
attempts.
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# R_ACMPHS _Close()

fsp_err t R_ACMPHS Close ( comparator_ctrl t * p ctrl)

Stops the comparator. Implements comparator_api_t::close().

Return values

FSP_SUCCESS Instance control block closed successfully.
FSP_ERR_ASSERTION An input pointer was NULL.
FSP_ERR_NOT _OPEN Instance control block is not open.

¢ R_ACMPHS VersionGet()

fsp_err t R_ACMPHS VersionGet ( fsp_version_t *const p_version)

Gets the API and code version. Implements comparator_api_t::versionGet().

Return values

FSP_SUCCESS Version information available in p_version.

FSP_ERR_ASSERTION The parameter p_version is NULL.

4.2.2 Low-Power Analog Comparator (r_acmplp)

Modules
Functions
fsp_err t R_ACMPLP_Open (comparator_ctrl_t *const p_ctrl, comparator _cfg t
const *const p_cfqg)
fsp_err t R_ACMPLP_OutputEnable (comparator_ctrl_t *const p_ctrl)
fsp_err t R_ACMPLP_InfoGet (comparator_ctrl_t *const p_ctrl,
comparator_info_t *const p_info)
fsp_err t R_ACMPLP_StatusGet (comparator_ctrl_t *const p_ctrl,
comparator_status_t *const p_status)
fsp_err t R_ACMPLP_Close (comparator_ctrl_t *const p_ctrl)
fsp_err t R_ACMPLP VersionGet (fsp_version_t *const p_version)
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Detailed Description

Driver for the ACMPLP peripheral on RA MCUs. This module implements the Comparator Interface.

Overview

Features
The ACMPLP HAL module supports the following features:

e Normal mode or window mode

Callback on rising edge, falling edge or both
Configurable debounce filter

Option for comparator output on VCOUT pin
ELC event output

Configuration

Build Time Configurations for r_acmplp

The following build time configurations are defined in fsp_cfg/r_acmplp_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
e Enabled parameter checking is
e Disabled included in the build.
Reference Voltage e I[VREFO IVREF1 Reference Voltage
Selection for ACMPLP1 e IVREF1 Selection for ACMPLP1.
(Standard mode only) When set to IVREFO,

configure the reference
for ACMPLP channel 1
(if used) to one of the
channel 0 sources.

Configurations for Driver > Analog > Comparator Driver on r_acmplp

This module can be added to the Stacks tab via New Stack > Driver > Analog > Comparator Driver
on r_acmplp:

Configuration Options Default Description
Name Name must be a valid g _comparatorO Module name.
C symbol
Channel Value must be a non- 0 Select the hardware
negative integer channel.
Mode e Standard Standard In standard mode,
e Window comparator output is

high if VCMP > VREF. In
window mode,
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Trigger

Filter

Output Polarity

Pin Output (VCOUT)

Vref (Standard mode
only)

Callback

Comparator Interrupt
Priority

Analog Input Voltage
Source (IVCMP)

e Rising
e Falling
e Both Edge

e No sampling
(bypass)

e Sampling at
PCLKB

e Sampling at
PCLKB/8

¢ Sampling at
PCLKB/32

¢ Not Inverted
¢ |nverted

e Disabled
e Enabled

e Enabled
e Disabled

Name must be a valid
C symbol

MCU Specific Options

MCU Specific Options

Both Edge

No sampling (bypass)

Not Inverted

Disabled

Disabled

NULL

comparator output is
high if VCMP is outside
the range of VREFO to
VREF1.

The trigger specifies
when a comparator
callback event should
occur. Unused if the
interrupt priority is
disabled or the callback
is NULL.

Select the PCLK divisor
for the hardware digital
debounce filter. Larger
divisors provide a
longer debounce and
take longer for the
output to update.

When enabled
comparator output is
inverted. This affects
the output read from
R_ACMPLP_StatusGet(),
the pin output level,
and the edge trigger.

Turn this on to include
the output from this
comparator on VCOUT.
The comparator output
on VCOUT is OR'd with
output from all other
ACMPHS and ACMPLP
comparators.

If reference voltage
selection is enabled
then internal reference
voltage is used as
comparator input

Define this function in
the application. It is
called when the Trigger
event occurs.

Select the interrupt
priority for the
comparator interrupt.

Select the comparator
input source. Only
options for the
configured channel are
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valid.
Reference Voltage MCU Specific Options Select the comparator
Input Source (IVREF) reference voltage
source.

If channel 1 is
seleected and the
'Reference Voltage
Selection (ACMPLP1)'
config option is set to
IVREFO, select one of
the Channel 0 options.
In all other cases, only
options for the
configured channel are
valid.

Clock Configuration

The ACMPLP peripheral is clocked from PCLKB. You can set the PCLKB frequency using the Clocks
tab of the RA Configuration editor or by using the CGC Interface at run-time.

Pin Configuration

Comparator output can be enabled or disabled on each channel individually. The VCOUT pin is a
logical OR of all comparator outputs.

The CMPINN pins are used as comparator inputs. The CMPREFn pins are used as comparator
reference values.

Usage Notes

IVCMPn

IVREFn [ -
IVREER Reference voltage
Comparator 0 0

vCouT A
IVCMPR :
Analog Input

vcouTt

Figure 116: ACMPLP Standard Mode Operation

Noise Filter

When the noise filter is enabled, the ACMPLPO/ACMPLP1 signal is sampled three times based on the
sampling clock selected. The filter clock frequency is determined by PCLKB and the
comparator _filter_t setting.

R11UMO146EU0120 Revision 1.20 RENESANAS Page 197 / 1,560
Jun.26.20



Flexible Software Package User’s Manual

API| Reference > Modules > Low-Power Analog Comparator (r_acmplp)

Output Polarity

If output polarity is configured as "Inverted" then the VCOUT signal will be inverted and the
R_ACMPLP_StatusGet() will return an inverted status.

Window Mode

In window mode, the comparator indicates if the analog input voltage falls within the window (low
and high reference voltage) or is outside the window.

IVCMPn

Low reference
voltage
IVREFO
IVREF1
—
> IVREFO
Analog Input VCoUT
IWVCMPn ———»
VCOoUT
High reference i
WREF] —oltage

Figure 117: ACMPLP Window Mode Operation

Limitations

e Once the analog comparator is configured, the program must wait for the stabilization time
to elapse before using the comparator.
e Low speed is not supported by the ACMPLP driver.

Examples

Basic Example

The following is a basic example of minimal use of the ACMPLP. The comparator is configured to
trigger a callback when the input rises above the internal reference voltage (VREF). A GPIO output
acts as the comparator input and is externally connected to the CMPIN input of the ACMPLP.

/* Connect this control pin to the VCWP input of the conparator. This can be any GPI O
pin

* that is not input only. */

#def i ne ACMPLP_EXAMPLE_CONTROL_PI N (BSP_| O PORT_04_PI N_08)

volatile uint32_t g conparator_events = 0U,

/* This callback is called when a conparator event occurs. */

voi d acnpl p_exanpl e_cal | back (conparator_cal |l back _args t * p_args)

{
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Enumerations

acmplp_input_t
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enum acmplp_reference t

Enumeration Type Documentation

¢ acmplp_input_t

enum acmplp_input t

Enumerator

ACMPLP_INPUT_AMPO Not available on all MCUs.

ACMPLP_INPUT_CMPIN_1 Not available on all MCUs.

¢ acmplp_reference_t

enum acmplp_reference_t

Enumerator

ACMPLP_REFERENCE_CMPREF_1 Not available on all MCUs.

Function Documentation

¢ R_ACMPLP_Open()

fsp_err t R_ ACMPLP_Open ( comparator_ctrl_t *const p_ctrl, comparator_cfg_t const *const p cfg )

Configures the comparator and starts operation. Callbacks and pin output are not active until
outputEnable() is called. comparator_api_t::outputEnable() should be called after the output has
stabilized. Implements comparator_api_t::open().

Comparator inputs must be configured in the application code prior to calling this function.

Return values

FSP_SUCCESS Open successful.
FSP_ERR_ASSERTION An input pointer is NULL
FSP_ERR_INVALID ARGUMENT An argument is invalid. Window mode

(COMPARATOR_MODE_WINDOW) and filter
of 1 (COMPARATOR FILTER 1) are not
supported in this implementation.
p_cfg->p_callback is not NULL, but ISR is not
enabled. ISR must be enabled to use
callback function.

FSP_ERR_ALREADY_OPEN The control block is already open or the
hardware lock is taken.
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4 R_ACMPLP_OutputEnable()

fsp_err_ t R_ACMPLP_OutputEnable ( comparator_ctrl_t *const p_ctrl)

Enables the comparator output, which can be polled using comparator_api_t::statusGet(). Also
enables pin output and interrupts as configured during comparator_api_t::open(). Implements
comparator_api_t::outputEnable().

Return values

FSP_SUCCESS Comparator output is enabled.
FSP_ERR_ASSERTION An input pointer was NULL.
FSP_ERR_NOT_OPEN Instance control block is not open.

¢ R_ACMPLP_InfoGet()

fsp_err_t R_ACMPLP_InfoGet ( comparator_ctrl_t *const p_ctrl, comparator_info_t *const p_info )

Provides the minimum stabilization wait time in microseconds. Implements
comparator_api_t::infoGet().

Return values

FSP_SUCCESS Information stored in p_info.
FSP_ERR_ASSERTION An input pointer was NULL.
FSP_ERR_NOT_OPEN Instance control block is not open.

¢ R_ACMPLP_StatusGet()

fsp_err t R_ ACMPLP_StatusGet ( comparator_ctrl _t *const p_ctrl, comparator_status t *const
p_status )

Provides the operating status of the comparator. Implements comparator_api_t::statusGet().

Return values

FSP_SUCCESS Operating status of the comparator is
provided in p_status.
FSP_ERR_ASSERTION An input pointer was NULL.
FSP_ERR_NOT _OPEN Instance control block is not open.
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& R_ACMPLP_Close()

fsp_err_ t R_ACMPLP_Close ( comparator_ctrl t * p ctrl)

Stops the comparator. Implements comparator_api_t::close().

Return values

FSP_SUCCESS Instance control block closed successfully.
FSP_ERR_ASSERTION An input pointer was NULL.
FSP_ERR_NOT _OPEN Instance control block is not open.

¢ R_ACMPLP _VersionGet()

fsp_err_ t R_ACMPLP_VersionGet ( fsp_version_t *const p_version)

Gets the API and code version. Implements comparator_api_t::versionGet().

Return values

FSP_SUCCESS Version information available in p_version.

FSP_ERR_ASSERTION The parameter p_version is NULL.

4.2.3 Analog to Digital Converter (r_adc)

Modules

Functions
fsp_err t R_ADC Open (adc_ctrl_t *p_ctrl, adc_cfg_t const *const p_cfg)
fsp_err t R_ADC_ScanCfg (adc_ctrl_t *p_ctrl, void const *const p_extend)
fsp_err t R_ADC InfoGet (adc_ctrl_t *p_ctrl, adc_info_t *p_adc_info)
fsp_err t R_ADC ScanStart (adc_ctrl_t *p_ctrl)
fsp_err t R_ADC ScanStop (adc_ctrl_t *p_ctrl)
fsp_err t R_ADC StatusGet (adc_ctrl_t *p_ctrl, adc_status_t *p_status)
fsp_err t R_ADC Read (adc_ctrl_t *p_ctrl, adc_channel t const reg_id, uintl6 t

*const p_data)
fsp_err t R_ADC Read32 (adc_ctrl_t *p ctrl, adc_channel_t const reg_id,
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uint32_t *const p_data)

fsp_err t R_ADC_SampleStateCountSet (adc_ctrl_t *p_ctrl, adc_sample_state t
*p_sample)

fsp_err t R_ADC Close (adc_ctrl_t *p_ctrl)

fsp_err t R_ADC_OffsetSet (adc_ctrl_t *const p_ctrl, adc_channel_t const
reg_id, int32_t offset)

fsp_err t R_ADC Calibrate (adc_ctrl_t *const p_ctrl, void *const p_extend)

fsp_err t R_ADC VersionGet (fsp_version_t *const p_version)

Detailed Description

Driver for the ADC12, ADC14, and ADC16 peripherals on RA MCUs. This module implements the ADC
Interface.

Overview

Features
The ADC module supports the following features:

e 12, 14, or 16 bit maximum resolution depending on the MCU
e Configure scans to include:
o Multiple analog channels
o Temperature sensor channel
o Voltage sensor channel
e Configurable scan start trigger:
o Software scan triggers
o Hardware scan triggers (timer expiration, for example)
o External scan triggers from the ADTRGn port pins
e Configurable scan mode:
o Single scan mode, where each trigger starts a single scan
o Continuous scan mode, where all channels are scanned continuously
o Group scan mode, where channels are grouped into group A and group B. The
groups can be assigned different start triggers, and group A can be given priority
over group B. When group A has priority over group B, a group A trigger suspends
an ongoing group B scan.
e Supports adding and averaging converted samples
e Optional callback when scan completes
e Supports reading converted data
e Sample and hold support
e Double-trigger support

Configuration
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Build Time Configurations for r_adc

The following build time configurations are defined in fsp_cfg/r_adc_cfg.h:

Configuration

Description

Parameter Checking

Options Default
e Default (BSP) Default (BSP)
e Enabled
e Disabled

Configurations for Driver > Analog > ADC Driver on r_adc

If selected code for
parameter checking is
included in the build.

This module can be added to the Stacks tab via New Stack > Driver > Analog > ADC Driver on r_adc:

Configuration

Options Default

Description

General > Name

General > Unit

General > Resolution

General > Alignment

General > Clear after
read

Name must be a valid g _adcO
C symbol

Unit must be a non- 0
negative integer

MCU Specific Options

MCU Specific Options

o Off On

Module name

Specifies the ADC Unit
to be used.

Specifies the
conversion resolution
for this unit.

Specifies the
conversion result
alignment.

Specifies if the result
register will be
automatically cleared
after the conversion
result is read.

General > Mode ¢ Single Scan Single Scan Specifies the mode that
¢ Continuous this ADC unit is used in.
Scan
e Group Scan
General > Double- e Disabled Disabled When enabled, the
trigger e Enabled scan-end interrupt for
e Enabled Group A is only thrown
(extended on every second scan.
mode) Extended double-
trigger mode (single-
scan only) triggers on
both ELC events,
allowing (for example)
a scan on two different
timer compare match
values.
In group mode Group B
is unaffected.
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Input > Sample and
Hold > Sample and
Hold Channels
(Available only on
selected MCUs)

Input > Sample and
Hold > Sample Hold
States (Applies only to
channels 0, 1, 2)

Input > Channel Scan
Mask (channel
availability varies by
MCU)

Input > Group B Scan
Mask (channel
availability varies by
MCU)

Input > Add/Average
Count

Input > Reference
Voltage control

Input >
Addition/Averaging
Mask (channel
availability varies by
MCU and unit)

Interrupts >
Normal/Group A
Trigger

Interrupts > Group B
Trigger

e Channel 0
e Channel 1
e Channel 2

Must be a valid non-
negative integer with
configurable value 4 to
255

Refer to the RA
Configuration tool for
available options.

Refer to the RA
Configuration tool for
available options.

¢ Disabled

¢ Add two
samples

e Add three
samples

e Add four
samples

¢ Add sixteen
samples

e Average two
samples

e Average four
samples

MCU Specific Options

Refer to the RA
Configuration tool for
available options.

MCU Specific Options

MCU Specific Options

Specifies if this channel
is included in the
Sample and Hold Mask.

Specifies the updated
sample-and-hold count
for the channel
dedicated sample-and-
hold circuit

In Normal mode of
operation, this bitmask
field specifies the
channels that are
enabled in that ADC
unit. In group mode,
this field specifies
which channels belong
to group A.

In group mode, this
field specifies which
channels belong to

group B.

Specifies if addition or
averaging needs to be
done for any of the
channels in this unit.

Specify
VREFH/VREFADC
output voltage control.

Select channels to
include in the
Addition/Averaging
Mask

Specifies the trigger
type to be used for this
unit.

Specifies the trigger for
Group B scanning in
group scanning mode.
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Interrupts > Group
Priority (Valid only in
Group Scan Mode)

Interrupts > Callback

Interrupts > Scan End
Interrupt Priority

Interrupts > Scan End
Group B Interrupt
Priority

Clock Configuration

e Group A cannot Group A cannot

interrupt Group
B

e Group A can
interrupt Group
B; Group B scan
restarts at next
trigger

e Group A can
interrupt Group
B; Group B scan
restarts
immediately

e Group A can
interrupt Group
B; Group B scan
restarts
immediately
and scans
continuously

Name must be a valid
C symbol

MCU Specific Options

MCU Specific Options

interrupt Group B

NULL

The ADC clock is PCLKC if the MCU has PCLKC, or PCLKD otherwise.

This event is also used
to trigger Group A in
extended double-
trigger mode.

Determines whether an
ongoing group B scan
can be interrupted by a
group A trigger,
whether it should abort
on a group A trigger, or
if it should pause to
allow group A scan and
restart immediately
after group A scan is
complete.

A user callback
function. If this callback
function is provided, it
is called from the
interrupt service
routine (ISR) each time
the ADC scan
completes.

Select scan end
interrupt priority.

Select group B scan
end interrupt priority.

The ADC clock must be at least 1 MHz when the ADC is used. Many MCUs also have PCLK ratio
restrictions when the ADC is used. For details on PCLK ratio restrictions, reference the footnotes in
the second table of the Clock Generation Circuit chapter of the MCU User's Manual (for example,
Table 9.2 "Specifications of the clock generation circuit for the internal clocks" in the RA6M3 manual

RO1UHO886EJ0100).

Pin Configuration

The ANxxx pins are analog input channels that can be used with the ADC.

ADTRGO and ADTRG1 can be used to start scans with an external trigger for unit 0 and 1
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respectively. When external triggers are used, ADC scans begin on the falling edge of the ADTRG
pin.

Usage Notes

Sample Hold

Enabling the sample and hold functionality reduces the maximum scan frequency because the
sample and hold time is added to each scan. Refer to the hardware manual for details on the sample
and hold time.

ADC Operational Modes

The driver supports three operation modes: single-scan, continuous-scan, and group-scan modes. In
each mode, analog channels are converted in ascending order of channel number, followed by scans
of the temperature sensor and voltage sensor if they are included in the mask of channels to scan.

Single-scan Mode
In single scan mode, one or more specified channels are scanned once per trigger.
Continuous-scan Mode

In continuous scan mode, a single trigger is required to start the scan. Scans continue until
R_ADC_ScanStop() is called.

Group-scan Mode

Group-scan mode allows the application to allocate channels to one of two groups (A and B).
Conversion begins when the specified ELC start trigger for that group is received.

With the priority configuration parameter, you can optionally give group A priority over group B. If
group A has priority over group B, a group B scan is interrupted when a group A scan trigger occurs.
The following options exist for group B when group A has priority:

e To restart the interrupted group B scan after the group A scan completes.
e To wait for another group B trigger and forget the interrupted scan.
e To continuously scan group B and suspend scanning group B only when a group A trigger is
received.
Note
If this option is selected, group B scanning beginsimmediately after R ADC_ScanCfg(). Group A scan
triggers must be enabled by R ADC_ScanStart() and can be disabled by R_ADC_ScanStop(). Group B
scans can only be disabled by reconfiguring the group A priority to a different mode.

Double-triggering

When double-triggering is enabled a single channel is selected to be scanned twice before an
interrupt is thrown. The first scan result when using double-triggering is always saved to the selected
channel's data register. The second result is saved to the data duplexing register

(ADC_CHANNEL DUPLEX).

Double-triggering uses Group A; only one channel can be selected when enabled. No other scanning
is possible on Group A while double-trigger mode is selected. In addition, any special ADC channels
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(such as temperature sensors or voltage references) are not valid double-trigger channels.

When extended double-triggering is enabled both ADC input events are routed to Group A. The
interrupt is still thrown after every two scans regardless of the triggering event(s). While the first and
second scan are saved to the selected ADC data register and the ADC duplexing register as before,
scans associated with event A and B are additionally copied into duplexing register A and B,
respectively (ADC_CHANNEL DUPLEX A and ADC_CHANNEL DUPLEX_B).

When Interrupts Are Not Enabled

If interrupts are not enabled, the R_ADC_StatusGet API can be used to poll the ADC to determine
when the scan has completed. The read API function is used to access the converted ADC result. This
applies to both normal scans and calibration scans for MCUs that support calibration.

Sample-State Count Setting

The application program can modify the setting of the sample-state count for analog channels by
calling the R_ADC _SampleStateCountSet() API function. The application program only needs to
modify the sample-state count settings from their default values to increase the sampling time. This
can be either because the impedance of the input signal is too high to secure sufficient sampling
time under the default setting or if the ADCLK is too slow. To modify the sample-state count for a
given channel, set the channel number and the number of states when calling the
R_ADC_SampleStateCountSet() API function. Valid sample state counts are 7-255.

Note
Although the hardware supports a minimum number of sample states of 5, some MCUs require 7 states, so the
minimum is set to 7. At the lowest supported ADC conversion clock rate (1 MHz), these extra states will lead to, at
worst case, a 2 microsecond increase in conversion time. At 60 MHz the extra states will add 33.4 nsto the
conversion time.

If the sample state count needs to be changed for multiple channels, the application program must
call the R_ADC_SampleStateCountSet() API function repeatedly, with appropriately modified
arguments for each channel.

If the ADCLK frequency changes, the sample states may need to be updated.
Sample States for Temperature Sensor and Internal Voltage Reference

Sample states for the temperature sensor and the internal reference voltage are calculated during
R_ADC_ScanCfg() based on the ADCLK frequency at the time. The sample states for the temperature
sensor and internal voltage reference cannot be updated with R_ADC_SampleStateCountSet(). If the
ADCLK frequency changes, call R_ADC ScanCfg() before using the temperature sensor or internal
reference voltage again to ensure the sampling time for the temperature sensor and internal voltage
reference is optimal.

Selecting Reference Voltage

The ADC16 can select VREFHO or VREFADC as the high-potential reference voltage on selected
MCU's. When using VREFADC stabilization time of 1500us is required after call for R_ADC_Open().

Using the Temperature Sensor with the ADC
The ADC HAL module supports reading the data from the on-chip temperature sensor. The value

returned from the sensor can be converted into degrees Celsius or Fahrenheit in the application
program using the following formula, T = (Vs - V1)/slope + T1, where:
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e T: Measured temperature (degrees C)

e Vs: Voltage output by the temperature sensor at the time of temperature measurement

(Volts)

T1: Temperature experimentally measured at one point (degrees C)

V1: Voltage output by the temperature sensor at the time of measurement of T1 (Volts)

T2: Temperature at the experimental measurement of another point (degrees C)

V2: Voltage output by the temperature sensor at the time of measurement of T2 (Volts)

e Slope: Temperature gradient of the temperature sensor (V/degrees C); slope = (V2 - V1)/
(T2 -T1)

Note
The slope value can be obtained from the hardware manual for each device in the Electrical Characteristics
Chapter - TSN Characteristics Table, Temperature slope entry.

Usage Notes for ADC16

Calibration

Calibration is required to use the ADC16 peripheral. When using this driver on an MCU that has
ADC16, call R_ADC_Calibrate() after open, and prior to any other function.

Range of ADC16 Results

The range of the ADC16 is from 0 (lowest) to Ox7FFF (highest) when used in single-ended mode. This
driver only supports single ended mode.

Examples

Basic Example

This is a basic example of minimal use of the ADC in an application.

/* A channel configuration is generated by the RA Configuration editor based on the
options selected. If additional

* configurations are desired additional adc_channel _cfg t elenents can be defined
and passed to R ADC ScanCfg. */

const adc_channel _cfg t g adcO_channel cfg =

{
. scan_mask = ADC_MASK_CHANNEL O | ADC_MASK CHANNEL_1,
.scan_mask_group_b = 0,
.priority _group_a = (adc_group_a_t) O,
. add_mask = 0,
. sanpl e_hol d_nask = 0,
.sanpl e_hol d_states = 0O,
}i

voi d adc_basi c_exanpl e (voi d)
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Temperature Sensor Example

This example shows how to calculate the MCU temperature using the ADC and the temperature
sensor.
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(void) R ADC InfoCet(&g _adcO _ctrl, &adc_info);
reference _calibration data = (int32 t) adc_info.calibration_data;
#el se
/* If the MCU does not provide calibration data, use the value in the hardware
manual or determine it
* experinmentally. */
int32 t reference _calibration _data = ADC EXAVMPLE CALI BRATI ON_DATA RA6ML;
#endi f
/* NOTE: The sl ope of the tenperature sensor varies from sensor to sensor. Renesas
reconmends cal cul ati ng
* the slope of the tenperature sensor experinentally.
*
* This exanpl e uses the typical slope provided in Table 52.38 "TSN characteristics"
in the RAGML manual
* ROLUMDO11EUO050. */
int32_t slope_uv_per_c = BSP_FEATURE ADC TSN SLOPE
/* Formula for calculating tenperature copied fromsection 44.3.1 "Preparation for
Usi ng the Tenperature Sensor”
* of the RA6ML manual RO1UHO0884EJ0100:
=
* In this MCU, the TSCDR regi ster stores the tenperature value (CAL127) of the
t enperature sensor neasured
* under the condition Ta = Tj = 127 C and AVCQ0 = 3.3 V. By using this value as the
sanpl e neasurenent result
* at the first point, preparation before using the tenperature sensor can be
om tted.
*
* If VI is calculated from CAL127,
* V1 = 3.3 * CAL127 / 4096 [V]
*
* Using this, the measured tenperature can be cal cul ated according to the foll ow ng
f or nul a.

*

*T = (Vs - V1) /| Slope + 127 [C]
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* T. Measured tenperature (O
* Vs: Voltage output by the tenperature sensor when the tenperature is neasured (V)
* V1. Vol tage output by the tenperature sensor when Ta = Tj = 127 C and AVCCO = 3.3
vV (V)
* Sl ope: Tenperature slope given in Table 52.38 / 1000 (V/ O
*/
int32 t vl uv = (ADC EXAVPLE VCC M CROVOLT >> ADC EXAMPLE TEMPERATURE RESOLUTI ON)

reference_calibration_data;

int32_t vs_uv = (ADC_EXAMPLE_VCC M CROVOLT >> ADC_EXAMPLE TEMPERATURE_RESOLUTI ON)

t enper at ure_conversion_resul t;
int32_t tenperature ¢ = (vs_uv - vl uv) / slope_uv_per_c +
ADC_EXAMPLE_REFERENCE_CAL| BRATI ON_TEMPERATURE;
/* Expect roomtenperature, break if tenperature is outside the range of 20 C to 25
C */
if ((tenperature ¢ < 20) || (tenperature c > 25))

{
__BKPT(0);

Double-Trigger Example

This example demonstrates reading data from a double-trigger scan. A flag is used to wait for a
callback event. Two scans must occur before the callback is called. These results are read via
R_ADC_Read using the selected channel enum value as well as ADC_CHANNEL DUPLEX.
vol atil e bool scan_conplete flag = fal se;
voi d adc_cal | back (adc_cal | back _args t * p_args)
{

FSP_PARAVETER NOT_USED(p_ar gs) ;

scan_conplete flag = true;

}
voi d adc_doubl e_trigger_exanpl e (void)
{
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Data Structures

Enumerations
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enum adc_mask t

enum adc_add t

enum adc_clear_t

enum adc_vref control t
enum adc_sample state reg t
enum adc_group_a t

enum adc_double_trigger _t

Data Structure Documentation

¢ adc_sample_state_t

struct adc_sample_state_t
ADC sample state configuration
Data Fields
adc_sample_state reg t reg_id Sample state register ID.
uint8_t num_states Number of sampling states for
conversion. Ch16-20/21 use the
same value.
¢ adc_extended_cfg_t
struct adc_extended_cfg_t
Extended configuration structure for ADC.
Data Fields
adc_add t add_average count Add or average samples.
adc_clear_t clearing Clear after read.
adc_trigger_t trigger _group_b Group B trigger source; valid
only for group mode.
adc_double_trigger t double_trigger_ mode Double-trigger mode setting.
adc_vref _control_t adc_vref_control VREFADC output voltage
control.
¢ adc_channel_cfg_t
struct adc_channel_cfg_t
ADC channel(s) configuration
Data Fields
uint32_t | scan_mask Channels/bits: bit 0 is chO; bit
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15 is ch15.

uint32_t scan_mask _group_b Valid for group modes.

uint32_t add_mask Valid if add enabled in Open().

adc_group_a t priority _group_a Valid for group modes.

uint8_t sample_hold_mask Channels/bits 0-2.

uint8 t sample_hold_states Number of states to be used for
sample and hold. Affects
channels 0-2.

¢ adc_instance _ctrl_t

struct adc_instance_ctrl_t

ADC instance control block. DO NOT INITIALIZE. Initialized in adc_api_t::open().

Enumeration Type Documentation

¢ adc_mask_t

enum adc_mask_t

For ADC Scan configuration adc_channel _cfg_t::scan_mask, adc_channel _cfg_t::scan_mask _group b
, adc_channel cfg t::add_mask and adc_channel_cfg_t::sample_hold_mask. Use bitwise OR to
combine these masks for desired channels and sensors.

Enumerator

ADC_MASK_OFF No channels selected.

ADC_MASK_CHANNEL_O Channel 0 mask.

ADC_MASK_CHANNEL_1 Channel 1 mask.

ADC_MASK_CHANNEL_2 Channel 2 mask.

ADC_MASK_CHANNEL_3 Channel 3 mask.

ADC_MASK_CHANNEL_4 Channel 4 mask.

ADC_MASK_CHANNEL_5 Channel 5 mask.

ADC_MASK_CHANNEL_6 Channel 6 mask.

ADC_MASK_CHANNEL_7 Channel 7 mask.

ADC_MASK_CHANNEL_8 Channel 8 mask.

ADC_MASK_CHANNEL_9 Channel 9 mask.
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ADC_MASK_CHANNEL_10

Channel 10 mask.

ADC_MASK_CHANNEL 11

Channel 11 mask.

ADC_MASK_CHANNEL 12

Channel 12 mask.

ADC_MASK_CHANNEL _13

Channel 13 mask.

ADC_MASK_CHANNEL_14

Channel 14 mask.

ADC_MASK_CHANNEL 15

Channel 15 mask.

ADC_MASK_CHANNEL 16

Channel 16 mask.

ADC_MASK_CHANNEL _17

Channel 17 mask.

ADC_MASK_CHANNEL 18

Channel 18 mask.

ADC_MASK_CHANNEL_19

Channel 19 mask.

ADC_MASK_CHANNEL 20

Channel 20 mask.

ADC_MASK_CHANNEL_21

Channel 21 mask.

ADC_MASK_CHANNEL_22

Channel 22 mask.

ADC_MASK_CHANNEL_23

Channel 23 mask.

ADC_MASK_CHANNEL 24

Channel 24 mask.

ADC_MASK_CHANNEL_25

Channel 25 mask.

ADC_MASK_CHANNEL 26

Channel 26 mask.

ADC_MASK_CHANNEL_27

Channel 27 mask.

ADC_MASK_TEMPERATURE

Temperature sensor channel mask.

ADC_MASK_VOLT

Voltage reference channel mask.

ADC_MASK_SENSORS

All sensor channel mask.
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¢ adc_add_t

enum adc_add_t

ADC data sample addition and averaging options

Enumerator

ADC_ADD_OFF

Addition turned off for channels/sensors.

ADC_ADD_TWO

Add two samples.

ADC_ADD_THREE

Add three samples.

ADC_ADD_FOUR

Add four samples.

ADC_ADD_SIXTEEN

Add sixteen samples.

ADC_ADD_AVERAGE_TWO

Average two samples.

ADC_ADD_AVERAGE_FOUR

Average four samples.

ADC_ADD_AVERAGE_EIGHT

Average eight samples.

ADC_ADD_AVERAGE_SIXTEEN

Add sixteen samples.

¢ adc_clear_t

enum adc_clear t

ADC clear after read definitions

Enumerator

ADC_CLEAR_AFTER_READ_OFF

Clear after read off.

ADC_CLEAR_AFTER_READ_ON

Clear after read on.
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¢ adc_vref _control _t

enum adc_vref_control_t

ADC VREFAMPCNT config options Reference Table 32.12 "VREFADC output voltage control list" in
the RA2A1 manual RO1UH0888EJ0100.

Enumerator
ADC_VREF_CONTROL_VREFH VREFAMPCNT reset value. VREFADC Output
voltage is Hi-Z.
ADC_VREF_CONTROL_1_5V_OUTPUT BGR turn ON. VREFADC Output voltage is 1.5
V.
ADC_VREF_CONTROL_2_0V_OUTPUT BGR turn ON. VREFADC Output voltage is 2.0
V.
ADC_VREF_CONTROL_2_5V_OUTPUT BGR turn ON. VREFADC Output voltage is 2.5
V.
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¢ adc_sample_state_reg_t

enum adc_sample state reg t

ADC sample state registers

Enumerator

ADC_SAMPLE_STATE_CHANNEL_0

Sample state

register channel 0.

ADC_SAMPLE_STATE_CHANNEL 1

Sample state

register channel 1.

ADC_SAMPLE_STATE_CHANNEL 2

Sample state

register channel 2.

ADC_SAMPLE_STATE_CHANNEL 3

Sample state

register channel 3.

ADC_SAMPLE_STATE_CHANNEL 4

Sample state

register channel 4.

ADC_SAMPLE_STATE_CHANNEL 5

Sample state

register channel 5.

ADC_SAMPLE_STATE_CHANNEL 6

Sample state

register channel 6.

ADC_SAMPLE_STATE_CHANNEL_7

Sample state

register channel 7.

ADC_SAMPLE_STATE_CHANNEL 8

Sample state

register channel 8.

ADC_SAMPLE_STATE_CHANNEL 9

Sample state

register channel 9.

ADC_SAMPLE_STATE_CHANNEL_10

Sample state

register channel 10.

ADC_SAMPLE_STATE_CHANNEL_11

Sample state

register channel 11.

ADC_SAMPLE_STATE_CHANNEL 12

Sample state

register channel 12.

ADC_SAMPLE_STATE_CHANNEL 13

Sample state

register channel 13.

ADC_SAMPLE_STATE_CHANNEL 14

Sample state

register channel 14.

ADC_SAMPLE_STATE_CHANNEL_15

Sample state

register channel 15.

ADC_SAMPLE_STATE_CHANNEL 16 TO 31

Sample state

register channel 16 to 31.
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¢ adc_group_a_t

enum adc_group_a_t

ADC action for group A interrupts group B scan. This enumeration is used to specify the priority
between Group A and B in group mode.

Enumerator

ADC_GROUP_A_PRIORITY_OFF Group A ignored and does not interrupt

onhgoing group B scan.

ADC_GROUP_A_GROUP_B_WAIT_FOR_TRIGGER Group A interrupts Group B(single scan) which

restarts at next Group B trigger.

ADC_GROUP_A_GROUP_B_RESTART_SCAN Group A interrupts Group B(single scan) which

restarts immediately after Group A scan is
complete.

ADC_GROUP_A_GROUP_B_CONTINUOUS_SCAN Group A interrupts Group B(continuous scan)

which continues scanning without a new Group

B trigger.
¢ adc_double_trigger_t
enum adc_double_trigger t
ADC double-trigger mode definitions
Enumerator

ADC_DOUBLE_TRIGGER_DISABLED Double-triggering disabled.

ADC_DOUBLE_TRIGGER_ENABLED Double-triggering enabled.

ADC_DOUBLE_TRIGGER_ENABLED_EXTENDED Double-triggering enabled on both ADC ELC
events.

Function Documentation
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4 R_ADC _Open()

fsp_err t R_ADC Open ( adc_ctrl t* p ctrl, adc_cfg_t const *const p cfg )

Sets the operational mode, trigger sources, interrupt priority, and configurations for the peripheral
as a whole. If interrupt is enabled, the function registers a callback function pointer for notifying the
user whenever a scan has completed.

Return values

FSP_SUCCESS Module is ready for use.

FSP_ERR_ASSERTION An input argument is invalid.

FSP_ERR_ALREADY_OPEN The instance control structure has already
been opened.

FSP_ERR_IRQ BSP_DISABLED A callback is provided, but the interrupt is
not enabled.

FSP_ERR_IP_CHANNEL_NOT_PRESENT The requested unit does not exist on this
MCU.

FSP_ERR_INVALID_HW_CONDITION The ADC clock must be at least 1 MHz

¢ R_ADC_ScanCfg()

fsp_err t R_ADC ScanCfg ( adc_ctrl t* p ctrl, void const *const p_extend )

Configures the ADC scan parameters. Channel specific settings are set in this function. Pass a
pointer to adc_channel_cfg_t to p_extend.

Note
This starts group B scansif adc_channel _cfg_t::priority group aissetto
ADC _GROUP_A GROUP_B_CONTINUOUS SCAN.

Return values

FSP_SUCCESS Channel specific settings applied.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT _OPEN Unit is not open.
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¢ R_ADC_InfoGet()

fsp_err_ t R_ADC InfoGet ( adc_ctrl t* p ctrl, adc_info t * p_adc_info )

Returns the address of the lowest number configured channel and the total number of bytes to be
read in order to read the results of the configured channels and return the ELC Event name. If no
channels are configured, then a length of 0 is returned.

Also provides the temperature sensor slope and the calibration data for the sensor if available on
this MCU. Otherwise, invalid calibration data of OXFFFFFFFF will be returned.

Note
In group mode, information is returned for group A only. Calculating information for group B is not currently
supported.
Return values
FSP_SUCCESS Information stored in p_adc_info.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT _OPEN Unit is not open.

4 R_ADC_ScanStart()

fsp_err t R_ADC ScanStart ( adc_ctrl_t* p_ctrl)

Starts a software scan or enables the hardware trigger for a scan depending on how the triggers
were configured in the R_ADC_Open call. If the unit was configured for ELC or external hardware
triggering, then this function allows the trigger signal to get to the ADC unit. The function is not
able to control the generation of the trigger itself. If the unit was configured for software triggering,
then this function starts the software triggered scan.

Precondition
Call R_ADC_ScanCfg after R_ADC_Open before starting a scan.
On MCUs that support calibration, call R_ADC_Calibrate and wait for calibration to complete
before starting a scan.

Return values

FSP_SUCCESS Scan started (software trigger) or hardware
triggers enabled.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT_OPEN Unit is not open.
FSP_ERR_IN_USE Another scan is still in progress (software
trigger).
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4 R_ADC_ScanStop()

fsp_err t R_ADC _ScanStop ( adc_ctrl_ t * p ctrl)

Stops the software scan or disables the unit from being triggered by the hardware trigger (ELC or
external) based on what type of trigger the unit was configured for in the R_ADC_Open function.
Stopping a hardware triggered scan via this function does not abort an ongoing scan, but prevents
the next scan from occurring. Stopping a software triggered scan aborts an ongoing scan.

Return values

FSP_SUCCESS Scan stopped (software trigger) or hardware
triggers disabled.

FSP_ERR_ASSERTION An input argument is invalid.

FSP_ERR_NOT _OPEN Unit is not open.

¢ R_ADC StatusGet()

fsp_err_ t R_ADC StatusGet ( adc_ctrl_ t * p ctrl, adc_status t * p_status )

Provides the status of any scan process that was started, including scans started by ELC or external
triggers and calibration scans on MCUs that support calibration.

Return values

FSP_SUCCESS Module status stored in the provided pointer
p_status

FSP_ERR_ASSERTION An input argument is invalid.

FSP_ERR_NOT _OPEN Unit is not open.

¢ R_ADC_Read()

fsp_err_t R_ADC_Read ( adc_ctrl_t* p_ctrl, adc_channel_t const reg_id, uintl6_t *const p_data )

Reads conversion results from a single channel or sensor.

Return values

FSP_SUCCESS Data read into provided p_data.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT_OPEN Unit is not open.
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& R_ADC_Read32()

fsp_err t R_ADC Read32 ( adc_ctrl t* p ctrl, adc_channel_t const reg id, uint32_t *const p data
)

Reads conversion results from a single channel or sensor register into a 32-bit result.

Return values

FSP_SUCCESS Data read into provided p_data.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT _OPEN Unit is not open.

¢ R_ADC_SampleStateCountSet()

fsp_err_t R_ADC_SampleStateCountSet ( adc_ctrl_t * p_ctrl, adc_sample_state t * p_sample )

Sets the sample state count for individual channels. This only needs to be set for special use cases.
Normally, use the default values out of reset.

Note

The sample states for the temperature and voltage sensor are set in R_ADC_ScanCfg.
Return values

FSP_SUCCESS Sample state count updated.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT _OPEN Unit is not open.

4 R_ADC _Close()

fsp_err t R_ADC Close ( adc_ctrl_t* p_ctrl)

This function ends any scan in progress, disables interrupts, and removes power to the A/D
peripheral.

Return values

FSP_SUCCESS Module closed.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT _OPEN Unit is not open.
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4 R_ADC _OffsetSet()

fsp_err_ t R_ADC OffsetSet ( adc_ctrl_t *const p_ctrl, adc_channel t const reg id, int32_t offset )

adc_api_t::offsetSet is not supported on the ADC.

Return values

FSP_ERR_UNSUPPORTED Function not supported in this
implementation.

¢ R_ADC Calibrate()

fsp_err_ t R_ADC Calibrate ( adc_ctrl_t *const p ctrl, void *const p_extend )

Initiates calibration of the ADC on MCUs that require calibration. This function must be called
before starting a scan on MCUs that require calibration.

Calibration is complete when the callback is called with ADC_EVENT_CALIBRATION_COMPLETE or
when R_ADC_StatusGet returns ADC_STATUS_IDLE. Reference Figure 32.35 "Software flow and
operation example of calibration operation." in the RA2A1 manual RO1IUH0888EJ0100.

ADC calibration time: 12 PCLKB + 774,930 ADCLK. (Reference Table 32.16 "Required calibration
time (shown as the number of ADCLK and PCLKB cycles)" in the RA2A1 manual RO1IUH0888E)J0100.
The lowest supported ADCLK is 1MHz.

Calibration will take a minimum of 24 milliseconds at 32 MHz PCLKB and ADCLK. This wait could
take up to 780 milliseconds for a 1 MHz PCLKD (ADCLK).

Parameters
[in] p_ctrl Pointer to the instance
control structure
[in] p_extend Unused argument. Pass
NULL.
Return values
FSP_SUCCESS Calibration successfully initiated.
FSP_ERR_INVALID_HW_CONDITION A scan is in progress or hardware triggers
are enabled.
FSP_ERR_UNSUPPORTED Calibration not supported on this MCU.
FSP_ERR_ASSERTION An input argument is invalid.
FSP_ERR_NOT_OPEN Unit is not open.
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4 R_ADC VersionGet()

fsp_err_t R_ADC VersionGet ( fsp_version_t *const p_version)

Retrieve the APl version number.

Return values
FSP_SUCCESS Version stored in the provided p_version.

FSP_ERR_ASSERTION An input argument is invalid.

4.2.4 Asynchronous General Purpose Timer (r_agt)

Modules
Functions
fsp_err t R_AGT_Close (timer_ctrl_t *const p_ctrl)
fsp_err t R_AGT PeriodSet (timer_ctrl_t *const p_ctrl, uint32_t const
period_counts)
fsp_err t R_AGT DutyCycleSet (timer_ctrl_t *const p_ctrl, uint32_t const
duty cycle counts, uint32_t const pin)
fsp_err t R_AGT Reset (timer_ctrl_t *const p_ctrl)
fsp_err t R_AGT Start (timer_ctrl_t *const p_ctrl)
fsp_err t R_AGT Enable (timer_ctrl_t *const p_ctrl)
fsp_err t R_AGT Disable (timer _ctrl_t *const p_ctrl)
fsp_err t R_AGT InfoGet (timer_ctrl_t *const p_ctrl, timer_info_t *const p_info)
fsp_err t R_AGT StatusGet (timer_ctrl_t *const p_ctrl, timer_status_t *const
p_status)
fsp_err t R_AGT_Stop (timer_ctrl_t *const p_ctrl)
fsp_err t R_AGT Open (timer_ctrl_t *const p_ctrl, timer_cfg_t const *const
p_cfg)
fsp_err t R_AGT VersionGet (fsp_version_t *const p_version)
R11UMO0146EU0120 Revision 1.20 RLENESAS Page 227 / 1,560

Jun.26.20



Flexible Software Package User’s Manual

API| Reference > Modules > Asynchronous General Purpose Timer (r_agt)

Detailed Description

Driver for the AGT peripheral on RA MCUs. This module implements the Timer Interface.

Overview

Features
The AGT module has the following features:

Supports periodic mode, one-shot mode, and PWM mode.

Signal can be output to a pin.

Configurable period (counts per timer cycle).

Configurable duty cycle in PWM mode.

Configurable clock source, including PCLKB, LOCO, SUBCLK, and external sources input to
AGTIO.

Supports runtime reconfiguration of period.

Supports runtime reconfiguration of duty cycle in PWM mode.

Supports counting based on an external clock input to AGTIO.

Supports debounce filter on AGTIO pins.

Supports measuring pulse width or pulse period.

APIs are provided to start, stop, and reset the counter.

APIs are provided to get the current period, source clock frequency, and count direction.
APIs are provided to get the current timer status and counter value.

Selecting a Timer

RA MCUs have two timer peripherals: the General PWM Timer (GPT) and the Asynchronous General
Purpose Timer (AGT). When selecting between them, consider these factors:

GPT AGT
Low Power Modes The GPT can operate in sleep The AGT can operate in all low
mode. power modes (when count

source is LOCO or subclock).

Available Channels The number of GPT channels is All MCUs have 2 AGT channels.
device specific. All currently
supported MCUs have at least 7
GPT channels.

Timer Resolution All MCUs have at least one The AGT timers are 16-bit
32-bit GPT timer. timers.

Clock Source The GPT runs off PCLKD witha  The AGT runs off PCLKB, LOCO,
configurable divider up to 1024. or subclock with a configurable
It can also be configured to divider up to 8 for PCLKB or up
count ELC events or external to 128 for LOCO or subclock.
pulses.

Configuration

Build Time Configurations for r_agt

R11UMO146EU0120 Revision 1.20 RENESANAS Page 228 /1,560
Jun.26.20



Flexible Software Package User’s Manual

API| Reference > Modules > Asynchronous General Purpose Timer (r_agt)

The following build time configurations are defined in fsp_cfg/r_agt_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
¢ Disabled included in the build.
Pin Output Support e Disabled Disabled If selected code for
¢ Enabled outputting a waveform
to a pinis included in
the build.
Pin Input Support e Disabled Disabled Enable input support to
e Enabled use pulse width

measurement mode,
pulse period
measurement mode, or
input from P402, P402,
or AGTIO.

Configurations for Driver > Timers > Timer Driver on r_agt

This module can be added to the Stacks tab via New Stack > Driver > Timers > Timer Driver on
r agt:

Configuration Options Default Description
General > Name Name must be a valid  g_timer0 Module name.
C symbol
General > Channel Available AGT Channels 0 Physical hardware
are0and1 channel.
General > Mode e Periodic Periodic Mode selection. Note:
¢ One-Shot One-shot mode is
e PWM implemented in

software. ISR's must be
enabled for one shot
even if callback is

unused.
General > Period Value must be non- 0x10000 Specify the timer
negative period based on the

selected unit.

When the unit is set to
'Raw Counts', setting
the period to 0x10000
results in the maximum
period at the lowest
divisor (fastest timer
tick). Set the period to
0x10000 for a free
running timer, pulse
width measurement or
pulse period
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General > Period Unit

General > Count
Source

Output > Duty Cycle
Percent (only
applicable in PWM
mode)

Output > AGTOA
Output

Output > AGTOB
Output

Output > AGTO Output

Input > Measurement
Mode

Raw Counts
Nanoseconds
Microseconds
Milliseconds
Seconds
Hertz
Kilohertz

PCLKB

LOCO
SUBCLOCK
AGTO Underflow
P402 Input
P403 Input
AGTIO Input

Value must be between
0 and 100

Disabled
Start Level Low
Start Level High

Disabled
Start Level Low
Start Level High

Disabled
Start Level Low
Start Level High

Measure
Disabled
Measure Low
Level Pulse
Width
Measure High
Level Pulse
Width
Measure Pulse

Raw Counts

PCLKB

50

Disabled

Disabled

Disabled

Measure Disabled

measurement. Setting
the period higher will
automatically select a
higher divider; the
period can be set up to
0x80000 when
counting from PCLKB or
0x800000 when
counting from
LOCO/subclock, which
will use a divider of 8
or 128 respectively
with the maximum
period.

Unit of the period
specified above

AGT counter clock
source. NOTE: The
divisor is calculated
automatically based on
the selected period.
See agt _count source_t
documentation for
details.

Specify the timer duty
cycle percent. Only
used in PWM mode.

Configure AGTOA
output.

Configure AGTOB
output.

Configure AGTO
output.

Select if the AGT
should be used to
measure pulse width or
pulse period. In high
level pulse width
measurement mode,
the AGT counts when
AGTIO is high and
starts counting
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Period immediately in the
middle of a pulse if
AGTIO is high when
R_AGT Start() is called.
In low level pulse width
measurement mode,
the AGT counts when
AGTIO is low and could
start counting in the
middle of a pulse if
AGTIO is low when
R_AGT _Start() is called.

Input > Input Filter ¢ No Filter No Filter Input filter, applies
¢ Filter sampled AGTIO in pulse period
at PCLKB measurement, pulse
e Filter sampled width measurement, or
at PCLKB / 8 event counter mode.
e Filter sampled The filter requires the
at PCLKB / 32 signal to be at the

same level for 3
successive reads at the
specified filter

frequency.
Input > Enable Pin e Enable Pin Not  Enable Pin Not Used Select active edge for
Used the AGTEE pin if used.
e Enable Pin Only applies if the
Active Low count source is P402,
¢ Enable Pin P403 or AGTIO.
Active High
Input > Trigger Edge e Trigger Edge Trigger Edge Rising Select the trigger edge.
Rising Applies if measurement
e Trigger Edge mode is pulse period,
Falling or if the count source is
e Trigger Edge P402, P403, or AGTIO.
Both Do not select Trigger
Edge Both with pulse
period measurement.
Interrupts > Callback Name must be a valid  NULL A user callback
C symbol function. If this callback
function is provided, it
is called from the
interrupt service
routine (ISR) each time
the timer period
elapses.
Interrupts > Underflow MCU Specific Options Timer interrupt priority.

Interrupt Priority
Clock Configuration

The AGT clock is based on the PCLKB, LOCO, or Subclock frequency. You can set the clock frequency
using the Clocks tab of the RA Configuration editor or by using the CGC Interface at run-time.

R11UMO146EU0120 Revision 1.20 RENESANAS Page 231 /1,560
Jun.26.20



Flexible Software Package User’s Manual

API| Reference > Modules > Asynchronous General Purpose Timer (r_agt)

Pin Configuration

This module can use the AGTOA and AGTOB pins as output pins for periodic, one-shot, or PWM
signals.

For input capture, the input signal must be applied to the AGTIOn pin.
For event counting, the AGTEEn enable pin is optional.
Timer Period

The RA Configuration editor will automatically calculate the period count value and source clock
divider based on the selected period time, units, and clock speed.

When the selected unit is "Raw counts", the maximum allowed period setting varies depending on
the selected clock source:

Clock source Maximum period (counts)
LOCO/Subclock 0x800000
PCLKB 0x80000
All other sources 0x10000

Note
Though the AGT is a 16-bit timer, because the period interrupt occurs when the counter underflows, setting the
period register to O resultsin an effective period of 1 count. For this reason all user-provided raw count values
reflect the actual number of period counts (not the raw register values).

Usage Notes
Starting and Stopping the AGT

After starting or stopping the timer, AGT registers cannot be accessed until the AGT state is updated
after 3 AGTCLK cycles. If another AGT function is called before the 3 AGTCLK period elapses, the
function spins waiting for the AGT state to update. The required wait time after starting or stopping
the timer can be determined using the frequency of AGTCLK, which is derived from
timer_cfg_t::source_div and agt_extended_cfg t::count_source.

The application is responsible for ensuring required clocks are started and stable before accessing
MCU peripheral registers.

Warning
The subclock can take seconds to stabilize. The RA startup code does not wait for subclock
stabilization unless the subclock is the main clock source. When running AGT or RTC off the
subclock, the application must ensure the subclock is stable before starting operation.

Low Power Modes
The AGT1 (channel 1 only) can be used to enter snooze mode or to wake the MCU from snooze,
software standby, or deep software standby modes when a counter underflow occurs. The compare

match A and B events can also be used to wake from software standby or snooze modes.

One-Shot Mode
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The AGT timer does not support one-shot mode natively. One-shot mode is achieved by stopping the
timer in the interrupt service routine before the callback is called. If the interrupt is not serviced
before the timer period expires again, the timer generates more than one event. The callback is only
called once in this case, but multiple events may be generated if the timer is linked to the Data
Transfer Controller (r_dtc).

One-Shot Mode Output

The output waveform in one-shot mode is one AGT clock cycle less than the configured period. The
configured period must be at least 2 counts to generate an output pulse.

Examples of one-shot signals that can be generated by this module are shown below:

AGT One-Shot Output

Time afer start (AGTCLK v
counts, AGT starts 3 AGTGLK ] | |l
counts after R_AGT_Start)

One-shot mode, agt_pin_cfg_t =
AGT_PIN_CFG_START_LEVEL_LOW

One-shot mode, agt_pin_cfg_t =
AGT PIN CFG START LEVEL HIGH

Figure 118: AGT One-Shot Output

Periodic Output

The AGTOA or AGTOB pin toggles twice each time the timer expires in periodic mode. This is
achieved by defining a PWM wave at a 50 percent duty cycle so that the period of the resulting
square (from rising edge to rising edge) matches the period of the AGT timer. Since the periodic
output is actually a PWM output, the time at the stop level is one cycle shorter than the time
opposite the stop level for odd period values.

Examples of periodic signals that can be generated by this module are shown below:
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Time after start (AGTCLK

AGT Periodic Output

counts, AGT starts 3 AGTCLK
counts after R_AGT_Start)

One-shot mode, agt_pin_cfg_t =

AGT_PIN_CFG_START_LEVEL_LOW

One-shot mode, agt_pin_cfg_t =
AGT PIN CFG START LEVEL HIGH

PWM Output

Figure 119: AGT Periodic Output

This module does not support in phase PWM output. The PWM output signal is low at the beginning
of the cycle and high at the end of the cycle.

Examples of PWM signals that can be generated by this module are shown below:

Time after start (AGTCLK
counts, AGT starts 3 AGTCLK

AGT PWM Output

N )
&
& s &
$ ROgrs &
o R
of Ho P Y
¥ & &
&
-\9 Q}S ¢ 57
o . B @
N S

counts after R_AGT_Start)

PWM mode, agt_pin_cfg_t =
AGT_PIN_CFG_START_LEVEL_LOW

PWNM mode, agt_pin_cfg_t =
AGT_PIN_CFG_START_LEVEL_HIGH

Triggering ELC Events with AGT

Figure 120: AGT PWM Output

The AGT timer can trigger the start of other peripherals. The Event Link Controller (r_elc) guide
provides a list of all available peripherals.

Examples

AGT Basic Example

This is a basic example of minimal use of the AGT in an application.

voi d agt _basi c_exanpl e (voi d)

{
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AGT Callback Example

This is an example of a timer callback.

AGT Free Running Counter Example

To use the AGT as a free running counter, select periodic mode and set the the Period to OxFFFF.
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AGT Input Capture Example

This is an example of using the AGT to capture pulse width or pulse period measurements.
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AGT Period Update Example

This an example of updating the period.

R11UMO0146EU0120 Revision 1.20 Page 237 /1,560
Jun.26.20




Flexible Software Package User’s Manual

API| Reference > Modules > Asynchronous General Purpose Timer (r_agt)

AGT Duty Cycle Update Example

This an example of updating the duty cycle.
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AGT Cascaded Timers Example

This an example of using AGTO underflow as the count source for AGTL.

R11UMO0146EU0120 Revision 1.20 Page 239 /1,560
Jun.26.20




Flexible Software Package

API| Reference > Modules > Asynchronous General Purpose Timer (r_agt)

User’s Manual

(void) R AGT _Stop(&g_tiner_channel O ctrl);

(void) R AGT Stop(&g_tiner_channel 1 ctrl);

/* Read the current counter val ue.

timer_status t status;

(void) R AGT _StatusCet(&g_tiner_channel 1 ctrl,

Data Structures

struct

struct

Enumerations

enum

enum

enum

enum

enum

enum

enum

Counter value is in status.counter. */

agt_instance_ctrl_t

agt_extended_cfg_t

agt_clock_t

agt_measure_t

agt_agtio_filter t

agt_enable_pin_t

agt _trigger_edge t

agt output pin_t

agt_pin_cfg_t

&st at us) ;

Data Structure Documentation

¢ agt_instance_ctrl_t

struct agt_instance_ctrl_t

Channel control block. DO NOT INITIALIZE. Initialization occurs when timer_api_t::open is called.

Data Fields
uint32_t open Whether or not channel is open.
const timer_cfg t* p_cfg Pointer to initial configurations.
R_AGTO Type * p_reg Base register for this channel.
uint32 t period Current timer period (counts)
¢ agt_extended_cfg_t
struct agt_extended_cfg_t
Optional AGT extension data structure.
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Data Fields

agt_clock_t

count_source

AGT channel clock source. Valid
values are: AGT_CLOCK PCLKB,
AGT_CLOCK LOCO,
AGT_CLOCK _FSUB.

union agt_extended_cfg_t

__unnamed__

agt _pin_cfg_t

agto: 3

Configure AGTO pin.

Note
AGTIO polarity is opposite
AGTO

agt_measure_t

measurement_mode

Measurement mode.

agt_agtio filter t

agtio _filter

Input filter for AGTIO.

agt_enable_pin_t

enable_pin

Enable pin (event counting
only)

agt _trigger_edge t

trigger_edge

Trigger edge to start pulse
period measurement or count
external event.

Enumeration Type Documentation
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¢ agt_clock_t

enum agt_clock_t

Count source

Enumerator

AGT_CLOCK_PCLKB PCLKB count source, division by 1, 2, or 8
allowed.

AGT_CLOCK_LOCO LOCO count source, division by 1, 2, 4, 8, 16,
32, 64, or 128 allowed.

AGT_CLOCK_AGTO_UNDERFLOW Underflow event signal from AGTO, division
must be 1.

AGT_CLOCK_SUBCLOCK Subclock count source, division by 1, 2, 4, 8,

16, 32, 64, or 128 allowed.

AGT_CLOCK_P402 Counts events on P402, events are counted in
deep software standby mode.

AGT_CLOCK_P403 Counts events on P403, events are counted in
deep software standby mode.

AGT_CLOCK_AGTIO Counts events on AGTIOn, events are not
counted in software standby modes.

¢ agt_measure_t

enum agt_ measure_t
Enable pin for event counting mode.
Enumerator

AGT_MEASURE_DISABLED AGT used as a counter.

AGT_MEASURE_PULSE_WIDTH_LOW_LEVEL AGT used to measure low level pulse width.

AGT_MEASURE_PULSE_WIDTH_HIGH_LEVEL AGT used to measure high level pulse width.

AGT_MEASURE_PULSE_PERIOD AGT used to measure pulse period.
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¢ agt_agtio_filter_t

enum agt_agtio_filter_t

Input filter, applies AGTIO in pulse period measurement, pulse width measurement, or event

counter mode. The filter requires the signal to be at the same level for 3 successive reads at the

specified filter frequency.
Enumerator

AGT_AGTIO_FILTER _NONE No filter.

AGT_AGTIO_FILTER PCLKB Filter at PCLKB.

AGT_AGTIO_FILTER PCLKB DIV_8 Filter at PCLKB / 8.

AGT_AGTIO_FILTER _PCLKB DIV_32 Filter at PCLKB / 32.

¢ agt_enable_pin_t

enum agt_enable_pin_t

Enable pin for event counting mode.
Enumerator

AGT_ENABLE_PIN_NOT_USED AGTEE is not used.

AGT_ENABLE_PIN_ACTIVE_LOW Events are only counted when AGTEE is low.

AGT_ENABLE_PIN_ACTIVE_HIGH Events are only counted when AGTEE is high.

¢ agt_trigger_edge_t

enum agt trigger edge t
Trigger edge for pulse period measurement mode and event counting mode.
Enumerator

AGT_TRIGGER_EDGE _RISING Measurement starts or events are counted on
rising edge.

AGT_TRIGGER_EDGE_FALLING Measurement starts or events are counted on
falling edge.

AGT_TRIGGER_EDGE_BOTH Events are counted on both edges (n/a for
pulse period mode)
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¢ agt_output_pin_t

enum agt_output pin_t
Output pins, used to select which duty cycle to update in R_AGT_DutyCycleSet().
Enumerator
AGT_OUTPUT _PIN_AGTOA GTIOCA.
AGT_OUTPUT_PIN_AGTOB GTIOCB.
¢ agt_pin_cfg_t
enum agt _pin_cfg_t
Level of AGT pin
Enumerator

AGT_PIN_CFG_START_LEVEL_LOW Pin level low.

AGT_PIN_CFG_START_LEVEL_HIGH Pin level high.

Function Documentation

¢ R_AGT Close()

fsp_err t R_AGT Close ( timer_ctrl_t *const p_ctrl)

Stops counter, disables interrupts, disables output pins, and clears internal driver data. Implements
timer_api_t::close.

Return values

FSP_SUCCESS Timer closed.
FSP_ERR_ASSERTION p_ctrl is NULL.
FSP_ERR_NOT_OPEN The instance control structure is not
opened.
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¢ R_AGT _PeriodSet()

fsp_err_ t R_AGT PeriodSet ( timer_ctrl_t *const p_ctrl, uint32_t const period counts )

Updates period. The new period is updated immediately and the counter is reset to the maximum
value. Implements timer_api_t::periodSet.

Warning
If periodic output is used, the duty cycle buffer registers are updated after the period buffer
register. If this function is called while the timer is running and an AGT underflow occurs
during processing, the duty cycle will not be the desired 50% duty cycle until the counter
underflow after processing completes.
Stop the timer before calling this function if one-shot output is used.

Example:

/* Get the source clock frequency (in Hz). There are several ways to do this in FSP

* - |f LOCO or subclock is chosen in agt_extended cfg_t::clock source

* - The source clock frequency is BSP_LOCO HZ >> tinmer_cfg_t::source_div

* - |f PCLKB is chosen in agt_extended cfg t::clock source and the PCLKB frequency
has not changed since reset,

* - The source clock frequency is BSP_STARTUP_PCLKB HZ >> timer_cfg t::source_div

* - Use the R AGT InfoGet function (it accounts for the clock source and divider).

* - Calculate the current PCLKB frequency using
R FSP_Syst enCl ockHzGet (FSP_PRI V_CLOCK PCLKB) and right shift

* by timer_cfg t::source_div.

B

* This exanpl e uses the |ast option (R FSP_SystentC ockHzGet) .

*/

uint32 t tinmer _freq _hz = R FSP_Syst enTCl ockHzGet (FSP_PRI V_CLOCK PCLKB) >>

g_tiner0_cfg.source_div;
/* Calculate the desired period based on the current clock. Note that this
cal cul ati on could overflow if the

* desired period is larger than U NT32_MAX / pcl kb _freq_hz. A cast to uint64_t is
used to prevent this. */

uint32 t period_counts =
(uint32_t) (((uint64_t) tiner_freq_hz * AGT_EXAMPLE_DESI RED PERI OD MSEC) /

IAGT _EXAMPLE_MBEC_PER _SEC) ;
/* Set the calculated period. This will return an error if paraneter checking is

enabl ed and the cal cul at ed
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* period is larger than U NT16_MAX. */
err = R AGT PeriodSet (& tinmerO _ctrl, period counts);

handl e_error(err);

Return values
FSP_SUCCESS Period value updated.
FSP_ERR_ASSERTION A required pointer was NULL, or the period
was not in the valid range of 1 to OxFFFF.
FSP_ERR_NOT_OPEN The instance control structure is not
opened.
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& R_AGT _DutyCycleSet()

fsp_err_ t R_AGT DutyCycleSet ( timer_ctrl_t *const p_ctrl, uint32_t const duty cycle counts,
uint32_t const pin )

Updates duty cycle. If the timer is counting, the new duty cycle is reflected after the next counter
underflow. Implements timer_api_t::dutyCycleSet.

Example:
/* Get the current period setting. */
timer_info_ t info;
(void) R AGT_InfoGet(&g_timer0_ctrl, & nfo);
uint32 t current _period _counts = info. period counts;
/* Calculate the desired duty cycle based on the current period. */
uint32 t duty cycle counts = (current period counts *
IAGT _EXAMPLE_DESI RED_DUTY_CYCLE_PERCENT) /
AGT_EXAMPLE_NMAX_PERCENT;
/* Set the cal culated duty cycle. */
err = R AGT DutyCycleSet(&y tinerO ctrl, duty cycle counts, AGI_OUTPUT PI N AGTOA

handl e _error(err);

Return values
FSP_SUCCESS Duty cycle updated.

FSP_ERR_ASSERTION A required pointer was NULL, or the pin was
not AGT_AGTO_AGTOA or
AGT _AGTO_AGTOB.

FSP_ERR_INVALID_ARGUMENT Duty cycle was not in the valid range of 0 to
period (counts) - 1
FSP_ERR_NOT _OPEN The instance control structure is not
opened.
FSP_ERR_UNSUPPORTED AGT_CFG_OUTPUT_SUPPORT_ENABLE is 0.
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¢ R_AGT_Reset()

fsp_err t R_AGT Reset ( timer_ctrl_t *const p_ctrl)

Return values

Resets the counter value to the period minus one. Implements timer_api_t::reset.

FSP_SUCCESS

Counter reset.

FSP_ERR_ASSERTION

p_ctrlis NULL

FSP_ERR_NOT OPEN

The instance control structure is not
opened.

& R_AGT Start()

fsp_err_ t R_AGT Start ( timer_ctrl_t *const p_ctrl)

Starts timer. Implements timer_api_t::start.
Example:
[* Start the timer. */

(void) RAGT Start(&g tinmer0O_ctrl);

Return values

FSP_SUCCESS

Timer started.

FSP_ERR_ASSERTION

p_ctrl is null.

FSP_ERR_NOT_OPEN

The instance control structure is not
opened.
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¢ R_AGT_Enable()

fsp_err_ t R_AGT Enable ( timer_ctrl_t *const p_ctr/)

Enables external event triggers that start, stop, clear, or capture the counter. Implements
timer_api_t::enable.

Example:
/* Enabl e captures. Captured values arrive in the interrupt. */

(void) R AGT Enable(&y timer0O ctrl);

Return values

FSP_SUCCESS External events successfully enabled.
FSP_ERR_ASSERTION p_ctrl was NULL.
FSP_ERR_NOT_OPEN The instance is not opened.

¢ R_AGT Disable()

fsp_err_t R_AGT _Disable ( timer_ctrl_t *const p_ctr/)

Disables external event triggers that start, stop, clear, or capture the counter. Implements
timer_api_t::disable.

Example:
/* (Optional) Disable captures. */
(void) R AGT Disable(&y tiner0 ctrl);

Return values

FSP_SUCCESS External events successfully disabled.
FSP_ERR_ASSERTION p_ctrl was NULL.
FSP_ERR_NOT_OPEN The instance is not opened.
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¢ R_AGT InfoGet()

fsp_err_ t R_AGT InfoGet ( timer_ctrl_t *const p_ctrl, timer_info_t *const p_info )

Gets timer information and store it in provided pointer p_info. Implements timer_api_t::infoGet.
Example:
/* (Optional) Get the current period if not known. */
timer_info_t info;
(void) R AGT_InfoGet(&g_tinmer0_ctrl, & nfo);

uint32 t period = info. period counts;

Return values

FSP_SUCCESS Period, count direction, and frequency
stored in p_info.

FSP_ERR_ASSERTION A required pointer is NULL.

FSP_ERR_NOT_OPEN The instance control structure is not
opened.

¢ R_AGT StatusGet()

fsp_err_ t R_AGT StatusGet ( timer_ctrl_t *const p_ctrl, timer_status_t *const p_status )

Retrieves the current state and counter value stores them in p_status. Implements
timer_api_t::statusGet.

Example:

/* Read the current counter value. Counter value is in status.counter. */

timer_status t status;

(void) R AGI _StatusGet(&g tinerO_ctrl, &status);

Return values

FSP_SUCCESS Current status and counter value provided
in p_status.
FSP_ERR_ASSERTION A required pointer is NULL.
FSP_ERR_NOT _OPEN The instance control structure is not
opened.
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& R_AGT_Stop()

fsp_err t R_AGT Stop ( timer_ctrl_t *const p_ctrl)

Stops the timer. Implements timer_api_t::stop.
Example:
/* (Optional) Stop the tinmer. */

(void) R AGT _Stop(&g_tiner0 ctrl);

Return values
FSP_SUCCESS

Timer stopped.
FSP_ERR_ASSERTION p_ctrl was NULL.

FSP_ERR_NOT OPEN

The instance control structure is not
opened.
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¢ R_AGT_Open()

fsp_err t R_AGT Open ( timer_ctrl_t *const p_ctrl, timer_cfg_t const *const p cfg )

Initializes the AGT module instance. Implements timer_api_t::open.

The AGT hardware does not support one-shot functionality natively. The one-shot feature is
therefore implemented in the AGT HAL layer. For a timer configured as a one-shot timer, the timer
is stopped upon the first timer expiration.

The AGT implementation of the general timer can accept an optional agt_extended_cfg t extension
parameter. For AGT, the extension specifies the clock to be used as timer source and the output
pin configurations. If the extension parameter is not specified (NULL), the default clock PCLKB is
used and the output pins are disabled.

Example:
/* Initializes the nodule. */

err = R AGT_Open(&g_tinerO ctrl, &g tiner0 _cfg);

Return values

FSP_SUCCESS Initialization was successful and timer has
started.

FSP_ERR_ASSERTION A required input pointer is NULL or the
period is not in the valid range of 1 to
OxFFFF.

FSP_ERR_ALREADY_OPEN R_AGT Open has already been called for
this p_ctrl.

FSP_ERR_IRQ_BSP _DISABLED A required interrupt has not been enabled in
the vector table.

FSP_ERR_IP_ CHANNEL NOT PRESENT Requested channel number is not available
on AGT.

¢ R_AGT VersionGet()

fsp_err t R_AGT VersionGet ( fsp_version_t *const p_version)

Sets driver version based on compile time macros. Implements timer_api_t::versionGet.

Return values

FSP_SUCCESS Version in p_version.
FSP_ERR_ASSERTION The parameter p_version is NULL.
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4.2.5 Bluetooth Low Energy Library (r_ble)
Modules

Functions
ble status t R _BLE Open (void)

Open the BLE protocol stack. More...

ble_status_ t R _BLE_Close (void)

Close the BLE protocol stack. More...

ble status t R BLE Execute (void)
Execute the BLE task. More...

uint32_t R _BLE IsTaskFree (void)

Check the BLE task queue is free or not. More...

ble_status_ t R_BLE_SetEvent (ble_event cb_t cb)

Set event. More...

uint32_t R_BLE_GetVersion (void)

Get the BLE FIT module version. More...

uint32 t R BLE GetLibType (void)
Get the type of BLE protocol stack library. More...

Detailed Description

Driver for the Radio peripheral on RA MCUs. This module implements the BLE Interface.

Overview

The bluetooth low energy library (r_ble) provides an API to control the Radio peripheral. This module
is configured via the QE for BLE.

Features
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e Common
o Open/Close the BLE protocol stack.
o Execute the BLE job.

o Add an event in the BLE protocol stack internal queue.

e GAP
Initialization of the Host stack.
Start/Stop Advertising.
Start/Stop Scan.
Connect/Disconnect a link.
o |nitiate/Respond a pairing request.
e GATT Common
o Get MTU size.
e GATT Server
o |nitialization of GATT Server.
o Notification/Indication.
e GATT Client
o Discovery services, characteristics.
o Read/Write characteristic.
e L2CAP
o Credit-based flow control transaction.
e Vendor Specific
o DTM.
o Set/Get transmit power.
o Set/Get BD_ADDR.

o O O o

Target Devices

The Renesas Bluetooth Low Energy Library supports the following devices.

* RA4W1

Configuration
Clock Configuration
Note

System clock (ICLK): 8 MHz or more
Peripheral module clock A (PCLKA): 8MHz or more

The BLE Protocol Stack is optimized for ICLK and PCLKA frequencies of 32 MHz

It is recommended that the clock be set so that the ICLK and PCLKA frequencies are 32MHzin order to get the

best performance fromthe BLE.
Pin Configuration

This module does not use I/O pins.

Usage Notes

Figure shows the software structure of the BLE FSP module.
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User Application

' Profile APl 1
Agﬁﬁitﬁgn || BLE Profile

R_BLE API
Bluetooth Low Energy Library

BLE (H/W)

Figure 121: BLE software structure

The BLE FSP module consists of the BLE library.

The BLE Application uses the BLE functions via the R_BLE API provided by the BLE Library.
The QE for BLE generates the source codes (BLE base skeleton program) as a base for the BLE
Application and the BLE Profile codes including the Profile API.

Limitations

Developers should be aware of the following limitations when using the ble:

Modules
GAP
GATT_COMMON
GATT_SERVER
GATT _CLIENT
L2CAP
VS

Typedefs

typedef void(* ble_event cb_t) (void)
ble_event cb_t is the callback function type for R_BLE_SetEvent().
More...
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Typedef Documentation

¢ ble_event_cb t

ble_event cb_t

ble_event cb_tis the callback function type for R_BLE_SetEvent().

Parameters

lin] void

Returns
none

Function Documentation

¢ R_BLE_Open()

ble status t R BLE Open ( void )

Open the BLE protocol stack.

This function should be called once before using the BLE protocol stack.

Return values
BLE_SUCCESS(0x0000) Success

¢ R_BLE_Close()

ble status t R BLE Close ( void )

Close the BLE protocol stack.

This function should be called once to close the BLE protocol stack.

Return values
BLE_SUCCESS(0x0000) Success
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¢ R_BLE_Execute()

ble_status_t R_BLE_Execute ( void )

Execute the BLE task.
This handles all the task queued in the BLE protocol stack internal task queue and return. This
function should be called repeatedly in the main loop.

Return values
BLE_SUCCESS(0x0000) Success

& R_BLE_IsTaskFree()

uint32_t R BLE IsTaskFree ( void )

Check the BLE task queue is free or not.

This function returns the BLE task queue free status. When this function returns 0x0, call
R_BLE_Execute() to execute the BLE task.

Return values

0x0 BLE task queue is not free

0x1 BLE task queue is free

¢ R_BLE_SetEvent()

ble_status_t R_BLE_SetEvent ( ble_event_cb t cb)

Set event.

This function add an event in the BLE protocol stack internal queue. The event is handled in
R_BLE_Execute just like Bluetooth event. This function is intended to be called in hardware
interrupt context. Even if calling this function with the same cb before the cb is invoked, only one
event is registered. The maximum number of the events can be registered at a time is eight.

Parameters
cb The callback for the event.

Return values

BLE_SUCCESS(0x0000) Success
BLE_ERR_ALREADY_IN_PROGRESS(0x000A) |[The event already registered with the
callback.
BLE_ERR_CONTEXT_FULL(0x000B) No free slot for the event.
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¢ R_BLE_GetVersion()

uint32_t R_BLE_GetVersion ( void )

Get the BLE FIT module version.

This function returns the BLE FIT module version.

The major version(BLE_VERSION_MAJOR) is contained in the two most significant bytes, and the
minor version(BLE_VERSION_MINOR) occupies the remaining two bytes.

Return values
BLE_VERSION_MAJOR | BLE_VERSION_MINOR

¢ R_BLE_GetLibType()

uint32 t R BLE GetLibType ( void )

Get the type of BLE protocol stack library.

This function returns the type of BLE protocol stack library.

Return values

BLE_LIB_ALL _FEATS(0x00) All Features
BLE_LIB_BALANCE(0x01) Balance
BLE_LIB_COMPACT(0x02) Compact

GATT_COMMON
Modules » Bluetooth Low Energy Library (r_ble)

Functions
ble_status_t R_BLE_GATT_GetMtu (uintl6_t conn_hdl, uintl6_t *p_mtu)

This function gets the current MTU used in GATT communication.

More...
Detailed Description
Function Documentation
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¢ R_BLE_GATT GetMtu()

ble status t R BLE GATT GetMtu ( uintl6 _t conn_hdl, uintle t* p mtu )

This function gets the current MTU used in GATT communication.

Both GATT server and GATT Client can use this function.
The result of this API call is returned by a return value.

Parameters
[in] conn_hdl Connection handle
identifying the GATT Server
or the GATT Client.
[in] p_mtu The Current MTU. Before
MTU exchange, this
parameter is 23 bytes.
After MTU exchange, this
parameter is the negotiated
MTU.
Return values
BLE_SUCCESS(0x0000) Success
BLE_ERR _INVALID PTR(0x0001) The mtu parameter is NULL.
BLE_ERR_INVALID_HDL(0x000E) The GATT Server or the GATT Client
specified by conn_hdl was not found.

4.2.6 Clock Frequency Accuracy Measurement Circuit (r_cac)

Modules

Functions

fsp_err t R_CAC_Open (cac_ctrl_t *const p_ctrl, cac_cfg_t const *const p_cfqg)

fsp_err t R_CAC_StartMeasurement (cac_ctrl_t *const p_ctrl)

fsp_err t R_CAC_StopMeasurement (cac_ctrl_t *const p_ctrl)

fsp_err t R_CAC Read (cac_ctrl_t *const p_ctrl, uintl6_t *const p_counter)

fsp_err t R_CAC _Close (cac_ctrl_t *const p_ctrl)

fsp_err t R_CAC_VersionGet (fsp_version_t *const p_version)

Detailed Description
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Driver for the CAC peripheral on RA MCUs. This module implements the CAC Interface.

Overview

The interface for the clock frequency accuracy measurement circuit (CAC) peripheral is used to
check a system clock frequency with a reference clock signal by counting the number of
measurement clock edges that occur between two edges of the reference clock.

Features

e Supports clock frequency-measurement and monitoring based on a reference signal input

e Reference can be either an externally supplied clock source or an internal clock source

e An interrupt request may optionally be generated by a completed measurement, a detected
frequency error, or a counter overflow.

A digital filter is available for an externally supplied reference clock, and dividers are

available for both internally supplied measurement and reference clocks.

Configuration

Build Time Configurations for r_cac

The following build time configurations are defined in fsp_cfg/r_cac_cfg.h:

Edge-detection options for the reference clock are configurable as rising, falling, or both.

Configuration

Options

Default

Description

Parameter Checking

e Default (BSP)
e Enabled
¢ Disabled

Default (BSP)

If selected code for
parameter checking is
included in the build.

Configurations for Driver > Monitoring > Clock Accuracy Circuit Driver on r_cac

This module can be added to the Stacks tab via New Stack > Driver > Monitoring > Clock Accuracy

Circuit Driver on r_cac:

Configuration

Options

Default

Description

Name

Reference clock divider

Reference clock source

Name must be a valid
C symbol

e 32

e 128

e 1024

e 8192

e Main Oscillator
Sub-clock
HOCO
MOCO
LOCO
PCLKB
IWDT
External

g_cacO

32

Main Oscillator

Module name.

Reference clock
divider.

Reference clock
source.
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Reference clock digital e Disabled Disabled Reference clock digital

filter

Reference clock edge
detect

Measurement clock
divider

Measurement clock
source

Upper Limit Threshold

Lower Limit Threshold

Frequency Error
Interrupt Priority

Measurement End
Interrupt Priority

Overflow Interrupt
Priority

Callback

Clock Configuration

The CAC measurement clock source can be configured as the following:

1. MAIN_OSC
2. SUBCLOCK
3. HOCO
4. MOCO
5. LOCO

e Sampling clock
=Measuring
freq

e Sampling clock
=Measuring
freq/4

¢ Sampling clock
=Measuring
freq/16

e Rising
e Falling
e Both

.1
. 4
.8
. 32

Main Oscillator
Sub-clock
HOCO

MOCO

LOCO

PCLKB

e IWDT

Value must be a non-
negative integer,
between 0 to 65535

Value must be a non-
negative integer,
between 0 to 65535

MCU Specific Options

MCU Specific Options

MCU Specific Options

Name must be a valid
C symbol

filter.

Reference clock edge
detection.

Measurement clock
divider.

Measurement clock
source.

Top end of allowable
range for measurement
completion.

Bottom end of
allowable range for
measurement
completion.

CAC frequency error
interrupt priority.

CAC measurement end
interrupt priority.

CAC overflow interrupt
priority.

Function name for
callback
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6. PCLKB
7. IWDT

The CAC reference clock source can be configured as the following:

. MAIN_OSC

. SUBCLOCK

. HOCO

. MOCO

. LOCo

. PCLKB

. IWDT

. External Clock Source (CACREF)

oNOUL s~ WN B

Pin Configuration

The CACREF pin can be configured to provide the reference clock for CAC measurements.

Usage Notes

Measurement Accuracy

The clock measurement result may be off by up to one pulse depending on the phase difference
between the edge detection circuit, digital filter, and CACREF pin signal, if applicable.

Frequency Error Interrupt

The frequency error interrupt is only triggered at the end of a CAC measurement. This means that
there will be a measurement complete interrupt in addition to the frequency error interrupt.

Examples

Basic Example

This is a basic example of minimal use of the CAC in an application.

volatile uint32 t g_call back conpl et e;
voi d cac_basi c_exanple ()
{
g_cal | back_conpl ete = 0;
fsp_err_t err = R CAC Open(&g_cac_ctrl, &g _cac_cfg);
/* Handl e any errors. This function should be defined by the user. */
handl e _error(err);
(void) R CAC Start Measurenent (&y_cac_ctrl);
/* Wait for neasurenment to conplete. */
while (0 == g_cal |l back_conpl et e)
{

R11UMO146EU0120 Revision 1.20 RENESANAS Page 262 / 1,560
Jun.26.20



Flexible Software Package

API| Reference > Modules > Clock Frequency Accuracy Measurement Circuit (r_cac)

User’s Manual

}

uint16 t val ue;

/* Read the CAC neasurenent. */

(void) R CAC Read(&g _cac _ctrl,

}

&val ue) ;

/* Call ed when neasurenent is conpleted. */

static void r_cac_call back (cac_call back _args_t * p_args)

{
i f (CAC_EVENT_MEASUREMENT COVPLETE == p_args->event)
{
g_cal | back _conplete = 1U;
}
}

Data Structures

struct cac_instance ctrl t

Data Structure Documentation

& cac_instance_ctrl_t

struct cac_instance_ctrl_t

CAC instance control block. DO NOT INITIALIZE.

Function Documentation

& R_CAC_Open()

fsp_err_ t R_CAC_Open ( cac_ctrl_t *const p ctrl, cac_cfg t const *const p cfg )

Return values

The Open function configures the CAC based on the provided user configuration settings.

FSP_SUCCESS

CAC is available and available for
measurement(s).

FSP_ERR_ASSERTION

An argument is invalid.

FSP_ERR_ALREADY_OPEN

The CAC has already been opened.

Note

Thereisonly a single CAC peripheral.
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¢ R_CAC_StartMeasurement()

fsp_err_t R_CAC_StartMeasurement ( cac_ctrl_t *const p_ctrl)

Start the CAC measurement process.

Return values

FSP_SUCCESS CAC measurement started.

FSP_ERR_ASSERTION NULL provided for p_instance_ctrl or p_cfg.

FSP_ERR_NOT_OPEN R_CAC_Open() has not been successfully
called.

¢ R_CAC_StopMeasurement()

fsp_err_t R_CAC_StopMeasurement ( cac_ctrl_t *const p_ctr/)

Stop the CAC measurement process.

Return values

FSP_SUCCESS CAC measuring has been stopped.

FSP_ERR_ASSERTION NULL provided for p_instance_ctrl or p_cfg.

FSP_ERR_NOT_OPEN R_CAC_Open() has not been successfully
called.

¢ R_CAC_Read()

fsp_err t R_ CAC Read ( cac_ctrl t *const p_ctrl, uintl6 t *const p_counter )

Read and return the CAC status and counter registers.

Return values

FSP_SUCCESS CAC read successful.
FSP_ERR_ASSERTION An argument is NULL.
FSP_ERR_NOT_OPEN R_CAC_Open() has not been successfully
called.
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4 R_CAC _Close()

fsp_err_ t R_CAC Close ( cac_ctrl_t *const p_ctrl)

Release any resources that were allocated by the Open() or any subsequent CAC operations.

Return values

FSP_SUCCESS Successful close.

FSP_ERR_ASSERTION NULL provided for p_instance_ctrl or p_cfg.

FSP_ERR_NOT_OPEN R_CAC_Open() has not been successfully
called.

¢ R_CAC VersionGet()

fsp_err_t R_CAC _VersionGet ( fsp_version_t *const p_version)

Get the API and code version information.

Return values
FSP_SUCCESS Version info returned.

FSP_ERR_ASSERTION An argument is NULL.

4.2.7 Controller Area Network (r_can)

Modules
Functions
fsp_err t R_CAN Open (can_ctrl_t *const p_api_ctrl, can_cfg_t const *const
p_cfg)
fsp_err t R_CAN _Close (can_ctrl_t *const p_api_ctrl)
fsp_err t R_CAN_Write (can_ctrl_t *const p_api_ctrl, uint32_t const mailbox,
can_frame_t *const p_frame)
fsp_err t R_CAN_ModeTransition (can_ctrl_t *const p_api_ctrl,
can_operation_mode_t operation_mode, can_test mode_t test mode)
fsp_err t R_CAN InfoGet (can_ctrl _t *const p_api_ctrl, can_info_t *const p_info)
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fsp_err t R_CAN VersionGet (fsp_version_t *const version)

Detailed Description

Driver for the CAN peripheral on RA MCUs. This module implements the CAN Interface.

Overview

The Controller Area network (CAN) HAL module provides a high-level APl for CAN applications and
supports the CAN peripherals available on RA microcontroller hardware. A user-callback function
must be defined that the driver will invoke when transmit, receive or error interrupts are received.
The callback is passed a parameter which indicates the channel, mailbox and event as well as the
received data (if available).

Features

e Supports both standard (11-bit) and extended (29-bit) messaging formats

e Supports speeds upto 1 Mbps

e Support for bit timing configuration as defined in the CAN specification

Supports up to 32 transmit or receive mailboxes with standard or extended ID frames
Receive mailboxes can be configured to capture either data or remote CAN Frames
Receive mailboxes can be configured to receive a range of IDs using mailbox masks
Mailboxes can be configured with Overwrite or Overrun mode

Supports a user-callback function when transmit, receive, or error interrupts are received

Configuration

Build Time Configurations for r_can

The following build time configurations are defined in fsp_cfg/r_can_cfg.h:

User’s Manual

Configuration Options Default Description

If selected code for

Parameter Checking

Configurations for Driver > Connectivity > CAN Driver on r_can

e Default (BSP)
e Enabled
e Disabled

Default (BSP)

parameter checking is
included in the build.

This module can be added to the Stacks tab via New Stack > Driver > Connectivity > CAN Driver on

r_can:

Configuration

Options

Default

Description

Jun.26.20

General > Name Name must be a valid g_canO Module name.
C symbol
General > Channel Channel should be O or 0 Specify the CAN
1 channel to use.
General > Clock Source MCU Specific Options Select the CAN clock
source.
General > Sample- Must be a valid integer 75 Sample-Point = (TSEG1
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Point (%)

General > CAN Baud
Rate (Hz)

General >
Overwrite/Overrrun
Mode

General > Standard or
Extended ID Mode

General > Number of
Mailboxes

Interrupts > Callback

Interrupts > Interrupt
Priority Level

Input > Mailbox 0-3
Group > Mailbox ID >
Mailbox O ID

Input > Mailbox 0-3
Group > Mailbox ID >
Mailbox 1 ID

Input > Mailbox 0-3
Group > Mailbox ID >
Mailbox 2 ID

between 0 and 100.

Must be a valid integer
configurable upto
maximum 4MHz.

e Overwrite Mode
e Overrrun Mode

e Standard ID
Mode

e Extended ID
Mode

e 4 Mailboxes
¢ 8 Mailboxes
¢ 16 Mailboxes
e 32 Mailboxes

Name must be a valid
C symbol

MCU Specific Options

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

500000

Overwrite Mode

Standard ID Mode

32 Mailboxes

can_callback

+ 1) / (TSEG1 + TSEG?2
+ 1).

Specify baud rate in
Hz.

Select whether receive
mailbox will be
overwritten or overrun
if data is not read in
time.

Select whether the
driver will use the CAN
standard or extended
IDs.

Select 4, 8, 16 or 32
mailboxes.

A user callback
function. If this callback
function is provided, it
is called from the
interrupt service
routine (ISR) each time
any interrupt occurs.

Error/Receive/Transmit
interrupt priority.

Select the receive ID
for mailbox 0, between
0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Select the receive ID
for mailbox 1, between
0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Select the receive ID

for mailbox 2, between
0 and Ox7ff when using
standard IDs, between
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0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Input > Mailbox 0-3 Value must be decimal 3 Select the receive ID
Group > Mailbox ID > or HEX integer of for mailbox 3, between
Mailbox 3 1D Ox1FFFFFFF or less. 0 and Ox7ff when using

standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Input > Mailbox 0-3 e Receive Transmit Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 0 Type e Transmit receive or transmit.
Mailbox
Input > Mailbox 0-3 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 1 Type e Transmit receive or transmit.
Mailbox
Input > Mailbox 0-3 ¢ Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 2 Type e Transmit receive or transmit.
Mailbox
Input > Mailbox 0-3 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 3 Type e Transmit receive or transmit.
Mailbox
Input > Mailbox 0-3 ¢ Data Mailbox Remote Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 0 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 0-3 ¢ Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 1 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 0-3 ¢ Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 2 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 0-3 e Data Mailbox Data Mailbox Select whether the
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Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 3
Frame Type

Input > Mailbox 0-3
Group > Mailbox 0-3
Group Mask

Input > Mailbox 4-7
Group > Mailbox ID >
Mailbox 4 1D

Input > Mailbox 4-7
Group > Mailbox ID >
Mailbox 5 ID

Input > Mailbox 4-7
Group > Mailbox ID >
Mailbox 6 1D

Input > Mailbox 4-7
Group > Mailbox ID >
Mailbox 7 ID

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Ox1FFFFFFF

capture data frames or
remote frames (ignored
for transmit
mailboxes).

Select the Mask for
mailboxes 0-3.

Select the receive ID
for mailbox 4, between
0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Select the receive ID
for mailbox 5, between
0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Select the receive ID
for mailbox 6, between
0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Select the receive ID
for mailbox 7, between
0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Jun.26.20

Input > Mailbox 4-7 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 4 Type e Transmit receive or transmit.
Mailbox
Input > Mailbox 4-7 ¢ Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 5 Type e Transmit receive or transmit.
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Mailbox
Input > Mailbox 4-7 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 6 Type e Transmit receive or transmit.
Mailbox
Input > Mailbox 4-7 ¢ Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 7 Type ¢ Transmit receive or transmit.
Mailbox
Input > Mailbox 4-7 e Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 4 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 4-7 e Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 5 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 4-7 ¢ Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 6 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 4-7 ¢ Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 7 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 4-7 Value must be decimal Ox1FFFFFFF >Select the Mask for
Group > Mailbox 4-7 or HEX integer of mailboxes 4-7.
Group Mask Ox1FFFFFFF or less.
Input > Mailbox 8-11 Value must be decimal 8 Select the receive ID
Group > Mailbox ID > or HEX integer of for mailbox 8, between
Mailbox 8 ID OxX1FFFFFFF or less. 0 and 0x7ff when using
standard IDs, between
0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.
Input > Mailbox 8-11 Value must be decimal 9 Select the receive ID
Group > Mailbox ID > or HEX integer of for mailbox 9, between
Mailbox 9 ID Ox1FFFFFFF or less. 0 and Ox7ff when using
standard IDs, between
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Input > Mailbox 8-11
Group > Mailbox ID >
Mailbox 10 ID

Input > Mailbox 8-11
Group > Mailbox ID >
Mailbox 11 ID

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

10

11

0 and Ox1FFFFFFF
when using extended
IDs. Value is not used
when the mailbox is set
as transmit type.

Select the receive ID
for mailbox 10,
between 0 and Ox7ff
when using standard
IDs, between 0 and
OXx1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 11,
between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Jun.26.20

Input > Mailbox 8-11 ¢ Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 8 Type ¢ Transmit receive or transmit.
Mailbox

Input > Mailbox 8-11 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 9 Type e Transmit receive or transmit.
Mailbox

Input > Mailbox 8-11 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 10 Type e Transmit receive or transmit.
Mailbox

Input > Mailbox 8-11 ¢ Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 11 Type ¢ Transmit receive or transmit.
Mailbox

Input > Mailbox 8-11 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 8 capture data frames or

Frame Type remote frames (ignored

for transmit
mailboxes).

Input > Mailbox 8-11 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 9 capture data frames or
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Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 8-11 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 10 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 8-11 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 11 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 8-11 Value must be decimal Ox1FFFFFFF Select the Mask for

Group > Mailbox 8-11  or HEX integer of mailboxes 8-11.

Group Mask OX1FFFFFFF or less.

Input > Mailbox 12-15 Value must be decimal 12 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 12,

Mailbox 12 ID OX1FFFFFFF or less. between 0 and 0x7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Input > Mailbox 12-15 Value must be decimal 13 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 13,

Mailbox 13 ID OX1FFFFFFF or less. between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Input > Mailbox 12-15 Value must be decimal 14 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 14,

Mailbox 14 ID OX1FFFFFFF or less. between 0 and 0Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Input > Mailbox 12-15 Value must be decimal 15 Select the receive ID

Group > Mailbox ID >  or HEX integer of for mailbox 15,

Mailbox 15 ID OX1FFFFFFF or less. between 0 and 0x7ff
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when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Jun.26.20

Input > Mailbox 12-15 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 12 Type ¢ Transmit receive or transmit.
Mailbox
Input > Mailbox 12-15 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 13 Type e Transmit receive or transmit.
Mailbox
Input > Mailbox 12-15 ¢ Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 14 Type e Transmit receive or transmit.
Mailbox
Input > Mailbox 12-15 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 15 Type ¢ Transmit receive or transmit.
Mailbox
Input > Mailbox 12-15 e Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 12 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 12-15 ¢ Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 13 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 12-15 ¢ Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 14 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 12-15 ¢ Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 15 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 12-15 Value must be decimal Ox1FFFFFFF Select the Mask for
Group > Mailbox 12-15 or HEX integer of mailboxes 12-15.
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Group Mask

Input > Mailbox 16-19
Group > Mailbox ID >
Mailbox 16 ID

Input > Mailbox 16-19
Group > Mailbox ID >
Mailbox 17 ID

Input > Mailbox 16-19
Group > Mailbox ID >
Mailbox 18 ID

Input > Mailbox 16-19
Group > Mailbox ID >
Mailbox 19 ID

Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

16

17

18

19

Select the receive ID
for mailbox 16,
between 0 and 0x7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 17,
between 0 and 0x7ff
when using standard
IDs, between 0 and
OX1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 18,
between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 19,
between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Jun.26.20

Input > Mailbox 16-19 ¢ Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 16 Type ¢ Transmit receive or transmit.
Mailbox

Input > Mailbox 16-19 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 17 Type e Transmit receive or transmit.
Mailbox

Input > Mailbox 16-19 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for
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> Mailbox 18 Type e Transmit receive or transmit.
Mailbox

Input > Mailbox 16-19 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 19 Type e Transmit receive or transmit.

Mailbox

Input > Mailbox 16-19 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 16 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 16-19 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 17 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 16-19 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 18 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 16-19 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 19 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 16-19 Value must be decimal Ox1FFFFFFF Select the Mask for

Group > Mailbox 16-19 or HEX integer of mailboxes 16-19.

Group Mask Ox1FFFFFFF or less.

Input > Mailbox 20-23  Value must be decimal 20 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 20,

Mailbox 20 ID OX1FFFFFFF or less. between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Input > Mailbox 20-23  Value must be decimal 21 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 21,

Mailbox 21 ID OX1FFFFFFF or less. between 0 and 0x7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
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Input > Mailbox 20-23
Group > Mailbox ID >
Mailbox 22 ID

Input > Mailbox 20-23
Group > Mailbox ID >
Mailbox 23 ID

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

22

23

not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 22,
between 0 and 0x7ff
when using standard
IDs, between 0 and
OX1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 23,
between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Jun.26.20

Input > Mailbox 20-23 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 20 Type ¢ Transmit receive or transmit.
Mailbox
Input > Mailbox 20-23 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 21 Type e Transmit receive or transmit.
Mailbox
Input > Mailbox 20-23 ¢ Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 22 Type e Transmit receive or transmit.
Mailbox
Input > Mailbox 20-23 e Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 23 Type ¢ Transmit receive or transmit.
Mailbox
Input > Mailbox 20-23 e Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 20 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 20-23 ¢ Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to
Type > Mailbox 21 capture data frames or
Frame Type remote frames (ignored
for transmit
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mailboxes).

Input > Mailbox 20-23 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 22 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 20-23 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 23 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 20-23  Value must be decimal Ox1FFFFFFF Select the Mask for

Group > Mailbox 20-23 or HEX integer of mailboxes 20-23

Group Mask OX1FFFFFFF or less.

Input > Mailbox 24-27  Value must be decimal 24 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 24,

Mailbox 24 ID OX1FFFFFFF or less. between 0 and 0Ox7ff
when using standard
IDs, between 0 and
OX1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Input > Mailbox 24-27  Value must be decimal 25 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 25,

Mailbox 25 ID OX1FFFFFFF or less. between 0 and 0x7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Input > Mailbox 24-27  Value must be decimal 26 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 26,

Mailbox 26 ID OX1FFFFFFF or less. between 0 and Ox7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Input > Mailbox 24-27 Value must be decimal 27 Select the receive ID

Group > Mailbox ID > or HEX integer of for mailbox 27,

Mailbox 27 ID OX1FFFFFFF or less. between 0 and Ox7ff
when using standard
IDs, between 0 and
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OX1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Input > Mailbox 24-27 Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 24 Type Transmit receive or transmit.
Mailbox
Input > Mailbox 24-27 Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 25 Type Transmit receive or transmit.
Mailbox
Input > Mailbox 24-27 Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 26 Type Transmit receive or transmit.
Mailbox
Input > Mailbox 24-27 Receive Receive Mailbox Select whether the
Group > Mailbox Type Mailbox mailbox is used for
> Mailbox 27 Type Transmit receive or transmit.
Mailbox
Input > Mailbox 24-27 Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame Remote Mailbox mailbox is used to
Type > Mailbox 24 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 24-27 Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame Remote Mailbox mailbox is used to
Type > Mailbox 25 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 24-27 Data Mailbox Data Mailbox Select whether the
Group > Mailbox Frame Remote Mailbox mailbox is used to
Type > Mailbox 26 capture data frames or
Frame Type remote frames (ignored
for transmit
mailboxes).
Input > Mailbox 24-27 Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame
Type > Mailbox 27
Frame Type

Remote Mailbox

mailbox is used to
capture data frames or
remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 24-27 Value must be decimal Ox1FFFFFFF
Group > Mailbox 24-27 or HEX integer of
Group Mask OX1FFFFFFF or less.

Select the Mask for
mailboxes 24-27.

Input > Mailbox 28-31 Value must be decimal 28 Select the receive ID
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Group > Mailbox ID >
Mailbox 28 ID

Input > Mailbox 28-31
Group > Mailbox ID >
Mailbox 29 ID

Input > Mailbox 28-31
Group > Mailbox ID >
Mailbox 30 ID

Input > Mailbox 28-31
Group > Mailbox ID >
Mailbox 31 ID

or HEX integer of
OX1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

Value must be decimal
or HEX integer of
Ox1FFFFFFF or less.

29

30

31

for mailbox 28,
between 0 and 0x7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 29,
between 0 and 0x7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 30,
between 0 and 0x7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Select the receive ID
for mailbox 31,
between 0 and 0x7ff
when using standard
IDs, between 0 and
Ox1FFFFFFF when using
extended IDs. Value is
not used when the
mailbox is set as
transmit type.

Jun.26.20

Input > Mailbox 28-31 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 28 Type e Transmit receive or transmit.
Mailbox

Input > Mailbox 28-31 ¢ Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 29 Type e Transmit receive or transmit.
Mailbox

Input > Mailbox 28-31 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 30 Type ¢ Transmit receive or transmit.
Mailbox
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Input > Mailbox 28-31 e Receive Receive Mailbox Select whether the

Group > Mailbox Type Mailbox mailbox is used for

> Mailbox 31 Type ¢ Transmit receive or transmit.

Mailbox

Input > Mailbox 28-31 e Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 28 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 28-31 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 29 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 28-31 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 30 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 28-31 ¢ Data Mailbox Data Mailbox Select whether the

Group > Mailbox Frame ¢ Remote Mailbox mailbox is used to

Type > Mailbox 31 capture data frames or

Frame Type remote frames (ignored
for transmit
mailboxes).

Input > Mailbox 28-31 Value must be decimal Ox1FFFFFFF Select the Mask for

Group > Mailbox 28-31 or HEX integer of mailboxes 28-31.

Group Mask OXx1FFFFFFF or less.

Clock Configuration

The CAN peripheral uses the CANMCLK (main-clock oscillator) or PCLKB as its clock source (fCAN,
CAN System Clock.) Using the PCLKB with the default of 60 MHz and the default CAN configuration
will provide a CAN bit rate of 500 Kbit. To set the PCLKB frequency, use the Clocks tab of the RA
Configuration editor. To change the clock frequency at run-time, use the CGC Interface. Refer to the
CGC module guide for more information on configuring clocks.

e The user application must start the main-clock oscillator (CANMCLK or XTAL) at run-time
using the CGC Interface if it has not already started (for example, if it is not used as the
MCU clock source.)

e For RA6, RA4 and RA2 MCUs, the following clock restriction must be satisfied for the CAN
HAL module when the clock source is the main-clock oscillator (CANMCLK):

o fPCLKB >= fCANCLK (fCANCLK = XTAL / Baud Rate Prescaler)

e For RA6 and RA4 MCUs, the source of the peripheral module clocks must be PLL for the CAN
HAL module when the clock source is PCLKB.

e For RA4 MCUs, the clock frequency ratio of PCLKA and PCLKB must be 2:1 when using the
CAN HAL module. Operation is not guaranteed for other settings.

e For RA2 MCUs, the clock frequency ratio of ICLK and PCLKB must be 2:1 when using the
CAN HAL module. Operation is not guaranteed for other settings.
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Pin Configuration
The CAN peripheral module uses pins on the MCU to communicate to external devices. I/O pins must

be selected and configured as required by the external device. A CAN channel would consist of two
pins - CRX and CTX for data transmission/reception.

Usage Notes

Bit Rate Calculation
The baudrate of the CAN peripheral is automatically set through the RA Configuration editor. For

more details on how the baudrate is set refer to section 37.4 "Data Transfer Rate Configuration" of
the RA6M3 User's Manual (RO1UH0886EJ0100).

Examples

Basic Example

This is a basic example of minimal use of the CAN in an application.

can_frame_t g can_tx frane;

can_frame_t g can_rx_frane;

vol ati |l e bool g_rx_flag = fal se;
vol atil e bool g tx flag = fal se;
vol ati |l e bool g_err_flag = fal se;

volatile uint32_t g rx_id;

voi d can_cal | back (can_cal | back_args_t * p_args)

{
swi tch (p_args->event)
{
case CAN _EVENT RX COVPLETE: /* Receive conplete event. */
{
g_rx_flag = true;
g rx_id = p_args->p_frame->id;

/* Read received frame */

mencpy(& can_rx frane, p_args->p_frame, sizeof(can_frame t));

br eak;
}
case CAN EVENT_ TX COVPLETE: /* Transnmit conplete event. */
{
g_tx flag = true;
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External Loop-back Test

This example requires a 120 Ohm resistor connected across channel 0 CAN pins. The mailbox
numbers are arbitrarily chosen.
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__BKPT(O0);

Function Documentation

4 R_CAN_Open()

fsp_err t R_CAN Open ( can_ctrl_t *const p_api _ctrl, can_cfg_t const *const p cfg )

Open and configure the CAN channel for operation.
Example:
/* Initialize the CAN nodul e */

err = R CAN Open(&g_canO _ctrl, &g canO_cfQ);

Return values

FSP_SUCCESS Channel opened successfully
FSP_ERR_ALREADY_OPEN Driver already open.
FSP_ERR_CAN_INIT_FAILED Channel failed to initialize.
FSP_ERR_ASSERTION Null pointer presented.

4 R_CAN_Close()

fsp_err t R_CAN_Close ( can_ctrl _t *const p_api _ctrl)

Close the CAN channel.

Return values

FSP_SUCCESS Channel closed successfully.
FSP_ERR_NOT _OPEN Control block not open.
FSP_ERR_ASSERTION Null pointer presented.
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¢ R_CAN_Write()

fsp_err_t R_CAN_Write ( can_ctrl_t *const p_api_ctrl, uint32_t mailbox, can_frame_t *const
p_frame )

Write data to the CAN channel. Write up to eight bytes to the channel mailbox.
Example:
err = R CAN Wite(&g canO_ctrl, CAN MAI LBOX NUMBER 31, &g can_tx_frane);

handl e _error(err);

Return values

FSP_SUCCESS Operation succeeded.

FSP_ERR_NOT_OPEN Control block not open.

FSP_ERR_CAN_TRANSMIT_NOT_READY Transmit in progress, cannot write data at
this time.

FSP_ERR_CAN_RECEIVE_MAILBOX Mailbox is setup for receive and cannot
send.

FSP_ERR_INVALID ARGUMENT Data length or frame type invalid.

FSP_ERR_ASSERTION Null pointer presented

4 R_CAN_ModeTransition()

fsp_err t R_ CAN_ModeTransition ( can_ctrl_t *const p_api ctrl, can_operation_mode_t
operation_mode, can_test mode_t test mode )

CAN Mode Transition is used to change CAN driver state.
Example:
err = R CAN ModeTransition(& canO ctrl, operation_node, test_node);

handl e_error(err);

Return values

FSP_SUCCESS Operation succeeded.
FSP_ERR_NOT _OPEN Control block not open.
FSP_ERR_ASSERTION Null pointer presented
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¢ R_CAN_InfoGet()

fsp_err_ t R_CAN InfoGet ( can_ctrl_t *const p_api ctrl, can_info_t *const p_info )

Get CAN state and status information for the channel.

Return values

FSP_SUCCESS Operation succeeded.
FSP_ERR_NOT _OPEN Control block not open.
FSP_ERR_ASSERTION Null pointer presented

& R_CAN _VersionGet()

fsp_err_ t R_CAN_VersionGet ( fsp_version_t *const p_version)

Get CAN module code and API versions.

Return values

FSP_SUCCESS Operation succeeded.
FSP_ERR_ASSERTION Null pointer presented note This function is
reentrant.

4.2.8 Clock Generation Circuit (r_cgc)

Modules
Functions
fsp_err t R_CGC Open (cgc_ctrl_t *const p_ctrl, cgc_cfg_t const *const p_cfg)
fsp_err t R_CGC _ClocksCfg (cgc_ctrl_t *const p_ctrl, cgc_clocks cfg t const
*const p_clock cfg)
fsp_err t R_CGC_ClockStart (cgc_ctrl_t *const p_ctrl, cgc_clock_t clock_source,
cgc_pll_cfg_t const *const p_pll_cfqg)
fsp_err t R_CGC_ClockStop (cgc_ctrl_t *const p_ctrl, cgc_clock t clock source)
fsp_err t R _CGC ClockCheck (cgc_ctrl _t *const p_ctrl, cgc_clock t
clock source)
fsp_err t R _CGC_SystemClockSet (cgc_ctrl_t *const p_ctrl, cgc_clock_t
clock source, cgc_divider _cfg_t const *const p_divider_cfg)
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fsp_err t R _CGC _SystemClockGet (cgc_ctrl_t *const p_ctrl, cgc_clock t *const
p_clock source, cgc_divider cfg t *const p_divider _cfqg)

fsp_err t R_CGC_OscStopDetectEnable (cgc_ctrl_t *const p_ctrl)
fsp_err t R_CGC_OscStopDetectDisable (cgc_ctrl_t *const p_ctrl)
fsp_err t R_CGC_OscStopStatusClear (cgc_ctrl_t *const p_ctrl)
fsp_err t R _CGC Close (cgc_ctrl_t *const p_ctrl)

fsp_err t R_CGC VersionGet (fsp_version_t *version)

Detailed Description
Driver for the CGC peripheral on RA MCUs. This module implements the CGC Interface.

Note
Thismoduleisnot required for the initial clock configuration. Initial clock settings are configurable on the
** Clocks tab of the RA Configuration editor. Theinitial clock settings are applied by the BSP during the startup
process before main.**

Overview

Features
The CGC module supports runtime modifications of clock settings. Key features include the following:

* Supports changing the system clock source to any of the following options (provided they
are supported on the MCU):
o High-speed on-chip oscillator (HOCO)
Middle-speed on-chip oscillator (MOCO)
Low-speed on-chip oscillator (LOCO)
Main oscillator (external resonator or external clock input frequency)
Sub-clock oscillator (external resonator)
PLL (not available on all MCUs)
e When the system core clock frequency changes, the following things are updated:
o The CMSIS standard global variable SystemCoreClock is updated to reflect the new
clock frequency.
o Wait states for ROM and RAM are adjusted to the minimum supported value for the
new clock frequency.
o The operating power control mode is updated to the minimum supported value for
the new clock settings.
e Supports starting or stopping any of the system clock sources
e Supports changing dividers for the internal clocks
e Supports the oscillation stop detection feature

o O o o

o

Internal Clocks

The RA microcontrollers have up to seven internal clocks. Not all internal clocks exist on all MCUs.
Each clock domain has its own divider that can be updated in R_CGC_SystemClockSet(). The dividers
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are subject to constraints described in the footnote of the table "Specifications of the Clock
Generation Circuit for the internal clocks" in the hardware manual.

The internal clocks include:

e System clock (ICLK): core clock used for CPU, flash, internal SRAM, DTC, and DMAC

e PCLKA/PCLKB/PCLKC/PCLKD: Peripheral clocks, refer to the table "Specifications of the Clock
Generation Circuit for the internal clocks" in the hardware manual to see which peripherals
are controlled by which clocks.

e FCLK: Clock source for reading data flash and for programming/erasure of both code and
data flash.

e BCLK: External bus clock

Configuration

Note
Theinitial clock settings are configurable on the Clocks tab of the RA Configuration editor.
There isa configuration to enable the HOCO on reset in the OF S settings on the BSP tab.
The following clock related settings are configurable in the RA Common section on the BSP tab:
o Main Oscillator Wait Time
o Main Oscillator Clock Source (external oscillator or crystal/resonator)
o Subclock Populated
o Subclock Drive
o Subclock Sabilization Time (ms)
The default stabilization times are determined based on devel opment boards provided by Renesas, but are
generally valid for most designs. Depending on the target board hardware configuration and requirements these
values may need to be adjusted for reliability or startup speed.

Build Time Configurations for r_cgc

The following build time configurations are defined in fsp_cfg/r_cgc_cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
e Enabled parameter checking is
¢ Disabled included in the build.

Configurations for Driver > System > CGC Driver on r_cgc

This module can be added to the Stacks tab via New Stack > Driver > System > CGC Driver on
r cgc:

Configuration Options Default Description
Name Name must be a valid  g_cgcO Module name.
C symbol
NMI Callback Name must be a valid NULL A user callback
C symbol function must be

provided if oscillation
stop detection is used.
If this callback function
is provided, it is called
from the NMI handler if
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the main oscillator
stops.

Clock Configuration

This module is used to configure the system clocks. There are no module specific clock
configurations required to use it.

Pin Configuration
The CGC module controls the output of the CLOCKOUT signal.

If an external oscillator is used the XTAL and EXTAL pins must be configured accordingly. When
running from an on chip oscillator there is no requirement for the main clock external oscillator. In
this case, the XTAL and EXTAL pins can be set to a different function in the RA Configuration editor.

The functionality of the subclock external oscillator pins XCIN and XCOUT is fixed.

Usage Notes
NMI Interrupt

The CGC timer uses the NMI for oscillation stop detection of the main oscillator after
R_CGC _OscStopDetectEnable is called. The NMI is enabled by default. No special configuration is
required. When the NMIl is triggered, the callback function registered during R_CGC_Open() is called.

Starting or Stopping the Subclock

If the Subclock Populated property is set to Populated on the BSP configuration tab, then the
subclock is started in the BSP startup routine. Otherwise, it is stopped in the BSP startup routine.
Starting and stopping the subclock at runtime is not recommended since the stabilization
requirements typically negate the negligible power savings.

The application is responsible for ensuring required clocks are started and stable before accessing
MCU peripheral registers.

Warning
The subclock can take up to several seconds to stabilize. RA startup code does not wait for
subclock stabilization unless the subclock is the main clock source. In this case the default
wait time is 1000ms (1 second). When running AGT or RTC off the subclock, the application
must ensure the subclock is stable before starting operation. Because there is no hardware
stabilization status bit for the subclock R_CGC_ClockCheck cannot be used to optimize this
wait.

Changing the subclock state during R_CGC_ClocksCfg() is not supported.
Low Power Operation
If "Use Low Voltage Mode" is enabled in the BSP MCU specific properties (not available on all MCUs),
the MCU is always in low voltage mode and no other power modes are considered. The following
conditions must be met for the MCU to run in low voltage mode:

e Requires HOCO to be running, so HOCO cannot be stopped in low voltage mode

e Requires PLL to be stopped, so PLL APIs are not available in low voltage mode
e Requires ICLK <= 4 MHz
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* [f oscillation stop detection is used, dividers of 1 or 2 cannot be used for any clock

If "Use Low Voltage Mode" is not enabled, the MCU applies the lowest power mode by searching
through the following list in order and applying the first power mode that is supported under the
current conditions:

e Subosc-speed mode (lowest power)
o Requires system clock to be LOCO or subclock
o Requires MOCO, HOCO, main oscillator, and PLL (if present) to be stopped
o Requires ICLK and FCLK dividers to be 1
e Low-speed mode
o Requires PLL to be stopped
o Requires ICLK <=1 MHz
o If oscillation stop detection is used, dividers of 1, 2, 4, or 8 cannot be used for any
clock
e Middle-speed mode (not supported on all MCUs)
o Requires ICLK <= 8 MHz
e High-speed mode
o Default mode if no other operating mode is supported

Refer to the section "Function for Lower Operating Power Consumption" in the "Low Power Modes"
chapter of the hardware manual for MCU specific information about operating power control modes.

When low voltage mode is not used, the following functions adjust the operating power control mode
to ensure it remains within the hardware specification and to ensure the MCU is running at the
optimal operating power control mode:

e R _CGC_ClocksStart()

e R CGC_ClockStop()

e R CGC_SystemClockSet()

e R CGC_OscStopDetectEnable()
e R CGC_OscStopDetectDisable()

Note
FSP APIs, including these APIs, are not thread safe. These APIs and any other user code that modifies the
operating power control mode must not be allowed to interrupt each other. Proper care must be taken during
application design if these APIs are used in threads or interrupts to ensure this constraint is met.

No action is required by the user of these APIs. This section is provided for informational purposes
only.

Examples

Basic Example

This is a basic example of minimal use of the CGC in an application.

voi d cgc_basi c_exanpl e (voi d)
{
fsp_err_t err = FSP_SUCCESS;

/* Initializes the CGC npodule. */
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err = R CGC Open(&g_cgcO ctrl, &g cgcO_cfqQ);
/* Handl e any errors. This function should be defined by the user. */
handl e_error(err);
/* Change the systemclock to LOCO for power saving. */
[* Start the LOCO */
err = R CGC O ockStart (&) cgcO _ctrl, CGC CLOCK LOCC, NULL);
handl e_error(err);
/* Wait for the LOCO stabilization wait tine.
*
* NOTE: The MOCO, LOCO and subcl ock do not have stabilization status bits, so any
stabilization time nmust be
* perfornmed via a software wait when starting these oscillators. For all other
oscillators, R CGC O ockCheck can
* be used to verify stabilization status.
*/
R _BSP_Sof t war eDel ay( BSP_FEATURE_CGC_LOCO STABI LI ZATI ON_MAX_US,
BSP_DELAY_UNI TS_M CROSECONDS) ;
/* Set divisors. Divisors for clocks that don't exist on the MCU are ignored. */
cgc_divider_cfg t dividers =
{
/* PCLKB is not used in this application, so select the maxi num di vi sor for | owest
power. */
.pcl kb_div = CGC _SYS CLOCK DI V_64,
/* PCLKD is not used in this application, so select the maxi num di vi sor for |owest
power. */
.pcl kd _div = CGC _SYS CLOCK DI V_64,
/* ICLK is the MCU clock, allowit to run as fast as the LOCO is capable. */
Jiclk_div = CGC_SYS_CLOCK DI V_1,
/* These cl ocks do not exist on sone devices. |f any clocks don't exist, set the
divider to 1. */

.pclka_div = CGC _SYS CLOCK DI V_1,

. pcl kc_div CGC _SYS CLOCK DIV 1,
.fclk _div = CGC_SYS CLOCK DI V_1,

.bel k_div = CGC_SYS_CLOCK DI V._1,
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I 5
/* Switch the systemclock to LOCO */
err = R CGC _SystenCl ockSet (& cgcO _ctrl, CGC CLOCK LOCC, &dividers);

handl e_error(err);

Configuring Multiple Clocks

This example demonstrates switching to a new source clock and stopping the previous source clock
in a single function call using R_CGC_ClocksCfg().
voi d cgc_cl ocks _cfg_exanpl e (void)
{
fsp_err_t err = FSP_SUCCESS,;
/* Initializes the CGC nodule. */
err = R CGC Open(&g_cgcO ctrl, &g cgcO_cfqQ);
/* Handl e any errors. This function should be defined by the user. */
handl e_error(err);
/* Change the systemclock to PLL running fromthe main oscillator. */
/* Assuming the systemclock is MOCO switch to HOCO */

cgc_clocks cfg_ t clocks cfg;

cl ocks_cfg. system cl ock CGC CLOCK _PLL;

clocks cfg.pll_state CGC_CLOCK _CHANGE NONE;

clocks _cfg.pll _cfg.source clock = CGC_ CLOCK MAIN OSC; // unused
clocks_cfg.pll_cfg.multiplier = CGC PLL_MJL 10 _O0; /'l unused
cl ocks_cfg. pll_cfg.divider = CGC_PLL_DI V_2; /] unused
cl ocks_cfg.divider cfg.iclk div = CGC_SYS CLOCK DIV_1;

cl ocks_cfg. divider_cfg.pclka div = CGC_SYS CLOCK DI V_4;

cl ocks_cfg. di vi der _cfg. pcl kb_di v CCGC_SYS CLOCK DI V_4;

cl ocks_cfg. divider cfg.pclkc _div CGC_SYS CLOCK DIV_4;

cl ocks_cfg. divider _cfg.pclkd div = CGC_SYS CLOCK DI V_4;

cl ocks_cfg. di vider_cfg. bcl k_div CCGC_SYS CLOCK DI V_4;

cl ocks_cfg.divider cfg.fclk div CGC_SYS CLOCK DIV_4;

cl ocks_cfg. mai nosc_st ate CGC_CLOCK_CHANGE NONE;

cl ocks_cfg. hoco_state CGC_CLOCK _CHANGE START;
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cl ocks_cfg. noco_state CGC _CLOCK _CHANGE _STOR;

CGC_CLOCK_CHANGE_NONE;

cl ocks_cfg.loco_state
err = R CGC O ocksCfg(&y_cgcO ctrl, &cl ocks_cfg);
handl e_error(err);
#i f BSP_FEATURE_CGC HAS PLL
/* Assum ng the systemclock is HOCO switch to PLL running frommain oscillator and

stop MOCO. */

cl ocks_cfg. system cl ock CGC CLOCK PLL;

cl ocks_cfg.pll_state CGC_CLOCK_CHANGE _START;

cl ocks_cfg.pll _cfg.source_cl ock CGC _CLOCK_NMAI N _OsCG;

clocks cfg.pll _cfg.multiplier (cgc_pll _mul t) BSP_CFG PLL_MJUL;

cl ocks_cfg.pll _cfg.divider (cgc_pll _div_t) BSP_CFG PLL_DlV;
cl ocks_cfg.divider _cfg.iclk div = CGC _SYS CLOCK DIV _1;

CGC_SYS_CLOCK DI V_4;

cl ocks_cfg. divider cfg.pclka_div

cl ocks_cfg. divider_cfg.pclkb_div CGC _SYS CLOCK DI V_4;

cl ocks_cfg. divider cfg.pclkc_div CGC_SYS CLOCK DIV_4;

CGC_SYS_CLOCK DI V_4;

cl ocks_cfg. divider cfg.pclkd div
cl ocks_cfg.divider_cfg.bclk div = CGC_SYS CLOCK DIV_4;

cl ocks_cfg.divider cfg.fclk div CGC_SYS CLOCK DIV_4;

cl ocks_cfg. mai nosc_state CGC_CLOCK _CHANGE START;

cl ocks_cfg. hoco_state CGC_CLOCK_CHANGE_STOP;

cl ocks_cfg. noco_state CGC_CLOCK_ CHANGE NONE;

cl ocks_cfg.loco_state CGC_CLOCK CHANGE NONE;
err = R CGC O ocksCfg(&y_cgcO ctrl, &cl ocks_cfg);
handl e_error(err);

#endi f

}

Oscillation Stop Detection

This example demonstrates registering a callback for oscillation stop detection of the main oscillator.

/* Exanpl e cal |l back called when oscillation stop is detected. */

void oscillation_stop_callback (cgc_call back args t * p_args)

{
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{
fsp err t err = FSP_SUCCESS;

/* Open the nodule. */

err = R CGC Open(&g_cgcO ctrl, &g cgcO_cfqQ);
/* Handl e any errors. This function should be defined by the user. */

handl e_error(err);
/* Enable oscillation stop detection. The main oscillator nust be running at this
point. */

err = R CGC _OscSt opDet ect Enabl e(&g _cgcO_ctrl);

handl e_error(err);
/* (Optional) Gscillation stop detection nust be disabled before entering any | ow
power node. */

err = R CGC _OscStopDet ect Di sabl e(&g_cgcO_ctrl);

handl e _error(err);

__W();
/* (Optional) Reenable oscillation stop detection after waking froml| ow power node.
*/

err = R CGC _OscSt opDet ect Enabl e(&g _cgcO_ctrl);

handl e_error(err);

Data Structures

struct cgc_instance_ctrl_t

Data Structure Documentation

& cgc_instance_ctrl_t

struct cgc_instance_ctrl_t

CGC private control block. DO NOT MODIFY. Initialization occurs when R_CGC_Open() is called.

Function Documentation
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4 R_CGC_Open()

fsp_err t R_CGC _Open ( cgc_ctrl_t *const p _ctrl, cgc_cfg_t const *const p cfg )

Initialize the CGC API. Implements cgc_api_t::open.
Example:
/* Initializes the CGC nodule. */

err = R CGC Open(&g_cgcO _ctrl, &g cgcO_cfqQ);

Return values

FSP_SUCCESS CGC successfully initialized.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_ALREADY_OPEN Module is already open.

4 R_CGC_ClocksCfg()

fsp_err t R_CGC_ClocksCfg ( cgc_ctrl_t *const p_ctrl, cgc_clocks cfg t const *const p clock cfg )

Reconfigures all main system clocks. This APl can be used for any of the following purposes:

e start or stop clocks

e change the system clock source

e configure the PLL multiplication and division ratios when starting the PLL
* change the system dividers

If the requested system clock source has a stabilization flag, this function blocks waiting for the
stabilization flag of the requested system clock source to be set. If the requested system clock
source was just started and it has no stabilization flag, this function blocks for the stabilization time
required by the requested system clock source according to the Electrical Characteristics section of
the hardware manual. If the requested system clock source has no stabilization flag and it is
already running, it is assumed to be stable and this function will not block. If the requested system
clock is the subclock, the subclock must be stable prior to calling this function.

The internal dividers (cgc_clocks cfg_t::divider_cfg) are subject to constraints described in
footnotes of the hardware manual table detailing specifications for the clock generation circuit for
the internal clocks for the MCU. For example:

e RA6M3: see footnotes of Table 9.2 "Specifications of the clock generation circuit for the
internal clocks" in the RA6M3 manual RO1IUH0886EJ0100

e RA2A1: see footnotes of Table 9.2 "Clock generation circuit specifications for the internal
clocks" in the RA2A1 manual RO1UH0888EJ0100

Do not attempt to stop the requested clock source or the source of the PLL if the PLL will be
running after this operation completes.

Implements cgc_api_t::clocksCfg.
Example:

/* Assuming the systemclock is MOCO switch to HOCO */
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cgc_clocks _cfg_t clocks cfg;

CGC_CLOCK_PLL;

cl ocks_cfg. system cl ock

cl ocks_cfg.pll_state CGC_CLOCK_CHANGE_NONE;

cl ocks_cfg.pll_cfg.source clock = CGC_ CLOCK MAIN OSC; // unused
clocks cfg.pll _cfg.multiplier = CGC PLL_MJL_10 O; /1 unused
cl ocks_cfg.pll _cfg.divider = CGC PLL_DIV_2; /'l unused

cl ocks_cfg.divider _cfg.iclk div = CGC SYS CLOCK DIV _1;

cl ocks_cfg. divider cfg.pclka_div CGC_SYS CLOCK DIV_4;

cl ocks_cfg. divider_cfg.pclkb_div CGC_SYS CLOCK DIV _4;

cl ocks_cfg. divider cfg.pclkc_div CGC_SYS CLOCK DIV_4;

CGC_SYS_CLOCK DI V_4;

cl ocks_cfg. divider cfg.pclkd div
cl ocks_cfg.divider_cfg.bclk div = CGC_SYS CLOCK DI V_4;

cl ocks_cfg.divider cfg.fclk div CGC_SYS CLOCK DIV_4;

cl ocks_cfg. mai nosc_state CGC_CLOCK CHANGE NONE;

cl ocks_cfg. hoco_state CGC_CLOCK_CHANGE_START;

cl ocks_cfg. noco_state CGC _CLOCK _CHANGE _STOR;

CGC_CLOCK_CHANGE_NONE;

cl ocks_cfg.loco_state
err = R CGC O ocksCfg(&y_cgcO ctrl, &cl ocks_cfg);

handl e_error(err);

Return values

FSP_SUCCESS Clock configuration applied successfully.
FSP_ERR_ASSERTION Invalid input argument.

FSP_ERR_NOT _OPEN Module is not open.

FSP_ERR_IN_USE Attempt to stop the current system clock or

the PLL source clock.

FSP_ERR_CLOCK ACTIVE PLL configuration cannot be changed while
PLL is running.

FSP_ERR_OSC _STOP_DET_ENABLED PLL multiplier must be less than 20 if
oscillation stop detect is enabled and the
input frequency is less than 12.5 MHz.

FSP_ERR_NOT_STABILIZED PLL clock source is not stable.
FSP_ERR_PLL SRC_INACTIVE PLL clock source is not running.
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4 R_CGC_ClockStart()

fsp_err t R_CGC_ClockStart ( cgc_ctrl_t *const p _ctrl, cgc_clock t clock source, cgc_pll_cfg t const
*const p pll cfg )

Start the specified clock if it is not currently active. The PLL configuration cannot be changed while
the PLL is running. Implements cgc_api_t::clockStart.

The PLL source clock must be operating and stable prior to starting the PLL.
Example:
/[* Start the LOCO */

err = R CGC C ockStart(&g_cgcO ctrl, CGC CLOCK LOCC, NULL);

handl e_error(err);

Return values

FSP_SUCCESS Clock initialized successfully.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_NOT_OPEN Module is not open.
FSP_ERR_NOT_STABILIZED The clock source is not stabilized after being
turned off or PLL clock source is not stable.
FSP_ERR_PLL SRC _INACTIVE PLL clock source is not running.
FSP_ERR_CLOCK_ ACTIVE PLL configuration cannot be changed while
PLL is running.
FSP_ERR_OSC_STOP_DET_ENABLED PLL multiplier must be less than 20 if

oscillation stop detect is enabled and the
input frequency is less than 12.5 MHz.
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4 R_CGC_ClockStop()

fsp_err t R_CGC_ClockStop ( cgc_ctrl_t *const p_ctrl, cgc_clock t clock source )

Stop the specified clock if it is active. Implements cgc_api_t::clockStop.

Do not attempt to stop the current system clock source. Do not attempt to stop the source clock of
the PLL if the PLL is running.

Return values

FSP_SUCCESS Clock stopped successfully.

FSP_ERR_ASSERTION Invalid input argument.

FSP_ERR_NOT _OPEN Module is not open.

FSP_ERR_IN_USE Attempt to stop the current system clock or
the PLL source clock.

FSP_ERR_OSC STOP_DET ENABLED Attempt to stop MOCO when Oscillation stop
is enabled.

FSP_ERR_NOT_STABILIZED Clock not stabilized after starting.

4 R_CGC_ClockCheck()

fsp_err t R_CGC_ClockCheck ( cgc_ctrl_t *const p_ctrl, cgc_clock t clock source )

Check the specified clock for stability. Implements cgc_api_t::clockCheck.

Return values
FSP_SUCCESS Clock is running and stable.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_NOT _OPEN Module is not open.
FSP_ERR_NOT_STABILIZED Clock not stabilized.
FSP_ERR_CLOCK_ INACTIVE Clock not turned on.
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4 R_CGC_SystemClockSet()

fsp_err_ t R_CGC_SystemClockSet ( cgc_ctrl t *const p ctrl, cgc_clock t clock source,
cgc_divider _cfg_t const *const p_divider cfg )

Set the specified clock as the system clock and configure the internal dividers for ICLK, PCLKA,
PCLKB, PCLKC, PCLKD, BCLK, and FCLK. Implements cgc_api_t::systemClockSet.

The requested clock source must be running and stable prior to calling this function. The internal
dividers are subject to constraints described in the hardware manual table "Specifications of the
Clock Generation Circuit for the internal clocks".

The internal dividers (p_divider_cfg) are subject to constraints described in footnotes of the
hardware manual table detailing specifications for the clock generation circuit for the internal
clocks for the MCU. For example:

e RA6M3: see footnotes of Table 9.2 "Specifications of the clock generation circuit for the
internal clocks" in the RA6M3 manual ROLUH0886EJ0100

e RA2A1: see footnotes of Table 9.2 "Clock generation circuit specifications for the internal
clocks" in the RA2A1 manual RO1UH0888E)J0100

This function also updates the RAM and ROM wait states, the operating power control mode, and
the SystemCoreClock CMSIS global variable.

Example:
/* Set divisors. Divisors for clocks that don't exist on the MCU are ignored. */
cgc_divider_cfg t dividers =
{

/* PCLKB is not used in this application, so select the maxi num divisor for |owest
power. */

.pcl kb _div = CGC _SYS CLOCK DI V_64,
/* PCLKD is not used in this application, so select the maxi num divisor for |owest
power. */

.pcl kd _div = CGC_SYS CLOCK DI V_64,
/* ICLK is the MCU clock, allowit to run as fast as the LOCO is capable. */

.iclk_div = CGC_SYS_CLOCK DI V_1,
/* These cl ocks do not exist on sone devices. |f any clocks don't exist, set the
di vider to 1. */

.pclka_div = CGC _SYS CLOCK DI V_1,

.pclkc_div = CGC _SYS CLOCK DIV_1,
.fclk _div = CGC_SYS CLOCK DI V_1,
.bclk div = CGC_SYS CLOCK DI V_1,

1
/* Switch the systemclock to LOCO */
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err = R CGC Syst entl ockSet (& cgcO ctrl, CGC CLOCK LOCC, &dividers);

handl e _error(err);

Return values

FSP_SUCCESS Operation performed successfully.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_NOT_OPEN Module is not open.

FSP_ERR_CLOCK INACTIVE The specified clock source is inactive.
FSP_ERR_NOT_STABILIZED The clock source has not stabilized

4 R_CGC_SystemClockGet()

fsp_err t R_CGC_SystemClockGet ( cgc_ctrl _t *const p_ctrl, cgc_clock_t *const p_clock source,
cgc_divider _cfg_t *const p_divider cfg )

Return the current system clock source and configuration. Implements cgc_api_t::systemClockGet.

Return values

FSP_SUCCESS Parameters returned successfully.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_NOT_OPEN Module is not open.
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4 R_CGC_OscStopDetectEnable()

fsp_err t R_CGC_OscStopDetectEnable ( cgc_ctrl _t *const p_ctrl)

Enable the oscillation stop detection for the main clock. Implements
cgc_api_t::oscStopDetectEnable.

The MCU will automatically switch the system clock to MOCO when a stop is detected if Main Clock
is the system clock. If the system clock is the PLL, then the clock source will not be changed and
the PLL free running frequency will be the system clock frequency.

Example:

/* Enable oscillation stop detection. The main oscillator nmust be running at this
poi nt. */

err = R CGC OscSt opDet ect Enabl e(&g cgcO_ctrl);

handl e _error(err);

Return values

FSP_SUCCESS Operation performed successfully.

FSP_ERR_ASSERTION Invalid input argument.

FSP_ERR_NOT _OPEN Module is not open.

FSP_ERR_LOW _ VOLTAGE_MODE Settings not allowed in low voltage mode.
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& R_CGC_OscStopDetectDisable()

fsp_err_ t R_CGC_OscStopDetectDisable ( cgc_ctrl_t *const p_ctrl)

Disable the oscillation stop detection for the main clock. Implements
cgc_api_t::oscStopDetectDisable.

Example:
/* (Optional) Gscillation stop detection nust be disabled before entering any | ow
power node. */

err = R CGC _OscStopDet ect Di sabl e(&g_cgcO_ctrl);

handl e_error(err);

__WFI();

Return values

FSP_SUCCESS Operation performed successfully.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_NOT_OPEN Module is not open.

FSP_ERR_OSC STOP DETECTED The Oscillation stop detect status flag is set.

Under this condition it is not possible to
disable the Oscillation stop detection
function.
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¢ R_CGC_OscStopStatusClear()

fsp_err_ t R_CGC_OscStopStatusClear ( cgc_ctrl_t *const p_ctrl)

Clear the Oscillation Stop Detection Status register. This register is not cleared automatically if the
stopped clock is restarted. Implements cgc_api_t::oscStopStatusClear.

After clearing the status, oscillation stop detection is no longer enabled.

This register cannot be cleared while the main oscillator is the system clock or the PLL source
clock.

Example:
/* (Optional) Clear the error flag. Only clear this flag after switching the MCU
cl ock source away fromthe main
* oscillator and if the main oscillator is stable again. */
err = R CGC OCscStopStatusC ear(&g_cgcO_ctrl);

handl e_error(err);

Return values

FSP_SUCCESS Operation performed successfully.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_NOT_OPEN Module is not open.
FSP_ERR_CLOCK_INACTIVE Main oscillator must be running to clear the
oscillation stop detection flag.
FSP_ERR_OSC_STOP_CLOCK_ACTIVE The Oscillation Detect Status flag cannot be

cleared if the Main Osc or PLL is set as the
system clock. Change the system clock
before attempting to clear this bit.

FSP_ERR_INVALID_HW_CONDITION Oscillation stop status was not cleared.
Check preconditions and try again.

4 R_CGC _Close()

fsp_err t R_ CGC Close ( cgc_ctrl_t *const p_ctrl)

Closes the CGC module. Implements cgc_api_t::close.

Return values

FSP_SUCCESS The module is successfully closed.
FSP_ERR_ASSERTION Invalid input argument.
FSP_ERR_NOT _OPEN Module is not open.
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& R_CGC_VersionGet()

fsp_err_ t R_CGC VersionGet ( fsp_version_t *const p_version)

Return the driver version. Implements cgc_api_t::versionGet.

Return values

FSP_SUCCESS Module version provided in p_version.

FSP_ERR_ASSERTION Invalid input argument.

4.2.9 Cyclic Redundancy Check (CRC) Calculator (r_crc)
Modules

Functions

fsp_err t R_CRC_Open (crc_ctrl_t *const p_ctrl, crc_cfg_t const *const p_cfqg)
fsp_err t R _CRC Close (crc_ctrl_t *const p_ctrl)

fsp_err t R_CRC_Calculate (crc_ctrl_t *const p_ctrl, crc_input_t *const
p_crc_input, uint32_t *calculatedValue)

fsp_err t R_CRC_CalculatedValueGet (crc_ctrl_t *const p_ctrl, uint32_t
*calculatedValue)

fsp_err t R_CRC_SnoopEnable (crc_ctrl_t *const p_ctrl, uint32_t crc_seed)
fsp_err t R_CRC _SnoopDisable (crc_ctrl_t *const p_ctrl)

fsp_err t R _CRC VersionGet (fsp_version_t *const p_version)

Detailed Description

Driver for the CRC peripheral on RA MCUs. This module implements the CRC Interface.

Overview

The CRC module provides a API to calculate 8, 16 and 32-bit CRC values on a block of data in
memory or a stream of data over a Serial Communication Interface (SCI) channel using industry-
standard polynomials.

Features

e CRC module supports the following 8 and 16 bit CRC polynomials which operates on 8-bit
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data in parallel
o X™8+X"2+X+1 (CRC-8)
o X*16+X"15+X"2+1 (CRC-16)
o X*16+X"12+X"5+1 (CRC-CCITT)
e CRC module supports the following 32 bit CRC polynomials which operates on 32-bit data in
parallel
0 XN324+X"N26+X"N234 X224+ XN 16+ XN 124X 114+ XN 104+ XN 8+ XN T+ X5+ XN 4+ X
~2+X+ 1 (CRC-32)
o XN324 X728+ X727+ X726+ X725+ X723+ X722+ X720+ X~ 19+
XM184+ XN 144 XN 134 XN 114X 104+ X9+ X8+ X" 6+1 (CRC-32C)
e CRC module can calculate CRC with LSB first or MSB first bit order.

Configuration

Build Time Configurations for r_crc

The following build time configurations are defined in fsp_cfg/r_crc_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.

Configurations for Driver > Monitoring > CRC Driver on r_crc

This module can be added to the Stacks tab via New Stack > Driver > Monitoring > CRC Driver on
r crc:

Configuration Options Default Description
Name Name must be a valid g_crcO Module name.
C symbol
CRC Polynomial e CRC-8 CRC-32C Select the CRC
e CRC-16 polynomial.
e CRC-CCITT
e CRC-32
e CRC-32C
Bit Order e LSB MSB Select the CRC bit
e MSB order.
Snoop Address Refer to the RA NONE Select the SCI register
Configuration tool for address CRC snoop

available options.
Clock Configuration
There is no clock configuration for the CRC module.
Pin Configuration

This module does not use I/O pins.
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Usage Notes
CRC Snoop

The CRC snoop function monitors reads from and writes to a specified I/O register address and
performs CRC calculation on the data read from and written to the register address automatically.
Instead of calling R_CRC_Calculate on a block of data, R_CRC_SnoopEnable is called to start
monitoring reads/writes and R_CRC_CalculatedValueGet is used to obtain the current CRC.

Note
Shoop mode is available for transmit/receive operations on SCI only.

Limitations

When using CRC32 polynomial functions the CRC module produces the same results as popular
online CRC32 calculators, but it is important to remember a few important points.

e Online CRC32 calculators allow the input to be any number of bytes. The FSP CRC32 API
function uses 32-bit words. This means the online calculations must be 'padded' to end on a
32-bit boundary.

e Online CRC32 calculators usually invert the output prior to presenting it as a result. It is up
to the application program to include this step if needed.

e The seed value of OXFFFFFFFF needs to be used by both the online calculator and the
R_CRC module API (CRC32 polynomials)

* Make sure the bit orientation of the R_CRC CRC32 is set for LSB and that you have CRC32
selected and not CRC32C.

e Some online CRC tools XOR the final result with OxFFFFFFFF.

Examples

Basic Example

This is a basic example of minimal use of the CRC module in an application.

void crc_exanple ()

{
uint32_t |ength;

uint32 t uint8 cal cul ated_val ue;
| ength = sizeof (g_data 8bit) / sizeof (g _data 8bit[0]);

crc_input_t exanpl e_i nput =

{
.p_input_buffer = g data_8bit,
. hum byt es = | engt h,
.crc_seed = 0,
i
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/* Open CRC nodule with 8 bit polynom al */
R CRC Open(&crc_ctrl, &g crc_test cfq);
/* 8-bit CRC cal culation */

R CRC Cal cul ate(&crc_ctrl, &exanple_input, &uint8 cal cul ated val ue);

Snoop Example

This example demonstrates CRC snoop operation.

voi d crc_snoop_exanple ()

{

/* Open CRC nodule with 8 bit polynom al */

R CRC Open(&crc_ctrl, &g crc_test cfq);

/* Open SCI Driver */

/* Configure Snoop address and enabl e snoop node */

R CRC SnoopEnabl e(&crc_ctrl, 0);

/* Perfrom SCI read/Wite operation depending on the SCI snoop address configure */
/* Read CRC val ue */

R CRC Cal cul at edVal ueGet (&crc_ctrl, &g crc_buff);

Data Structures

struct crc_instance_ctrl_t

Data Structure Documentation

& crc_instance_ctrl_t

struct crc_instance_ctrl_t

Driver instance control structure.

Function Documentation
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4 R_CRC_Open()

fsp_err t R_CRC_Open ( crc_ctrl_t *const p ctrl, crc_cfg t const *const p cfg )

Open the CRC driver module
Implements crc_api_t::open

Open the CRC driver module and initialize the driver control block according to the passed-in
configuration structure.

Return values

FSP_SUCCESS Configuration was successful.
FSP_ERR_ASSERTION p_ctrl or p_cfg is NULL.
FSP_ERR_ALREADY_OPEN Module already open

4 R_CRC_Close()

fsp_err t R_CRC Close ( crc_ctrl_t *const p_ctrl)

Close the CRC module driver.

Implements crc_api_t::close

Return values

FSP_SUCCESS Configuration was successful.
FSP_ERR_ASSERTION p_ctrl is NULL.
FSP_ERR_NOT_OPEN The driver is not opened.
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4 R_CRC_Calculate()

fsp_err_ t R_CRC_Calculate ( crc_ctrl_t *const p_ctrl, crc_input_t *const p_crc_input, uint32 t*
calculatedValue )

Perform a CRC calculation on a block of 8-bit/32-bit (for 32-bit polynomial) data.

Implements crc_api_t::calculate

This function performs a CRC calculation on an array of 8-bit/32-bit (for 32-bit polynomial) values
and returns an 8-bit/32-bit (for 32-bit polynomial) calculated value

Return values

FSP_SUCCESS Calculation successful.

FSP_ERR_ASSERTION Either p_ctrl, inputBuffer, or calculatedValue
is NULL.

FSP_ERR_INVALID_ARGUMENT length value is NULL.

FSP_ERR_NOT _OPEN The driver is not opened.

¢ R_CRC_CalculatedValueGet()

fsp_err_ t R_CRC_CalculatedValueGet ( crc_ctrl _t *const p_ctrl, uint32_t * calculatedValue )

Return the current calculated value.
Implements crc_api_t::crcResultGet

CRC calculation operates on a running value. This function returns the current calculated value.

Return values

FSP_SUCCESS Return of calculated value successful.
FSP_ERR_ASSERTION Either p_ctrl or calculatedValue is NULL.
FSP_ERR_NOT_OPEN The driver is not opened.
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4 R_CRC_SnoopEnable()

fsp_err_t R_CRC_SnoopEnable ( crc_ctrl_t *const p_ctr/, uint32_t crc seed )

Configure the snoop channel and set the CRC seed.
Implements crc_api_t::snoopEnable

The CRC calculator can operate on reads and writes over any of the first ten SCI channels. For
example, if set to channel 0, transmit, every byte written out SCI channel 0 is also sent to the CRC
calculator as if the value was explicitly written directly to the CRC calculator.

Return values

FSP_SUCCESS Snoop configured successfully.
FSP_ERR_ASSERTION Pointer to control stucture is NULL
FSP_ERR_NOT_OPEN The driver is not opened.

4 R_CRC_SnoopDisable()

fsp_err_ t R_CRC_SnoopDisable ( crc_ctrl_t *const p_ctrl)

Disable snooping.

Implements crc_api_t::snoopDisable

Return values

FSP_SUCCESS Snoop disabled.
FSP_ERR_ASSERTION p_ctrl is NULL.
FSP_ERR_NOT_OPEN The driver is not opened.

¢ R_CRC VersionGet()

fsp_err_ t R_CRC_VersionGet ( fsp_version_t *const p_version)

Get the driver version based on compile time macros.

Implements crc_api_t::versionGet

Return values

FSP_SUCCESS Successful close.
FSP_ERR_ASSERTION p_version is NULL.
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4.2.10 Capacitive Touch Sensing Unit (r_ctsu)
Modules

Functions

fsp_err t R _CTSU Open (ctsu_ctrl_t *const p_ctrl, ctsu_cfg_t const *const
p_cfg)

Opens and configures the CTSU driver module. Implements
ctsu_api_t::open. More...

fsp_err t R_CTSU_ScanStart (ctsu_ctrl_t *const p_ctrl)

This function should be called each time a periodic timer expires. If
initial offset tuning is enabled, The first several calls are used to
tuning for the sensors. Before starting the next scan, first get the
data with R_CTSU_DataGet(). If a different control block scan should
be run, check the scan is complete before executing. Implements
ctsu_api_t::scanStart. More...

fsp_err t R _CTSU DataGet (ctsu_ctrl t *const p_ctrl, uintl6 t *p data)

This function gets the sensor values as scanned by the CTSU. If initial
offset tuning is enabled, The first several calls are used to tuning for
the sensors. Implements ctsu_api_t::dataGet. More...

fsp_err t R_CTSU Close (ctsu_ctrl_t *const p_ctrl)

Disables specified CTSU control block. Implements ctsu_api_t::close.
More...

fsp_err t R_CTSU VersionGet (fsp_version_t *const p_version)

Return CTSU HAL driver version. Implements ctsu_api_t::versionGet.
More...

Detailed Description

This HAL driver supports the Capacitive Touch Sensing Unit (CTSU). It implements the CTSU Interface

Overview

The capacitive touch sensing unit HAL driver (r_ctsu) provides an API to control the CTSU peripheral.
This module performs capacitance measurement based on various settings defined by the
configuration. This module is configured via the QE for Capacitive Touch.
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Features

Supports both Self-capacitance multi scan mode and Mutual-capacitance full scan mode
Scans may be started by software or an external trigger

Returns measured capacitance data on scan completion

Optional DTC support

Configuration

Note
Thismoduleis configured via the QE for Capacitive Touch. For information on how to use the QE tool, once
thetool isinstalled click Help -> Help Contentsin e2 studio and search for " QE".

Build Time Configurations for r_ctsu

The following build time configurations are defined in fsp_cfg/r_ctsu_cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.
Support for using DTC e Enabled Disabled Enable DTC support for
e Disabled the CTSU module.
Interrupt priority level MCU Specific Options Priority level of all

CTSU interrupt (CSTU_
WR,CTSU_RD,CTSU_FN)

Configurations for Driver > CapTouch > CTSU Driver on r_ctsu

This module can be added to the Stacks tab via New Stack > Driver > CapTouch > CTSU Driver on
r ctsu:

Configuration Options Default Description

Scan Start Trigger MCU Specific Options CTSU Scan Start
Trigger Select

Interrupt Configuration

The first R_CTSU_Open function call sets CTSU peripheral interrupts. The user should provide a
callback function to be invoked at the end of the CTSU scan sequence. The callback argument will
contain information about the scan status.

Clock Configuration

The CTSU peripheral module uses PCLKB as its clock source. You can set the PCLKB frequency using
the Clocks tab of the RA Configuration editor or by using the CGC Interface at run-time.

Note
The CTSU Drive pulse will be calculated and set by the tooling depending on the selected transfer rate.
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Pin Configuration
The TSn pins are sensor pins for the CTSU.

The TSCAP pin is used for an internal low-pass filter and must be connected to an external
decoupling capacitor.

Usage Notes

CTSU

Self-capacitance multi scan mode

In self-capacitance mode each TS pin is assigned to one touch button. Electrodes of multiple TS pins
can be physically aligned to create slider or wheel interfaces.

e Scan Order
o The hardware scans the specified pins in ascending order.
o For example, if pins TS05, TS08, TS02, TS03, and TS06 are specified in your
application, the hardware will scan them in the order TS02, TS03, TS05, TSO06,
TS08.
e Element
o An element refers to the index of a pin within the scan order. Using the previous
example, TSO5 is element 2.
e Scan Time
o Scanning is handled directly by the CTSU peripheral and does not utilize any main
processor time.
o |t takes approximately 500us to scan a single sensor.
o If DTC is not used additional overhead is required for the main processor to
transfer data to/from registers when each sensor is scanned.

Mutual-capacitance full scan mode

In mutual-capacitance mode each TS pin acts as either a 'row' or '‘column' in an array of sensors. As
a result, this mode uses fewer pins when more than five sensors are configured. Mutual-capacitance

mode is ideal for applications where many touch sensors are required, like keypads, button matrices
and touchpades.

As an example, consider a standard phone keypad comprised of a matrix of four rows and three
columns.

T5a o 1% -0 When rows are “RX”
2 5 6 And columns are “TX",
ISb -O- e O Button 4 is sensor-pair 15b,15x
r\7 8 9
I5¢ U 0 When rows are "TX"
And columns are “RX”",
- 0 # 5 %
5d ——O O e} Button 8 is sensor-pair TSy, TSc

I5x TSy TSz
Figure 125: Mutual Button Image

In mutual capacitance mode only 7 pins are necessary to scan 12 buttons. In self mode, 12 pins
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would be required.

e Scan Order
o The hardware scans the matrix by iterating over the TX pins first and the RX pins

second.

o For example, if pins TS10, TS11, and TS03 are specified as RX sensors and pins
TS02, TS07, and TS04 are specified as TX sensors, the hardware will scan them in
the following sensor-pair order:
TS03-TS02, TS03-TS04, TS03-TS07, TS10-TS02, TS10-TS04, TS10-TS07,
TS11-TS02, TS11-TS04, TS11-TS07

e Element

o An element refers to the index of a sensor-pair within the scan order. Using the

previous example, TS10-TS07 is element 5.

e Scan Time
o Because mutual-capacitance scans two patterns for one element it takes twice as
long as self-capacitance (1ms vs 0.5ms per element).

Examples

Basic Example

This is a basic example of minimal use of the CTSU in an application.

volatile bool g scan flag = fal se;

voi d ctsu_call back (ctsu_callback args t * p_args)

{
i f (CTSU_EVENT_SCAN COVPLETE == p_ar gs- >event )
{
g_scan_flag = true;
}
}
voi d ctsu_basi c_exanpl e (void)
{

fsp_err t err = FSP_SUCCESS;
ui nt 16_t data[ CTSU_CFG NUM SELF_ELEMENTS] ;
err = R CTSU Open(&g_ctsu_ctrl, &g ctsu cfg);
/* Handl e any errors. This function should be defined by the user. */
handl e_error(err);
while (true)
{
err = R CISU ScanStart(&g_ctsu_ctrl);

handl e _error(err);
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Multi-configuration Example

This is a optional example of using both Self-capacitance and Mutual-capacitance configurations in
the same project.
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User’s Manual

Data Structures

struct ctsu_ctsuwr_t

struct ctsu_self buf t

struct ctsu_mutual_buf t

struct ctsu_correction_info_t

struct ctsu_instance_ctrl_t
Enumerations

enum ctsu_state_t

enum ctsu_tuning_t

enum ctsu_correction_status_t

enum ctsu_range_t
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Data Structure Documentation

¢ ctsu_ctsuwr_t

struct ctsu_ctsuwr t
CTSUWR write register value
Data Fields
uintl6_t ctsussc Copy from (ssdiv << 8) by
Open API.
uintl6_t ctsuso0 Copy from ((snum << 10) | so)
by Open API.
uintl6_t ctsusol Copy from (sdpa << 8) by Open
API. ICOG and RICOA is set
recommend value.
¢ ctsu_self buf t
struct ctsu_self buf t
Scan buffer data formats (Self)
Data Fields
uintl6é t sen Sensor counter data.
uintl6_t ref Reference counter data (Not
used)
¢ ctsu_mutual_buf_t
struct ctsu_mutual_buf t
Scan buffer data formats (Mutual)
Data Fields
uintl6_t pri_sen Primary sensor data.
uintle t pri_ref Primary reference data (Not
used)
uintl6_t snd_sen Secondary sensor data.
uintl6 t snd_ref Secondary reference data (Not
used)
& ctsu_correction_info_t
struct ctsu_correction_info_t
Correction information
Data Fields
ctsu_correction_status_t status Correction status.
ctsu_ctsuwr_t ctsuwr Correction scan parameter.
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User’s Manual

volatile ctsu_self buf t scanbuf Correction scan buffer.
uintlé t first val 1st correction value
uintl6_t second_val 2nd correction value
uint32 t first_coefficient 1st correction coefficient
uint32_t second_coefficient 2nd correction coefficient
uint32_t ctsu_clock CTSU clock [MHz].

& ctsu_instance_ctrl_t

struct ctsu_instance_ctrl t

CTSU private control block. DO NOT MODIFY. Initialization occurs when R_CTSU_Open() is called.

Data Fields

uint32_t

open

Whether or not driver is open.

ctsu_state_t

state

CTSU run state.

ctsu_tuning_t

tuning

CTSU Initial offset tuning status.

uintl6_t num_elements

Number of elements to scan.
uintlé_t wr_index

Word index into ctsuwr register array.
uintlé t rd_index

Word index into scan data buffer.
uint8 t* p_tuning_complete

Pointer to tuning completion flag of each element.
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g_ctsu_tuning _complete[] is set by Open API.

int32_t *  p_tuning_diff

Pointer to difference from base value of each element.
g_ctsu_tuning_diff[] is set by Open API.

uintlé_t average

CTSU Moving average counter.

uintl6_t num_moving_average

Copy from config by Open API.

uint8 t ctsucrl

Copy from (atunel << 3, md << 6) by Open API. CLK, ATUNEO, CSW,
and PON is set by HAL driver.

ctsu_ctsuwr_t* p_ctsuwr

CTSUWR write register value. g _ctsu_ctsuwr[] is set by Open API.

ctsu_self buf t* p_self raw

Pointer to Self raw data. g _ctsu_self raw[] is set by Open API.

uintle t* p_self work

Pointer to Self work buffer. g_ctsu_self_work[] is set by Open API.

uintlé t* p self data

Pointer to Self moving average data. g _ctsu_self data[] is set by
Open API.
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ctsu_mutual_buf t * | p_mutual_raw

Pointer to Mutual raw data. g_ctsu_mutual_raw[] is set by Open API.

uintlé_t * | p_mutual_pri_work

Pointer to Mutual primary work buffer. g ctsu_mutual_pri_work[] is
set by Open API.

uintlé_t* p_mutual_snd_work

Pointer to Mutual secondary work buffer. g ctsu mutual snd_work[]
is set by Open API.

uintlé t* p_mutual pri_data

Pointer to Mutual primary moving average data.
g_ctsu_mutual_pri_data[] is set by Open API.

uintlé_t* p_mutual_snd_data

Pointer to Mutual secondary moving average data.
g_ctsu_mutual snd_data[] is set by Open API.

ctsu_correction_info_t * p_correction_info

Pointer to correction info.

ctsu cfg tconst * p ctsu cfg

Pointer to initial configurations.

IRQn_Type | write_irq

Copy from config by Open API. CTSU_CTSUWR interrupt vector.

IRQNn_Type read irq

Copy from config by Open API. CTSU_CTSURD interrupt vector.
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IRQn_Type end irq
Copy from config by Open APl. CTSU_CTSUFN interrupt vector.
void const * | p_context
Placeholder for user data.
void(* p_callback )(ctsu_callback args t *p_args)
Callback provided when a CTSUFN occurs.

Enumeration Type Documentation

¢ ctsu_state_t

enum ctsu_state t

CTSU run state

Enumerator
CTSU_STATE_INIT Not open.
CTSU_STATE_IDLE Opened.

CTSU_STATE_SCANNING

Scanning now.

CTSU_STATE_SCANNED Scan end.
¢ ctsu_tuning_t
enum ctsu_tuning_t
CTSU Initial offset tuning status
Enumerator

CTSU_TUNING_INCOMPLETE

Initial offset tuning incomplete.

CTSU_TUNING_COMPLETE

Initial offset tuning complete.
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# ctsu_correction_status_t

enum ctsu_correction_status_t

CTSU Correction status

Enumerator

CTSU_CORRECTION_INIT Correction initial status.

CTSU_CORRECTION_RUN Correction scan running.

CTSU_CORRECTION_ERROR Correction error.

¢ ctsu_range_t

enum ctsu_range_t

CTSU range definition

Enumerator
CTSU_RANGE_20UA 20uA mode
CTSU_RANGE_40UA 40uA mode
CTSU_RANGE_80UA 80uA mode
CTSU_RANGE_160UA 160uA mode
CTSU_RANGE_NUM number of range

Function Documentation
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# R_CTSU Open()

fsp_err t R_CTSU_Open ( ctsu_ctrl_t *const p_ctrl, ctsu_cfg_t const *const p cfg )

Opens and configures the CTSU driver module. Implements ctsu_api_t::open.
Example:

err = R CTSU Open(&g_ctsu_ctrl, &g ctsu cfg);

Return values

FSP_SUCCESS CTSU successfully configured.

FSP_ERR_ASSERTION Null pointer, or one or more configuration
options is invalid.

FSP_ERR_ALREADY_OPEN Module is already open. This module can
only be opened once.

FSP_ERR_INVALID_ARGUMENT Configuration parameter error.

Note
In the first Open, measurement for correction works, and it takes several tens of milliseconds.
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& R_CTSU_ScanStart()

fsp_err t R_CTSU_ScanStart ( ctsu_ctrl_t *const p_ctr/)

This function should be called each time a periodic timer expires. If initial offset tuning is enabled,
The first several calls are used to tuning for the sensors. Before starting the next scan, first get the
data with R_CTSU_DataGet(). If a different control block scan should be run, check the scan is
complete before executing. Implements ctsu_api_t::scanStart.

Example:
while (true)
{
err = R CTSU ScanStart(&g_ctsu_ctrl);
handl e_error(err);
while (!g_scan_fl ag)
{
/* Wait for scan end call back */
}
g_scan_flag = fal se;
err = R CTSU DataCet (&g ctsu ctrl, data);
i f (FSP_SUCCESS == err)

{
/* Application specific data processing. */
}
}
Return values
FSP_SUCCESS CTSU successfully configured.
FSP_ERR_ASSERTION Null pointer passed as a parameter.
FSP_ERR_NOT_OPEN Module is not open.
FSP_ERR_CTSU_SCANNING Scanning this instance or other.
FSP_ERR_CTSU NOT GET DATA The previous data has not been retrieved by
DataGet.
R11UMO146EU0120 Revision 1.20 RLENESAS Page 327/ 1,560

Jun.26.20



Flexible Software Package User’s Manual

API| Reference > Modules > Capacitive Touch Sensing Unit (r_ctsu)

¢ R_CTSU_DataGet()

fsp_err t R_CTSU_DataGet ( ctsu_ctrl_t *const p_ctrl/, uintlé t* p data )

This function gets the sensor values as scanned by the CTSU. If initial offset tuning is enabled, The
first several calls are used to tuning for the sensors. Implements ctsu_api_t::dataGet.

Example:
while (true)
{
err = R CTSU ScanStart(&g_ctsu_ctrl);
handl e_error(err);
while (!g scan flag)
{
/* Wait for scan end cal |l back */
}
g_scan_flag = fal se;
err = R CTSU Dat aGet (&g _ctsu_ctrl, data);
i f (FSP_SUCCESS == err)

{
/* Application specific data processing. */
}
}
Return values
FSP_SUCCESS CTSU successfully configured.
FSP_ERR_ASSERTION Null pointer passed as a parameter.
FSP_ERR_NOT _OPEN Module is not open.
FSP_ERR_CTSU_SCANNING Scanning this instance.
FSP_ERR_CTSU_INCOMPLETE_TUNING Incomplete initial offset tuning.
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& R_CTSU_Close()

fsp_err t R_CTSU_Close ( ctsu_ctrl_t *const p_ctrl)

Disables specified CTSU control block. Implements ctsu_api_t::close.

Return values

FSP_SUCCESS CTSU successfully configured.
FSP_ERR_ASSERTION Null pointer passed as a parameter.
FSP_ERR_NOT_OPEN Module is not open.

& R_CTSU VersionGet()

fsp_err_ t R_CTSU_VersionGet ( fsp_version_t *const p_version)

Return CTSU HAL driver version. Implements ctsu_api_t::versionGet.

Return values

FSP_SUCCESS Version information successfully read.

FSP_ERR_ASSERTION Null pointer passed as a parameter

4.2.11 Digital to Analog Converter (r_dac)
Modules

Functions

fsp_err t R_DAC Open (dac_ctrl_t *p_api_ctrl, dac_cfg_t const *const p_cfqg)
fsp_err t R_DAC_Write (dac_ctrl_t *p_api_ctrl, uintl6_t value)

fsp_err t R_DAC Start (dac_ctrl_t *p_api_ctrl)

fsp_err t R _DAC Stop (dac_ctrl_t *p_api_ctrl)

fsp_err t R _DAC Close (dac_ctrl _t *p_api_ctrl)

fsp_err t R_DAC VersionGet (fsp_version_t *p_version)

Detailed Description

Driver for the DAC12 peripheral on RA MCUs. This module implements the DAC Interface.
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Overview

Features

The DAC module outputs one of 4096 voltage levels between the positive and negative reference
voltages.

e Supports setting left-justified or right-justified 12-bit value format for the 16-bit input data
registers

e Supports output amplifiers on selected MCUs

Supports charge pump on selected MCUs

Supports synchronization with the Analog-to-Digital Converter (ADC) module

Configuration

Note
For MCUs supporting more than one channel, the following configuration options are shared by all the DAC
channels:;
o Synchronize with ADC
o Data Format
o Charge Pump

Build Time Configurations for r_dac

The following build time configurations are defined in fsp_cfg/r_dac_cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
e Enabled parameter checking is
e Disabled included in the build.

Configurations for Driver > Analog > DAC Driver on r_dac

This module can be added to the Stacks tab via New Stack > Driver > Analog > DAC Driver on r_dac:

Configuration Options Default Description
Name Name must be a valid g _dacO Module name.
C symbol
Channel Value must be an 0 Specify the hardware
integer greater than or channel.
equalto 0
Synchronize with ADC ¢ Enabled Disabled Enable DA/AD
e Disabled synchronization.
Data Format ¢ Right Justified Right Justified Specify the DAC data
o Left Justified format.
Output Amplifier MCU Specific Options Enable the DAC output
amplifier.
Charge Pump (Requires MCU Specific Options Enable the DAC charge
MOCO active) pump.
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ELC Trigger Source MCU Specific Options ELC event source that
will trigger the DAC to
start a conversion.

Clock Configuration

The DAC peripheral module uses PCLKB as its clock source.

Pin Configuration

The DAnN pins are used as analog outputs. Each DAC channel has one output pin.

The AVCCO and AVSSO pins are power and ground supply pins for the DAC and ADC.

The VREFH and VREFL pins are top and ground voltage reference pins for the DAC and ADC.

Usage Notes

Charge Pump
The charge pump must be enabled when using DAC pin output while operating at AV¢c < 2.7V.

Note
The MOCO must be running to use the charge pump.
If the DAC output isto be routed to an internal signal, do not enable the charge pump.

Synchronization with ADC

When ADC synchronization is enabled and an ADC conversion is in progress, if a DAC conversion is
started it will automatically be delayed until after the ADC conversion is complete.

Limitations

e For MCUs supporting ADC unit 1:

o Once synchronization between DAC and ADC unit 1 is turned on during
R_DAC_Open synchronization cannot be turned off by the driver. In order to
desynchronize DAC with ADC unit 1, manually clear DAADSCR.DAADST to 0 when
the ADCSR.ADST bit is 0 and ADC unit 1 is halted.

o The DAC module can only be synchronized with ADC unit 1.

o For MCUs having more than 1 DAC channel, both channels are synchronized with
ADC unit 1 if synchronization is enabled.

Examples

Basic Example

This is a basic example of minimal use of the R_DAC in an application. This example shows how this
driver can be used for basic Digital to Analog Conversion operations.

voi d basi c_exanpl e (void)

{

fsp_err_t err;
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/*
/*

/*

uint16_t val ue;
Pin configuration: Qutput enable DAO as Anal og. */
Initialize the DAC channel */

err = R DAC Open(&g_dac_ctrl, &g dac _cfg);

Handl e any errors. This function should be defined by the user.

handl e_error(err);

value = (uintl1l6 t) DAC EXAMPLE VALUE ABC,
err = R DAC Wite(&g dac _ctrl, val ue);
handl e_error(err);

err = R DAC Start(&g_dac_ctrl);

handl e _error(err);

Data Structures

struct dac_instance_ctrl_t

struct dac_extended cfg_t

*/

Data Structure Documentation

¢ dac_instance_ctrl_t

struct dac_instance_ctrl_t

DAC instance control block.

¢ dac_extended_cfg_t

struct dac_extended_cfg_t
DAC extended configuration
Data Fields

bool enable_charge pump Enable DAC charge pump
available on selected MCUs.

bool output_amplifier_enabled Output amplifier enable
available on selected MCUs.

dac_data_format t data_format Data format.

Function Documentation
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4 R_DAC _Open()

fsp_err t R_DAC Open ( dac_ctrl_t* p_api ctrl, dac_cfg_t const *const p cfg )

Perform required initialization described in hardware manual. Implements dac_api_t::open.
Configures a single DAC channel, starts the channel, and provides a handle for use with the DAC
APl Write and Close functions. Must be called once prior to calling any other DAC API functions.
After a channel is opened, Open should not be called again for the same channel without calling
Close first.

Return values
FSP_SUCCESS The channel was successfully opened.

FSP_ERR_ASSERTION Parameter check failure due to one or more
reasons below:

1. One or both of the following
parameters may be NULL: p_api_ctrl
or p_cfg

2. data_format value in p_cfg is out of
range.

3. Extended configuration structure is
set to NULL for MCU supporting
charge pump.

FSP_ERR_IP_CHANNEL_NOT_PRESENT Channel ID requested in p_cfg may not
available on the devices.

FSP_ERR_ALREADY_OPEN The control structure is already opened.

4 R_DAC_Write()

fsp_err t R_DAC Write ( dac_ctrl t * p_api _ctrl, uintlé t value )

Write data to the D/A converter and enable the output if it has not been enabled.

Return values

FSP_SUCCESS Data is successfully written to the D/A
Converter.
FSP_ERR_ASSERTION p_api_ctrl is NULL.
FSP_ERR_NOT_OPEN Channel associated with p_ctrl has not been
opened.
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¢ R_DAC _Start()

fsp_err_ t R_DAC Start ( dac_ctrl t* p_api ctrl)

Start the D/A conversion output if it has not been started.

Return values

FSP_SUCCESS The channel is started successfully.

FSP_ERR_ASSERTION p_api_ctrl is NULL.

FSP_ERR_IN_USE Attempt to re-start a channel.

FSP_ERR_NOT _OPEN Channel associated with p_ctrl has not been
opened.

4 R_DAC_Stop()

fsp_err t R_DAC Stop ( dac_ctrl t* p_api ctrl)

Stop the D/A conversion and disable the output signal.

Return values

FSP_SUCCESS The control is successfully stopped.

FSP_ERR_ASSERTION p_api_ctrl is NULL.

FSP_ERR_NOT_OPEN Channel associated with p_ctrl has not been
opened.

¢ R_DAC Close()

fsp_err_t R_DAC Close ( dac_ctrl_t* p_api_ctrl)

Stop the D/A conversion, stop output, and close the DAC channel.

Return values

FSP_SUCCESS The channel is successfully closed.
FSP_ERR_ASSERTION p_api_ctrl is NULL.
FSP_ERR_NOT_OPEN Channel associated with p_ctrl has not been
opened.
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4 R_DAC VersionGet()

fsp_err_t R_DAC VersionGet ( fsp_version_t * p_version)

Get version and store it in provided pointer p_version.

Return values
FSP_SUCCESS Successfully retrieved version information.

FSP_ERR_ASSERTION p_version is NULL.

4.2.12 Digital to Analog Converter (r_dac8)
Modules

Functions

fsp_err t R_DAC8 Open (dac_ctrl_t *const p_ctrl, dac_cfg_t const *const p_cfg)
fsp_err t R _DAC8 Close (dac_ctrl_t *const p_ctrl)

fsp_err t R_DAC8 Write (dac_ctrl_t *const p_ctrl, uintl6_t value)

fsp_err t R_DACS8_Start (dac_ctrl_t *const p_ctrl)

fsp_err t R_DACS8_Stop (dac_ctrl_t *const p_ctrl)

fsp_err t R _DAC8 VersionGet (fsp_version_t *p_version)

Detailed Description

Driver for the DACS8 peripheral on RA MCUs. This module implements the DAC Interface.

Overview

Features

The DAC8 module outputs one of 256 voltage levels between the positive and negative reference
voltages. DACS8 on selected MCUs have below features

e Charge pump control
e Synchronization with the Analog-to-Digital Converter (ADC) module
e Multiple Operation Modes

o Normal

o Real-Time (Event Link)
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Configuration

Note
For MCUs supporting more than one channel, the following configuration options are shared by all the DAC8
channels:
o Synchronize with ADC
o Charge Pump

Build Time Configurations for r_dac8

The following build time configurations are defined in fsp_cfg/r_dac8 cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
e Enabled parameter checking is
e Disabled included in the build.

Configurations for Driver > Analog > DACS8 Driver on r_dac8

This module can be added to the Stacks tab via New Stack > Driver > Analog > DACS8 Driver on
r dac8:

Configuration Options Default Description
Name Name must be a valid g dac8 0 Module name.
C symbol
Channel Value must be an 0 Specify the hardware
integer greater than or channel.
equal to 0
D/A A/D Synchronous ¢ Enabled Disabled Synchronize the DAC8
Conversion ¢ Disabled update with the ADC to

reduce interference
with A/D conversions.

DAC Mode MCU Specific Options Select the DAC
operating mode

Real-time Trigger Event MCU Specific Options Specify the event used
to trigger conversion in
Real-time mode. This
setting is only valid
when Real-time mode

is enabled.
Charge Pump (Requires MCU Specific Options Enable the DAC charge
MOCO active) pump.
Clock Configuration
The DACS8 peripheral module uses the PCLKB as its clock source.
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Pin Configuration
The DA8_n pins are used as analog outputs. Each DAC8 channel has one output pin.

The AVCCO and AVSSO0 pins are power and ground supply and reference pins for the DACS.

Usage Notes

Charge Pump
The charge pump must be enabled when using DAC8 pin output while operating at AV¢c < 2.7V.
Note

The MOCO must be running to use the charge pump.

If DACS8 output is to be routed to an internal signal, do not enable the charge pump.

Synchronization with ADC

When ADC synchronization is enabled and an ADC conversion is in progress, if a DAC8 conversion is
started it will automatically be delayed until after the ADC conversion is complete.

Real-time Mode

When Real-time mode is selected, the DAC8 will perform a conversion each time the selected ELC
event is received.

Limitations

* Synchronization between DAC8 and ADC is activated when calling R_DAC8_ Open. At this
point synchronization cannot be deactivated by the driver. In order to desynchronize DACS8
with ADC, manually clear DACADSCR.DACADST to 0 while the ADCSR.ADST bit is 0 and the
ADC is halted.

e For MCUs having more than 1 DAC8 channel, both channels are synchronized with ADC if
synchronization is enabled.

Examples

Basic Example

This is a basic example of minimal use of the R_DACS8 in an application. This example shows how this
driver can be used for basic 8 bit Digital to Analog Conversion operations.

dac8 instance ctrl t g _dac8 ctrl;

dac_cfg t g dac8 cfg =

{
. channel = 0y,
.ad_da_synchroni zed = fal se,
. p_extend = &g_dac8 cfg extend
ki
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voi d basi c_exanpl e (void)
{
fsp_err_t err;
uint16_t val ue;
/* Pin configuration: Qutput enable DA8 O(RA2A1) as Anal og. */
/* Initialize the DAC8 channel */
err = R DAC8_(pen(&g_dac8 ctrl, &g dac8 cfg);
/* Handl e any errors. This function should be defined by the user. */
handl e_error(err);
value = (uint8 t) DAC8 EXAVPLE VALUE ABC,
/* Wite value to DAC nodul e */
err = R DACB Wite(&y dac8 ctrl, value);
handl e_error(err);
/* Start DAC8 conversion */
err = R DAC8_Start(&g dac8 ctrl);

handl e_error(err);

Data Structures

struct dac8_instance_ctrl_t
struct dac8 extended cfg t

Enumerations

enum dac8 _mode_t

Data Structure Documentation

¢ dac8_instance _ctrl_t

struct dac8_instance_ctrl_t

DACS instance control block. DO NOT INITIALIZE.

¢ dac8_extended cfg t

struct dac8_extended_cfg_t

DAC8 extended configuration

Data Fields
bool enable_charge_pump Enable DAC charge pump.
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dac8 mode_t dac_mode DAC mode.

Enumeration Type Documentation

¢ dac8_mode_t

enum dac8 mode_t

Enumerator

DAC8_MODE_NORMAL DAC Normal mode.

DAC8 MODE_REAL_TIME

DAC Real-time (event link) mode.

Function Documentation

4 R_DACS8 Open()

fsp_err t R_ DAC8 Open ( dac_ctrl t *const p_ctrl, dac_cfg_t const *const p cfg )

Perform required initialization described in hardware manual.
Implements dac_api_t::open.

Configures a single DAC channel. Must be called once prior to calling any other DAC API functions.
After a channel is opened, Open should not be called again for the same channel without calling
Close first.

Return values

FSP_SUCCESS The channel was successfully opened.

FSP_ERR_ASSERTION One or both of the following parameters
may be NULL: p_ctrl or p_cfg

FSP_ERR_ALREADY_OPEN The instance control structure has already
been opened.

FSP_ERR_IP_ CHANNEL NOT _PRESENT An invalid channel was requested.

FSP_ERR_NOT_ENABLED Setting DACADSCR is not enabled when

ADCSR.ADST = 0.

Note
This function is reentrant for different channels. It is not reentrant for the same channel.
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4 R_DACS8_Close()

fsp_err t R_DAC8 Close ( dac_ctrl_t *const p_ctrl)

Stop the D/A conversion, stop output, and close the DAC channel.

Return values

FSP_SUCCESS The channel is successfully closed.

FSP_ERR_ASSERTION p_ctrl is NULL.

FSP_ERR_NOT_OPEN Channel associated with p_instance_ctrl has
not been opened.

¢ R_DAC8 Write()

fsp_err_t R_DAC8_Write ( dac_ctrl_t *const p_ctrl, uintl6_t value )

Write data to the D/A converter.

Return values

FSP_SUCCESS Data is successfully written to the D/A
Converter.

FSP_ERR_ASSERTION p_ctrl is NULL.

FSP_ERR_NOT_OPEN Channel associated with p_instance_ctrl has
not been opened.

FSP_ERR_OVERFLOW Data overflow when data value exceeds
8-bit limit.

& R_DACS Start()

fsp_err t R_DACS8 Start ( dac_ctrl_t *const p_ctrl)

Start the D/A conversion output.

Return values

FSP_SUCCESS The channel is started successfully.
FSP_ERR_ASSERTION p_ctrl is NULL.
FSP_ERR_NOT_OPEN Channel associated with p_instance_ctrl has
not been opened.
FSP_ERR_IN_USE Attempt to re-start a channel.
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& R_DAC8_Stop()

fsp_err_ t R_DACS8 Stop ( dac_ctrl_t *const p_ctr/)

Stop the D/A conversion and disable the output signal.

Return values

FSP_SUCCESS The control is successfully stopped.

FSP_ERR_ASSERTION p_ctrl is NULL.

FSP_ERR_NOT_OPEN Channel associated with p_instance_ctrl has
not been opened.

¢ R_DAC8 VersionGet()

fsp_err_t R_DAC8_VersionGet ( fsp_version_t * p_version)

Get version and store it in provided pointer p_version.

Return values

FSP_SUCCESS Successfully retrieved version information.

FSP_ERR_ASSERTION p_version is NULL.

4.2.13 Direct Memory Access Controller (r_dmac)

Modules
Functions
fsp_err t R_DMAC Open (transfer_ctrl_t *const p_api_ctrl, transfer_cfg t const
*const p_cfg)
fsp_err t R_DMAC_Reconfigure (transfer_ctrl_t *const p_api_ctrl, transfer_info_t
*p_info)
fsp_err t R_DMAC_Reset (transfer_ctrl_t *const p_api_ctrl, void const *volatile
p_src, void *volatile p_dest, uintl6_t const num_transfers)
fsp_err t R_DMAC SoftwareStart (transfer_ctrl_t *const p_api_ctrl,
transfer_start_mode_t mode)
fsp_err t R_DMAC_SoftwareStop (transfer_ctrl_t *const p_api_ctrl)
fsp_err t R_DMAC _Enable (transfer _ctrl _t *const p_api_ctrl)
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fsp_err t R_DMAC Disable (transfer_ctrl t *const p_api_ctrl)

fsp_err t R_DMAC InfoGet (transfer _ctrl_t *const p_api_ctrl,
transfer_properties_t *const p_info)

fsp_err t R_DMAC Close (transfer_ctrl_t *const p_api_ctrl)

fsp_err t R_DMAC VersionGet (fsp_version_t *const p_version)

Detailed Description

Driver for the DMAC peripheral on RA MCUs. This module implements the Transfer Interface.

Overview

The Direct Memory Access Controller (DMAC) transfers data from one memory location to another
without using the CPU.

Features

e Supports multiple transfer modes
o Normal transfer
o Repeat transfer
o Block transfer
e Address increment, decrement, fixed, or offset modes
e Triggered by ELC events
o Some exceptions apply, see the Event table in the Event Numbers section of the
Interrupt Controller Unit chapter of the hardware manual
e Supports 1, 2, and 4 byte data units

Configuration

Build Time Configurations for r_dmac

The following build time configurations are defined in fsp_cfg/r dmac_cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
e Enabled parameter checking is
e Disabled included in the build.

Configurations for Driver > Transfer > Transfer Driver on r_dmac

This module can be added to the Stacks tab via New Stack > Driver > Transfer > Transfer Driver on
r dmac:

Configuration Options Default Description
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Name Name must be a valid  g_transferQ Module name.
C symbol
Channel Value must be a non- 0 Specify the hardware
negative integer channel.
Mode ¢ Normal Normal Select the transfer
¢ Repeat mode. Normal: One
¢ Block transfer per activation,
transfer ends after
Number of Transfers;
Repeat: One transfer
per activation, Repeat
Area address reset
after Number of
Transfers, transfer
ends after Number of
Blocks; Block: Number
of Blocks per
activation, Repeat Area
address reset after
Number of Transfers,
transfer ends after
Number of Blocks.
Transfer Size e 1 Byte 2 Bytes Select the transfer size.
e 2 Bytes
e 4 Bytes
Destination Address ¢ Fixed Fixed Select the address
Mode e Offset addition mode for the
¢ Incremented destination.
e Decremented
Source Address Mode * Fixed Fixed Select the address
» Offset addition mode for the source.
¢ Incremented
e Decremented
Repeat Area (Unused in e Destination Source Select the repeat area.
Normal Mode) e Source Either the source or
destination address
resets to its initial
value after completing
Number of Transfers in
Repeat or Block mode.
Destination Pointer Manual Entry NULL Specify the transfer
destination pointer.
Source Pointer Manual Entry NULL Specify the transfer
source pointer.
Number of Transfers Value must be a non- 1 Specify the number of
negative integer transfers.
Number of Blocks Value must be a non- 0 Specify the number of
(Valid only in Repeat negative integer blocks to transfer in
and Block Mode) Repeat or Block mode.
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Activation Source MCU Specific Options Select the DMAC
transfer start event. If
no ELC event is chosen
then software start can

be used.
Callback Name must be a valid NULL A user callback that is
C symbol called at the end of the
transfer.
Context Manual Entry NULL Pointer to the context

structure passed
through the callback

argument.
Transfer End Interrupt  MCU Specific Options Select the transfer end
Priority interrupt priority.
Interrupt Frequency ¢ Interrupt after  Interrupt after all Select to have interrupt
all transfers transfers have after each transfer or
have completed completed after last transfer.
e Interrupt after
each block, or
repeat size is
transfered
Offset value (Valid only Value must be a 24 bit 1 Offset value * transfer
when address mode is  signed integer. size is added to the
\'Offset\') address after each
transfer.

Clock Configuration

The DMAC peripheral module uses ICLK as the clock source. The ICLK frequency is set by using the
Clocks tab of the RA Configuration editor prior to a build, or by using the CGC module at run-time.

Pin Configuration

This module does not use I/O pins.

Usage Notes

Transfer Modes
The DMAC Module supports three modes of operation.

¢ Normal Mode - In normal mode, a single data unit is transfered every time the configured
ELC event is received by the DMAC channel. A data unit can be 1-byte, 2-bytes, or 4-bytes.
The source and destination addresses can be fixed, increment, decrement, or add an offset
to the next data unit after each transfer. A 16-bit counter decrements after each transfer.
When the counter reaches 0, transfers will no longer be triggered by the ELC event and the
CPU can be interrupted to signal that all transfers have finished.

e Repeat Mode - Repeat mode works the same way as normal mode, however the length is
limited to an integer in the range[1,1024]. When the transfer counter reaches 0, the
counter is reset to its configured value, the repeat area (source or destination address)
resets to its starting address and the block count remaining will decrement by 1. When the
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block count reaches 0, transfers will no longer be triggered by the ELC event and the CPU
may be interrupted to signal that all transfers have finished.

¢ Block Mode - In block mode, the amount of data units transfered by each interrupt can be
set to an integer in the range [1,1024]. The number of blocks to transfer can also be
configured to a 16-bit number. After each block transfer the repeat area (source or
destination address) will reset to the original address and the other address will be
incremented or decremented to the next block.

Selecting the DTC or DMAC

The Transfer APl is implemented by both DTC and the DMAC so that applications can switch between
the DTC and the DMAC. When selecting between them, consider these factors:

DTC

DMAC

Repeat Mode

Block Mode

Channels

Chained Transfers

Software Trigger

Offset Address Mode

Interrupts

¢ Repeats forever
¢ Max repeat size is 256 x
4 bytes

e Max block size is 256 x
4 bytes

¢ One instance per
interrupt

e Supported

e Must use the software
ELC event

¢ Not supported

¢ Configurable number of
repeats

¢ Max repeat size is 1024
x 4 bytes

e Max block size is 1024 x
4 bytes

¢ MCU specific (8
channels or less)

¢ Not Supported

¢ Has support for software
trigger without using
software ELC event

e Supports TRANSFER_ST
ART_MODE_SINGLE and
TRANSFER _START_MOD
E_REPEAT

e Supported

The DTC and DMAC interrupts behave differently. The DTC uses the configured IELSR event IRQ as
the interrupt source whereas each DMAC channel has its own IRQ.

The transfer_info_t::irq setting also behaves a little differently depending on which mode is selected.

Normal Mode

DTC

DMAC

TRANSFER_IRQ_EACH
TRANSFER_IRQ_END

Repeat Mode

Interrupt after each transfer

Interrupt after last transfer

N/A

Interrupt after last transfer

DTC

DMAC

TRANSFER_IRQ_EACH

Interrupt after each transfer

Interrupt after each repeat
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TRANSFER_IRQ_END Interrupt after each repeat Interrupt after last transfer
Block Mode

DTC DMAC
TRANSFER_IRQ_EACH Interrupt after each block Interrupt after each block
TRANSFER IRQ _END Interrupt after last block Interrupt after last block

Additional Considerations

e The DTC requires a moderate amount of RAM (one transfer_info_t struct per open instance
+ DTC_VECTOR TABLE_SIZE).

e The DTC stores transfer information in RAM and writes back to RAM after each transfer
whereas the DMAC stores all transfer information in registers.

* When transfers are configured for more than one activation source, the DTC must fetch the
transfer info from RAM on each interrupt. This can cause a higher latency between
transfers.

Offset Address Mode

When the source or destination mode is configured to offset mode, a configurable offset is added to
the source or destination pointer after each transfer. The offset is a signed 24 bit number.

Examples

Basic Example

This is a basic example of minimal use of the DMAC in an application. In this case, one or more
events have been routed to the DMAC for handling so it only needs to be enabled to start accepting
transfers.
voi d dmac_mi ni mal _exanpl e (voi d)
{
/* Open the transfer instance with initial configuration. */
fsp err t err = R DMAC Open(&g _transfer _ctrl, &g transfer_cfg);
/* Handl e any errors. This function should be defined by the user. */
handl e_error(err);
/* Enable the DVAC so that it responds to transfer requests. */
err = R DMAC Enabl e(&g_transfer _ctrl);

handl e _error(err);

CRC32 Example

In this example the DMAC is used to feed the CRC peripheral to perform a CRC32 operation.
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/*

/*

/*
/*

Wait for transfer conplete interrupt */

}

Get CRC result and performfinal XOR */

uint32_t crc3z;

(voi d) R CRC Cal cul at edVal ueGet (&g crc_ctrl, &crc32);
crc32 A= CRC32_FI NAL_XOR VALUE;

Verify that the CRC32 is calculated correctly. */
CRC32("ABCD. . . NOP*) = OxXEOE8FF4D. */

const uint32_t expected crc32 = OXEOES8FF4D,

i f

/*

(expected _crc32 !'= crc32)
{

Handl e any CRC errors. This function should be defined by the user.

handl e crc_error();

Data Structures

struct dmac_instance_ctrl_t
struct dmac_callback_args t

struct dmac_extended_cfg_t

Macros

#define DMAC_MAX_NORMAL TRANSFER_LENGTH
#define DMAC_MAX_REPEAT TRANSFER_LENGTH
#define DMAC_MAX_BLOCK TRANSFER LENGTH
#define DMAC_MAX_REPEAT COUNT

#define  DMAC_MAX_BLOCK_COUNT

*/

Data Structure Documentation

4 dmac_instance_ctrl_t

struct dmac_instance_ctrl_t

Control block used by driver. DO NOT INITIALIZE - this structure will be initialized in
transfer_api_t::open.
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4 dmac_callback_args_t

struct dmac_callback_args_t

Callback function parameter data.

Data Fields

void const * p_context

Placeholder for user data. Set in
r transfer_t::open function in
transfer cfg_t.

¢ dmac_extended cfg t

struct dmac_extended_cfg_t

DMAC transfer configuration extension. This extension is required.

Data Fields

uint8 t channel

Channel number, does not apply to all HAL drivers.

IRQn_Type | irq

DMAC interrupt number.

uint8_t ipl

DMAC interrupt priority.

int32_t | offset

Offset value used with

transfer_addr_mode_t:: TRANSFER_ADDR_MODE_OFFSET.

elc_event t activation_source

void(* | p_callback )(dmac_callback args t *cb_data)

void const * | p_context

Field Documentation
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¢ activation_source

elc_event_t dmac_extended_cfg_t::activation_source

Select which event will trigger the transfer.

Note
Select ELC_EVENT_NONE for software activation in order to use softwareStart and softwareStart to trigger
transfers.
¢ p_callback

void(* dmac_extended_cfg_t::p_callback) (dmac_callback_args_t *cb_data)

Callback for transfer end interrupt.

¢ p_context

void const* dmac_extended_cfg_t::p_context

Placeholder for user data. Passed to the user p_callback in dmac_callback args t.

Macro Definition Documentation

¢ DMAC_MAX_NORMAL_TRANSFER_LENGTH

#define DMAC_MAX_NORMAL_TRANSFER_LENGTH

Max configurable number of transfers in TRANSFER_MODE_NORMAL.

¢ DMAC_MAX_REPEAT_TRANSFER_LENGTH

#define DMAC_MAX_REPEAT_TRANSFER LENGTH

Max number of transfers per repeat for TRANSFER_MODE_REPEAT.

& DMAC_MAX_BLOCK_TRANSFER_LENGTH

#define DMAC_MAX BLOCK TRANSFER_LENGTH
Max number of transfers per block in TRANSFER_MODE_BLOCK

¢ DMAC_MAX_REPEAT COUNT

#define DMAC_MAX_REPEAT COUNT

Max configurable number of repeats to trasnfer in TRANSFER_MODE_REPEAT
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¢ DMAC_MAX_BLOCK_COUNT

#define DMAC_MAX_BLOCK_COUNT

Max configurable number of blocks to transfer in TRANSFER_MODE_BLOCK

Function Documentation

4 R_DMAC _Open()

fsp_err t R_ DMAC _Open ( transfer_ctrl_t *const p_api _ctrl, transfer_cfg_t const *const p_cfg )

Configure a DMAC channel.

Return values

FSP_SUCCESS Successful open.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_IP_CHANNEL_NOT_PRESENT The configured channel is invalid.

FSP_ERR_IRQ_BSP_DISABLED The IRQ associated with the activation
source is not enabled in the BSP.

FSP_ERR_ALREADY_OPEN The control structure is already opened.

¢ R_DMAC_Reconfigure()

fsp_err_t R_DMAC_Reconfigure ( transfer_ctrl_t *const p_api_ctrl, transfer_info_t * p_info )

Reconfigure the transfer with new transfer info.

Return values

FSP_SUCCESS Transfer is configured and will start when
trigger occurs.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT_ENABLED DMAC is not enabled. The current

configuration must not be valid.

FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DMAC_Open
to initialize the control block.
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¢ R_DMAC_Reset()

fsp_err t R_ DMAC_Reset ( transfer_ctrl_t *const p_api ctrl, void const *volatile p_src, void *volatile
p_dest, uintl6 t const num_transfers )

Reset transfer source, destination, and number of transfers.

Return values

FSP_SUCCESS Transfer reset successfully.
FSP_ERR_ASSERTION An input parameter is invalid.
FSP_ERR_NOT_ENABLED DMAC is not enabled. The current

configuration must not be valid.

FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DMAC_Open
to initialize the control block.

4 R_DMAC_SoftwareStart()

fsp_err t R_ DMAC_SoftwareStart ( transfer_ctrl_t *const p_api ctrl, transfer_start mode_t mode )

If the mode is TRANSFER_START_MODE_SINGLE initiate a single transfer with software. If the mode

is TRANSFER_START_MODE_REPEAT continue triggering transfers until all of the transfers are
completed.

Return values

FSP_SUCCESS Transfer started written successfully.
FSP_ERR_ASSERTION An input parameter is invalid.
FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DMAC_Open
to initialize the control block.
FSP_ERR_UNSUPPORTED Handle was not configured for software
activation.
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4 R_DMAC_SoftwareStop()

fsp_err_t R_DMAC_SoftwareStop ( transfer_ctrl _t *const p_api ctrl)
Stop software transfers if they were started with TRANSFER_START _MODE_REPEAT.

Return values

FSP_SUCCESS Transfer stopped written successfully.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DMAC_Open
to initialize the control block.

4 R_DMAC_Enable()

fsp_err_t R_DMAC_Enable ( transfer_ctrl_t *const p_api_ctrl)

Enable transfers for the configured activation source.

Return values

FSP_SUCCESS Counter value written successfully.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT_OPEN Handle is not initialized. Call R_DMAC_Open
to initialize the control block.

4 R_DMAC Disable()

fsp_err t R_ DMAC Disable ( transfer_ctrl t *const p_api ctrl)

Disable transfers so that they are no longer triggered by the activation source.

Return values

FSP_SUCCESS Counter value written successfully.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DMAC_Open
to initialize the control block.
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¢ R_DMAC _InfoGet()

fsp_err_ t R_DMAC InfoGet ( transfer _ctrl_t *const p_api ctrl, transfer_properties_t *const p_info )

Set driver specific information in provided pointer.

Return values
FSP_SUCCESS Information has been written to p_info.

FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DMAC_Open
to initialize the control block.

FSP_ERR_ASSERTION An input parameter is invalid.

¢ R_DMAC Close()

fsp_err_t R_DMAC_Close ( transfer_ctrl_t *const p_api_ctrl)

Disable transfer and clean up internal data. Implements transfer_api_t::close.

Return values

FSP_SUCCESS Successful close.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT_OPEN Handle is not initialized. Call R_DMAC_Open
to initialize the control block.

4 R_DMAC VersionGet()

fsp_err t R_ DMAC VersionGet ( fsp_version_t *const p_version)

Set driver version based on compile time macros.

Return values
FSP_SUCCESS Successful close.

FSP_ERR_ASSERTION An input parameter is invalid.

4.2.14 Data Operation Circuit (r_doc)
Modules
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Functions

fsp_err t R_DOC Open (doc_ctrl_t *const p_api_ctrl, doc_cfg_t const *const
p_cfg)

fsp_err t R _DOC Close (doc_ctrl t *const p_api_ctrl)

fsp_err t R _DOC StatusGet (doc_ctrl _t *const p_api_ctrl, doc_status_t *const
p_status)

fsp_err t R_DOC_Write (doc_ctrl_t *const p_api_ctrl, uintl6_t data)

fsp_err t R_DOC VersionGet (fsp_version_t *const p_version)

Detailed Description

Driver for the DOC peripheral on RA MCUs. This module implements the DOC Interface.

Overview

Features

The DOC HAL module peripheral is used to compare, add or subtract 16-bit data and can detect the
following events:

e A match or mismatch between data values
e Overflow of an addition operation
e Underflow of a subtraction operation

A user-defined callback can be created to inform the CPU when any of above events occur.

Configuration

Build Time Configurations for r_doc

The following build time configurations are defined in fsp_cfg/r_doc_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.

Configurations for Driver > Monitoring > Data Operation Circuit Driver on r_doc

This module can be added to the Stacks tab via New Stack > Driver > Monitoring > Data Operation
Circuit Driver on r_doc:

Configuration Options Default Description
Name Name must be a valid g_docO Module name.
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C symbol
Event e Comparison Comparison mismatch  Select the event that
mismatch will trigger the DOC
e Comparison interrupt.
match
e Addition
overflow
e Subtraction
underflow
Reference/Initial Data Value must be a 16 bit 0 Enter Initial Value for
integer between 0 and Addition/Subtraction or
65535 enter reference value
for comparison.
Callback Name must be a valid NULL A user callback
C symbol function must be
provided. This will be
called from the
interrupt service
routine (ISR) when the
configured DOC event
occurs.
DOC Interrupt Priority MCU Specific Options Select the DOC

interrupt priority.
Clock Configuration
The DOC HAL module does not require a specific clock configuration.
Pin Configuration

The DOC HAL module does not require and specific pin configurations.

Usage Notes

DMAC/DTC Integration

DOC can be used with Direct Memory Access Controller (r_dmac) or Data Transfer Controller (r_dtc)
to write to the input register without CPU intervention. DMAC is more useful for most DOC

applications because it can be started directly from software. To write DOC input data with
DTC/DMAC, set transfer_info_t::p_dest to R_DOC->DODIR.

Examples

Basic Example
This is a basic example of minimal use of the R_DOC in an application. This example shows how this

driver can be used for continuous 16 bit addition operation while reading the result at every overflow
event.

#def i ne DOC_EXAMPLE_VALUE 0xFO000
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4 R_DOC _Open()

fsp_err t R_DOC Open ( doc_ctrl_t *const p_api _ctrl, doc_cfg t const *const p cfg )

Opens and configures the Data Operation Circuit (DOC) in comparison, addition or subtraction
mode and sets initial data for addition or subtraction, or reference data for comparison.

Example:

/* Initialize the DOC nodule for addition with initial value specified in
doc_cfg t::doc_data. */

err = R DOC Open(&g_doc_ctrl, &g doc cfg);

Return values

FSP_SUCCESS DOC successfully configured.

FSP_ERR_ALREADY_OPEN Module already open.

FSP_ERR_ASSERTION One or more pointers point to NULL or
callback is NULL or the interrupt vector is
invalid.

¢ R_DOC _Close()

fsp_err t R_DOC Close ( doc_ctrl_t *const p_api ctrl)

Closes the module driver. Enables module stop mode.

Return values

FSP_SUCCESS Module successfully closed.
FSP_ERR_NOT _OPEN Driver not open.
FSP_ERR_ASSERTION Pointer pointing to NULL.
Note
This function will disable the DOC interrupt in the NVIC.
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4 R_DOC _StatusGet()

fsp_err_ t R_DOC StatusGet ( doc_ctrl_t *const p_api ctrl, doc_status_t *const p status )

Returns the result of addition/subtraction.

Example:
/* Read the result of the operation */

err = R DOC StatusGet (& _doc_ctrl, &result);

handl e _error(err);

Return values

FSP_SUCCESS Status successfully read.
FSP_ERR_NOT _OPEN Driver not open.
FSP_ERR_ASSERTION One or more pointers point to NULL.

¢ R_DOC_Write()

fsp_err_ t R_DOC_Write ( doc_ctrl_t *const p_api ctrl, uintl6 t data )

Writes to the DODIR - DOC Input Register.
Example:
err = RDOC Wite(&g doc _ctrl, DOC EXAVPLE VALUE);

handl e_error(err);

Return values
FSP_SUCCESS

Values successfully written to the registers.
FSP_ERR_NOT_OPEN Driver not open.

FSP_ERR_ASSERTION

One or more pointers point to NULL.

4 R_DOC _VersionGet()

fsp_err_t R_DOC_VersionGet ( fsp_version_t *const p_version)

Returns DOC HAL driver version.

Return values
FSP_SUCCESS

Version information successfully read.
FSP_ERR_ASSERTION Pointer pointing to NULL.
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4.2.15 D/AVE 2D Port Interface (r_drw)

Modules

Driver for the DRW peripheral on RA MCUs. This module is a port of D/AVE 2D.

Overview

Note
The D/AVE 2D Port Interface (D1 layer) isa HAL layer for the D/AVE D2 layer API and does not provide any
interfacesto the user. Consult the TES Dave2D Driver Documentation for further information on using the D2
API.
For cross-platform compatibility purposes the D1 and D2 APIs are not bound by the FSP coding guidelines for
function names and general module functionality.

Configuration

Build Time Configurations for r_drw

The following build time configurations are defined in fsp_cfg/r _drw_cfg.h:

Configuration Options Default Description
Allow Indirect Mode e Enabled Enabled Enable indirect mode
e Disabled to allow no-copy mode

for d2_adddlist (see the
TES Dave2D Driver
Documentation for

details).
Memory Allocation ¢ Default Default Set Memory Allocation
e Custom to Default to use built-

in dynamic memory
allocation for the D2
heap. This will use an
RTOS heap if
configured; otherwise,
standard C malloc and
free will be used.

Set to Custom to define
your own allocation
scheme for the D2
heap. In this case, the
developer will need to
define the following
functions:
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void * d1_malloc(size_t
size)
void d1_free(void * ptr)

Configurations for Driver > Graphics > D/AVE 2D Port Interface on r_drw

This module can be added to the Stacks tab via New Stack > Driver > Graphics > D/AVE 2D Port
Interface on r_drw:

Configuration Options Default Description

D2 Device Handle Name must be a valid  d2_handle0 Set the name for the

Name C symbol d2_device handle used
when calling D2 layer
functions.

DRW Interrupt Priority = MCU Specific Options Select the DRW_INT
(display list
completion) interrupt
priority.

Heap Size

The D1 port layer allows the D2 driver to allocate memory as needed. There are three ways the
driver can accomplish this:

1. Allocate memory using the main heap
2. Allocate memory using a heap provided by an RTOS
3. Allocate memory via user-provided functions

When the "Memory Allocation" configuration option is set to "Default" the driver will use an RTOS
implementation if available and the main heap otherwise. Setting the option to "Custom" allows the
user to define their own scheme using the following prototypes:

void * dl_malloc(size_t size);

void dl free(void * ptr);

Warning
If there is no RTOS-based allocation scheme the main heap will be used. Be sure that it is
enabled by setting the "Heap size (bytes)" property under RA Common on the BSP tab of
the RA Configuration editor.

Note
It isrecommended to add 32KB of additional heap space for the D2 driver until the actual usage can be determined
in your application.

Interrupt

The D1 port includes one interrupt to handle various events like display list completion or bus error.
This interrupt is managed internally by the D2 driver and no callback function is available.

Usage Notes
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Limitations
Developers should be aware of the following limitations when using the DRW engine:

e The DRW module supports two additional interrupt types - bus error and render complete.
These interrupts are not needed for D2 layer operation and thus are not supported.

e |f the DRW module is stopped during rendering the render will continue once the module is
started again. If this behavior is undesirable in your application it is recommended to call
d2_flushframe before stopping the peripheral.

4.2.16 Data Transfer Controller (r_dtc)
Modules

Functions

fsp_err t R _DTC Open (transfer _ctrl_t *const p_api_ctrl, transfer_cfg_t const
*const p_cfg)

fsp_err t R_DTC_Reconfigure (transfer _ctrl_t *const p_api_ctrl, transfer_info_t
e
p_info)

fsp_err t R_DTC_Reset (transfer_ctrl_t *const p_api_ctrl, void const *volatile
p_src, void *volatile p_dest, uintl6_t const num_transfers)

fsp_err t R_DTC_SoftwareStart (transfer_ctrl_t *const p_api_ctrl,
transfer_start_mode_t mode)

fsp_err t R_DTC_SoftwareStop (transfer_ctrl_t *const p_api_ctrl)
fsp_err t R _DTC Enable (transfer ctrl_t *const p_api_ctrl)
fsp_err t R_DTC Disable (transfer _ctrl _t *const p_api_ctrl)

fsp_err t R _DTC InfoGet (transfer_ctrl_t *const p_api_ctrl, transfer_properties_t
*const p_properties)

fsp_err t R_DTC Close (transfer_ctrl_t *const p_api_ctrl)

fsp_err t R _DTC VersionGet (fsp_version_t *const p_version)

Detailed Description

Driver for the DTC peripheral on RA MCUs. This module implements the Transfer Interface.

Overview

The Data Transfer Controller (DTC) transfers data from one memory location to another without
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using the CPU.

The DTC uses a RAM based vector table. Each entry in the vector table corresponds to an entry in
the ISR vector table. When the DTC is triggered by an interrupt, it reads the DTC vector table,
fetches the transfer information, and then executes the transfer. After the transfer is executed, the
DTC writes the updated transfer info back to the location pointed to by the DTC vector table.

Features

e Supports multiple transfer modes
o Normal transfer
o Repeat transfer
o Block transfer
Chain transfers
Address increment, decrement or fixed modes
Can be triggered by any event that has reserved a slot in the interrupt vector table.
o Some exceptions apply, see the Event table in the Event Numbers section of the
Interrupt Controller Unit chapter of the hardware manual
Supports 1, 2, and 4 byte data units

Configuration

Build Time Configurations for r_dtc

The following build time configurations are defined in fsp_cfg/r_dtc_cfg.h:

Configuration Options Default Description
Parameter Checking e Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.
Linker section to keep  Manual Entry .fsp_dtc_vector _table Section to place the
DTC vector table DTC vector table.

Configurations for Driver > Transfer > Transfer Driver on r_dtc

This module can be added to the Stacks tab via New Stack > Driver > Transfer > Transfer Driver on
r_dtc:

Configuration Options Default Description
Name Name must be a valid  g_transferQ Module name.
C symbol
Mode ¢ Normal Normal Select the transfer
¢ Repeat mode. Select the
e Block transfer mode. Normal:

One transfer per
activation, transfer
ends after Number of
Transfers; Repeat: One
transfer per activation,
Repeat Area address
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Transfer Size

Destination Address
Mode

Source Address Mode

Repeat Area (Unused in

Normal Mode)

Interrupt Frequency

Number of Transfers

Number of Blocks
(Valid only in Block
Mode)

Activation Source

Clock Configuration

1 Byte
2 Bytes
4 Bytes

e Fixed
¢ |[ncremented
e Decremented

e Fixed
¢ |[ncremented
e Decremented

¢ Destination
e Source

o After all
transfers have
completed

o After each
transfer

Value must be a non-
negative integer

Must be a valid non-
negative integer with a
maximum configurable
value of 65536.
Applicable only in Block
Mode.

MCU Specific Options

2 Bytes

Fixed

Fixed

Source

After all transfers have
completed

reset after Number of
Transfers, transfer
repeats until stopped;
Block: Number of
Blocks per activation,
Repeat Area address
reset after Number of
Transfers, transfer
ends after Number of
Blocks.

Select the transfer size.

Select the address
mode for the
destination.

Select the address
mode for the source.

Select the repeat area.
Either the source or
destination address
resets to its initial
value after completing
Number of Transfers in
Repeat or Block mode.

Select to have interrupt
after each transfer or
after last transfer.

Specify the number of
transfers.

Specify the number of
blocks to transfer in
Block mode.

Select the DTC transfer
start event.

The DTC peripheral module uses ICLK as the clock source. The ICLK frequency is set by using the
Clocks tab of the RA Configuration editor prior to a build or by using the CGC module at runtime.

Pin Configuration

This module does not use I/O pins.
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Usage Notes

Transfer Modes
The DTC Module supports three modes of operation.

¢ Normal Mode - In normal mode, a single data unit is transfered every time an interrupt is
received by the DTC. A data unit can be 1-byte, 2-bytes, or 4-bytes. The source and
destination addresses can be fixed, increment or decrement to the next data unit after each
transfer. A 16-bit counter (length) decrements after each transfer. When the counter
reaches 0, transfers will no longer be triggered by the interrupt source and the CPU can be
interrupted to signal that all transfers have finished.

e Repeat Mode - Repeat mode works the same way as normal mode, however the length is
limited to an integer in the range[1,256]. When the tranfer counter reaches 0, the counter
is reset to its configured value and the repeat area (source or destination address) resets to
its starting address and transfers will still be triggered by the interrupt.

e Block Mode - In block mode, the amount of data units transfered by each interrupt can be
set to an integer in the range [1,256]. The number of blocks to transfer can also be
configured to a 16-bit number. After each block transfer the repeat area (source or
destination address) will reset to the original address and the other address will be
incremented or decremented to the next block.

Note
1. The source and destination address of the transfer must be aligned to the configured data unit.
2. In normal mode the length can be set to [ 0,65535] . When the length is set to O, than the transaction will execute
65536 transfers not O.
3. In block mode, num_blocks can be set to [ 0,65535]. When the length is set to 0, than the transaction will execute
65536 transfers not O.

Chaining Transfers

Multiple transfers can be configured for the same interrupt source by specifying an array of
transfer_info_t structs instead of just passing a pointer to one. In this configuration, every
transfer_info_t struct must be configured for a chain mode except for the last one. There are two
types of chain mode; CHAIN_MODE_EACH and CHAIN_MODE_END. If a transfer is configured in
CHAIN_MODE_EACH then it triggers the next transfer in the chain after it completes each transfer. If
a transfer is configured in CHAIN_MODE_END then it triggers the next transfer in the chain after it
completes its last transfer.
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DTC
Activation
ource Even

Chain NMode
[Disabled]

Transfer Complete

Transfer data

Repeat mode? [Yes]
[No]
Chain Mode
[Each]
Chain mode?
Chain Mode
[End, Disabled]
h 4 Y

Decrement counter Reset transfer
and update source Disable DTC counter and repeat

A

and destination activation source

area(source or

Go to next transfer

pointer destination)
< |
y
Chain mode? Chﬁ%‘;gﬁde N
Chain Mode
[End]
Last transfer? [Yes]

info in the chain

A

1. Counter refers to transfer_info_t::length in normal and repeat mode and transfer_info_t::num_klocks in block mode.

Selecting the DTC or DMAC

Figure 126: DTC Transfer Flow

chart

The Transfer API is implemented by both DTC and the DMAC so that applications can switch between
the DTC and the DMAC. When selecting between them, consider these factors:

DTC

DMAC

Repeat Mode

Block Mode

Channels

Chained Transfers

Software Trigger

e Repeats forever

e Max repeat size is 256 x

4 bytes

e Max block size is 256 x

4 bytes

¢ One instance per
interrupt

e Supported

e Must use the software

Configurable number of
repeats

Max repeat size is 1024
x 4 bytes

Max block size is 1024 x
4 bytes

MCU specific (8
channels or less)

Not Supported

Has support for software

ELC event trigger without using
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software ELC event

e Supports TRANSFER ST
ART _MODE_SINGLE and
TRANSFER START _MOD
E_REPEAT

Offset Address Mode ¢ Not supported e Supported
Additional Considerations

e The DTC requires a moderate amount of RAM (one transfer_info_t struct per open instance
+ DTC_VECTOR TABLE_SIZE).

* The DTC stores transfer information in RAM and writes back to RAM after each transfer
whereas the DMAC stores all transfer information in registers.

e When transfers are configured for more than one activation source, the DTC must fetch the
transfer info from RAM on each interrupt. This can cause a higher latency between
transfers.

e The DTC interrupts the CPU using the activation source's IRQ. Each DMAC channel has its
own IRQ.

Interrupts

The DTC and DMAC interrupts behave differently. The DTC uses the configured IELSR event IRQ as
the interrupt source whereas each DMAC channel has its own IRQ.

The transfer_info_t::irq setting also behaves a little differently depending on which mode is selected.

Normal Mode

DTC DMAC
TRANSFER IRQ_EACH Interrupt after each transfer N/A
TRANSFER_IRQ_END Interrupt after last transfer Interrupt after last transfer
Repeat Mode

DTC DMAC
TRANSFER IRQ_EACH Interrupt after each transfer Interrupt after each repeat
TRANSFER_IRQ_END Interrupt after each repeat Interrupt after last transfer
Block Mode

DTC DMAC
TRANSFER_IRQ_EACH Interrupt after each block Interrupt after each block
TRANSFER IRQ_END Interrupt after last block Interrupt after last block
Note

DTC_VECTOR TABLE_SIZE = (ICU_NVIC_IRQ_SOURCESX 4) Bytes
Peripheral Interrupts and DTC

When an interrupt is configured to trigger DTC transfers, the peripheral ISR will trigger on the
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following conditions:

e Each transfer completed (transfer_info_t::irq = TRANSFER IRQ_EACH)
e Last transfer completed (transfer_info_t::irg = TRANSFER _IRQ END)

For example, if SCI1_RXI is configured to trigger DTC transfers and a SCI1_RXI event occurs, the
interrupt will not fire until the DTC transfer is completed. If the DTC transfer_info_t::irq is configured
to only interrupt on the last transfer, than no RXI interrupts will occur until the last transfer is
completed.

Note
1. The DTC activation source must be enabled in the NVIC in order to trigger DTC transfers (Modules that are
designed to integrate the R_DTC module will automatically handle this).
2. The DTC prioritizes activation sources by granting the smaller interrupt vector numbers higher priority. The
priority of interrupts to the CPU is determined by the NVIC priority.

Low Power Modes
DTCST must be set to 0 before transitioning to any of the following:

e Module-stop state
e Software Standby mode without Snooze mode transition
* Deep Software Standby mode

Note
1. R_ LPM Module stops the DTC before entering deep softwar e standby mode and softwar e standby without snooze

mode transition.
2. For more information see 18.9 and 18.10 in the RA6M3 manual RO1UHO0886EJ0100.

Limitations
Developers should be aware of the following limitations when using the DTC:

e |f the DTC is configured to service many different activation sources, the system could run
in to performance issues due to memory contention. To address this issue, it is
reccomended that the DTC vector table and transfer information be moved to their own
dedicated memory area (Ex: SRAMO, SRAM1, SRAMHS). This allows memory accesses from
different BUS Masters (CPU, DTC, DMAC, EDMAC and Graphics IPs) to occur in parallel.

Examples

Basic Example

This is a basic example of minimal use of the DTC in an application.

voi d dtc_mni ni mal _exanpl e (void)

{

/* Open the transfer instance with initial configuration. */
fsp_err_ t err = R DIC Open(&g_transfer _ctrl, & _transfer_cfg);

/* Handl e any errors. This function should be defined by the user. */

handl e _error(err);
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/* Enable the DTC to handle incom ng transfer requests. */
err = R DTC Enabl e(&g transfer _ctrl);

handl e_error(err);

Data Structures

struct dtc_extended cfg t
struct dtc_instance_ctrl_t

Macros

#define DTC_MAX_NORMAL_TRANSFER_LENGTH
#define DTC_MAX_REPEAT TRANSFER_LENGTH
#define DTC_MAX_BLOCK_TRANSFER_LENGTH

#define DTC_MAX_BLOCK_COUNT

Data Structure Documentation

¢ dtc_extended cfg_ t

struct dtc_extended_cfg_t

DTC transfer configuration extension. This extension is required.

Data Fields

IRQn_Type activation_source Select which IRQ will trigger the
transfer.

¢ dtc_instance_ctrl_t

struct dtc_instance_ctrl_t

Control block used by driver. DO NOT INITIALIZE - this structure will be initialized in
transfer_api_t::open.

Macro Definition Documentation

¢ DTC_MAX_NORMAL_TRANSFER_LENGTH

#define DTC_MAX_NORMAL_TRANSFER_LENGTH

Max configurable number of transfers in NORMAL MODE
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& DTC_MAX_REPEAT_TRANSFER_LENGTH

#define DTC_MAX_REPEAT TRANSFER_LENGTH

Max number of transfers per repeat for REPEAT MODE

¢ DTC_MAX_BLOCK _TRANSFER_LENGTH

#define DTC_MAX_BLOCK_TRANSFER_LENGTH

Max number of transfers per block in BLOCK MODE

& DTC_MAX_BLOCK_COUNT

#define DTC_MAX_BLOCK_COUNT

Max configurable number of blocks to transfer in BLOCK MODE

Function Documentation

¢ R_DTC Open()

fsp_err t R_DTC Open ( transfer _ctrl _t *const p_api ctrl, transfer _cfg t const *const p cfg )

Configure the vector table if it hasn't been configured, enable the Module and copy the pointer to
the transfer info into the DTC vector table. Implements transfer_api_t::open.

Example:
/* Open the transfer instance with initial configuration. */

fsp err t err = R DIC Open(&g_transfer ctrl, & transfer cfg);

Return values

FSP_SUCCESS Successful open. Transfer transfer info
pointer copied to DTC Vector table. Module
started. DTC vector table configured.

FSP_ERR_ASSERTION An input parameter is invalid.
FSP_ERR_UNSUPPORTED Address Mode Offset is selected.
FSP_ERR_ALREADY_OPEN The control structure is already opened.
FSP_ERR_IN_USE The index for this IRQ in the DTC vector

table is already configured.

FSP_ERR_IRQ BSP_DISABLED The IRQ associated with the activation
source is not enabled in the BSP.
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4 R_DTC_Reconfigure()

fsp_err_ t R_DTC_Reconfigure ( transfer_ctrl_t *const p_api ctrl, transfer_info t * p _info )

Copy pointer to transfer info into the DTC vector table and enable transfer in ICU. Implements
transfer_api_t::reconfigure.

Return values

FSP_SUCCESS Transfer is configured and will start when
trigger occurs.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT_OPEN Handle is not initialized. Call R_DTC_Open to

initialize the control block.

FSP_ERR_NOT_ENABLED Transfer source address is NULL or is not
aligned corrrectly. Transfer destination
address is NULL or is not aligned corrrectly.

Note

p_info must persist until all transfers are completed.

¢ R_DTC_Reset()

fsp_err t R_DTC_Reset ( transfer_ctrl_t *const p_api ctrl, void const *volatile p_src, void *volatile
p_dest, uintl6_t const num_transfers )

Reset transfer source, destination, and number of transfers. Implements transfer_api_t::reset.

Return values

FSP_SUCCESS Transfer reset successfully (transfers are
enabled).

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT_OPEN Handle is not initialized. Call R_DTC_Open to

initialize the control block.

FSP_ERR_NOT_ENABLED Transfer source address is NULL or is not
aligned corrrectly. Transfer destination
address is NULL or is not aligned corrrectly.
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4 R_DTC_SoftwareStart()

fsp_err_ t R_DTC_SoftwareStart ( transfer_ctrl_t *const p_api_ctrl, transfer_start mode t mode )

Placeholder for unsupported softwareStart function. Implements transfer_api_t::softwareStart.

Return values

FSP_ERR_UNSUPPORTED DTC software start is not supported.

¢ R_DTC_SoftwareStop()

fsp_err_t R_DTC_SoftwareStop ( transfer_ctrl_t *const p_api_ctrl)

Placeholder for unsupported softwareStop function. Implements transfer_api_t::softwareStop.

Return values

FSP_ERR_UNSUPPORTED DTC software stop is not supported.

¢ R_DTC_Enable()

fsp_err_ t R_DTC_Enable ( transfer_ctrl_t *const p_api_ctrl)

Enable transfers on this activation source. Implements transfer_api_t::enable.

Example:
/* Enable the DTC to handl e inconmi ng transfer requests. */
err = R DTC Enabl e(&g_transfer_ctrl);

handl e _error(err);

Return values

FSP_SUCCESS Transfers will be triggered by the activation
source

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_UNSUPPORTED Address Mode Offset is selected.

FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DTC_Open to
initialize the control block.
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¢ R_DTC Disable()

fsp_err_ t R_DTC Disable ( transfer_ctrl_t *const p_api _ctrl)

Disable transfer on this activation source. Implements transfer_api_t::disable.

Return values

FSP_SUCCESS Transfers will not occur on activation
events.
FSP_ERR_NOT_OPEN Handle is not initialized. Call R_DTC_Open to

initialize the control block.

FSP_ERR_ASSERTION An input parameter is invalid.

¢ R_DTC InfoGet()

fsp_err_t R_DTC_InfoGet ( transfer_ctrl_t *const p_api_ctrl, transfer_properties_t *const
p_properties )

Provides information about this transfer. Implements transfer_api_t::infoGet.

Return values

FSP_SUCCESS p_info updated with current instance
information.
FSP_ERR_NOT _OPEN Handle is not initialized. Call R_ DTC_Open to

initialize the control block.

FSP_ERR_ASSERTION An input parameter is invalid.

¢ R_DTC_Close()

fsp_err t R_DTC Close ( transfer_ctrl_t *const p_api_ctrl)

Disables DTC activation in the ICU, then clears transfer data from the DTC vector table. Implements
transfer_api_t::close.

Return values

FSP_SUCCESS Successful close.

FSP_ERR_ASSERTION An input parameter is invalid.

FSP_ERR_NOT_OPEN Handle is not initialized. Call R_DTC_Open to
initialize the control block.
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¢ R_DTC VersionGet()

fsp_err_ t R_DTC VersionGet ( fsp_version_t *const p_version)

Get the driver version based on compile time macros. Implements transfer_api_t::versionGet.

Return values

FSP_SUCCESS Version information written to p_version.

FSP_ERR_ASSERTION An input parameter is invalid.

4.2.17 Event Link Controller (r_elc)
Modules

Functions

fsp_err t R_ELC Open (elc_ctrl_t *const p_ctrl, elc_cfg_t const *const p_cfg)
fsp_err t R _ELC Close (elc_ctrl_t *const p_ctrl)

fsp_err t R_ELC SoftwareEventGenerate (elc_ctrl_t *const p_ctrl,
elc_software_event t event_number)

fsp_err t R _ELC _LinkSet (elc_ctrl_t *const p_ctrl, elc_peripheral_t peripheral,
elc_event _t signal)

fsp_err t R_ELC_LinkBreak (elc_ctrl_t *const p_ctrl, elc_peripheral_t peripheral)
fsp_err t R_ELC Enable (elc_ctrl_t *const p_ctrl)
fsp_err t R _ELC Disable (elc_ctrl _t *const p_ctrl)

fsp_err t R_ELC VersionGet (fsp_version_t *const p_version)

Detailed Description

Driver for the ELC peripheral on RA MCUs. This module implements the ELC Interface.

Overview

The event link controller (ELC) uses the event requests generated by various peripheral modules as
source signals to connect (link) them to different modules, allowing direct cooperation between the
modules without central processing unit (CPU) intervention. The conceptual diagram below illustrates
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a potential setup where a pin interrupt triggers a timer which later triggers an ADC conversion and
CTSU scan, while at the same time a serial communication interrupt automatically starts a data
transfer. These tasks would be automatically handled without the need for polling or interrupt

management.

Port IRQs

DMAC ELC

T

1]

Timers

i

ADC

DAC

Serial

OO/OO O O
o o

Software

Power

.

11O Ports

E
I_U
=

TSU

DTC

Ii Di
> o
9] O

Figure 127: Event Link Controller Conceptual Diagram

In essence, the ELC is an array of multiplexers to route a wide variety of interrupt signals to a subset
of peripheral functions. Events are linked by setting the multiplexer for the desired function to the
desired signal (through R_ELC LinkSet). The diagram below illustrates one peripheral output of the
ELC. In this example, a conversion start is triggered for ADCO Group A when the GPTO counter

overflows:

Available events

| GPTOMatch B }—\_:
| GPTO0 Match C }—\_>

| GPTO0 Match D |—\_>

/

Peripheral function

02aY Tvd3HdRAd 9713

[ GPTO Overflow |—— 7]
[ GPTO Underflow }—/_:

/ ELC_EVENT_GPTO_COUNTER_OVERFLOW

Selected event
Figure 128: ELC Example

Features

The ELC HAL module can perform the following functions:

ADCO Start
Conversion A

R11UMO0146EU0120 Revision 1.20

LENESAS
Jun.26.20 -2

Page 375/ 1,560



Flexible Software Package User’s Manual

API Reference > Modules > Event Link Controller (r_elc)

* |nitialize the ELC to a pre-defined set of links

* Create an event link between two blocks

* Break an event link between two blocks

e Generate one of two software events that interrupt the CPU
e Globally enable or disable event links

A variety of functions can be activated via events, including:

e General-purpose timer (GPT) control

e ADC and DAC conversion start

e Synchronized I/O port output (ports 1-4 only)

e Capacitive touch unit (CTSU) measurement activation

Note
The available sources and peripherals may differ between devices. A full list of selectable peripherals and eventsis
available in the User's Manual for your device.
Some peripherals have specific settings related to ELC event generation and/or reception. Details on how to enable
event functionality for each peripheral are located in the usage notes for the related module(s) as well asin the
User's Manual for your device.

Configuration

Note

Event links will be automatically generated based on the sel ections made in module properties. To view the
currently linked events check the Event Links tab in the RA Configuration editor.
Calling R_ELC_Open followed by R_ELC_Enable will automatically link all events shown in the Event Links tab.

To manually link an event to a peripheral at runtime perform the following steps:

1. Configure the operation of the destination peripheral (including any configuration necessary
to receive events)

2. Use R_ELC_LinkSet to set the desired event link to the peripheral

3. Use R_ELC_Enable to enable transmission of event signals

4. Configure the signaling module to output the desired event (typically an interrupt)

To disable the event, either use R_ELC_LinkBreak to clear the link for a specific event or
R_ELC Disable to globally disable event linking.

Note

The ELC module needs no pin, clocking or interrupt configuration; it is merely a mechanismto connect signals
between peripherals. However, when linking 1/0 Ports via the ELC the relevant 1/0 pins need to be configured as
inputs or outputs.

Build Time Configurations for r_elc

The following build time configurations are defined in fsp_cfg/r_elc_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
e Disabled included in the build.

Configurations for Driver > System > ELC Driver on r_elc
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This module can be added to the Stacks tab via New Stack > Driver > System > ELC Driver on r_elc:

Configuration Options Default Description
Name ELC instance name g_elc Module name. Fixed to
must be g_elc to match g_elc.

elc_cfg_t data structure
created in elc_data.c

Usage Notes

Limitations
Developers should be aware of the following limitations when using the ELC:

e To link events it is necessary for the ELC and the related modules to be enabled. The ELC
cannot operate if the related modules are in the module stop state or the MCU is in a low
power consumption mode for which the module is stopped.

e If two modules are linked across clock domains there may be a 1 to 2 cycle delay between
event signaling and reception. The delay timing is based on the frequency of the slowest
clock.

Examples

Basic Example
Below is a basic example of minimal use of event linking in an application.
/* This struct is automatically generated based on the events configured by

peri pherals in the RA Configuration editor. */

static const elc_cfg t g elc cfg =

{
.1ink[ ELC_PERI PHERAL_GPT_A] = ELC_EVENT_| CU_| RQ,
.1'i nk[ ELC_PERI PHERAL | OPORT1] = ELC_EVENT_GPTO_COUNTER OVERFLOW
ki
voi d el c_basi c_exanpl e (void)
{

fsp_err_t err = FSP_SUCCESS,;

/* Initializes the software and sets the links defined in the control structure. */
err = RELC Open(&g_elc ctrl, & elc _cfg);

/* Handl e any errors. This function should be defined by the user. */
handl e_error(err);

/* Create or nodify a |link between a peripheral function and an event source. */

err = R ELC LinkSet(&g_elc_ctrl, ELC PER PHERAL_ADCO,
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Software-Generated Events

This example demonstrates how to use a software-generated event to signal a peripheral. This can
be useful when the desired event source is not supported by the ELC hardware.
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Data Structures

struct elc_instance_ctrl t

Data Structure Documentation

¢ elc_instance_ctrl_t

struct elc_instance_ctrl_t

ELC private control block. DO NOT MODIFY. Initialization occurs when R_ELC Open() is called.

Function Documentation

4 R_ELC_Open()

fsp_err t R_ELC Open ( elc_ctrl_t *const p _ctrl, elc_cfg_t const *const p cfg )

Initialize all the links in the Event Link Controller. Implements elc_api_t::open

The configuration structure passed in to this function includes links for every event source included
in the ELC and sets them all at once. To set or clear an individual link use R_ELC_LinkSet and
R_ELC_LinkBreak respectively.

Example:
/* Initializes the software and sets the |links defined in the control structure. */

err = R ELC Open(&g_elc ctrl, &g elc cfg);

Return values

FSP_SUCCESS Initialization was successful
FSP_ERR_ASSERTION p_ctrl or p_cfg was NULL
FSP_ERR_ALREADY_OPEN The module is currently open

4 R_ELC Close()

fsp_err t R_ELC Close ( elc_ctrl_t *const p_ctrl)

Globally disable ELC linking. Implements elc_api_t::close

Return values

FSP_SUCCESS The ELC was successfully disabled

FSP_ERR_ASSERTION p_ctrl was NULL

FSP_ERR_NOT _OPEN The module has not been opened
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4 R_ELC SoftwareEventGenerate()

fsp_err_t R_ELC_SoftwareEventGenerate ( elc_ctrl_t *const p_ctrl, elc_software_event_t
event_number )

Generate a software event in the Event Link Controller. Implements
elc_api_t::softwareEventGenerate

Example:
/* Generate an event signal through software to the |inked peripheral. */

err = R ELC Softwar eEvent Generate(&g elc_ctrl, ELC SOFTWARE _EVENT 0);

handl e _error(err);

Return values

FSP_SUCCESS Initialization was successful
FSP_ERR_ASSERTION Invalid event number or p_ctrl was NULL
FSP_ERR_NOT _OPEN The module has not been opened

& R_ELC_LinkSet()

fsp_err t R_ELC LinkSet ( elc_ctrl_t *const p ctrl, elc_peripheral t peripheral, elc_event t signal )

Create a single event link. Implements elc_api_t::linkSet

Example:

/* Create or nodify a |link between a peripheral function and an event source. */
err = R ELC LinkSet(&g_elc _ctrl, ELC PERI PHERAL ADCO,

ELC EVENT_GPTO_COUNTER OVERFLOW ;

handl e _error(err);

Return values

FSP_SUCCESS Initialization was successful

FSP_ERR_ASSERTION p_ctrl was NULL

FSP_ERR_NOT_OPEN The module has not been opened
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4 R_ELC_LinkBreak()

fsp_err_ t R_ELC_LinkBreak ( elc_ctrl_t *const p_ctrl, elc_peripheral_t peripheral )

Break an event link. Implements elc_api_t::linkBreak

Return values

FSP_SUCCESS Event link broken
FSP_ERR_ASSERTION p_ctrl was NULL
FSP_ERR_NOT_OPEN The module has not been opened

¢ R_ELC_Enable()

fsp_err t R_ELC Enable ( elc_ctrl_t *const p_ctr/)

Enable the operation of the Event Link Controller. Implements elc_api_t::enable

Return values

FSP_SUCCESS ELC enabled.
FSP_ERR_ASSERTION p_ctrl was NULL
FSP_ERR_NOT _OPEN The module has not been opened

¢ R_ELC Disable()

fsp_err t R_ELC Disable ( elc_ctrl_t *const p_ctrl)

Disable the operation of the Event Link Controller. Implements elc_api_t::disable

Return values

FSP_SUCCESS ELC disabled.

FSP_ERR_ASSERTION p_ctrl was NULL

FSP_ERR_NOT_OPEN The module has not been opened
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¢ R_ELC VersionGet()

fsp_err t R_ELC VersionGet ( fsp_version_t *const p_version)

Get the driver version based on compile time macros. Implements elc_api_t::versionGet

Return values
FSP_SUCCESS Successful close.

FSP_ERR_ASSERTION p_version is NULL.

4.2.18 Ethernet (r_ether)
Modules

Functions

fsp_err t R_ETHER Open (ether_ctrl_t *const p_ctrl, ether_cfg_t const *const
p_cfg)

After ETHERC, EDMAC and PHY-LSI are reset in software, an auto
negotiation of PHY-LSI is begun. Afterwards, the link signal change
interrupt is permitted. Implements ether_api_t::open. More...

fsp_err t R_ETHER_Close (ether_ctrl_t *const p_ctrl)

Disables interrupts. Removes power and releases hardware lock.
Implements ether_api_t::close. More...

fsp_err t R _ETHER Read (ether ctrl t *const p_ctrl, void *const p_buffer,
uint32_t *const length_bytes)

Receive Ethernet frame. Receives data to the location specified by
the pointer to the receive buffer. In zero copy mode, the address of
the receive buffer is returned. In non zero copy mode, the received
data in the internal buffer is copied to the pointer passed by the
argument. Implements ether_api_t::read. More...

fsp_err t R_ETHER BufferRelease (ether ctrl t *const p_ctrl)

Move to the next buffer in the circular receive buffer list. Implements
ether_api_t::bufferRelease. More...

fsp_err t R_ETHER Write (ether_ctrl_t *const p_ctrl, void *const p_buffer,
uint32_t const frame_length)
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Transmit Ethernet frame. Transmits data from the location specified
by the pointer to the transmit buffer, with the data size equal to the
specified frame length. In the non zero copy mode, transmits data
after being copied to the internal buffer. Implements
ether_api_t::write. More...

fsp_err t R _ETHER LinkProcess (ether ctrl t *const p_ctrl)

The Link up processing, the Link down processing, and the magic
packet detection processing are executed. Implements
ether_api_t::linkProcess. More...

fsp_err t R_ETHER_WakeOnLANEnNable (ether_ctrl_t *const p_ctrl)

The setting of ETHERC is changed from normal sending and
receiving mode to magic packet detection mode. Implements
ether_api_t::wakeOnLANEnable. More...

fsp_err t R_ETHER VersionGet (fsp_version_t *const p_version)

Provides APl and code version in the user provided pointer.
Implements ether_api_t::versionGet. More...

Detailed Description

Driver for the Ethernet peripheral on RA MCUs. This module implements the Ethernet Interface.

Overview

This module performs Ethernet frame transmission and reception using an Ethernet controller and an
Ethernet DMA controller.

Features
The Ethernet module supports the following features:

Transmit/receive processing

Optional zero-copy buffering

Callback function with returned event code
Magic packet detection mode support
Auto negotiation support

Flow control support

Multicast filtering support

Broadcast filtering support

Promiscuous mode support

Configuration

Build Time Configurations for r_ether
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The following build time configurations are defined in fsp_cfg/r_ether_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.
The polarity of the link e Fall -> Rise Fall -> Rise Specify the polarity of
signal output by the e Rise -> Fall the link signal output
PHY-LSI by the PHY-LSI. When 0

is specified, link-up and
link-down correspond
respectively to the fall
and rise of the LINKSTA
signal. When 1 is
specified, link-up and
link-down correspond
respectively to the rise
and fall of the LINKSTA

signal.
The link status is ¢ Unused Unused Use LINKSTA signal for
detected by LINKSTA e Used detect link status
signal changes 0 = unused

(use PHY-LSI status
register) 1 = use (use
LINKSTA signal)

Configurations for Driver > Network > Ethernet Driver on r_ether

This module can be added to the Stacks tab via New Stack > Driver > Network > Ethernet Driver on
r_ether:

Configuration Options Default Description
General > Name Name must be a valid  g_ether0 Module name.
C symbol
General > Channel 0 0 Select the ether
channel number.
General > MAC address Must be a valid MAC 00:11:22:33:44:55 MAC address of this
address channel.
General > Zero-copy ¢ Disable Disable Enable or disable zero-
Mode e Enable copy mode.
General > Flow control e Disable Disable Enable or disable flow
functionality ¢ Enable control.
Filters > Multicast e Disable Enable Enable or disable
Mode e Enable multicast frame
reception.
Filters > Promiscuous ¢ Disable Disable Enable this option to
Mode ¢ Enable receive packets

addressed to other
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NICs.
Filters > Broadcast Must be a valid non- 0 Limit of the number of
filter negative integer with broadcast frames
maximum configurable received continuously
value of 65535.
Buffers > Number of Must be an integer 1 Number of transmit
TX buffer from 1to 8 buffers
Buffers > Number of Must be an integer 1 Number of receive
RX buffer from 1to 8 buffers
Buffers > Buffer size Must be at least 1514 1514 Size of Ethernet buffer
which is the maximum
Ethernet frame size
Interrupts > Interrupt MCU Specific Options Select the EDMAC
priority interrupt priority.
Interrupts > Callback Name must be a valid NULL Callback provided
C symbol when an ISR occurs

Interrupt Configuration

The first R_ ETHER Open function call sets EINT interrupts. The user could provide callback function
which would be invoked when EINT interrupt handler has been completed. The callback arguments
will contain information about a channel nhumber, the ETHERC and EDMAC status, the event code,
and a pointer to the user defined context.

Callback Configuration

The user could provide callback function which would be invoked when either a magic packet or a
link signal change is detected. When the callback function is called, a variable in which the channel
number for which the detection occurred and a constant shown in Table 2.4 are stored is passed as
an argument. If the value of this argument is to be used outside the callback function, its value
should be copied into, for example, a global variable.

Clock Configuration

The ETHER clock is derived from the following peripheral clock on each device.

MCU Peripheral Clock

RA6M2 PCLKA
RA6M3 PCLKA

Note
1. When using ETHERC, the PCLKA freguency isin therange 12.5 MHz <= PCLKA <= 120 MHz
2. When using ETHERC, PCLKA = ICLK.

Pin Configuration

To use the Ethernet module, input/output signals of the peripheral function have to be allocated to
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pins with the multi-function pin controller (MPC). Please perform the pin setting before calling the
R_ETHER_Open function.

Usage Notes
Ethernet Frame Format
The Ethernet module supports the Ethernet II/IEEE 802.3 frame format.

Frame Format for Data Transmission and Reception

Preamble SFD dlg'{l?ﬁgﬂ Trar:;z;;;urce Length/type Data + padding FCS
(7 bytes) (1 byte) address (6 bytes) (8 bytes) (2 bytes) (46 to 1,500 bytes) (4 bytes)

<+— Physical header —»#——— Ethemst header ——————»{¢——— Payload ———»4— Trailler —»

Hardware
processing data

Hardware

processing data —p4————  Valid software (Ethernet module) data

-—

Figure 129: Frame Format Image

The preamble and SFD signal the start of an Ethernet frame. The FCS contains the CRC of the
Ethernet frame and is calculated on the transmitting side. When data is received the CRC value of
the frame is calculated in hardware, and the Ethernet frame is discarded if the values do not match.
When the hardware determines that the data is normal, the valid range of receive data is:
(transmission destination address) + (transmission source address) + (length/type) + (data).

PAUSE Frame Format

Preamble SFD Transfer destination | Transfer source Lengthitype Operation Pause duration ) ees
7 bytes) (1 byte) Address address (0x8808) code (0~65535) Padding (4 bytes)
Y Y (01:80:C2:00:00:01) (6 bytes) ° (0x0001) - Y

4— Physical header —»4¢———— Ethemet header ———»f¢———————————— Payload ————pja— Trailer —»

Figure 130: Pause Frame Format Image

The transmission destination address is specified as 01:80:C2:00:00:01 (a multicast address
reserved for PAUSE frames). At the start of the payload the length/type is specified as 0x8808 and
the operation code as 0x0001. The pause duration in the payload is specified by the value of the
automatic PAUSE (AP) bits in the automatic PAUSE frame setting register (APR), or the manual PAUSE
time setting (MP) bits in the manual PAUSE frame setting register (MPR).

Magic Packet Frame Format

- Transfer source ; Data
Preamble SFD Transfer destination Length/type (FFFE-FF-FE-FF FF, Transfer destination Padding (4!;325)

address
(7 bytes) (1 byte) address (6 bytes) (6 bytes) (2 bytes) address < 16)

4— Physical header —m»4————— Ethemnet header ———»4¢—————————————— Payload ———p4— Trailer —»

Figure 131: Magic Packet Frame Format Image

In a Magic Packet, the value FF:FF:FF:FF:FF:FF followed by the transmission destination address
repeated 16 times is inserted somewhere in the Ethernet frame data.
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Limitations

The Ethernet Driver has several alignment constraints:

16-byte alignment for the descriptor
32-byte aligned write buffer for R_ ETHER Write when zero copy mode is enabled

Examples

ETHER Basic Example

This is a basic example of minimal use of the ETHER in an application.

Note

#def i
#def i
#def i
#def i
#def i
#def i
0x00,

ne
ne
ne
ne
ne
ne

\

0x00,

0x00,

0x00,

In this example zero-copy mode is disabled and there are no restrictions on buffer alignment.

ETHER_EXAMPLE_NAXI MUM_ETHERNET_FRAME_SI ZE (1514)
ETHER_EXAMPLE _TRANSM T_ETHERNET_FRAME_SI ZE (60)
ETHER _EXAMPLE_SOURCE_MAC _ADDRESS 0x74, 0x90, 0x50, 0x00, 0x79, 0x01

ETHER EXAMPLE_DESTI NATI ON_MAC_ADDRESS 0x74, 0x90, 0x50, 0x00, 0x79, 0x02

ETHER_EXAMPLE_FRAME_TYPE 0x00, Ox2E

ETHER EXAMPLE_PAYLCAD 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00,

0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \
0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \
0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, \

/* Receive data buffer */

static uint8_ t gp_read buffer[ ETHER EXAMPLE MAXI MUM ETHERNET FRAME SI ZE] = {0};

[* Transmit data buffer */

static uint8 t gp_send datal ETHER EXAMPLE TRANSM T_ETHERNET FRAME S| ZE] =

{
ETHER EXAMPLE DESTI NATI ON_MAC ADDRESS, /* Destinati on MAC address */
ETHER EXAMPLE_SOURCE_NMAC_ADDRESS, /* Source MAC address */
ETHER_EXAMPLE_FRAVE_TYPE, /* Type field */
ETHER_EXAMPLE_PAYLOAD /* Payl oad val ue (46byte) */

ki

voi d et her basi c_exanpl e (void)

{

fsp_err_t err = FSP_SUCCESS,;
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/*

Source MAC Address */

static uint8 t nmac_address_source[ 6] = { ETHER EXAMPLE SOURCE MAC ADDRESS};

/*

/*

do

/*
up,

/*
/*

/*

/*

uint32_t read _data _size = 0;

g_ether0 _cfg. p_nmac_address = mac_addr ess_sour ce;

pen the ether instance with initial configuration. */

err = R ETHER Open(&g ether0O_ctrl, &g ether0_cfg);

Handl e any errors. This function shoul d be defined by the user. */

handl e _error(err);

{
When the Ethernet |ink status read fromthe PHY-LSI Basic Status register is |ink-

Initializes the nodul e and nmake auto negoti ation. */

err = R ETHER Li nkProcess(&g ether0 _ctrl);
} while (FSP_SUCCESS != err);
Transm ssion i s non-bl ocking. */
User data copy to internal buffer and is transferred by DVA in the background. */
err = RETHER Wite(&gy_ether0 ctrl, (void *) gp_send data, sizeof(gp_send data));
handl e_error(err);
recei ved data copy to user buffer frominternal buffer. */
err = R ETHER Read(&g etherO_ctrl, (void *) gp_read_buffer, & ead data_size);
handl e_error(err);

Di sabl e transni ssion and recei ve function and cl ose the ether instance. */

R ETHER Cl ose(&g _etherO_ctrl);

ETHER Advanced Example

The example demonstrates using send and receive function in zero copy mode. Transmit buffers
must be 32-byte aligned and the receive buffer must be released once its contents have been used.

#defi ne ETHER EXAMPLE_FLAG ON ( 1U)

#def i ne ETHER_EXAMPLE_FLAG OFF (0U)

#defi ne ETHER EXAMPLE_ETHER | SR EE_FR MASK (1UL << 18)

#def i ne ETHER_EXAVPLE_ETHER | SR EE_TC MASK (1UL << 21)
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#def i ne ETHER EXAMPLE_ETHER | SR EC_MPD MASK (1UL << 1)
#def i ne ETHER EXAMPLE_ALI GNVENT_32_BYTE (32)

static volatile uint32_t g exanple_receive _conplete = 0;

I
=

static volatile uint32_t g exanple transfer_conpl ete

I
=

static volatile uint32_t g _exanpl e nagi c_packet done
/* The data buffer nust be 32-byte aligned when using zero copy node. */
static uint8 t gp_send data nocopy[ ETHER EXAMPLE TRANSM T _ETHERNET FRAME_SI ZE]
BSP_ALI GN_VARI ABLE(32) =

{
ETHER EXAMPLE DESTI NATI ON_MAC ADDRESS, /* Destinati on MAC address */
ETHER EXAMPLE SOURCE MAC ADDRESS, /* Source MAC address */
ETHER_EXAMPLE_FRAVE_TYPE, /* Type field */
ETHER EXAMPLE PAYLOAD /* Payl oad val ue (46byte) */
i

voi d et her _exanpl e_cal | back (ether_cal |l back_args_t * p_args) {
switch (p_args->event)
{
case ETHER EVENT | NTERRUPT:
{
i f (ETHER EXAMPLE ETHER | SR EC MPD MASK == (p_args->status_ecsr &
ETHER EXAMPLE ETHER | SR EC MPD_ MASK) )
{
g_exanpl e_magi c_packet done = ETHER EXAMPLE FLAG ON;
}
i f (ETHER EXAMPLE ETHER | SR EE TC MASK == (p_args->status_eesr &
ETHER EXAMPLE ETHER | SR EE TC NMASK) )

{
g_exanpl e_transfer_conpl ete = ETHER EXAMPLE_FLAG ON,

}
i f (ETHER _EXAMPLE ETHER | SR EE FR MASK == (p_args->status_eesr &
ETHER EXAMPLE ETHER | SR EE FR NMASK) )

{
g_exanpl e_recei ve_conpl ete = ETHER EXAVPLE _FLAG ON;
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/* Data array should not change in zero copy node until transfer conplete. */

whi | e (ETHER EXAVMPLE FLAG ON ! = g exanpl e_transfer _conpl et e)
{

}

/* Cet receive buffer fromRX descriptor. */
err = R ETHER Read(&g ether0O _ctrl, (void *) &p_read buffer nocopy,
& ead_dat a_si ze) ;
handl e_error(err);
/* Process received data here */
/* Rel ease receive buffer to RX descriptor. */
err = R ETHER BufferRel ease(&g_ether0 ctrl);
handl e _error(err);
/* Disable transm ssion and receive function and cl ose the ether instance. */

R ETHER Cl ose(&g _ether0_ctrl);

Data Structures

struct ether_instance_ctrl_t

Enumerations

enum ether_previous_link_status_t
enum ether_link_change_t
enum ether magic_packet t

enum ether_link_establish_status_t

Data Structure Documentation

¢ ether_instance_ctrl_t

struct ether _instance ctrl t

ETHER control block. DO NOT INITIALIZE. Initialization occurs when ether_api_t::open is called.

Data Fields
uint32_t open Used to determine if the
channel is configured.
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ether_cfg_t const * p_ether_cfg Pointer to initial configurations.
ether_instance_descriptor_t * p_rx_descriptor Pointer to the currently
referenced transmit descriptor.
ether_instance_descriptor_t * p_tx_descriptor Pointer to the currently
referenced receive descriptor.
void * p_reg_etherc Base register of ethernet
controller for this channel.
void * p_reg edmac Base register of EDMA
controller for this channel.
ether_previous_link status t previous_link_status Previous link status.
ether_link_change_t link_change status of link change
ether_magic_packet t magic_packet status of magic packet
detection
ether_link_establish_status t link_establish_status Current Link status.

Enumeration Type Documentation

¢ ether_previous_link_status_t

enum ether_previous_link status_t

Enumerator

ETHER_PREVIOUS_LINK_STATUS_DOWN Previous link status is down.

ETHER_PREVIOUS_LINK_STATUS_UP Previous link status is up.

¢ ether_link_change_t

enum ether_link_change_t
Enumerator
ETHER _LINK CHANGE_NO_CHANGE Link status is no change.
ETHER_LINK CHANGE_LINK DOWN Link status changes to down.
ETHER_LINK_CHANGE_LINK_UP Link status changes to up.
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¢ ether_magic_packet_t

enum ether_magic_packet t

Enumerator

ETHER_MAGIC_PACKET NOT DETECTED

Magic packet is not detected.

ETHER_MAGIC_PACKET_DETECTED

Magic packet is detected.

¢ ether_link_establish_status_t

enum ether_link_establish_status_t

Enumerator

ETHER_LINK_ESTABLISH_STATUS_DOWN

Link establish status is down.

ETHER_LINK_ESTABLISH_STATUS_UP

Link establish status is up.

Function Documentation

¢ R_ETHER Open()

fsp_err t R ETHER Open ( ether _ctrl_t *const p_ctrl, ether cfg t const *const p cfg )

Return values

After ETHERC, EDMAC and PHY-LSI are reset in software, an auto negotiation of PHY-LSI is begun.
Afterwards, the link signal change interrupt is permitted. Implements ether_api_t::open.

FSP_SUCCESS

Channel opened successfully.

FSP_ERR_ASSERTION

Pointer to ETHER control block or
configuration structure is NULL.

FSP_ERR_ALREADY OPEN

Control block has already been opened or
channel is being used by another instance.
Call close() then open() to reconfigure.

FSP_ERR_ETHER_ERROR_PHY_COMMUNICATI
ON

Initialization of PHY-LSI failed.

FSP_ERR_INVALID_CHANNEL

Invalid channel number is given.

FSP_ERR_INVALID_POINTER

Pointer to MAC address is NULL.

FSP_ERR_INVALID_ARGUMENT

Interrupt is not enabled.

FSP_ERR_ETHER_PHY_ERROR_LINK

Initialization of PHY-LSI failed.
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¢ R_ETHER_Close()

fsp_err t R_ ETHER Close ( ether ctrl_t *const p_ctrl)

Disables interrupts. Removes power and releases hardware lock. Implements ether_api_t::close.

Return values

FSP_SUCCESS Channel successfully closed.
FSP_ERR_ASSERTION Pointer to ETHER control block is NULL.
FSP_ERR_NOT_OPEN The control block has not been opened

o R_ETHER_Read()

fsp_err t R_ETHER Read ( ether_ctrl_t *const p_ctr/, void *const p_buffer, uint32_t *const
length_bytes )

Receive Ethernet frame. Receives data to the location specified by the pointer to the receive
buffer. In zero copy mode, the address of the receive buffer is returned. In non zero copy mode, the
received data in the internal buffer is copied to the pointer passed by the argument. Implements
ether_api_t::read.

Return values

FSP_SUCCESS Processing completed successfully.
FSP_ERR_ASSERTION Pointer to ETHER control block is NULL.
FSP_ERR_NOT_OPEN The control block has not been opened.
FSP_ERR_ETHER_ERROR_NO_DATA There is no data in receive buffer.
FSP_ERR_ETHER ERROR_LINK Auto-negotiation is not completed, and

reception is not enabled.

FSP_ERR_ETHER_ERROR_MAGIC_PACKET M [As a Magic Packet is being detected,

ODE transmission and reception is not enabled.
FSP_ERR_ETHER ERROR FILTERING Multicast Frame filter is enable, and
Multicast Address Frame is received.
FSP_ERR_INVALID POINTER Value of the pointer is NULL.
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¢ R_ETHER_BufferRelease()

fsp_err_ t R_ETHER BufferRelease ( ether ctrl_t *const p_ctrl)

Move to the next buffer in the circular receive buffer list. Implements ether_api_t::bufferRelease.

Return values

FSP_SUCCESS Processing completed successfully.

FSP_ERR_ASSERTION Pointer to ETHER control block is NULL.
FSP_ERR_NOT_OPEN The control block has not been opened
FSP_ERR_ETHER _ERROR_LINK Auto-negotiation is not completed, and

reception is not enabled.

FSP_ERR_ETHER_ERROR_MAGIC_PACKET M |As a Magic Packet is being detected,
ODE transmission and reception is not enabled.

# R_ETHER Write()

fsp_err t R_ETHER Write ( ether_ctrl _t *const p_ctrl, void *const p_buffer, uint32_t const
frame_length )

Transmit Ethernet frame. Transmits data from the location specified by the pointer to the transmit
buffer, with the data size equal to the specified frame length. In the non zero copy mode, transmits
data after being copied to the internal buffer. Implements ether_api_t::write.

Return values

FSP_SUCCESS Processing completed successfully.

FSP_ERR_ASSERTION Pointer to ETHER control block is NULL.
FSP_ERR_NOT_OPEN The control block has not been opened.
FSP_ERR_ETHER _ERROR_LINK Auto-negotiation is not completed, and

reception is not enabled.

FSP_ERR_ETHER ERROR_MAGIC PACKET M | As a Magic Packet is being detected,

ODE transmission and reception is not enabled.

FSP_ERR_ETHER_ERROR_TRANSMIT_BUFFER | Transmit buffer is not empty.

_FULL

FSP_ERR_INVALID_POINTER Value of the pointer is NULL.

FSP_ERR_INVALID ARGUMENT Value of the send frame size is out of range.
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¢ R_ETHER_LinkProcess()

fsp_err t R_ETHER _LinkProcess ( ether _ctrl _t *const p _ctrl)

The Link up processing, the Link down processing, and the magic packet detection processing are
executed. Implements ether_api_t::linkProcess.

Return values

FSP_SUCCESS

Link is up.

FSP_ERR_ASSERTION

Pointer to ETHER control block is NULL.

FSP_ERR_NOT OPEN

The control block has not been opened.

FSP_ERR_ETHER_ERROR_LINK

Link is down.

FSP_ERR_ETHER_ERROR_PHY_COMMUNICATI
ON

When reopening the PHY interface
initialization of the PHY-LSI failed.

FSP_ERR_ALREADY_OPEN

When reopening the PHY interface it was
already opened.

FSP_ERR_INVALID_CHANNEL

When reopening the PHY interface an
invalid channel was passed.

FSP_ERR_INVALID_POINTER

When reopening the PHY interface the MAC
address pointer was NULL.

FSP_ERR_INVALID_ARGUMENT

When reopening the PHY interface the
interrupt was not enabled.

FSP_ERR_ETHER_PHY ERROR_LINK

Initialization of the PHY-LSI failed.

¢ R_ETHER_WakeOnLANEnable()

fsp_err_ t R_ ETHER WakeOnLANEnable ( ether ctrl _t *const p_ctrl)

Return values

The setting of ETHERC is changed from normal sending and receiving mode to magic packet
detection mode. Implements ether_api_t::wakeOnLANEnable.

FSP_SUCCESS

Processing completed successfully.

FSP_ERR_ASSERTION

Pointer to ETHER control block is NULL.

FSP_ERR_NOT OPEN

The control block has not been opened.

FSP_ERR_ETHER_ERROR_LINK

Auto-negotiation is not completed, and
reception is not enabled.

FSP_ERR_ETHER_PHY_ERROR_LINK

Initialization of PHY-LSI failed.
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¢ R_ETHER_ VersionGet()

__INLINE fsp_err_t R_ETHER_VersionGet ( fsp_version_t *const p_version)

Provides APl and code version in the user provided pointer. Implements ether_api_t::versionGet.

Return values

FSP_SUCCESS Version information stored in provided
p_version.
FSP_ERR_ASSERTION p_version is NULL.

4.2.19 Ethernet PHY (r_ether_phy)

Modules
Functions

fsp_err t R_ETHER_PHY Open (ether phy ctrl t *const p_ctrl, ether phy cfg t
const *const p_cfg)
Resets Ethernet PHY device. Implements ether phy_api_t::open.
More...

fsp_err t R_ETHER_PHY_Close (ether_phy ctrl_t *const p_ctrl)
Close Ethernet PHY device. Implements ether phy api_t::close.
More...

fsp_err t R _ETHER PHY StartAutoNegotiate (ether phy ctrl t *const p_ctrl)
Starts auto-negotiate. Implements
ether_phy api_t::startAutoNegotiate. More...

fsp_err t R_ETHER_PHY_LinkPartnerAbilityGet (ether_phy_ctrl_t *const p_ctrl,
uint32_t *const p_line_speed_duplex, uint32_t *const p_local_pause,
uint32_t *const p_partner_pause)
Reports the other side's physical capability. Implements
ether_phy api_t::linkPartnerAbilityGet. More...

fsp_err t R_ETHER PHY LinkStatusGet (ether phy ctrl t *const p_ctrl)
Returns the status of the physical link. Implements
ether_phy api_t::linkStatusGet. More...
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fsp_err t R_ETHER_PHY VersionGet (fsp_version_t *const p_version)

Provides APl and code version in the user provided pointer.
Implements ether_phy_api_t::versionGet. More...

Detailed Description

The Ethernet PHY module (r_ether_phy) provides an API for standard Ethernet PHY communications
applications that use the ETHERC peripheral. It implements the Ethernet PHY Interface.

Overview

The Ethernet PHY module is used to setup and manage an external Ethernet PHY device for use with
the on-chip Ethernet Controller (ETHERC) peripheral. It performs auto-negotiation to determine the
optimal connection parameters between link partners. Once initialized the connection between the
external PHY and the onboard controller is automatically managed in hardware.
Features
The Ethernet PHY module supports the following features:

¢ Auto negotiation support

e Flow control support
e Link status check support

Configuration

Build Time Configurations for r_ether_phy

The following build time configurations are defined in fsp_cfg/r_ether _phy cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
e Disabled included in the build.
Select PHY e Default Default Select PHY chip to use.
e Other Selecting 'Default’ will
e KSZ8091RNB automatically choose
e KSZ8041 the correct option
e DP83620 when using a Renesas
development board.
Use Reference Clock e Default Enabled Select whether to use
e Enabled the RMII reference
e Disabled clock. Selecting
'‘Default' will
automatically choose
the correct option
when using a Renesas
development board.
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Configurations for Driver > Network > Ethernet Driver on r_ether_phy

This module can be added to the Stacks tab via New Stack > Driver > Network > Ethernet Driver on
r_ether_phy:

Configuration Options Default Description
Name Name must be a valid  g_ether_phy0 Module name.
C symbol
Channel e 0 0 Select the Ethernet
o1 controller channel
number.
PHY-LSI Address Specify a value 0 Specify the address of
between 0 and 31. the PHY-LSI used.
PHY-LSI Reset Specify a value 0x00020000 Specify the number of
Completion Timeout between 1 and times to read the PHY-
OXFFFFFFFF. LSI control register

while waiting for reset
completion. This value
should be adjusted
experimentally based
on the PHY-LSI used.

MII/RMII Register Specify a value 8 Specify the bit timing
Access Wait-time between 1 and for MII/RMII register
OX7FFFFFFF. accesses during PHY

initialization. This value
should be adjusted
experimentally based
on the PHY-LSI used.

Flow Control e Disable Disable Select whether to
e Enable enable or disable flow
control.

Usage Notes

Note
See the example below for details on how to initialize the Ethernet PHY module.

Limitations
e The r_ether_phy module may need to be customized for PHY devices other than the ones

currently supported (KSZ8091RNB, KSZ8041 and DP83620). Use the existing code as a
starting point for creating a custom implementation.

Examples
ETHER PHY Basic Example

This is a basic example of minimal use of the ETHER PHY in an application.
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voi d et her _phy basi c_exanpl e (voi d)

{

fsp_err_t err = FSP_SUCCESS;

/*

/*

/*

/*

whi

/*

/*

/*

g_ether _phyO _ctrl . open oy,

g_et her _phy0_cf g. channel

I
=

Initializes the nodule. */

err = R ETHER PHY_Open(&g_et her _phyO_ctrl, &g_ether_phyO_cfq);
Handl e any errors. This function should be defined by the user. */
handl e_error(err);

Start auto negotiation. */

err = R ETHER PHY_St art Aut oNegoti at e(&g et her _phy0 ctrl);

handl e_error(err);

Polling until link is established. */

|l e (FSP_SUCCESS ! = R ETHER PHY Li nkStatusGet (&g et her _phyO ctrl))
{

Do not hing */

}

Get link partner ability fromphy interface. */

err = R ETHER PHY_Li nkPartner AbilityGet (&g et her phyO0 ctrl,
&g et her phyO |ine_speed dupl ex,
&g_et her _phyO_| ocal _pause,
&g et her phyO _partner pause);
handl e _error(err);
Check current |ink status. */
err = R ETHER PHY_Li nkSt at usGet (&g _et her _phy0 ctrl);

handl e _error(err);

Data Structures

struct ether_phy instance_ctrl _t

Data Structure Documentation

¢ ether_phy_instance_ctrl_t

struct ether_phy instance_ctrl t

R11UMO0146EU0120 Revision 1.20 RENESAS

Jun.26.20

Page 400/ 1,560



Flexible Software Package User’s Manual

API Reference > Modules > Ethernet PHY (r_ether_phy)

ETHER PHY control block. DO NOT INITIALIZE. Initialization occurs when ether_phy api_t::open is
called.
Data Fields
uint32_t open Used to determine if the
channel is configured.
ether_phy cfg t const * p_ether phy cfg Pointer to initial configurations.
volatile uint32_t * p_reg_pir Pointer to ETHERC peripheral
registers.
uint32_t local_advertise Capabilities bitmap for local
advertising.

Function Documentation

& R_ETHER_PHY Open()

fsp_err t R_ETHER_PHY_Open ( ether_phy_ctrl_t *const p_ctrl, ether_phy cfg t const *const p_cfg
)

Resets Ethernet PHY device. Implements ether phy_api_t::open.

Return values

FSP_SUCCESS Channel opened successfully.

FSP_ERR_ASSERTION Pointer to ETHER_PHY control block or
configuration structure is NULL.

FSP_ERR_ALREADY_OPEN Control block has already been opened or

channel is being used by another instance.
Call close() then open() to reconfigure.

FSP_ERR_INVALID CHANNEL Invalid channel number is given.
FSP_ERR_INVALID_POINTER Pointer to p_cfg is NULL.
FSP_ERR_TIMEOUT PHY-LSI Reset wait timeout.

¢ R_ETHER_PHY Close()

fsp_err t R_ ETHER PHY Close ( ether_phy ctrl_t *const p_ctrl)

Close Ethernet PHY device. Implements ether_phy_api_t::close.

Return values

FSP_SUCCESS Channel successfully closed.

FSP_ERR_ASSERTION Pointer to ETHER_PHY control block is NULL.

FSP_ERR_NOT_OPEN The control block has not been opened
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¢ R_ETHER_PHY_StartAutoNegotiate()

fsp_err t R_ETHER _PHY_StartAutoNegotiate ( ether phy ctrl _t *const p ctr/)

Starts auto-negotiate. Implements ether_phy api_t::startAutoNegotiate.

Return values

FSP_SUCCESS ETHER_PHY successfully starts auto-
negotiate.

FSP_ERR_ASSERTION Pointer to ETHER_PHY control block is NULL.

FSP_ERR_NOT_OPEN The control block has not been opened

¢ R_ETHER_PHY_LinkPartnerAbilityGet()

fsp_err_t R_ETHER_PHY_LinkPartnerAbilityGet ( ether_phy_ctrl_t *const p_ctrl, uint32_t *const
p_line_speed _duplex, uint32_t *const p local pause, uint32_t *const p_partner pause )

Reports the other side's physical capability. Implements ether_phy api_t::linkPartnerAbilityGet.

Return values

FSP_SUCCESS ETHER_PHY successfully get link partner
ability.

FSP_ERR_ASSERTION Pointer to ETHER _PHY control block is NULL.

FSP_ERR_INVALID POINTER Pointer to arguments are NULL.

FSP_ERR_NOT_OPEN The control block has not been opened

FSP_ERR_ETHER_PHY_ERROR_LINK PHY-LSI is not link up.

FSP_ERR_ETHER_PHY_NOT_READY The auto-negotiation isn't completed

# R_ETHER_PHY_LinkStatusGet()

fsp_err_t R_ETHER_PHY_LinkStatusGet ( ether_phy ctrl_t *const p_ctr/)

Returns the status of the physical link. Implements ether_phy api_t::linkStatusGet.

Return values

FSP_SUCCESS ETHER_PHY successfully get link partner
ability.
FSP_ERR_ASSERTION Pointer to ETHER _PHY control block is NULL.
FSP_ERR_NOT_OPEN The control block has not been opened
FSP_ERR_ETHER_PHY_ERROR_LINK PHY-LSI is not link up.
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¢ R_ETHER_PHY_VersionGet()

__INLINE fsp_err_t R_ETHER_PHY_VersionGet ( fsp_version_t *const p_version)

Provides APl and code version in the user provided pointer. Implements
ether _phy api_t::versionGet.

Parameters

[in] p_version Version number set here

Return values

FSP_SUCCESS Version information stored in provided
p_version.
FSP_ERR_ASSERTION p_version is NULL.

4.2.20 High-Performance Flash Driver (r_flash_hp)

Modules
Functions

fsp_err t R _FLASH HP_Open (flash_ctrl_t *const p_api_ctrl, flash_cfg _t const
*const p_cfg)

fsp_err_ t R_FLASH_HP_Write (flash_ctrl_t *const p_api_ctrl, uint32_t const
src_address, uint32_t flash_address, uint32_t const num_bytes)

fsp_err t R_FLASH_HP_Erase (flash_ctrl_t *const p_api_ctrl, uint32_t const
address, uint32_t const num_blocks)

fsp_err t R_FLASH_HP_BlankCheck (flash_ctrl_t *const p_api_ctrl, uint32_t
const address, uint32_t num_bytes, flash_result t
*blank_check_result)

fsp_err t R_FLASH_HP_Close (flash_ctrl_t *const p_api_ctrl)

fsp_err t R _FLASH HP_StatusGet (flash_ctrl_t *const p_api_ctrl, flash_status t
*const p_status)

fsp_err t R _FLASH HP_AccessWindowSet (flash_ctrl_t *const p_api_ctrl,
uint32_t const start_addr, uint32_t const end_addr)

fsp_err t R _FLASH HP_AccessWindowClear (flash_ctrl_t *const p_api_ctrl)

fsp_err t R_FLASH HP IdCodeSet (flash_ctrl_t *const p_api_ctrl, uint8 t const
*const p_id_code, flash_id_code_mode_t mode)
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fsp_err t R _FLASH HP_Reset (flash_ctrl _t *const p_api_ctrl)
fsp_err t R_FLASH_HP_ UpdateFlashClockFreq (flash_ctrl_t *const p_api_ctrl)

fsp_err t R_FLASH_HP_StartUpAreaSelect (flash_ctrl_t *const p_api_ctrl,
flash_startup_area_swap_t swap_type, bool is_temporary)

fsp_err t R_FLASH HP VersionGet (fsp_version_t *const p_version)

fsp_err t R _FLASH HP_InfoGet (flash_ctrl_t *const p_api_ctrl, flash_info t
*const p_info)

Detailed Description

Driver for the flash memory on RA high-performance MCUs. This module implements the Flash
Interface.

Overview

The Flash HAL module APIs allow an application to write, erase and blank check both the data and
ROM flash areas that reside within the MCU. The amount of flash memory available varies across
MCU parts.

Features
The R_FLASH_HP module has the following key features:

Blocking and non-blocking erasing, writing and blank-checking of data flash.

Blocking erasing, writing and blank-checking of code flash.

Callback functions for completion of non-blocking data flash operations.

Access window (write protection) for ROM Flash, allowing only specified areas of code flash
to be erased or written.

e Boot block-swapping.

¢ ID code programming support.

Configuration

Build Time Configurations for r_flash_hp

The following build time configurations are defined in fsp_cfg/r_flash_hp_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.
Code Flash e Enabled Disabled Controls whether or not
Programming Enable e Disabled code-flash

programming is
enabled. Disabling
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reduces the amount of
ROM and RAM used by

the API.
Data Flash e Enabled Enabled Controls whether or not
Programming Enable e Disabled data-flash

programming is
enabled. Disabling
reduces the amount of
ROM used by the API.

Configurations for Driver > Storage > Flash Driver on r_flash_hp

This module can be added to the Stacks tab via New Stack > Driver > Storage > Flash Driver on
r flash_hp:

Configuration Options Default Description
Name Name must be a valid  g_flashO Module name.
C symbol
Data Flash Background e Enabled Enabled Enabling allows Flash
Operation ¢ Disabled API calls that reference

data-flash to return
immediately, with the
operation continuing in
the background.

Callback Name must be a valid  NULL A user callback
C symbol function can be
specified. Callback
function called when a
dataflash BGO
operation completes or

errors.
Flash Ready Interrupt MCU Specific Options Select the flash ready
Priority interrupt priority.
Flash Error Interrupt MCU Specific Options Select the flash error
Priority interrupt priority.

Clock Configuration

Flash uses FCLK as the clock source depending on the MCU. When writing and erasing the clock
source must be at least 4 MHz.

Pin Configuration

This module does not use I/O pins.

Usage Notes

Warning
It is highly recommended that the developer reviews sections 5 and 6 of the Flash Memory
section of the target MCUs Hardware User’s Manual prior to using the r_flash_hp module. In
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particular, understanding ID Code and Access Window functionality can help avoid
unrecoverable flash scenarios.

Data Flash Background Operation (BGO) Precautions

When using the data flash BGO (Background Operation) mode, you can still access the user ROM,
RAM and external memory. You must ensure that the data flash is not accessed during a data flash
operation. This includes interrupts that may access the data flash.

Code Flash Precautions

Code flash cannot be accessed while writing, erasing or blank checking code flash. Code flash cannot
be accessed while modifying the access window, selecting the startup area or setting the ID code. In
order to support modifying code flash all supporting code must reside in RAM. This is only done when
code flash programming is enabled. BGO mode is not supported for code flash, so a code flash
operation will not return before the operation has completed. By default, the vector table resides in
the code flash. If an interrupt occurs during the code flash operation, then code flash will be
accessed to fetch the interrupt's starting address and an error will occur. The simplest work-around
is to disable interrupts during code flash operations. Another option is to copy the vector table to
RAM, update the VTOR (Vector Table Offset Register) accordingly and ensure that any interrupt
service routines execute out of RAM. Similarly, you must insure that if in a multi-threaded
environment, threads running from code flash cannot become active while a code flash operation is
in progress.

Flash Clock (FCLK)

The flash clock source is the clock used by the Flash peripheral in performing all Flash operations. As
part of the flash_api_t::open function the Flash clock source is checked will return FSP_ERR_FCLK if it
is invalid. Once the Flash APl has been opened, if the flash clock source frequency is changed, the
flash_api_t::updateFlashClockFreq API function must be called to inform the API of the change.
Failure to do so could result in flash operation failures and possibly damage the part.

Interrupts

Enable the flash ready interrupt only if you plan to use the data flash BGO. In this mode, the
application can initiate a data flash operation and then be asynchronously notified of its completion,
or an error, using a user supplied-callback function. The callback function is passed a structure
containing event information that indicates the source of the callback event (for example,
flash_api_t::FLASH_EVENT_ERASE_COMPLETE) When the FLASH FRDYI interrupt is enabled, the
corresponding ISR will be defined in the flash driver. The ISR will call a user-callback function if one
was registered with the flash_api_t::open API.

Note
The Flash HP supports an additional flash-error interrupt and if the BGO mode is enabled for the FLASH HP then
both the Flash Ready Interrupt and Flash Error Interrupts must be enabled (assigned a priority).

Limitations

e Write operations must be aligned on page boundaries and must be a multiple of the page
boundary size.

e Erase operations will erase the entire block the provided address resides in.

e Data flash is better suited for storing data as it can be erased and written to while code is
still executing from code flash. Data flash is also guaranteed for a larger number of
reprogramming/erasure cycles than code flash.

e Read values of erased data flash blocks are not guaranteed to be OxFF. Blank check should
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be used to determine if memory has been erased but not yet programmed.

Examples
High-Performance Flash Basic Example

This is a basic example of erasing and writing to data flash and code flash.

#defi ne FLASH DF BLOCK 0 0x40100000U /* 64 B: 0x40100000 - 0x4010003F */
#defi ne FLASH CF_BLOCK_8 0x00010000 /* 32 KB: 0x00010000 - Ox00017FFF */
#def i ne FLASH DATA BLOCK_SI ZE (1024)
#defi ne FLASH HP_EXAMPLE WRI TE_SI ZE 32
uint8 t g_dest [ TRANSFER LENGTH] ;
uint8 t g_src[ TRANSFER _LENGTH] ;
flash result t blank check result;
void r_flash_hp_basi c_exanpl e (void)
{
/[* Initialize p_src to known data */
for (uint32_t i = 0; i < TRANSFER LENGTH; i ++)
{
g_src[i] = (uint8_t) (‘A + (i %26));
}
/* Open the flash hp instance. */
fsp_err t err = R FLASH HP Open(&g flash_ctrl, &g flash cfqg);
handl e_error(err);
/* Erase 1 block of data flash starting at block 0. */
err = R FLASH HP _Erase(&g_flash ctrl, FLASH DF BLOCK 0, 1);
handl e_error(err);
[* Check if block O is erased. */
err = R FLASH HP Bl ankCheck(&g_flash ctrl, FLASH DF BLOCK O,
FLASH DATA BLOCK_SI ZE, &bl ank_check_result);
handl e_error(err);
/* Verify the previously erased area is blank */

i f (FLASH RESULT_NOT_BLANK == bl ank_check_result)

{
handl e_error ( FSP_ERR BLANK CHECK FAl LED);
}
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High-Performance Flash Advanced Example

This example demonstrates using BGO to do non-blocking operations on the data flash.
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Data Structures

struct flash_hp_instance_ctrl_t

Enumerations

enum flash_bgo_operation _t

Data Structure Documentation
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¢ flash_hp_instance_ctrl_t

struct flash_hp_instance_ctrl_t

Flash HP instance control block. DO NOT INITIALIZE.

Data Fields

uint32_t opened

To check whether api has been opened or not.

flash_cfg_t const * p_cfg

User Callback function.

flash_bgo _operation_t current operation

Operation in progress, for example, FLASH _OPERATION_CF_ERASE.

Enumeration Type Documentation

¢ flash_bgo_operation_t

enum flash_bgo_operation_t

Possible Flash operation states

Function Documentation
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& R_FLASH_HP _Open()

fsp_err t R_FLASH HP_Open ( flash_ctrl_t *const p_api _ctrl, flash_cfg_t const *const p cfg )

Initializes the high performance flash peripheral. Implements flash_api_t::open.
The Open function initializes the Flash.

Example:

/* Open the flash hp instance. */

fsp_err_t err = R FLASH HP_Open(&g_flash_ctrl, &g_flash_cfqg);

Return values

FSP_SUCCESS Initialization was successful and timer has
started.

FSP_ERR_ALREADY_OPEN The flash control block is already open.

FSP_ERR_ASSERTION NULL provided for p_ctrl or p_cfg.

FSP_ERR_IRQ_BSP _DISABLED Caller is requesting BGO but the Flash
interrupts are not enabled.

FSP_ERR_FCLK FCLK must be a minimum of 4 MHz for Flash
operations.
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¢ R_FLASH_HP_Write()

fsp_err t R_FLASH HP_Write ( flash_ctrl_t *const p_api ctrl, uint32_t const src_address, uint32_t
flash_address, uint32_t const num_bytes )

Writes to the specified Code or Data Flash memory area. Implements flash_api_t::write.
Example:
/* Wite 32 bytes to the first block of data flash. */

err = R FLASH HP Wite(&g flash ctrl, (uint32_t) g src, FLASH DF BLOCK O,
FLASH HP_EXAMPLE_V\RI TE_SI ZE) ;

Return values

FSP_SUCCESS Operation successful. If BGO is enabled this
means the operation was started
successfully.

FSP_ERR_IN_USE The Flash peripheral is busy with a prior on-
going transaction.

FSP_ERR_NOT_OPEN The Flash API is not Open.

FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result

of attempting to Write an area that is
protected by an Access Window.

FSP_ERR_WRITE_FAILED Status is indicating a Programming error for
the requested operation. This may be
returned if the requested Flash area is not

blank.

FSP_ERR_TIMEOUT Timed out waiting for FCU operation to
complete.

FSP_ERR_INVALID SIZE Number of bytes provided was not a

multiple of the programming size or
exceeded the maximum range.

FSP_ERR_INVALID ADDRESS Invalid address was input or address not on
programming boundary.
FSP_ERR_ASSERTION NULL provided for p_ctrl.
FSP_ERR_PE_FAILURE Failed to enter or exit P/E mode.
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¢ R_FLASH_HP_Erase()

fsp_err t R_FLASH HP Erase ( flash_ctrl _t *const p_api ctrl, uint32_t const address, uint32_t const
num_blocks )

Erases the specified Code or Data Flash blocks. Implements flash_api_t::erase by the
block _erase_address.

Note
Code flash may contain blocks of different sizes. When erasing code flash it isimportant to take thisinto
consideration to prevent erasing a larger address space than desired.

Example:

/* Erase 1 block of data flash starting at block 0. */

err = R FLASH HP_Erase(&g_flash_ctrl, FLASH DF BLOCK 0, 1);

Return values

FSP_SUCCESS Successful open.
FSP_ERR_INVALID_BLOCKS Invalid number of blocks specified
FSP_ERR_INVALID ADDRESS Invalid address specified. If the address is in

code flash then code flash programming
must be enabled.

FSP_ERR_IN_USE Other flash operation in progress, or API not
initialized
FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result

of attempting to Erase an area that is
protected by an Access Window.

FSP_ERR_ASSERTION NULL provided for p_ctrl
FSP_ERR_NOT_OPEN The Flash API is not Open.
FSP_ERR_ERASE _FAILED Status is indicating a Erase error.
FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.
FSP_ERR_PE_FAILURE Failed to enter or exit P/E mode.
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¢ R_FLASH_HP_BlankCheck()

fsp_err t R_FLASH HP BlankCheck ( flash_ctrl_t *const p_api ctrl, uint32_t const address, uint32 t
num_bytes, flash_result t * p blank check result )

Performs a blank check on the specified address area. Implements flash_api_t::blankCheck.
Example:
[* Check if block O is erased. */
err = R FLASH HP Bl ankCheck(&g_flash ctrl, FLASH DF BLOCK O,
FLASH DATA BLOCK_SI ZE, &bl ank_check_result);

handl e_error(err);

Return values

FSP_SUCCESS Blank check operation completed with result
in p_blank_check_result, or blank check
started and in-progess (BGO mode).

FSP_ERR_INVALID ADDRESS Invalid data flash address was input.

FSP_ERR_INVALID SIZE 'num_bytes' was either too large or not
aligned for the CF/DF boundary size.

FSP_ERR_IN_USE Other flash operation in progress or APl not
initialized.

FSP_ERR_ASSERTION NULL provided for p_ctrl.

FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result

of attempting to Erase an area that is
protected by an Access Window.

FSP_ERR_NOT _OPEN The Flash API is not Open.
FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.
FSP_ERR_PE_FAILURE Failed to enter or exit P/E mode.
FSP_ERR_BLANK CHECK FAILED Blank check operation failed.
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¢ R_FLASH_HP_Close()

fsp_err t R_FLASH HP_Close ( flash_ctrl_t *const p_api ctrl)

Releases any resources that were allocated by the Open() or any subsequent Flash operations.
Implements flash_api_t::close.

Return values
FSP_SUCCESS

Successful close.

FSP_ERR_NOT_OPEN The control block is not open.

FSP_ERR_ASSERTION NULL provided for p_ctrl or p_cfg.

¢ R_FLASH_HP_StatusGet()

fsp_err_t R_FLASH_HP_StatusGet ( flash_ctrl_t *const p_api_ctrl, flash_status_t *const p_status )

Query the FLASH peripheral for its status. Implements flash_api_t::statusGet.
Example:

flash_status t status;

/* Wait until the current flash operation conpletes. */
do

err = R FLASH HP_Stat usGet (& flash_ctrl, &status);

} while ((FSP_SUCCESS == err) && (FLASH STATUS BUSY == status));

Return values
FSP_SUCCESS

FLASH peripheral is ready to use.

FSP_ERR_ASSERTION NULL provided for p_ctrl.

FSP_ERR_NOT OPEN

The Flash API is not Open.
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¢ R_FLASH_HP_AccessWindowSet()

fsp_err t R_FLASH HP_AccessWindowSet ( flash_ctrl_t *const p_api ctrl, uint32_t const start addr,
uint32_t const end_addr )

Configure an access window for the Code Flash memory using the provided start and end address.
An access window defines a contiguous area in Code Flash for which programming/erase is
enabled. This area is on block boundaries. The block containing start_addr is the first block. The
block containing end_addr is the last block. The access window then becomes first block -> last
block inclusive. Anything outside this range of Code Flash is then write protected.

Note
If the start address and end address are set to the same value, then the access window is effectively removed. This
accomplishes the same functionality asR FLASH _HP_AccessWindowClear().

Implements flash_api_t::accessWindowSet.

Return values

FSP_SUCCESS Access window successfully configured.

FSP_ERR_INVALID_ADDRESS Invalid settings for start_addr and/or
end_addr.

FSP_ERR_IN_USE FLASH peripheral is busy with a prior
operation.

FSP_ERR_ASSERTION NULL provided for p_ctrl.

FSP_ERR_UNSUPPORTED Code Flash Programming is not enabled.

FSP_ERR_NOT _OPEN Flash API has not yet been opened.

FSP_ERR_PE_FAILURE Failed to enter or exit Code Flash P/E mode.

FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.

FSP_ERR_WRITE_FAILED Status is indicating a Programming error for
the requested operation.

FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result
of having received an illegal command.
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4 R_FLASH_HP_AccessWindowClear()

fsp_err t R_FLASH HP_AccessWindowClear ( flash_ctrl _t *const p_api ctrl)

Remove any access window that is currently configured in the Code Flash. Subsequent to this call
all Code Flash is writable. Implements flash_api_t::accessWindowClear.

Return values

FSP_SUCCESS Access window successfully removed.

FSP_ERR_IN_USE FLASH peripheral is busy with a prior
operation.

FSP_ERR_ASSERTION NULL provided for p_ctrl.

FSP_ERR_UNSUPPORTED Code Flash Programming is not enabled.

FSP_ERR_NOT_OPEN Flash APl has not yet been opened.

FSP_ERR_PE_FAILURE Failed to enter or exit Code Flash P/E mode.

FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.

FSP_ERR_WRITE_FAILED Status is indicating a Programming error for
the requested operation.

FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result
of having received an illegal command.
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¢ R_FLASH_HP_IdCodeSet()

fsp_err t R_FLASH HP_IdCodeSet ( flash_ctrl _t *const p_api ctrl, uint8_t const *const p_id code,
flash_id code _mode t mode )
Implements flash_api_t::idCodeSet.
Return values
FSP_SUCCESS ID Code successfully configured.
FSP_ERR_IN_USE FLASH peripheral is busy with a prior
operation.
FSP_ERR_ASSERTION NULL provided for p_ctrl.
FSP_ERR_UNSUPPORTED Code Flash Programming is not enabled.
FSP_ERR_NOT_OPEN Flash APl has not yet been opened.
FSP_ERR_PE_FAILURE Failed to enter or exit Code Flash P/E mode.
FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.
FSP_ERR_WRITE_FAILED Status is indicating a Programming error for
the requested operation.
FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result
of having received an illegal command.

# R_FLASH_HP_Reset()

fsp_err_ t R_FLASH_HP_Reset ( flash_ctrl_t *const p_api_ctrl)

Reset the FLASH peripheral. Implements flash_api_t::reset.

No attempt is made to check if the flash is busy before executing the reset since the assumption is
that a reset will terminate any existing operation.

Return values

FSP_SUCCESS Flash circuit successfully reset.

FSP_ERR_ASSERTION NULL provided for p_ctrl.

FSP_ERR_NOT _OPEN The control block is not open.

FSP_ERR_PE_FAILURE Failed to enter or exit P/E mode.

FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.

FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result
of having received an illegal command.
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¢ R_FLASH_HP_UpdateFlashClockFreq()

fsp_err_ t R_FLASH HP_UpdateFlashClockFreq ( flash_ctrl _t *const p_api ctrl)

Indicate to the already open Flash API that the FCLK has changed. Implements
flash_api_t::updateFlashClockFreq.

This could be the case if the application has changed the system clock, and therefore the FCLK.

Failure to call this function subsequent to changing the FCLK could result in damage to the flash
macro.

Return values

FSP_SUCCESS Start-up area successfully toggled.
FSP_ERR_IN_USE Flash is busy with an on-going operation.
FSP_ERR_ASSERTION NULL provided for p_ctrl
FSP_ERR_NOT_OPEN Flash APl has not yet been opened.
FSP_ERR_FCLK FCLK is not within the acceptable range.
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¢ R_FLASH_HP_StartUpAreaSelect()

fsp_err t R_FLASH HP_StartUpAreaSelect ( flash_ctrl t *const p_api ctrl, flash_startup_area swap_t
swap_type, bool is temporary )

Selects which block, Default (Block 0) or Alternate (Block 1), is used as the startup area block. The
provided parameters determine which block will become the active startup block and whether that
action will be immediate (but temporary), or permanent subsequent to the next reset. Doing a
temporary switch might appear to have limited usefulness. If there is an access window in place
such that Block 0 is write protected, then one could do a temporary switch, update the block and
switch them back without having to touch the access window. Implements
flash_api_t::startupAreaSelect.

Return values

FSP_SUCCESS Start-up area successfully toggled.

FSP_ERR_IN_USE FLASH peripheral is busy with a prior
operation.

FSP_ERR_ASSERTION NULL provided for p_ctrl.

FSP_ERR_NOT_OPEN The control block is not open.

FSP_ERR_UNSUPPORTED Code Flash Programming is not enabled.

FSP_ERR_PE_FAILURE Failed to enter or exit Code Flash P/E mode.

FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.

FSP_ERR_WRITE_FAILED Status is indicating a Programming error for
the requested operation.

FSP_ERR_CMD_LOCKED FCU is in locked state, typically as a result
of having received an illegal command.

4 R_FLASH_HP_VersionGet()

fsp_err t R_FLASH HP VersionGet ( fsp_version_t *const p_version)

This function gets FLASH HAL driver version

Return values

FSP_SUCCESS Operation performed successfully
FSP_ERR_ASSERTION Null pointer
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& R_FLASH_HP_InfoGet()

fsp_err t R_FLASH HP_InfoGet ( flash_ctrl_t *const p_api_ctrl, flash_info_t *const p_info )

Returns the information about the flash regions. Implements flash_api_t::infoGet.

Return values

FSP_SUCCESS Successful retrieved the request
information.

FSP_ERR_NOT_OPEN The control block is not open.

FSP_ERR_ASSERTION NULL provided for p_ctrl or p_info.

4.2.21 Low-Power Flash Driver (r_flash_Ip)

Modules
Functions

fsp_err t R_FLASH_LP Open (flash_ctrl_t *const p_api_ctrl, flash_cfg_t const
*const p_cfg)

fsp_err t R_FLASH_LP_ Write (flash_ctrl_t *const p_api_ctrl, uint32_t const
src_address, uint32_t flash_address, uint32_t const num_bytes)

fsp_err t R_FLASH_LP Erase (flash_ctrl_t *const p_api_ctrl, uint32_t const
address, uint32_t const num_blocks)

fsp_err t R_FLASH_LP BlankCheck (flash_ctrl_t *const p_api_ctrl, uint32_t
const address, uint32_t num_bytes, flash_result t
*blank_check_result)

fsp_err t R _FLASH LP Close (flash_ctrl t *const p_api_ctrl)

fsp_err t R _FLASH LP_StatusGet (flash_ctrl t *const p_api_ctrl, flash_status_t
*const p_status)

fsp_err t R_FLASH LP_AccessWindowSet (flash_ctrl _t *const p_api_ctrl,
uint32_t const start_addr, uint32_t const end_addr)

fsp_err t R_FLASH LP AccessWindowClear (flash_ctrl_t *const p_api_ctrl)

fsp_err t R_FLASH LP IdCodeSet (flash_ctrl_t *const p_api_ctrl, uint8_t const
*const p_id_code, flash_id_code_mode_t mode)

fsp_err t R _FLASH LP Reset (flash_ctrl _t *const p_api_ctrl)
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fsp_err t R_FLASH LP StartUpAreaSelect (flash_ctrl_t *const p_api_ctrl,
flash_startup_area_swap_t swap_type, bool is_temporary)

fsp_err t R_FLASH_LP UpdateFlashClockFreq (flash_ctrl_t *const p_api_ctrl)
fsp_err t R _FLASH LP VersionGet (fsp_version_t *const p_version)

fsp_err_ t R_FLASH_LP_InfoGet (flash_ctrl_t *const p_api_ctrl, flash_info_t *const
p_info)

Detailed Description

Driver for the flash memory on RA low-power MCUs. This module implements the Flash Interface.

Overview

The Flash HAL module APIs allow an application to write, erase and blank check both the data and
code flash areas that reside within the MCU. The amount of flash memory available varies across
MCU parts.

Features
The Low-Power Flash HAL module has the following key features:

Blocking and non-blocking erasing, writing and blank-checking of data flash.

Blocking erasing, writing and blank checking of code flash.

Callback functions for completion of non-blocking data flash operations.

Access window (write protection) for code flash, allowing only specified areas of code flash
to be erased or written.

* Boot block-swapping.

e ID code programming support.

Configuration

Build Time Configurations for r_flash_Ip

The following build time configurations are defined in fsp_cfg/r_flash_Ip_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected code for
¢ Enabled parameter checking is
* Disabled included in the build.
Code Flash e Enabled Disabled Controls whether or not
Programming e Disabled code-flash

programming is
enabled. Disabling
reduces the amount of
ROM and RAM used by
the API.
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Data Flash ¢ Enabled Enabled Controls whether or not

Programming ¢ Disabled data-flash
programming is
enabled. Disabling
reduces the amount of
ROM used by the API.

Configurations for Driver > Storage > Flash Driver on r_flash_Ip

This module can be added to the Stacks tab via New Stack > Driver > Storage > Flash Driver on
r_flash_lIp:

Configuration Options Default Description
Name Name must be a valid g flashO Module name.
C symbol
Data Flash Background e Enabled Enabled Enabling allows Flash
Operation e Disabled API calls that reference

data-flash to return
immediately, with the
operation continuing in
the background.

Callback Name must be a valid NULL A user callback
C symbol function can be
specified. Callback
function called when a
dataflash BGO
operation completes or

errors.
Flash Ready Interrupt MCU Specific Options Select the flash ready
Priority interrupt priority.

Clock Configuration

Flash either uses FCLK or ICLK as the clock source depending on the MCU. When writing and erasing
the clock source must be at least 4 MHz.

Pin Configuration

This module does not use I/O pins.

Usage Notes

Warning
It is highly recommended that the developer reviews sections 5 and 6 of the Flash Memory
section of the target MCUs Hardware User’s Manual prior to using the r_flash_Ip module. In
particular, understanding ID Code and Access Window functionality can help avoid
unrecoverable flash scenarios.

Data Flash Background Operation (BGO) Precautions

When using the data flash BGO, the code flash, RAM and external memory can still be accessed. You
must ensure that the data flash is not accessed during a data flash operation. This includes
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interrupts that may access the data flash.
Code Flash Precautions

Code flash cannot be accessed while writing, erasing or blank checking code flash. Code flash cannot
be accessed while modifying the access window, selecting the startup area or setting the ID code. In
order to support modifying code flash all supporting code must reside in RAM. This is only done when
code flash programming is enabled. BGO mode is not supported for code flash, so a code flash
operation will not return before the operation has completed. By default, the vector table resides in
the code flash. If an interrupt occurs during the code flash operation, then code flash will be
accessed to fetch the interrupt's starting address and an error will occur. The simplest work-around
is to disable interrupts during code flash operations. Another option is to copy the vector table to
RAM, update the VTOR (Vector Table Offset Register) accordingly and ensure that any interrupt
service routines execute out of RAM. Similarly, you must insure that if in a multi-threaded
environment, threads running from code flash cannot become active while a code flash operation is
in progress.

Flash Clock Source

The flash clock source is the clock used by the Flash peripheral in performing all Flash operations. As
part of the flash_api_t::open function the Flash clock source is checked will return FSP_ERR_FCLK if it
is invalid. Once the Flash APl has been opened, if the flash clock source frequency is changed, the
flash_api_t::updateFlashClockFreq API function must be called to inform the API of the change.
Failure to do so could result in flash operation failures and possibly damage the part.

Interrupts

Enable the flash ready interrupt only if you plan to use the data flash BGO. In this mode, the
application can initiate a data flash operation and then be asynchronously notified of its completion,
or an error, using a user supplied-callback function. The callback function is passed a structure
containing event information that indicates the source of the callback event (for example,
flash_api_t::FLASH_EVENT_ERASE_COMPLETE) When the FLASH FRDYI interrupt is enabled, the
corresponding ISR will be defined in the flash driver. The ISR will call a user-callback function if one
was registered with the flash_api_t::open API.

Note
The Flash HP supports an additional flash-error interrupt and if the BGO mode is enabled for the FLASH HP then
both the Flash Ready Interrupt and Flash Error Interrupts must be enabled (assigned a priority).

Limitations

e Write operations must be aligned on page boundaries and must be a multiple of the page
boundary size.

e Erase operations will erase the entire block the provided address resides in.

e Data flash is better suited for storing data as it can be erased and written to while code is
still executing from code flash. Data flash is also guaranteed for a larger number of
reprogramming/erasure cycles than code flash.

e Read values of erased blocks are not guaranteed to be OxFF. Blank check should be used to
determine if memory has been erased but not yet programmed.

Examples

Low-Power Flash Basic Example
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User’s Manual

This is a basic example of erasing and writing to data flash and code flash.

#def i ne FLASH DF_BLOCK_0 0x40100000U /* 1 KB: 0x40100000 - Ox401003FF */
#defi ne FLASH CF_BLOCK 10 0x00005000 /* 2 KB: 0x00005000 - OxO000057FF */
#def i ne FLASH DATA BLOCK SI ZE (1024)
#define FLASH LP_EXAMPLE WRI TE_SI ZE 32
uint8 t g_dest [ TRANSFER LENGTH] ;
uint8 t g_src[ TRANSFER_LENGTH] ;
flash_result_t blank_check_result;
void R FLASH LP basi c_exanpl e (void)
{
/* Initialize p_src to known data */

for (uint32_t i = 0; i < TRANSFER LENGTH; i ++)

g_src[i] = (uint8_t) (‘A + (i %26));
}
/* Open the flash | p instance. */
fsp_err_t err = R FLASH LP _Open(&g_flash_ctrl, &g_flash_cfqg);
handl e_error(err);
/* Erase 1 block of data flash starting at block 0. */
err = R FLASH LP_Erase(&g_flash_ctrl, FLASH DF_ BLOCK 0, 1);
handl e_error(err);
/[* Check if block O is erased. */
err = R FLASH LP_Bl ankCheck(&g_flash_ctrl, FLASH DF BLOCK O,
FLASH DATA BLOCK SI ZE, &bl ank_check result);
handl e_error(err);
/* Verify the previously erased area is blank */
i f (FLASH RESULT NOT_BLANK == bl ank_check _result)

{
handl e_err or (FSP_ERR BLANK_CHECK_ FAI LED) ;

}
/* Wite 32 bytes to the first block of data flash. */

err = R FLASH LP Wite(&g flash ctrl, (uint32_t) g src, FLASH DF BLOCK O,

FLASH_LP_EXAMPLE_WRI TE_SI ZE) ;

handl e_error(err);
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Low-Power Flash Advanced Example

This example demonstrates using BGO to do non-blocking operations on the data flash.
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err = R FLASH LP StatusGet (&g flash ctrl, &status);
} while ((FSP_SUCCESS == err) && (FLASH STATUS BUSY == status));
/* If the interrupt wasn't called process the error. */
if (!interrupt_call ed)
{
handl e_error (FSP_ERR WRI TE_FAI LED) ;
}
/* If the event wasn't a wite conplete process the error. */
i f (FLASH EVENT _WRI TE_COWMPLETE ! = fl ash_event)

{
handl e_error (FSP_ERR WRI TE_FAI LED) ;

}

/* Verify the data was witten correctly. */

if (0 != mencnp(g_src, (uint8_t *) FLASH DF _BLOCK 0, FLASH LP_EXAVPLE WRI TE_SI ZE))

{
handl e_error (FSP_ERR WRI TE_FAI LED) ;

}
}
void flash_call back (flash_callback args t * p_args)
{

interrupt _called = true;

fl ash_event = p_args->event;
}

Data Structures

struct flash_Ip_instance_ctrl_t

Data Structure Documentation

¢ flash_Ip_instance_ctrl_t

struct flash_lp_instance_ctrl_t

Flash instance control block. DO NOT INITIALIZE. Initialization occurs when R_FLASH LP Open() is
called.

Function Documentation
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¢ R_FLASH_LP Open()

fsp_err t R_FLASH LP Open ( flash_ctrl_t *const p_api _ctrl, flash_cfg t const *const p cfg )

Initialize the Low Power flash peripheral. Implements flash_api_t::open.
The Open function initializes the Flash.

This function must be called once prior to calling any other FLASH API functions. If a user supplied
callback function is supplied, then the Flash Ready interrupt will be configured to call the users
callback routine with an Event type describing the source of the interrupt for Data Flash operations.

Example:
/* Open the flash | p instance. */

fsp_err_t err = R FLASH LP_Open(&g_flash_ctrl, &g flash_cfqg);

Note
Providing a callback function in the supplied p_cfg-> callback field automatically configures the Flash for Data
Flash to operate in non-blocking background operation (BGO) mode.

Return values

FSP_SUCCESS Initialization was successful and timer has
started.

FSP_ERR_ASSERTION NULL provided for p_ctrl, p_cfg or p_callback
if BGO is enabled.

FSP_ERR_IRQ BSP_DISABLED Caller is requesting BGO but the Flash
interrupts are not enabled.

FSP_ERR_FCLK FCLK must be a minimum of 4 MHz for Flash
operations.

FSP_ERR_ALREADY_OPEN Flash Open() has already been called.

FSP_ERR_TIMEOUT Failed to exit P/E mode after configuring
flash.
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¢ R_FLASH_LP_Write()

fsp_err t R_FLASH_ LP_Write ( flash_ctrl_t *const p_api ctrl, uint32_t const src_address, uint32_t
flash_address, uint32_t const num_bytes )

Write to the specified Code or Data Flash memory area. Implements flash_api_t::write.
Example:
/* Wite 32 bytes to the first block of data flash. */

err = R FLASH LP Wite(&g flash ctrl, (uint32_t) g src, FLASH DF BLOCK O,
FLASH LP_EXAMPLE W\RI TE_SI ZE) ;

Return values

FSP_SUCCESS Operation successful. If BGO is enabled this
means the operation was started
successfully.

FSP_ERR_IN_USE The Flash peripheral is busy with a prior on-
going transaction.

FSP_ERR_NOT_OPEN The Flash API is not Open.

FSP_ERR_WRITE_FAILED Status is indicating a Programming error for

the requested operation. This may be
returned if the requested Flash area is not

blank.

FSP_ERR_TIMEOUT Timed out waiting for FCU operation to
complete.

FSP_ERR_INVALID SIZE Number of bytes provided was not a

multiple of the programming size or
exceeded the maximum range.

FSP_ERR_INVALID _ADDRESS Invalid address was input or address not on
programming boundary.
FSP_ERR_ASSERTION NULL provided for p_ctrl.
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4 R_FLASH_LP_Erase()

fsp_err t R_FLASH LP Erase ( flash_ctrl_t *const p_api ctrl, uint32_t const address, uint32_t const
num_blocks )

Erase the specified Code or Data Flash blocks. Implements flash_api_t::erase.
Example:
/* Erase 1 block of data flash starting at block 0. */

err = R FLASH LP Erase(&g_flash ctrl, FLASH DF BLOCK 0, 1);

Return values

FSP_SUCCESS Successful open.

FSP_ERR_INVALID BLOCKS Invalid number of blocks specified

FSP_ERR_INVALID_ADDRESS Invalid address specified

FSP_ERR_IN_USE Other flash operation in progress, or API not

initialized

FSP_ERR_ASSERTION NULL provided for p_ctrl

FSP_ERR_NOT _OPEN The Flash APl is not Open.

FSP_ERR_TIMEOUT Timed out waiting for FCU to be ready.

FSP_ERR_ERASE_FAILED Status is indicating a Erase error.
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4 R_FLASH_LP_BlankCheck()

fsp_err t R_FLASH LP BlankCheck ( flash_ctrl_t *const p_api ctrl, uint32_t const address, uint32_t
num_bytes, flash_result t * p blank check result )

Perform a blank check on the specified address area. Implements flash_api_t::blankCheck.
Example:
[* Check if block O is erased. */
err = R FLASH LP Bl ankCheck(&g_flash ctrl, FLASH DF BLOCK O,
FLASH DATA BLOCK_SI ZE, &bl ank_check_result);

handl e_error(err);

Return values

FSP_SUCCESS Blankcheck operation completed with result
in p_blank_check_result, or blankcheck
started and in-progess (BGO mode).

FSP_ERR_INVALID ADDRESS Invalid data flash address was input

FSP_ERR_INVALID SIZE 'num_bytes' was either too large or not
aligned for the CF/DF boundary size.

FSP_ERR_IN_USE Flash is busy with an on-going operation.

FSP_ERR_ASSERTION NULL provided for p_ctrl

FSP_ERR_NOT _OPEN Flash API has not yet been opened.

FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.

FSP_ERR_BLANK CHECK FAILED An error occurred during blank checking.

¢ R_FLASH_LP Close()

fsp_err t R_FLASH LP Close ( flash_ctrl _t *const p_api ctrl)

Release any resources that were allocated by the Flash API. Implements flash_api_t::close.

Return values

FSP_SUCCESS Successful close.

FSP_ERR_ASSERTION NULL provided for p_ctrl or p_cfg.

FSP_ERR_NOT_OPEN Flash APl has not yet been opened.

FSP_ERR_IN_USE The flash is currently in P/E mode.
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¢ R_FLASH_LP_StatusGet()

fsp_err t R_FLASH_ LP_ StatusGet ( flash_ctrl_t *const p_api ctrl, flash_status_t *const p_status )

Query the FLASH for its status. Implements flash_api_t::statusGet.

Example:
flash_status t status;

/* Wait until the current flash operation conpletes. */
do

err = R FLASH LP _StatusGet (&g flash_ctrl, &status);
} while ((FSP_SUCCESS == err) && (FLASH STATUS BUSY == status));

Return values

FSP_SUCCESS Flash is ready and available to accept
commands.
FSP_ERR_ASSERTION NULL provided for p_ctrl
FSP_ERR_NOT _OPEN Flash API has not yet been opened.
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¢ R_FLASH LP_AccessWindowSet()

fsp_err t R_FLASH LP_AccessWindowsSet ( flash_ctrl_t *const p_api ctrl, uint32_t const start_addr,
uint32_t const end_addr )

Note

Configure an access window for the Code Flash memory. Implements flash_api_t::accessWindowSet

An access window defines a contiguous area in Code Flash for which programming/erase is
enabled. This area is on block boundaries. The block containing start_addr is the first block. The
block containing end_addr is the last block. The access window then becomes first block (inclusive)
-> |ast block (exclusive). Anything outside this range of Code Flash is then write protected. As an
example, if you wanted to place an accesswindow on Code Flash Blocks 0 and 1, such that only
those two blocks were writable, you would need to specify (address in block 0, address in block 2)
as the respective start and end address.

If the start address and end address are set to the same value, then the access window is effectively removed. This
accomplishes the same functionality asR FLASH_LP_AccessWindowClear ().

The invalid address and programming boundaries supported and enforced by this function are
dependent on the MCU in use as well as the part package size. Please see the User manual and/or
requirements document for additional information.

Parameters
p_api_ctrl The p api control
[in] start_addr The start address
[in] end_addr The end address
Return values
FSP_SUCCESS Access window successfully configured.
FSP_ERR_INVALID_ADDRESS Invalid settings for start_addr and/or
end_addr.
FSP_ERR_IN_USE FLASH peripheral is busy with a prior
operation.
FSP_ERR_ASSERTION NULL provided for p_ctrl.
FSP_ERR_UNSUPPORTED Code Flash Programming is not enabled.
FSP_ERR_NOT_OPEN Flash APl has not yet been opened.
FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.
FSP_ERR_WRITE_FAILED Status is indicating a Programming error for
the requested operation.
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¢ R_FLASH_LP_AccessWindowClear()

fsp_err t R_FLASH LP_AccessWindowClear ( flash_ctrl _t *const p_api ctrl)

Return values

Remove any access window that is configured in the Code Flash. Implements
flash_api_t::accessWindowClear. On successful return from this call all Code Flash is writable.

FSP_SUCCESS

Access window successfully removed.

FSP_ERR_IN_USE

FLASH peripheral is busy with a prior
operation.

FSP_ERR_ASSERTION

NULL provided for p_ctrl.

FSP_ERR_UNSUPPORTED

Code Flash Programming is not enabled.

FSP_ERR_NOT OPEN

Flash APl has not yet been opened.

FSP_ERR_TIMEOUT

Timed out waiting for the FCU to become
ready.

FSP_ERR_WRITE_FAILED

Status is indicating a Programming error for
the requested operation.

¢ R_FLASH_LP IdCodeSet()

flash_id_code_mode_t mode )

fsp_err t R_FLASH_LP_IdCodeSet ( flash_ctrl _t *const p_api ctrl, uint8_t const *const p_id code,

Return values

Write the ID code provided to the id code registers. Implements flash_api_t::idCodeSet.

FSP_SUCCESS

ID code successfully configured.

FSP_ERR_IN_USE

FLASH peripheral is busy with a prior
operation.

FSP_ERR_ASSERTION

NULL provided for p_ctrl.

FSP_ERR_UNSUPPORTED

Code Flash Programming is not enabled.

FSP_ERR_NOT _OPEN

Flash API has not yet been opened.

FSP_ERR_TIMEOUT

Timed out waiting for completion of extra
command.

FSP_ERR_WRITE_FAILED

Status is indicating a Programming error for
the requested operation.
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¢ R_FLASH_LP Reset()

fsp_err t R_FLASH LP Reset ( flash_ctrl_t *const p_api ctrl)

Reset the FLASH peripheral. Implements flash_api_t::reset.

No attempt is made to check if the flash is busy before executing the reset since the assumption is
that a reset will terminate any existing operation.

Return values

FSP_SUCCESS Flash circuit successfully reset.
FSP_ERR_ASSERTION NULL provided for p_ctrl
FSP_ERR_NOT _OPEN Flash API has not yet been opened.

4 R_FLASH_LP_StartUpAreaSelect()

fsp_err t R_FLASH_LP_StartUpAreaSelect ( flash_ctrl_t *const p_api ctrl, flash_startup_area swap t
swap_type, bool is temporary )

Select which block is used as the startup area block. Implements flash_api_t::startupAreaSelect.

Selects which block - Default (Block 0) or Alternate (Block 1) is used as the startup area block. The
provided parameters determine which block will become the active startup block and whether that
action will be immediate (but temporary), or permanent subsequent to the next reset. Doing a
temporary switch might appear to have limited usefulness. If there is an access window in place
such that Block 0 is write protected, then one could do a temporary switch, update the block and
switch them back without having to touch the access window.

Return values

FSP_SUCCESS Start-up area successfully toggled.

FSP_ERR_IN_USE Flash is busy with an on-going operation.

FSP_ERR_ASSERTION NULL provided for p_ctrl

FSP_ERR_NOT _OPEN Flash API has not yet been opened.

FSP_ERR_WRITE_FAILED Status is indicating a Programming error for
the requested operation.

FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.

FSP_ERR_UNSUPPORTED Code Flash Programming is not enabled.

Cannot set FLASH _STARTUP_AREA BTFLG
when the temporary flag is false.
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4 R_FLASH_LP_UpdateFlashClockFreq()

fsp_err t R_FLASH LP UpdateFlashClockFreq ( flash_ctrl t *const p_api ctrl)

Indicate to the already open Flash API that the FCLK has changed. Implements
flash_api_t::updateFlashClockFreq.

This could be the case if the application has changed the system clock, and therefore the FCLK.
Failure to call this function subsequent to changing the FCLK could result in damage to the flash
macro.

Return values

FSP_SUCCESS Start-up area successfully toggled.

FSP_ERR_IN_USE Flash is busy with an on-going operation.

FSP_ERR_FCLK Invalid flash clock source frequency.

FSP_ERR_ASSERTION NULL provided for p_ctrl

FSP_ERR_NOT _OPEN Flash API has not yet been opened.

FSP_ERR_TIMEOUT Timed out waiting for the FCU to become
ready.

¢ R_FLASH_LP_VersionGet()

fsp_err t R_FLASH_LP VersionGet ( fsp_version_t *const p_version)

Get Flash LP driver version.

Return values

FSP_SUCCESS Operation performed successfully
FSP_ERR_ASSERTION Null Pointer

¢ R_FLASH_LP InfoGet()

fsp_err_t R_FLASH_LP_InfoGet ( flash_ctrl_t *const p_api ctrl, flash_info_t *const p_info )

Returns the information about the flash regions. Implements flash_api_t::infoGet.

Return values

FSP_SUCCESS Successful retrieved the request
information.
FSP_ERR_ASSERTION NULL provided for p_ctrl or p_info.
FSP_ERR_NOT_OPEN The flash is not open.
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4.2.22 Graphics LCD Controller (r_glcdc)

Modules

Functions

fsp_err t R_GLCDC Open (display_ctrl t *const p_api_ctrl, display cfg t const
*const p_cfg)

fsp_err t R_GLCDC Close (display_ctrl_t *const p_api_ctrl)
fsp_err t R_GLCDC Start (display_ctrl_t *const p_api_ctrl)
fsp_err t R_GLCDC_Stop (display_ctrl_t *const p_api_ctrl)

fsp_err t R _GLCDC LayerChange (display_ctrl_t const *const p_api_ctrl,
display_runtime_cfg_t const *const p_cfg, display_frame_layer t
layer)

fsp_err t R_GLCDC BufferChange (display_ctrl t const *const p_api_ctrl,
uint8_t *const framebuffer, display frame layer t layer)

fsp_err t R_GLCDC ColorCorrection (display_ctrl_t const *const p_api_ctrl,
display_correction_t const *const p_correction)

fsp_err t R_GLCDC_ClutUpdate (display_ctrl_t const *const p_api_ctrl,
display clut cfg t const *const p_clut_cfg, display_frame_layer t
layer)

fsp_err t R_GLCDC_ClutEdit (display_ctrl_t const *const p_api_ctrl,
display_frame_layer t layer, uint8_t index, uint32_t color)

fsp_err t R_GLCDC_StatusGet (display_ctrl_t const *const p_api_ctrl,
display_status_t *const status)

fsp_err t R_GLCDC VersionGet (fsp_version_t *p_version)

Detailed Description

Driver for the GLCDC peripheral on RA MCUs. This module implements the Display Interface.

Overview

The GLCDC is a multi-stage graphics output peripheral designed to automatically generate timing
and data signals for LCD panels. As part of its internal pipeline the two internal graphics layers can
be repositioned, alpha blended, color corrected, dithered and converted to and from a wide variety
of pixel formats.
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Features

The following features are available:

Feature Options

Input color formats ARGB8888, ARGB4444, ARGB1555, RGB888
(32-bit), RGB565, CLUT 8bpp, CLUT 4bpp, CLUT
lbpp

Output color formats RGB888, RGB666, RGB565, Serial RGB888 (8-bit
parallel)

Correction processes Alpha blending, positioning, brightness and
contrast, gamma correction, dithering

Timing signals Dot clock, Vsync, Hsync, Vertical and horizontal
data enable (DE)

Maximum resolution Up to 1020 x 1008 pixels (dependent on sync
signal width)

Maximum dot clock 60MHz for serial RGB mode, 54MHz otherwise

Internal clock divisors 1-9, 12, 16, 24, 32

Interrupts Vsync (line detect), Layer 1 underflow, Layer 2
underflow

Other functions Byte-order and endianness control, line repeat
function

Configuration

Build Time Configurations for r_glcdc

The following build time configurations are defined in fsp_cfg/r_glcdc_cfg.h:

Configuration Options Default Description
Parameter Checking ¢ Default (BSP) Default (BSP) If selected, code for
¢ Enabled parameter checking is
* Disabled included in the build.
Color Correction e On Off If selected, code to
e Off adjust brightness,

contrast and gamma
settings is included in
the build. When
disabled all color

correction
configuration options
are ignored.
Configurations for Driver > Graphics > Display Driver on r_glcdc
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This module can be added to the Stacks tab via New Stack > Driver > Graphics > Display Driver on

r glcdc:
Configuration Options Default Description
General > Name Name must be a valid  g_display0 Module name.
C symbol

Interrupts > Callback Name must be a valid  NULL A user callback

Function C symbol function can be defined
here.

Interrupts > Line MCU Specific Options Select the line detect

Detect Interrupt (Vsync) interrupt

Priority priority.

Interrupts > Underflow MCU Specific Options Select the underflow

1 Interrupt Priority interrupt priority for
layer 1.

Interrupts > Underflow MCU Specific Options Select the underflow

2 Interrupt Priority interrupt priority for
layer 2.

Input > Graphics Layer e Yes Yes Specify Used if the

1 > General > Enabled * No graphics layer 1 is
used. If so a
framebuffer will be
automatically
generated based on
the specified height
and horizontal stride.

Input > Graphics Layer Value must be between 480 Specify the number of

1 > General > 16 and 1016 horizontal pixels.

Horizontal size

Input > Graphics Layer Value must be between 272 Specify the number of

1 > General > Vertical 16 and 1020 vertical pixels.

size

Input > Graphics Layer Must be a valid non- 0 Specify the horizontal

1 > General > negative integer with a offset in pixels of the

Horizontal position maximum configurable graphics layer from the

value of 4091 background layer.
Input > Graphics Layer Must be a valid non- 0 Specify the vertical

1 > General > Vertical
position

Input > Graphics Layer
1 > General > Color
format

negative integer with a
maximum configurable
value of 4094

« ARGB8888
(32-bit)

+ RGB888 (32-bit)

« RGB565 (16-bit)

« ARGB1555
(16-bit)

« ARGB4444
(16-bit)

RGB565 (16-bit)

offset in pixels of the
graphics layer from the
background layer.

Specify the graphics
layer Input format. If
selecting CLUT formats,
you must write the
CLUT table data before
starting output.
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CLUTS (8-bit)
CLUT4 (4-bit)
CLUT1 (1-bit)

Input > Graphics Layer e Enabled Disabled Select Used if the

1 > General > Line e Disabled framebuffer starts from

descending mode the bottom of the line.

Input > Graphics Layer Value must be between 255 Based on the alpha

1 > Background Color 0 and 255 value, either the

> Alpha graphics Layer 2
(foreground graphics
layer) is blended into
the graphics Layer 1
(background graphics
layer) or the graphics
Layer 1 is blended into
the monochrome
background layer.

Input > Graphics Layer Value must be between 255 Red component of the

1 > Background Color 0 and 255 background color for

> Red layer 1.

Input > Graphics Layer Value must be between 255 Green component of

1 > Background Color 0 and 255 the background color

> Green for layer 1.

Input > Graphics Layer Value must be between 255 Blue component of the

1 > Background Color
> Blue

Input > Graphics Layer
1 > Framebuffer >
Framebuffer name

0 and 255

This property must be
a valid C symbol

fb_background

background color for
layer 1.

Specify the name for
the framebuffer for
Layer 1.

Jun.26.20

Input > Graphics Layer Must be a valid non- 2 Number of
1 > Framebuffer > negative integer with a framebuffers allocated
Number of maximum configurable for Graphics Layer 1.
framebuffers value of 65535
Input > Graphics Layer Manual Entry .bss Specify the section in
1 > Framebuffer > which to allocate the
Section for framebuffer framebuffer.
allocation
Input > Graphics Layer e On Off Select On if the display
1 > Line Repeat > o Off will be repeated from a
Enable smaller section of the
framebuffer.

Input > Graphics Layer Must be a valid non- 0 Specify the number of
1 > Line Repeat > negative integer with a times the image is
Repeat count maximum configurable repeated.

value of 65535 i.e

(vertical size) x (lines

repeat times) must be

equal to the panel

vertical size
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Input > Graphics Layer
1 > Fading > Mode

Input > Graphics Layer
1 > Fading > Speed

Input > Graphics Layer
2 > General > Enabled

Input > Graphics Layer
2 > General >
Horizontal size

Input > Graphics Layer
2 > General > Vertical
size

Input > Graphics Layer
2 > General >
Horizontal position

Input > Graphics Layer
2 > General > Vertical
position

Input > Graphics Layer
2 > General > Color
format

* None
e Fade-in
e Fade-out

Value must be between
0 and 255

e Yes
e No

Value must be between
16 and 1016

Value must be between
16 and 1020

Must be a valid non-
negative integer with a
maximum configurable
value of 4091

Must be a valid non-
negative integer with a
maximum configurable
value of 4094

* ARGB8888
(32-bit)

e RGB888 (32-bit)

* RGB565 (16-bit)

e ARGB1555
(16-bit)

e ARGB4444
(16-bit)

e CLUTS8 (8-bit)

e CLUT4 (4-bit)

e CLUT1 (1-bit)

None

No

480

272

RGB565 (16-bit)

Select the fade
method.

Specify the number of
frames for the fading
transition to complete.

Specify Used if the
graphics layer 2 is
used. If so a
framebuffer will be
automatically
generated based on
the specified height
and horizontal stride.

Specify the number of
horizontal pixels.

Specify the number of
vertical pixels.

Specify the horizontal
offset in pixels of the
graphics layer from the
background layer.

Specify the vertical
offset in pixels of the
graphics layer from the
background layer.

Specify the graphics
layer Input format. If
selecting CLUT formats,
you must write the
CLUT table data before
starting output.

Input > Graphics Layer e Enabled Disabled Select Used if the

2 > General > Line e Disabled framebuffer starts from

descending mode the bottom of the line.

Input > Graphics Layer Value must be between 255 Based on the alpha

2 > Background Color 0 and 255 value, either the

> Alpha graphics Layer 2
(foreground graphics
layer) is blended into
the graphics Layer 1
(background graphics
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layer) or the graphics
Layer 1 is blended into
the monochrome
background layer.

Input > Graphics Layer Value must be between 255 Red component of the
2 > Background Color 0 and 255 background color for
> Red layer 2.

Input > Graphics Layer Value must be between 255 Green component of

2 > Background Color 0 and 255 the background color
> Green for layer 2.

Input > Graphics Layer Value must be between 255 Blue component of the

2 > Background Color
> Blue

Input > Graphics Layer
2 > Framebuffer >
Framebuffer name

0 and 255

This property must be
a valid C symbol

fb_foreground

background color for
layer 2.

Specify the name for
the framebuffer for
Layer 2.

Jun.26.20

Input > Graphics Layer Must be a valid non- 2 Number of
2 > Framebuffer > negative integer with a framebuffers allocated
Number of maximum configurable for Graphics Layer 2.
framebuffers value of 65535
Input > Graphics Layer Manual Entry .bss Specify the section in
2 > Framebuffer > which to allocate the
Section for framebuffer framebuffer.
allocation
Input > Graphics Layer * On Off Select On if the display
2 > Line Repeat > e Off will be repeated from a
Enable smaller section of the
framebuffer.
Input > Graphics Layer Must be a valid non- 0 Specify the number of
2 > Line Repeat > negative integer with a times the image is
Repeat count maximum configurable repeated.
value of 65535 i.e
(vertical size) x (lines
repeat times) must be
equal to the panel
vertical size
Input > Graphics Layer * None None Select the fade
2 > Fading > Mode ¢ Fade-in method.
e Fade-out
Input > Graphics Layer Value must be between 0 Specify the number of
2 > Fading > Speed 0 and 255 frames for the fading
transition to complete.
Output > Timing > Value must be between 525 Specify the total cycles
Horizontal total cycles 24 and 1024 in a horizontal line. Set
to the number of cycles
defined in the data
sheet of LCD panel
sheet in your system
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Output > Timing > Value must be between 480 Specify the number of
Horizontal active video 16 and 1016 active video cycles in a
cycles horizontal line
(including front and
back porch). Set to the
number of cycles
defined in the data
sheet of LCD panel
sheet in your system.
Output > Timing > Value must be between 40 Specify the number of
Horizontal back porch 6 and 1006 back porch cycles in a
cycles horizontal line. Back
porch starts from the
beginning of Hsync
cycles, which means
back porch cycles
contain Hsync cycles.
Set to the number of
cycles defined in the
data sheet of LCD
panel sheet in your
system.
Output > Timing > Value must be between 1 Specify the number of
Horizontal sync signal 0 and 1023 Hsync signal assertion
cycles cycles. Set to the
number of cycles
defined in the data
sheet of LCD panel
sheet in your system.
Output > Timing > e Low active Low active Select the polarity of
Horizontal sync signal ¢ High active Hsync signal to match
polarity your system.
Output > Timing > Value must be between 316 Specify number of total
Vertical total lines 20 and 1024 lines in a frame
(including front and
back porch).
Output > Timing > Value must be between 272 Specify the number of
Vertical active video 16 and 1020 active video lines in a
lines frame.
Output > Timing > Value must be between 8 Specify the number of
Vertical back porch 3 and 1007 back porch lines in a
lines frame. Back porch
starts from the
beginning of Vsync
lines, which means
back porch lines
contain Vsync lines.
Output > Timing > Value must be between 1 Specify the Vsync
Vertical sync signal 0 and 1023 signal assertion lines in
lines a frame.
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Output > Timing >
Vertical sync signal
polarity

Output > Timing >
Data Enable Signal
Polarity

Output > Timing >
Sync edge

Output > Format >
Color format

Output > Format >
Color order

Output > Format >
Endian

e Low active
¢ High active

e Low active
e High active

¢ Rising edge
¢ Falling edge

24bits RGB888
18bits RGB666
16bits RGB565
8bits serial

RGB
e BGR

¢ Little endian
¢ Big endian

Low active

High active

Rising edge

16bits RGB565

RGB

Little endian

Select the polarity of
Vsync signal to match
to your system.

Select the polarity of
Data Enable signal to
match to your system.

Select the polarity of
Sync signals to match
to your system.

Specify the graphics
layer output format to
match to your LCD
panel.

Select data order for
output signal to LCD
panel.

Select data endianness
for output signal to LCD
panel.

Output > Background  Value must be between 255 Alpha component of

> Alpha 0 and 255 the background color.

Output > Background  Value must be between 0 Red component of the

> Red 0 and 255 background color.

Output > Background  Value must be between 0 Green component of

> Green 0 and 255 the background color.

Output > Background  Value must be between 0 Blue component of the

> Blue 0 and 255 background color.

CLUT > Enabled e Yes No Specify Used if

* No selecting CLUT formats
for a graphics layer
input format. If used, a
buffer (CLUT buffer)
will be automatically
generated based on
the selected pixel
width.

CLUT > Size Must be a valid non- 256 Specify the number of
negative integer with a entries for the CLUT
maximum configurable source data buffer.
value of 256 Each entry consumes 4

bytes (1 word).

TCON > Hsync pin ¢ Not used LCD_TCONO Select the TCON pin

select e LCD_TCONO used for the Hsync

e LCD TCON1 signal to match to your
e LCD_TCONZ2 system.
e LCD TCON3
TCON > Vsync pin ¢ Not used LCD TCON1 Select TCON pin used
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select

TCON > Data enable
(DE) pin select

TCON > Panel clock
source

TCON > Panel clock
division ratio

Color Correction >
Brightness > Enabled

Color Correction >
Brightness > Red
channel

Color Correction >
Brightness > Green
channel

Color Correction >
Brightness > Blue
channel

Color Correction >
Contrast > Enabled

Color Correction >
Contrast > Red
channel gain

Color Correction >
Contrast > Green
channel gain

Color Correction >
Contrast > Blue
channel gain

LCD_TCONO
LCD_TCON1
LCD_TCON2
LCD_TCON3

Not used

LCD_TCONO
LCD_TCON1
LCD_TCON?2
LCD TCON3

¢ |Internal clock

LCD_TCON2

Internal clock

for Vsync signal to
match to your system.

Select TCON pin used
for DataEnable signal
to match to your
system.

Choose between an
internal GLCDCLK
generated from PCLKA
or an external clock
provided to the
LCD_EXTCLK pin.

Select the clock source
divider value.

Enable brightness color
correction.

Red component of the
brightness calibration.
This value is divided by
512 to determine gain.

Green component of
the brightness
calibration. This value
is divided by 512 to
determine gain.

Blue component of the
brightness calibration.

This value is divided by
512 to determine gain.

Enable contrast color
correction.

Red component of the
contrast calibration.
This value is divided by
128 to determine gain.

Green component of
the contrast
calibration. This value
is divided by 128 to
determine gain.

Blue component of the
contrast calibration.

This value is divided by
128 to determine gain.

R11UMO0146EU0120 Revision 1.20
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(GLCDCLK) (GLCDCLK)
e External clock
(LCD_EXTCLK)

Refer to the RA 1/24
Configuration tool for
available options.

* Yes No

e No
Value must be between 512
0 and 1023
Value must be between 512
0 and 1023
Value must be between 512
0 and 1023

e Yes No

e No
Value must be between 128
0 and 255
Value must be between 128
0 and 255
Value must be between 128
0 and 255
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Color Correction >
Gamma > Red

Color Correction >
Gamma > Green

Color Correction >
Gamma > Blue

Color Correction >
Process order

Dithering > Enabled

Dithering > Mode

Dithering > Pattern A

Dithering > Pattern B

Dithering > Pattern C

Dithering > Pattern D

Clock Configuration

The peripheral clock for this module is PCLKA.

On
Off

On
Off

On
Off

Brightness/cont

rast first

Gamma first

Yes
No

Truncate
Round off

2x2 Pattern

Pattern 00
Pattern 01
Pattern 10
Pattern 11

Pattern 00
Pattern 01
Pattern 10
Pattern 11

Pattern 00
Pattern 01
Pattern 10
Pattern 11

Pattern 00
Pattern 01
Pattern 10
Pattern 11

Off

Off

Off

Brightness/contrast

first

No

Truncate

Pattern 11

Pattern 11

Pattern 11

Pattern 11

Enable gamma color
correction for the red
channel.

Enable gamma color
correction for the green
channel.

Enable gamma color
correction for the blue
channel.

Select the color
correction processing
order.

Enable dithering to
reduce the effect of
color banding.

Select the dithering
mode.

Select the dithering
pattern.

Select the dithering
pattern.

Select the dithering
pattern.

Select the dithering
pattern.

The dot clock is typically generated from the PLL with a maximum output frequency of 54 MHz in
most pixel formats (60 MHz for serial RGB). Optionally, a clock signal can be provided to the
LCD_EXTCLK pin for finer framerate control (60 MHz maximum input). With either clock source
dividers of 1-9, 12, 16, 24 and 32 may be used. Clocks must be initialized and settled prior to

starting this module.

Pin Configuration

This module controls a variety of pins necessary for LCD data and timing signal output:
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Pin Name Function Notes

LCD_EXTCLK External clock signal input The maximum input clock
frequency is 60MHz.

LCD_CLK Dot clock output The maximum output frequency
is 54MHz (60MHz in serial RGB
mode).

LCD_DATAN Pixel data output lines Pin assignment and color order

is based on the output block
configuration. See the RA6M3
User's Manual
(RO1UHO0886E)J0100) section
58.1.4 "Output Control for Data
Format" for details.

LCD_TCONnN Panel timing signal output These pins can be configured to
output vertical and horizontal
synchronization and data valid
signals.

Note
There are two banks of pinslisted for the GLCDC in the RA6M3 User's Manual (_A and _B). In most casesthe _B
bank will be used as A conflicts with SDRAM pins. In either case, it is generally recommended to only use pins
fromonly one bank at a time as this allows for superior signal routing both inside and outside the package. If _A
and B pins must be mixed be sure to note the timing precision penalty detailed in Table 60.33 in in the RA6M3
User's Manual.

Usage Notes

Overview

The GLCDC peripheral is a combination of several sub-peripherals that form a pixel data processing
pipeline. Each block passes pixel data to the next but otherwise they are disconnected from one
another - in other words, changing timing block parameters does not affect the output generation
block configuration and vice versa.

Initial Configuration

During R_GLCDC Open all configured parameters are set in the GLCDC peripheral fully preparing it
for operation. Once opened, calling R_GLCDC Start is typically all that is needed for basic operation.
Background generation, timing and output parameters are not configurable at runtime, though layer
control and color correction options can be altered.

Framebuffer Allocation

The framebuffer should be allocated in the highest-speed region available (excluding SRAMHS)
without displacing the stack, heap and other program-critical structures. While the RA6M3 does
contain a relatively large 640K of on-chip SRAM, for many screen sizes and color depths SDRAM will
be required. Regardless of the placement two rules must be followed to ensure correct operation of
the GLCDC:

¢ The framebuffer must be aligned on a 64-byte boundary
e The horizontal stride of the buffer must be a multiple of 64 bytes
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Note
Framebuffers allocated through the RA Configuraton tool automatically follow the alignment and size
requirements.

If your framebuffer will be placed into internal SRAM please note the following best practices:

e The framebuffer should ideally not be placed in the SRAMHS block of SRAM as there is no
speed advantage for doing so. In particular, it is important to ensure the framebuffer does
not push the stack or any heaps outside of SRAMHS to preserve CPU performance.

e |t is recommended to not cross the boundary between SRAMO and SRAM1 with a single
framebuffer for performance reasons.

e If double-buffering is desired (and possible within SRAM), place one framebuffer in SRAMO
and the other in SRAML.

If you are using SRAM for the framebuffer, to ensure correct placement you will need to edit the
linker script to add new sections. Below is an example of the required edits in the GCC and IAR
formats:

GCC Linker
/*

Li nker File for RAG6MB MCU
/]

/* Linker script to configure nmenory regions. */

MEMORY
{
FLASH (rx) : ORIG N = 0x00000000, LENGIH = 0x0200000 /* 2M */
RAM (1 wx) : ORIG N = Ox1FFEOO000, LENGTH = 0x00A0000 /* 640K */
FBO (rwx) : ORIG N = 0x20000000, LENGTH = 0x0080000 /* 512K */ // Section

for framebuffer O (or only franebuffer)

FB1 (rwx) : ORRG N 0x0040000 /* 256K */ // Section

0x20040000, LENGTH

for franmebuffer 1

DATA FLASH (rx) : ORIA N = 0x40100000, LENGTH = 0x0010000 /* 64K */
QSPI _FLASH (rx) : ORIA N = 0x60000000, LENGTH = 0x4000000 /* 64M */
SDRAM (1 wx) : ORIG N = 0x90000000, LENGTH = 0x2000000 /* 32M */
| D CODE (rx) : ORIA N = 0x0100A150, LENGITH = 0x10 /* 16 bytes */
}
/1
.noinit (NOLQAD):
{
= ALI GN(4) ;
__noinit_start = .;
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IAR Linker

Note

The IAR linker does not place items correctly when sections overlap. Asaresult, it is advised to place your
framebuffer(s) as high as possible in the SRAM region in the linker script to maximize the RAM available for
everything else. The below is a general case that should be used unedited only if RAM usage (excluding
framebuffers) isless than 128K.
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/*

*/

/*-Menory Regions-*/

def i
def i
defi
def i
def i
defi
def i
def i
defi
def i
*/

defi
def i
*/

defi
def i
def i
defi
def i
def i
| *

def i
def i
defi
def i
regi
defi
def i
Def

def i
Def

defi

ne synbo
ne synbol
ne synbol
ne synbo
ne synbol
ne synbol
ne synbo
ne synbol
ne synbol
ne synbo

ne synbol
ne synbo

ne synbol
ne synbo
ne synbol
ne synbol
ne synbo
ne synbol
*/
ne nenory
ne region
ne region

ne region

regi on_VECT start

regi
regi
regi
regi
regi
regi
regi
regi

regi

regi

regi

regi
regi
regi
regi
regi

regi

on_VECT end

on_ROVREG st art

on_ROVREG end

on_FLASH start

on_FLASH end

on_RAM st art

on_RAM end

on_FBO_start

on_FBO_end

on_FBl start

on_FBl1 end

on_DF start

on_DF_end

on_SDRAM st art

on_SDRAM end

on_QSPI _start

on_QSPI _end

memw th size

VECT_r egi on

ROVREG r egi on

FLASH r egi on

on_FLASH end];

ne regi on RAM regi on

ne regi on FBO_region

ne franmebuffer 0 region */

ne regi on FBl region

ne franmebuffer

1 region

ne regi on DF_region

*/

0x00000000;

0x000003FF;
0x00000400;

0x000004FF;

0x00000500;

O0x001FFFFF;

0x1FFE0000;
= OX1FFFFFFF; /*

0x20000000;

= Ox2003FFFF; /*

0x20040000;

/*

0x2007FFFF; SRAML

0x40100000;

0x4010FFFF;
= 0x90000000;

OX91FFFFFF;
= 0x60000000;

0x63FFFFFF;
4G

= nmem [fromregi on_VECT_start
mem [ from regi on_ROVREG st art

= mem[fromregi on_FLASH start

mem [ from regi on_RAM st art

mem [ from regi on_FBO_st art

mem [ from regi on_FB1 start

= nmem [fromregi on_DF_start

RAM limted to SRAVHS */

SRAM) dedi cated to franmebuffer O

dedi cated to franmebuffer 1

to regi on_VECT end];
to regi on_ROVREG end];

to

to regi on_RAM end];

to region_FBO end]; /*

to region FB1 end]; /*

to region_DF end];

R11UMO0146EU0120 Revision 1.20

Jun.26.20

RLENESAS

Page 452 /1,560



Flexible Software Package User’s Manual

API| Reference > Modules > Graphics LCD Controller (r_glcdc)

define regi on SDRAM r egi on mem [ from regi on_SDRAM st ar t to

regi on_SDRAM end] ;

define regi on QSPI _region mem [from regi on_QSPlI _start to regi on_QSPI _end];
[* .. %]
define bl ock START OF RAMwi th fixed order { rw section .fsp dtc_vector _table,
bl ock RAM CODE };
pl ace at start of RAMregion { bl ock START OF RAM };
/* Place framebuffer sections first, then the rest of RAM */
place in FBO_region { rw section .fbO0 };
place in FB1_region { rw section .fbl };
pl ace in RAMregi on { rw,
rw section .noinit,
rw section .bss,
rw section .data,

rw secti on HEAP,

rw section .stack };

Graphics Layers and Timing Parameters

The GLCDC synthesizes graphics data through two configurable graphics layers onto a background
layer. The background is used as a solid-color canvas upon which to composite data from the
graphics layers. The two graphics layers are blended on top of each other (Layer 2 above Layer 1)
and overlaid on the background layer based on their individual configuration. The placement of the
layers (as well as LCD timing parameters) are detailed in Figure 1. The colors of the dimensions
indicate which element of the display cfg t struct is being referenced - for example, the width of the
background layer would be [display_cfgl.output.htiming.display_cyc as shown in the figure below.
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Horizontal sync

Timing signals
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«—————— htiming.display _cy¢c ——
= htiming.total_cyc >

Figure 132: GLCDC layers and timing

Note
The data enable signal (if configured) isthe logical AND of the horizontal and vertical data valid signals.
In the GLCDC layers and timing figure, only one graphics layer is shown for simplicity. Additionally, in most
applications the graphics layer(s) will be the same dimensions as the background layer.

Runtime Configuration Options

Note
All runtime configurations detailed below are also automatically configured during R_GLCDC_Open based on the
options selected in the RA Configuration editor.

Blend processing

Control of layer positioning, alpha blending and fading is possible at runtime via

R_GLCDC LayerChange. This function takes a display_runtime_cfg_t parameter which contains the
same input and layer elements as the display_cfg_t control block. Refer to the documentation for
display runtime_cfg t as well as the Examples below to see what options are configurable.

Brightness and contrast
Brightness and contrast correction can be controlled through R_GLCDC_ColorCorrection. The

display_correction_t parameter is used to control enabling, disabling and gain values for both
corrections as shown below:
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di splay correction_t correction;

/* Brightness values are 0-1023 with +512 of fset being neutral
correction. brightness.r = 512;
correction. brightness.g = 512;
correction. brightness.b = 512;

/* Contrast values are 0-255 representing gain of 0-2 (128 is gain of 1) */
correction.contrast.r = 128;
correction.contrast.g = 128;
correction.contrast.b = 128;

/* Brightness and contrast correction can be enabl ed or disabl ed i ndependent of one
anot her */
correction. bri ght ness. enabl e = true;
correction.contrast.enabl e = true;
/* Enabl e correction */

R GLCDC Col or Correction(&g_disp_ctrl, &correction);

Color Look-Up Table (CLUT) Modes

The GLCDC supports 1-, 4- and 8-bit color look-up table (CLUT) formats for input pixel data. By using
these modes the framebuffer size in memory can be reduced significantly, allowing even high-
resolution displays to be buffered in on-chip SRAM. To enable CLUT modes for a layer the color
format must be set to a CLUT mode (either at startup or through R_GLCDC_LayerChange) in addition
to filling the CLUT as appropriate via R_GLCDC_ClutUpdate as shown below:

/* Basic 4-bit (16-color) CLUT definition */
uint32 t clut_4[16] =

{
0xFF000000, /1 Bl ack
OxXFFFFFFFF, /1 \Wite
OxFFOOOOFF, /1 Bl ue
OxFFO080FF, /1 Turquoi se
OxFFOOFFFF, /1l Cyan
OxFFOOFF80, /[l Mnt Geen
OxFFOOFFOO, /1 G een
OxFF80FFO00, /1 Lime Geen
OxFFFFFFOO, /1 Yell ow
OxFFFF8000, /1 Orange
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OxFFFFO0000, /'l Red
OxFFFF0080, /1 Pink
OXFFFFOOFF, /1l NMagent a
OxFF8000FF, /1 Purple
0xFF808080, Il Gay
0x00000000 /1 Transpar ent

I 5
/* Define the CLUT configuration */

di splay clut _cfg t clut_cfg =

{
.start = 0,
. Si ze = 16,
.p_base = clut_4
i

/* Update the CLUT in the GLCDC */
R GLCDC C ut Updat e(&g_di sp_ctrl, &clut cfg, DI SPLAY FRAVE LAYER 1);

Note
If individual elements of the CLUT must be changed or if elements must be changed one at a time (for instance,
when using emWin) it isrecommended to use R_ GLCDC_ClutEdit to avoid repeated memcpy operations.

Other Configuration Options

Gamma correction

Gamma correction is performed based on a gain curved defined in the RA Configuration editor. Each
point on the curve is defined by a threshold and a gain value - each gain value represents a
multiplier from 0x-2x (set as 0-2047) that sets the Y-value of the slope of the gain curve, while each
threshold interval sets the X-value respectively. For a more detailed explanation refer to the RA6M3
User's Manual (RO1UHO0886E)J0100) Figure 58.12 "Calculation of gamma correction value" and the
related description above it.

When setting threshold values three rules must be followed:
e Each threshold value must be greater than the previous value
e Threshold values must be greater than zero and less than 1024

e Threshold values can equal the previous value only if they are 1023 (maximum)

Note
Gamma correction can only be applied via R_GLCDC_Open.

Dithering

Dithering is a method of pixel blending that allows for smoother transitions between colors when
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using a limited palette. A full description of dithering is outside the scope of this document. For more
information on the pattern settings and how to configure them refer to the RA6M3 User's Manual
(RO1UHO886EJ0100) Figure 58.13 "Configuration of dither correction block" and Figure 58.14
"Addition value selection method for 2x2 pattern dither".

Bus Utilization

Note
The data provided in this section consists of estimates only. Experimentation is necessary to
obtain real-world performance data on any platform.

While the GLCDC is very flexible in size and color depth of displays there are considerations to be
made in the tradeoff between color depth, framerate and bus utilization. Below is a table showing
estimates of the load at various resolutions, framerates and color depths based on a PLL frequency
of 120MHz (default) and an effective SDRAM throughput of 60 MB/sec. Bus utilization percentages
are provided for the following use cases:

e Static image display (GLCDC only): One read

e Redrawing one framebuffer every display frame (minimal redraw): One write, one read

e Blitting one buffer to another then redrawing the entire buffer every display frame (worst
case): Two writes, three reads

Name |Width |Heigh | Input | Fram |Buffer |[SRAM [SRAM |SDRA |SRAM |SDRA |SRAM |SDRA

t color |erate | size use bus |Mbus | bus |[Mbus | bus |M bus
depth | (FPS) | (byte (GLC | (GLC | (mini | (mini |(wors |(wors
(bits) s) DC DC malr | malr t t

only) | only) |edraw |edraw |case) |case)

) )
HQVG 240 160 8 60 3840 6% 1% 4% 2% 8% 5% 19%

HQVG 240 160 16 60 7680 12% 2% 8% 4% 15% 10% 38%

QVGA 320 240 16 60 1536 23% 4% 15% 8% 31% 19% 77%

00
wQv 400 240 8 60 9600 15% 2% 10% 5% 19% 12% 48%
GA 0

wQv 400 240 16 60 1920 29% 5% 19% 10% 38% 24% 96%
GA 00

HVGA 480 320 16 60 3072 47% 8% 31% 15% 61% 38% 154%

00
VGA 640 480 16 30 6144 — — 31% — 61% — 154%
00
WVG 800 480 8 60 3840 59% 10% 38% 19% 77% 48% 192%
A 00
WVG 800 480 16 30 7680 — — 38% — 77% — 192%
A 00
WVG 800 480 32 15 1536 — — 38% — 77% — 192%
A 000
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FWVG 960 480 8 30 4608 70% 6% 23% 12% 46% 29% 115%

A 00

FWVG 960 480 16 30 9216 — — 46% — 92% — 230%

A 00

qHD 960 540 8 30 5184 79% 6% 26% 13% 52% 32% 130%
00

Note

Bus utilization values over 100% indicate that the bandwidth for that bus is exceeded in that scenario and GLCDC
underflow and/or dropped frames may result depending on the bus priority setting. It is recommended to avoid
these scenariosif at all possible by reducing the buffer drawing rate, number of draw/copy operations or the
input color depth. Relaxing vertical timing (increasing total line count) or increasing the clock divider are the
easiest ways to increase the time per frame.

Limitations
Developers should be aware of the following limitations when using the GLCDC API:

e Due to a limitation of the GLCDC hardware, if the horizontal back porch is less than the
number of pixels in a graphics burst read (64 bytes) for a layer and the layer is positioned
at a negative X-value then the layer X-position will be locked to the nearest 64-byte
boundary, rounded toward zero.

e The GLCDC peripheral offers a chroma-key function that can be used to perform a green-
screen-like color replacement. This functionality is not exposed through the GLCDC API. See
the descriptions for GRn.AB7 through .AB9 in the RA6M3 User's Manual for further details.

e Use of R_GLCDC ClutUpdate and R_GLCDC_ClutEdit may not be mixed on the same frame.

Examples

Basic Example

This is a basic example showing the minimum code required to initialize and start the GLCDC
module. If the entire display can be drawn within the vertical blanking period no further code may be
necessary.

void glcdc_init (void)
{
fsp_err_t err;
/1 Open the GLCDC driver
err = R GLCDC Open(&g disp _ctrl, &g disp cfg);
/* Handl e any errors. This function should be defined by the user. */
handl e_error(err);
/1 Start display output
err = R GLCDC Start(&g_disp_ctrl);

handl e _error(err);
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Layer Transitions

This example demonstrates how to set up and execute both a sliding and fading layer transition. This
is most useful in static image transition scenarios as switching between two actively-drawing
graphics layers may require up to four framebuffers to eliminate tearing.
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Double-Buffering

Using a double-buffer allows one to be output to the LCD while the other is being drawn to memory,
eliminating tearing and in some cases reducing bus load. The following is a basic example showing

integration of the line detect (Vsync) interrupt to set the timing for buffer swapping and drawing.
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Data Structures

struct glcdc_instance_ctrl_t

struct glcdc_extended_cfg_t
Enumerations

enum glcdc_clk src_t

enum glcdc_panel_clk _div_t

enum glcdc_tcon pin_t

enum glcdc_bus_arbitration_t

enum glcdc_correction_proc_order_t

enum glcdc_tcon_signal_select t

enum glcdc_clut_plane_t

enum glcdc_dithering_mode_t

enum glcdc_dithering_pattern_t

enum glcdc_input_interface_format t

enum glcdc_output interface format t
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enum glcdc_dithering_output_format_t

Data Structure Documentation

¢ glcdc_instance_ctrl_t

struct glcdc_instance ctrl t

Display control block. DO NOT INITIALIZE.

¢ glcdc_extended_cfg_t

struct glcdc_extended cfg t
GLCDC hardware specific configuration

Data Fields
glcdc_tcon_pin_t tcon_hsync GLCD